R&S®SMW-B14/-B15/-K71/-K72/-K73/-K74/-K75/-K820/-K821
Fading Simulation
User Manual
Fading Simulator, Dynamic Fading, Enhanced Fading Models, MIMO-OTA Enhancements, MIMO-Fading/Routing, Higher Order MIMO, Customized Dynamic Fading, MIMO Subsets
This document describes the following software options:

- R&S®SMW-B14/-B15/-K71/-K72/-K73/-K74/-K75/-K820/-K821
  1413.1500.02, 1414.4710.xx, 1413.3532.xx, 1413.3584.xx, 1414.2300.xx, 1413.3632.xx,
  1413.9576.xx, 1414.2581.xx, 1414.4403.xx

This manual describes firmware version FW 4.60.092.xx and later of the R&S®SMW200A.
Contents

1 Preface ........................................................................................................................................... 13
   1.1 About this Manual ...................................................................................................................... 13

1.2 Documentation Overview .............................................................................................................. 13
   1.2.1 Getting Started Manual ...................................................................................................... 14
   1.2.2 User Manuals and Help ........................................................................................................ 14
   1.2.3 Tutorials ................................................................................................................................ 14
   1.2.4 Service Manual ..................................................................................................................... 14
   1.2.5 Instrument Security Procedures ............................................................................................ 15
   1.2.6 Basic Safety Instructions ....................................................................................................... 15
   1.2.7 Data Sheets and Brochures .................................................................................................. 15
   1.2.8 Release Notes and Open Source Acknowledgment (OSA) ..................................................... 15
   1.2.9 Application Notes, Application Cards, White Papers, etc. ..................................................... 15

2 Welcome to the Fading Simulator ................................................................................................. 16
   2.1 Accessing the Fading Simulator ................................................................................................. 17
   2.2 Scope ....................................................................................................................................... 17
   2.3 Notes on Screenshots ................................................................................................................. 18

3 About the Fading Simulator ........................................................................................................... 19
   3.1 Required Options ....................................................................................................................... 19
   3.2 Overview of the Functions Provided by the Fading Simulator ................................................... 20
   3.3 Definition of Commonly Used Terms .......................................................................................... 22
   3.4 Major Differences Between R&S SMW-B14 and R&S SMW-B15 .............................................. 25
   3.5 Further Signal Processing ............................................................................................................ 26

4 Fading Settings ............................................................................................................................... 27
   4.1 General Settings ......................................................................................................................... 28
   4.2 Restart Settings ........................................................................................................................... 37
   4.3 Insertion Loss Configuration, Coupled Parameters and Global Fader Coupling ...................... 39
      4.3.1 Insertion Loss Configuration Settings ................................................................................ 41
      4.3.2 Coupled Parameters and Global Fader Coupling Settings ................................................. 42
   4.4 Path Table .................................................................................................................................. 44
      4.4.1 Table Settings ....................................................................................................................... 46
4.4.2 Copy Path Group Settings ................................................................. 47
4.4.3 Path Table Settings ........................................................................... 48
4.5 Path Graph ......................................................................................... 56
4.6 Birth Death Propagation ................................................................. 57
4.7 Moving Propagation ........................................................................ 63
4.7.1 Moving Propagation Conditions for Testing of Baseband Performance ........................................................................... 63
4.7.2 Moving Propagation Conditions for Testing the UL Timing Adjustment Performance ........................................................................... 66
4.7.2.1 Scenario 1 ......................................................................................... 67
4.7.2.2 Scenario 2 ......................................................................................... 68
4.7.3 Path Tables Moving Propagation .................................................... 68
4.7.3.1 One Moving Channel ................................................................ 68
4.7.3.2 All Moving Channels ................................................................... 70
4.8 Two Channel Interferer ................................................................... 71
4.9 Customized Dynamic Fading ............................................................ 77
4.10 High-Speed Train ........................................................................... 79
4.10.1 Scenario 1 and Scenario 3 .............................................................. 80
4.10.2 Scenario 2 ....................................................................................... 80
4.10.3 High-Speed Train Scenario Parameters ....................................... 80
4.11 Custom Fading Profile ..................................................................... 85

5 Signal Routing (non-MIMO) Settings ................................................. 88

6 Multiple Input Multiple Output (MIMO) ............................................. 91
6.1 Multiple Entity MxN MIMO Test Configurations ............................... 92
6.2 Signal Routing Settings in MIMO Configuration .............................. 92
6.3 Fading Settings in MIMO Configuration ........................................... 94
6.3.1 Current Path (Tap) Settings ............................................................. 99
6.3.2 Correlation Matrix Table ................................................................. 100
6.3.3 Relative Gain Vector Matrix Settings ........................................... 102
6.3.4 Kronecker Mode Correlation Coefficients .................................. 104
6.3.5 TGn/TGac Channel Models Settings ............................................ 106
6.3.6 SCME/WINNER Model Settings .................................................. 108
6.3.7 SCM Fading Profile ....................................................................... 112
6.3.7.1 SCM Cluster Settings ................................................................. 113
6.3.7.2 3D Channel Model ................................................................. 115
6.3.7.3 Channel Polarization Settings................................................................. 115
6.3.7.4 Antenna Modeling Settings................................................................. 117
6.3.7.5 LOS Component Settings................................................................. 120
6.3.7.6 Subpath Start Phases........................................................................... 121
6.3.8 MIMO OTA Testing Related Settings.................................................... 123
6.3.8.1 Channel Polarization Settings.......................................................... 127
6.3.8.2 Antenna Model Settings.................................................................... 130
6.3.9 Inverse Channel Matrix........................................................................ 137
6.4 Bypassing a Deactivated Fading Simulator............................................ 138

7 Remote-Control Commands................................................................. 142
7.1 General Settings....................................................................................... 143
7.2 Delay Modes........................................................................................... 165
7.3 Birth Death.............................................................................................. 175
7.4 High Speed Train..................................................................................... 179
7.5 Moving Propagation................................................................................ 183
7.6 MIMO Settings......................................................................................... 188
7.7 TGn Settings............................................................................................ 197
7.8 SCME/WINNER and Antenna Model Settings.......................................... 200
7.9 2 Channel Interferer................................................................................ 210
7.10 Custom Fading Profile............................................................................ 215
7.11 SCM Fading Profile................................................................................ 216
7.12 Customized Dynamic Fading................................................................... 225

Annex........................................................................................................... 229

A Predefined Fading Settings................................................................. 229
A.1 CDMA Standards..................................................................................... 229
A.1.1 CDMA 1 (8km/h - 2 Path).................................................................. 230
A.1.2 CDMA 2 (30km/h - 2 Path)............................................................... 230
A.1.3 CDMA 3 (30km/h - 1 Path)............................................................... 230
A.1.4 CDMA 4 (100km/h - 3 Path)............................................................. 231
A.1.5 CDMA 5 (0km/h - 2 Path)................................................................ 231
A.1.6 CDMA 6 (3km/h - 1 Path)................................................................ 232
A.2 GSM Standards....................................................................................... 232
A.2.1 GSM TU3 (6 Path)...................................................................................................... 232
A.2.2 GSM TU50 (6 Path).................................................................................................. 233
A.2.3 GSM HT100 (6 Path)............................................................................................... 233
A.2.4 GSM RA250 (6 Path).............................................................................................. 233
A.2.5 GSM ET50 (EQ50) (6 Path)................................................................................... 234
A.2.6 GSM ET60 (EQ60) (6 Path)................................................................................... 234
A.2.7 GSM ET100 (EQ100) (6 Path).............................................................................. 235
A.2.8 GSM TU3 (12 Path)............................................................................................... 235
A.2.9 GSM TU50 (12 Path)............................................................................................. 236
A.2.10 GSM HT100 (12 Path)........................................................................................ 236
A.2.11 GSM TI5.............................................................................................................. 237

A.3 NADC Standards....................................................................................................... 237
A.3.1 NADC 8 (2 Path).................................................................................................... 237
A.3.2 NADC 50 (2 Path)............................................................................................... 238
A.3.3 NADC 100 (2 Path)............................................................................................. 238

A.4 PCN Standards.......................................................................................................... 238
A.4.1 PCN TU1.5 (6 Path)............................................................................................ 239
A.4.2 PCN TU50 (6 Path)............................................................................................. 239
A.4.3 PCN HT100 (6 Path)............................................................................................ 239
A.4.4 PCN RA130 (6 Path)........................................................................................... 240
A.4.5 PCN ET50 (EQ50) (6 Path)................................................................................ 240
A.4.6 PCN ET60 (EQ60) (6 Path)................................................................................ 240
A.4.7 PCN ET100 (EQ100) (6 Path)............................................................................ 241
A.4.8 PCN TU1.5 (12 Path)........................................................................................ 241
A.4.9 PCN TU50 (12 Path)......................................................................................... 242
A.4.10 PCN HT100 (12 Path)....................................................................................... 243

A.5 TETRA Standards..................................................................................................... 243
A.5.1 TETRA TU50 (2 Path)......................................................................................... 244
A.5.2 TETRA TU50 (6 Path)......................................................................................... 244
A.5.3 TETRA BU50 (2 Path)......................................................................................... 244
A.5.4 TETRA HT200 (2 Path)....................................................................................... 245
A.5.5 TETRA HT200 (6 Path)....................................................................................... 245
A.5.6 TETRA ET200 (4 Path)....................................................................................... 245
A.5.7 TETRA DU 50 (1Path)................................................................................................ 246
A.5.8 TETRA DR 50 (1Path)............................................................................................. 246
A.6 3GPP Standards......................................................................................................... 247
A.6.1 3GPP Case 1 (UE/BS). ............................................................................................ 247
A.6.2 3GPP Case 2 (UE/BS). ............................................................................................ 248
A.6.3 3GPP Case 3 (UE/BS). ............................................................................................ 248
A.6.4 3GPP Case 4 (UE). .................................................................................................. 248
A.6.5 3GPP Case 5 (UE). .................................................................................................. 249
A.6.6 3GPP Case 6 (UE) and Case 4 (BS)........................................................................ 249
A.6.7 3GPP Mobile Case 7 (UE-Sector). ........................................................................... 250
A.6.8 3GPP Mobile Case 7 (UE-Beam). .......................................................................... 250
A.6.9 3GPP Mobile Case 8 (UE, CQI)............................................................................... 250
A.6.10 3GPP Mobile PA3. .................................................................................................. 251
A.6.11 3GPP Mobile PB3. .................................................................................................. 251
A.6.12 3GPP Mobile VA3, 3GPP Mobile VA30, 3GPP Mobile VA120.............................. 252
A.6.13 3GPP MBSFN Propagation Channel Profile (18 Path)............................................. 252
A.6.14 3GPP Birth Death.................................................................................................. 253
A.6.15 3GPP TUx............................................................................................................... 254
A.6.16 3GPP HTx............................................................................................................... 255
A.6.17 3GPP RAx............................................................................................................... 256
A.6.18 3GPP Birth Death.................................................................................................. 257
A.6.19 Reference + Moving Channel.................................................................................. 257
A.6.20 HST1 Open Space, HST1 Open Space (DL+UL)...................................................... 257
A.6.21 HST2 Tunnel Leaky Cable....................................................................................... 257
A.6.22 HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL+UL)...................... 257
A.7 WLAN Standards....................................................................................................... 258
A.7.1 WLAN / HyperLan/2 Model A................................................................................ 258
A.7.2 WLAN / HyperLan/2 Model B................................................................................ 259
A.7.3 WLAN / HyperLan/2 Model C................................................................................ 260
A.7.4 WLAN / HyperLan/2 Model D................................................................................ 261
A.7.5 WLAN / HyperLan/2 Model E................................................................................ 262
A.8 DAB Standards.......................................................................................................... 263
A.8.1 DAB RA (4Tabs). ..................................................................................................... 263
A.8.2 DAB RA (6 Tabs)......................................................................................................... 264
A.8.3 DAB TU (12 Tabs)....................................................................................................... 264
A.8.4 DAB TU (6 Tabs)......................................................................................................... 265
A.8.5 DAB SFN (VHF).......................................................................................................... 265
A.9 WIMAX Standards..................................................................................................... 266
  A.9.1 SUI 1 (omni ant., 90%)............................................................................................. 266
  A.9.2 SUI 1 (omni ant., 75%)............................................................................................. 267
  A.9.3 SUI 1 (30° ant., 90%)................................................................................................ 267
  A.9.4 SUI 1 (30° ant., 75%)................................................................................................ 267
  A.9.5 SUI 2 (omni ant., 75%)............................................................................................. 268
  A.9.6 SUI 2 (30° ant., 90%)................................................................................................ 268
  A.9.7 SUI 2 (30° ant., 75%)................................................................................................ 268
  A.9.8 SUI 3 (omni ant., 90%)............................................................................................. 269
  A.9.9 SUI 3 (omni ant., 75%)............................................................................................. 269
  A.9.10 SUI 3 (30° ant., 90%).............................................................................................. 270
  A.9.11 SUI 3 (30° ant., 75%).............................................................................................. 270
  A.9.12 SUI 4 (omni ant., 90%)............................................................................................. 270
  A.9.13 SUI 4 (omni ant., 75%)............................................................................................. 271
  A.9.14 SUI 4 (30° ant., 90%).............................................................................................. 271
  A.9.15 SUI 4 (30° ant., 75%).............................................................................................. 272
  A.9.16 SUI 5 (omni ant., 90%)............................................................................................. 272
  A.9.17 SUI 5 (omni ant., 75%)............................................................................................. 272
  A.9.18 SUI 5 (omni ant., 50%)............................................................................................. 273
  A.9.19 SUI 5 (30° ant., 90%).............................................................................................. 273
  A.9.20 SUI 5 (30° ant., 75%).............................................................................................. 274
  A.9.21 SUI 5 (30° ant., 50%).............................................................................................. 274
  A.9.22 SUI 6 (omni ant., 90%)............................................................................................. 274
  A.9.23 SUI 6 (omni ant., 75%)............................................................................................. 275
  A.9.24 SUI 6 (omni ant., 50%)............................................................................................. 275
  A.9.25 SUI 6 (30° ant., 90%).............................................................................................. 276
  A.9.26 SUI 6 (30° ant., 75%).............................................................................................. 276
  A.9.27 SUI 6 (30° ant., 50%).............................................................................................. 276
  A.9.28 ITU OIP-A................................................................................................................ 277
A.9.29 ITU OIP-B
A.9.30 ITU V-A 60
A.9.31 ITU V-A 120

A.10 LTE Standards
A.10.1 CQI 5Hz
A.10.2 EPA (Extended Pedestrian A)
A.10.3 EVA (Extended Vehicular A)
A.10.4 ETU (Extended Typical Urban)
A.10.5 MBSFN Propagation Channel Profile (5 Hz)
A.10.6 HST1 Open Space
A.10.7 HST3 Tunnel Multi Antennas
A.10.8 ETU 200Hz Moving
A.10.9 Pure Doppler Moving

A.11 LTE-MIMO Standards
A.11.1 EPA (Extended Pedestrian A)
A.11.2 EVA (Extended Vehicular A)
A.11.3 ETU (Extended Typical Urban)
A.11.4 MIMO Parameter
A.11.5 HST3 Tunnel Multi Antennas

A.12 WIMAX-MIMO Standards
A.12.1 ITU Pedestrian B 3
A.12.2 ITU Vehicular A-60

A.13 1xEVDO Standards
A.13.1 1xEVDO Chan. 1
A.13.2 1xEVDO Chan. 1 (Bd. 5, 11)
A.13.3 1xEVDO Chan. 2
A.13.4 1xEVDO Chan. 2 (Bd. 5, 11)
A.13.5 1xEVDO Chan. 3
A.13.6 1xEVDO Chan. 3 (Bd. 5, 11)
A.13.7 1xEVDO Chan. 4
A.13.8 1xEVDO Chan. 4 (Bd. 5, 11)
A.13.9 1xEVDO Chan. 5
A.13.10 1xEVDO Chan. 5 (Bd. 5, 11)
A.14 3GPP/LTE High Speed Train.................................................................292
A.14.1 HST1 Open Space, HST1 Open Space (DL+UL).................................292
A.14.2 HST2 Tunnel Leaky Cable, HST2 Tunnel Leaky Cable (DL+UL).........293
A.14.3 HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL+UL)...293
A.15 3GPP/LTE Moving Propagation............................................................294
A.15.1 Reference + Moving Channel..............................................................294
A.15.2 ETU 200Hz Moving (UL Timing Adjustment, Scenario 1)...................295
A.15.3 Pure Doppler Moving (UL Timing Adjustment, Scenario 2)...............295
A.16 SCM and SCME Channel Models for MIMO OTA................................296
A.16.1 SCME/Geo SCME Urban Micro-Cell Channel (UMi) 3 km/h and 30 km/h...297
A.16.2 SCME/Geo SCME Urban Macro-Cell Channel (UMa) 3 km/h and 30 km/h...298
A.17 Watterson Standards..............................................................................299
A.17.1 Watterson I1.......................................................................................299
A.17.2 Watterson I2.......................................................................................300
A.17.3 Watterson I3.......................................................................................300
A.18 802.11n-SISO Standards......................................................................301
A.19 802.11n-MIMO Standards....................................................................301
A.19.1 Model A............................................................................................301
A.19.2 Model B............................................................................................302
A.19.3 Model C............................................................................................303
A.19.4 Model D............................................................................................304
A.19.5 Model E............................................................................................306
A.19.6 Model F............................................................................................309
A.20 802.11ac-MIMO Standards.................................................................312
A.20.1 Model A (≤ 40 MHz)........................................................................312
A.20.2 Model B (≤ 40 MHz)........................................................................313
A.20.3 Model C (≤ 40 MHz)........................................................................314
A.20.4 Model D (≤ 40 MHz)........................................................................315
A.20.5 Model E (≤ 40 MHz)........................................................................317
A.20.6 Model F (≤ 40 MHz)........................................................................320
A.21 802.11ac-SISO Standards...................................................................323
A.22 802.11p Channel Models......................................................................323
A.22.1 Rural LOS.........................................................................................324
A.22.2 Urban Approaching LOS................................................................. 324
A.22.3 Urban Crossing NLOS................................................................. 324
A.22.4 Highway LOS............................................................................. 325
A.22.5 Highway NLOS.......................................................................... 325
A.23 5G NR Standards...................................................................... 325
A.23.1 FR1 TDLA30-5/10 Hz.............................................................. 326
A.23.2 FR1 TDLB100-400 Hz.............................................................. 327
A.23.3 FR1 TDLC300-100 Hz.............................................................. 327
A.23.4 FR2 TDLA30-75/300 Hz........................................................... 328
A.23.5 MIMO Parameter.................................................................. 328

B Antenna Pattern File Format.......................................................... 329

Glossary: Specifications, References, Further Information.......... 333

List of Commands.......................................................................... 334

Index.............................................................................................. 339
1 Preface

1.1 About this Manual

This User Manual is a supplement to the user manual for the base unit and provides all the information specific to the Fading Simulator. All general instrument functions and settings common to all applications and operating modes are described in the main R&S SMW User Manual.

The main focus in this manual is on the provided settings and the tasks required to generate a signal. The following topics are included:

- **Welcome to the Fading Simulator R&S SMW-B14/B14/-K71/-K72/-K73/-K74/-K75/-K76/-K820**
  Introduction to and getting familiar with the option

- **About the Fading Simulator**
  Background information on basic terms and principles in the context of the signal generation

- **Configuration and Settings**
  A concise description of all functions and settings available to configure the signal generation with their corresponding remote control command; the description is divided into several sections:
  - Fading Settings
  - Signal Routing (non-MIMO) Settings
  - Multiple Input Multiple Output (MIMO)
  - Summation Ratio A/B

- **Remote Control Commands**
  Remote commands required to configure and perform signal generation in a remote environment, sorted by tasks (Commands required to set up the instrument or to perform common tasks on the instrument are provided in the main R&S SMW User Manual)
  Programming examples demonstrate the use of many commands and can usually be executed directly for test purposes

- **Annex**
  Reference material

- **List of remote commands**
  Alphabetical list of all remote commands described in the manual

- **Index**

1.2 Documentation Overview

This section provides an overview of the R&S SMW user documentation. Unless specified otherwise, you find the documents on the R&S SMW product page at:
1.2.1 Getting Started Manual

Introduces the R&S SMW and describes how to set up and start working with the product. Includes basic operations, typical measurement examples, and general information, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.2.2 User Manuals and Help

Separate manuals for the base unit and the software options are provided for download:

- Base unit manual
  Contains the description of all instrument modes and functions. It also provides an introduction to remote control, a complete description of the remote control commands with programming examples, and information on maintenance, instrument interfaces and error messages. Includes the contents of the getting started manual.

- Software option manual
  Contains the description of the specific functions of an option. Basic information on operating the R&S SMW is not included.

The contents of the user manuals are available as help in the R&S SMW. The help offers quick, context-sensitive access to the complete information for the base unit and the software options.

All user manuals are also available for download or for immediate display on the Internet.

1.2.3 Tutorials

The R&S SMW provides interactive examples and demonstrations on operating the instrument in form of tutorials. A set of tutorials is available directly on the instrument.

1.2.4 Service Manual

Describes the performance test for checking the rated specifications, module replacement and repair, firmware update, troubleshooting and fault elimination, and contains mechanical drawings and spare part lists.

The service manual is available for registered users on the global Rohde & Schwarz information system (GLORIS, https://gloris.rohde-schwarz.com).
1.2.5 Instrument Security Procedures

Deals with security issues when working with the R&S SMW in secure areas. It is available for download on the Internet.

1.2.6 Basic Safety Instructions

Contains safety instructions, operating conditions and further important information. The printed document is delivered with the instrument.

1.2.7 Data Sheets and Brochures

The data sheet contains the technical specifications of the R&S SMW. It also lists the options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific characteristics.

See www.rohde-schwarz.com/brochure-datasheet/smw200a

1.2.8 Release Notes and Open Source Acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current firmware version, and describe the firmware installation.

The open source acknowledgment document provides verbatim license texts of the used open source software.

See www.rohde-schwarz.com/firmware/smw200a

1.2.9 Application Notes, Application Cards, White Papers, etc.

These documents deal with special applications or background information on particular topics.

2 Welcome to the Fading Simulator

The hardware option R&S SMW-B14/B15 in combination with the firmware applications R&S SMW-K71/-K72/-K73/-K74/-K75/-K820 add functionality to simulate fading propagation conditions.

The most important R&S SMW-B14/B15-K71/-K72/-K73/-K74/-K75/-K76/-K820 features at a glance:

- Simulation of real time fading conditions in SISO and MIMO modes.
- Main characteristics in SISO mode:
  - Maximal bandwidth $B_{\text{max}} = 160$ MHz (R&S SMW-B14) and 200 MHz (R&S SMW-B15)
  - Up to 20 dynamic fading paths in SISO mode in two independent channels
- Support of versatile MIMO configurations, like 2x2, 2x8 and 4x4 MIMO channels with up to 32 MIMO channels
  Main characteristics of the 4x4 MIMO mode:
  - 20 paths per MIMO channel
  - Sampling rate in 4x4 MIMO mode $f_{\text{sys}} = 100$ MHz (R&S SMW-B14) and 125 MHz (R&S SMW-B15)
  - Maximal bandwidth up to $B_{\text{max}}$, depending on the MIMO mode
- Simulation of multiple entity MIMO scenarios, like 4x2x2 MIMO or 8xSISO (8x1x1) configurations
- A wide range of presets based on the test specifications of the major mobile radio standards, incl. Rel. 15 5G new radio channel models
- Graphical presentation of the defined fading paths

For more information, see data sheet.

This user manual contains a description of the functionality that the application provides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are described in the R&S SMW user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMW200A

Installation

You can find detailed installation instructions in the delivery of the option or in the R&S SMW service manual.
2.1 Accessing the Fading Simulator

To access and configure the "Fading Simulator" settings

Depending on the installed options:

1. Option: R&S SMW-B14
   a) In the block diagram of the R&S SMW, select "Fading > Fading Settings".

2. Option: R&S SMW-B15
   a) In the block diagram of the R&S SMW, select "I/Q Stream Mapper > Fading/ Baseband Config > Mode = Advanced".
   b) Select "Signal Outputs = Analog & Digital"
   c) Confirm with "Apply".
   d) In the block diagram of the R&S SMW, select "Fading > Fading Settings".

A dialog box opens that display the provided general settings.

The signal generation is not started immediately. To start signal generation with the default settings, select "Fading > State > On".

For information, see:
- Chapter 3, "About the Fading Simulator", on page 19
- Chapter 4, "Fading Settings", on page 27
- Chapter 5, "Signal Routing (non-MIMO) Settings", on page 88
- Chapter 6, "Multiple Input Multiple Output (MIMO)", on page 91

2.2 Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the same way are not described here.

In particular, it includes:
- Managing settings and data lists, like storing and loading settings, creating and accessing data lists, or accessing files in a particular directory.
- Information on regular trigger, marker and clock signals and filter settings, if appropriate.
- General instrument configuration, such as checking the system configuration, configuring networks and remote operation.
- Using the common status registers.

For a description of such tasks, see the R&S SMW user manual.
2.3 Notes on Screenshots

When describing the functions of the product, we use sample screenshots. These screenshots are meant to illustrate as many as possible of the provided functions and possible interdependencies between parameters. The shown values may not represent realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options installed. Thus, some functions shown in the screenshots may not be available in your particular product configuration.
3 About the Fading Simulator

Equipped with the required options, the R&S SMW allows you to superimpose real time fading on the baseband signal at the output of the baseband block. In R&S SMW equipped with standard baseband (R&S SMW-B10) and fitted with all the possible fading options, there are up to 20 fading paths in SISO mode and per MIMO channel in 4x4 MIMO mode available.

3.1 Required Options

R&S SMW equipped with standard baseband (R&S SMW-B10)

The equipment layout for simulating fading effects in non-MIMO configurations:

- Option Baseband Generator (R&S SMW-B10) per signal path
- Option Baseband main module, one/two I/Q paths to RF (R&S SMW-B13/B13T)
- Option Fading Simulator (R&S SMW-B14) per signal path
  (sufficient for simulation of fading paths with standard delay and paths with enhanced resolution)
- Additional options that extend the fading functionality:
  - Option Dynamic Fading (R&S SMW-K71) per signal path
    (required for the simulation of dynamic fading conditions, like birth death propagation, moving propagation, two-channels interferes, high-speed train and customized fading conditions)
  - Option Extended statistic functions (R&S SMW-K72) per signal path
    (required for additional fading profiles and some of the predefined test scenarios)
  - Option MIMO-OTA Enhancements (R&S SMW-K73) per signal path
    (required for full support of antenna radiation patterns, inverse channel matrix and the geometric-based channel model)
  - Option Customized Fading (R&S SMW-K820) per signal path
    (required for import of dynamic fading list)

For more information, see data sheet.

The equipment layout for simulating fading effects in MIMO configurations:

- Two options Baseband Generator (R&S SMW-B10)
- Option two I/Q paths to RF (R&S SMW-B13T)
- At least two options Fading Simulator (R&S SMW-B14)
- Option MIMO Fading (R&S SMW-K74)
  (required for the configuration of MIMO scenarios, like 1x2x8 or 1x4x4 scenarios)
- Option Higher-Order MIMO (R&S SMW-K75)
  (required for the configuration of higher-order MIMO scenarios, like 4x2x2)
- Option Multiple Entities (R&S SMW-K76)
(required for the configurations with more than two entities, like 8x1x1 scenarios)

R&S SMW equipped with wideband baseband (R&S SMW-B9)

- Option baseband wideband generator (R&S SMW-B9) per signal path
- Option baseband main module (R&S SMW-B13XT)
- Option fading simulator (R&S SMW-B15) per signal path (sufficient for simulation of fading paths with standard delay and paths with enhanced resolution)
- Option MIMO Fading (R&S SMW-K74) (required for the configuration of MIMO scenarios with up to 16 channels, like 1x2x8 or 1x4x4 scenarios)
- Option Multiple Entities (R&S SMW-K76) (required for the configurations with more than two entities, like 2x1x1 scenarios)

For more information, see the data sheet.

3.2 Overview of the Functions Provided by the Fading Simulator

This section summarizes the key functions of the fading simulator to emphasize the way it is suitable for test setups during research, development, and quality assurance involving mobile radio equipment.

Flexible configuration for support of different test scenarios

You can use the provided fading channels and configure them differently for different test scenarios. Use the same input signal and two separate output signals, for example, to simulate a frequency diversity. Or use separate input signals and sum them after fading, to simulate a network handover, for instance.

See also Chapter 5, "Signal Routing (non-MIMO) Settings", on page 88.

Predefined fading scenarios

The fading simulator is equipped with a wide range of presets based on the test specifications of the major mobile radio standards. For more complex tests, all the parameters of the supplied fading configurations can be user-defined as required.

See also "Standard / Test Case" on page 30.

Repeatable test conditions

To ensure the repeatability of the tests, the fading process is always initiated from a defined starting point.

See also Chapter 4.2, "Restart Settings", on page 37.
Graphical presentation

The path graph displays the current defined fading paths and supports you to configure the desired fading channel.

See also Chapter 4.5, "Path Graph", on page 56.

Simulation of diverse fading effects

During transmission of a signal from the transmitter to the receivers, diverse fading effects occur. In the fading simulator, you can simulate these effects separately or in combination.

Using the fading configurations for example, you can define up to 20 fading paths with different delays as they would occur on a transmission channel due to different propagation paths.

See also Chapter 4.4, "Path Table", on page 44.

Predefined fast fading profile for different fading scenarios

The fading simulator provides a wide range of fast fading profiles. You can define the fading conditions per generated fading path. The fast fading profiles simulate fast fluctuations of the signal power level which arise due to variation between constructive and destructive interference during multipath propagation.

See also "Configuration" on page 30 and "Profile" on page 49

Simulation of slow fading effect

"Lognormal" and "Suzuki Fading" are slow fading profiles suitable to simulate slow level changes which can occur, due to shadowing effects (for example tunnels, buildings blocks or hills).

See also Chapter 4.4, "Path Table", on page 44.

Simulation of dynamic configurations

Delay variations (whether sudden or slow) do not become important until we reach the fast modulation standards, such as the 3GPP FDD or EUTRA/LTE standards. The delay variations start to play a role if they are on the order of magnitude of the transmitted symbols so that transmission errors can arise.

The provided dynamic configurations simulate dynamic propagation in conformity with test cases defined in the 3GPP and MediaFlo specifications.

See also:
- Chapter 4.6, "Birth Death Propagation", on page 57
- Chapter 4.7, "Moving Propagation", on page 63
- Chapter 4.10, "High-Speed Train", on page 79
- Chapter 4.8, "Two Channel Interferer", on page 71
Insertion loss for correct drive at the baseband level

The insertion loss is a method to provide a drive reserve and to keep the output power constant. In the R&S SMW, the used insertion loss is not a fixed value but is dynamically adjusted for different measurement tasks. Thus, you can define the way the range for insertion loss is determined.

See also Chapter 4.3, "Insertion Loss Configuration, Coupled Parameters and Global Fader Coupling", on page 39.

Support of versatile MIMO configurations

See also Chapter 6, "Multiple Input Multiple Output (MIMO)", on page 91.

3.3 Definition of Commonly Used Terms

Fading Simulator

Each option R&S SMW-B14 provides the hardware of one fading simulator, i.e. for each installed fading simulator option, one hardware fader board is available. One, two or four fading simulators can be installed. The provided fading functionality, however, depends on the installed firmware options.

Fading channel

A fading channel is the term describing the signal between a transmit (Tx) and a receive (Rx) antenna, scattered in various paths.

In a 2x2 MIMO fading configuration, there are four fading channels between the transmit (Tx) and the receive (Rx) antennas. In this description, each fading channel is represented as a block with name following the naming convention "F< Tx><Rx>\text{"}, where Tx and Rx are the antennas (e.g. A and B in a 2x2 MIMO configuration).

An instrument equipped with the R&S SMW-K74 option simulates up to 16 MIMO fading channels, as it is for instance required for 4x4 MIMO receiver tests. If the option R&S SMW-K75 is installed, the number of MIMO channels increases to 32.

Fading path (tap)

Each fading channel consists of up to 20 fading paths.

The Figure 3-1 illustrates an example of single-channel fading with three transmission paths.
About the Fading Simulator

Figure 3-1: Example of single-channel fading with three transmission paths (SISO configuration)

Path 1 = represents the discrete component, that is a direct line-of-sight (LOS) transmission between the transmitter and receiver (pure Doppler fading profile)

Paths 2 and 3 = represent the distributed components, that is signals which are scattered due to obstacles (Rayleigh fading profile)

Distributed components, like the paths 2 and 3, consists of several signal echoes and are referred to as "taps".

The Figure 3-2 illustrates an example of two-channel fading with three transmission paths (taps) per channel.

Figure 3-2: Example of two-channel fading with three transmission paths each

The R&S SMW supports 20 fading paths per installed fading simulator.
Path group

In this implementation, a group of paths builds a "path group". In the R&S SMW, the 20 fading paths are divided in 4 path groups. Each group consists of 3 fine and 2 standard delay paths.

A basic delay can be set per path group and an additional delay per path. The total delay per path is the sum of the basic delay of the respective group and of the additional delay of the path.

For more information, see:

- Chapter 3.4, "Major Differences Between R&S SMW-B14 and R&S SMW-B15", on page 25
- "Basic Delay" on page 51.

Fading Profile

The fading profile determines which transmission path or which radio hop is simulated.

The following is a list of the basic fading profiles implemented in the Fading Simulator.

- **Static Path**
  A static path is an unfaded signal, that is a signal with constant amplitude and no Doppler shift; though this signal can undergo attenuation (loss) or delay.

- **Constant Phase**
  A suitable fading profile to simulate a reflection of an obstacle. Simulated is a transmission signal with constant amplitude and no Doppler shift, but with rotating phase.

- **Pure Doppler**
  A fading profile that simulates a direct transmission path on which Doppler shift is occurring due to movement of the receiver.
  See Path 1 on the Figure 3-1.

- **Rayleigh**
  A suitable fading profile to simulate a radio hop which arises as a result of scatter caused by obstacles in the signal path, like buildings.
  See also the conditions of the Paths 2 and 3 on the Figure 3-1.
  The resulting received amplitude varies over time. The probability density function for the magnitude of the received amplitude is characterized by a Rayleigh distribution. This fading spectrum is "Classical".

- **Rice**
  A fading profile that simulates a Rayleigh radio hop along with a strong direct signal, i.e. applies a combination of distributed and discrete components (see Figure 3-1).
  The probability density of the magnitude of the received amplitude is characterized by a Rice distribution. The fading spectrum of an unmodulated signal involves the superimposition of the classic Doppler spectrum (Rayleigh) with a discrete spectral line (pure Doppler).
  The ratio of the power of the two components (Rayleigh and pure Doppler) is configurable, see parameter Power Ratio.
  Example: The Figure 3-3 shows a baseband signal with QPSK modulation and a rectangular filter which was subjected to Rician fading (one path). As a result of the
luminescence setting on the oscilloscope, the variation in phase and amplitude of
the constellation points caused by the fader is clearly visible.

![Figure 3-3: Effect of a Rician fading on a baseband signal with QPSK modulation](image)

**MIMO correlation models**

The R&S SMW supports the following ways to simulate spatial correlated MIMO channels:

- By description of transmit and receive correlation matrix with direct definition of matrix coefficients or based on the Kronecker assumption
- By definition of clusters at the transmitter and receiver end using channel parameter like angle spread or angle of arrival/departure (AoA/AoD).

See Chapter 6.3, "Fading Settings in MIMO Configuration", on page 94

### 3.4 Major Differences Between R&S SMW-B14 and R&S SMW-B15

The fading simulator is a hardware that influence several signal characteristics. This section lists the characteristics, that influence the value ranges of major signal parameters.

For details and characteristics on each of the options, see data sheet.
About the Fading Simulator

Table 3-1: R&S SMW-B14

<table>
<thead>
<tr>
<th>Number of channel (depends on the LxMxN &quot;System Config&quot;)</th>
<th>Fading Clock Rate [MHz]</th>
<th>Signal Bandwidth [MHz]</th>
<th>Basic Delay per group [ns]</th>
<th>Additional Delay fine delay path 1 [ps]</th>
<th>Additional Delay per fine delay path (2 and 3) [ps]</th>
<th>Additional Delay per standard delay path (4 and 5) [ns]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 8</td>
<td>200</td>
<td>160</td>
<td>Range 0 to 0.5 s</td>
<td>0 to 40.9 us</td>
<td>0 to 20 us</td>
<td>0 to 20 us</td>
</tr>
<tr>
<td>9 to 16</td>
<td>100</td>
<td>80</td>
<td></td>
<td>0 to 80 us</td>
<td>0 to 40 us</td>
<td>0 to 40 us</td>
</tr>
<tr>
<td>17 to 32</td>
<td>50</td>
<td>40</td>
<td></td>
<td>0 to 160 us</td>
<td>0 to 80 us</td>
<td>0 to 80 us</td>
</tr>
<tr>
<td>1 to 8</td>
<td>200</td>
<td>160</td>
<td>Resolution 5</td>
<td>2.5</td>
<td>2.5</td>
<td>5</td>
</tr>
<tr>
<td>9 to 16</td>
<td>100</td>
<td>80</td>
<td></td>
<td>10</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>17 to 32</td>
<td>50</td>
<td>40</td>
<td></td>
<td>20</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

Table 3-2: R&S SMW-B15

<table>
<thead>
<tr>
<th>Number of channel (depends on the LxMxN &quot;System Config&quot;)</th>
<th>Fading Clock Rate [MHz]</th>
<th>Signal Bandwidth [MHz]</th>
<th>Additional Delay fine delay path 1 [ps]</th>
<th>Additional Delay per fine delay path (2 to 3) [ps]</th>
<th>Additional Delay per standard delay path (4 and 5) [ns]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 8</td>
<td>250</td>
<td>200</td>
<td>Range 0 to 32.72 us</td>
<td>0 to 16 us</td>
<td>0 to 16 us</td>
</tr>
<tr>
<td>9 to 16</td>
<td>125</td>
<td>100</td>
<td>0 to 64 us</td>
<td>0 to 32 us</td>
<td>0 to 32 us</td>
</tr>
<tr>
<td>17 to 32</td>
<td>62.5</td>
<td>50</td>
<td>0 to 128 us</td>
<td>0 to 64 us</td>
<td>0 to 64 us</td>
</tr>
<tr>
<td>1 to 8</td>
<td>250</td>
<td>200</td>
<td>Resolution 2</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>9 to 16</td>
<td>125</td>
<td>100</td>
<td>4</td>
<td>4</td>
<td>8</td>
</tr>
<tr>
<td>17 to 32</td>
<td>62.5</td>
<td>50</td>
<td>8</td>
<td>8</td>
<td>16</td>
</tr>
</tbody>
</table>

The difference in the system clocks and the delay resolutions also affects the used fading paths and the preset values in some of the predefined fading profiles, see Chapter A, "Predefined Fading Settings", on page 229.

### 3.5 Further Signal Processing

During further signal routing, you can also offset the faded signals or apply noise to them.

For more information, refer to sections "Adding Noise to the Signal" and "Impairing the Signal" in the R&S SMW User Manual.
4 Fading Settings

The "Fading" dialog allows you to configure multipath fading signals. Regardless of the current "System Configuration > Mode", to access this dialog, proceed as follows:

► Select "Block Diagram > Fading > Fading Settings".

The "Fading" dialog opens and displays the general settings.

The dialog is divided into several tabs, logically grouping the available setting.

The remote commands required to define these settings are described in Chapter 7, "Remote-Control Commands", on page 142.

The provided settings and related background information are described in:

- General Settings................................................................. 28
- Restart Settings................................................................. 37
- Insertion Loss Configuration, Coupled Parameters and Global Fader Coupling... 39
- Path Table................................................................. 44
- Path Graph................................................................. 56
- Birth Death Propagation.................................................... 57
- Moving Propagation.......................................................... 63
- Two Channel Interferer....................................................... 71
- Customized Dynamic Fading................................................ 77
- High-Speed Train.............................................................. 79
- Custom Fading Profile....................................................... 85


4.1 General Settings

To access this dialog, select the "Fading > Fading Settings".

Apart from the standard "Set to Default" and "Save/Recall" functions, the dialog provides the settings to:
- In "System Configurations" with more than two entities, the dialog consists of more than one side tabs; one tab per entity. The tab name indicates the fader state the settings are related to. See also Chapter 6.1, "Multiple Entity MxN MIMO Test Configurations", on page 92.
- Select a predefined fading profile according to the common mobile radio standards

Settings:

State ........................................................................................................................................... 29
Copy To / Entity ....................................................................................................................... 29
Set to Default .......................................................................................................................... 29
Save/Recall ............................................................................................................................. 30
Standard / Test Case ........................................................................................................... 30
Configuration ......................................................................................................................... 30
Moving Channels ..................................................................................................................... 33
Fading Clock Rate ................................................................................................................. 33
Signal Dedicated To ............................................................................................................ 33
Dedicated Frequency ............................................................................................................ 36
Dedicated Connector ............................................................................................................ 36
Virtual RF .............................................................................................................................. 36
Ignore RF Changes < 5PCT ................................................................................................. 36
Freq. Hopping ....................................................................................................................... 37
State

- Option: R&S SMW-B14
  Enables the fading simulator.
- Option: R&S SMW-B15
  Enabled if "System Config > Fading/Baseband Config > Mode = Advanced" is selected and "Apply" executed.

If activated, the fading process is initiated for the enabled paths.

A selectable trigger ("Restart > Mode") can be used to restart the fading process. The fading process always begins at a fixed starting point after each restart. This helps to achieve repeatable test conditions.

Remote command:
[:SOURce<hw>:FSIMulator[:STATE] on page 161

Copy To / Entity

Option: R&S SMW-K76

In "System Configurations" with multiple entities, copies the settings of the current fading simulator to all or to the selected entities.

See also Chapter 6.1, "Multiple Entity MxN MIMO Test Configurations", on page 92.

Remote command:
[:SOURce<hw>:FSIMulator:SISO:COPY on page 145

Set to Default

Activates the default settings of the fading simulator.

By default, a path is activated with a Rayleigh profile and a slow speed. All the other paths are switched off.

The following table provides an overview of the settings. The preset value is indicated for each parameter in the description of the remote-control commands.

Table 4-1: Default values

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Off</td>
</tr>
<tr>
<td>Standard</td>
<td>User</td>
</tr>
<tr>
<td>Configuration</td>
<td>Standard Delay</td>
</tr>
<tr>
<td>Signal Dedicated to</td>
<td>RF Output</td>
</tr>
<tr>
<td>Speed Unit</td>
<td>km/h</td>
</tr>
<tr>
<td>Restart Event</td>
<td>Auto</td>
</tr>
<tr>
<td>Ignore RF Changes</td>
<td>Off</td>
</tr>
<tr>
<td>Frequency Hop. Mode</td>
<td>Off</td>
</tr>
<tr>
<td>Insertion Loss</td>
<td></td>
</tr>
<tr>
<td>Insertion Loss Mode</td>
<td>Normal</td>
</tr>
<tr>
<td>Coupled Parameters</td>
<td></td>
</tr>
<tr>
<td>All States</td>
<td>Off</td>
</tr>
</tbody>
</table>
### General Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Path Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>State of path 1</td>
<td>On</td>
</tr>
<tr>
<td>State of all other paths</td>
<td>Off</td>
</tr>
<tr>
<td>Profile</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Delays</td>
<td>0</td>
</tr>
<tr>
<td>Speed of path 1</td>
<td>Slow</td>
</tr>
<tr>
<td>Speed of all other paths</td>
<td>0</td>
</tr>
</tbody>
</table>

Remote command:
`[:SOURce<hw>]:FSIMulator:PRESet` on page 149

### Save/Recall

Accesses the "Save/Recall" dialog, that is the standard instrument function for saving and recalling the complete dialog-related settings in a file. The provided navigation possibilities in the dialog are self-explanatory.

The filename and the directory, in which the settings are stored, are user-definable; the file extension is however predefined.

See also, chapter "File and Data Management" in the R&S SMW user manual.

The R&S SMW stores fading configurations in files with file extension *.*.fad.*

The dialog displays the name of a currently loaded user settings file. The file name is displayed as long as you do not modify the settings.

Remote command:
`
[:SOURce]:FSIMulator:CATalog?

[:SOURce<hw>]:FSIMulator:LOAD` on page 162

`
[:SOURce<hw>]:FSIMulator:STORe` on page 163

`[:SOURce]:FSIMulator:DELETE` on page 162

### Standard / Test Case

Selects predefined fading settings according to the test scenarios defined in the common mobile radio standards.

For an overview of the predefined standards, along with the underlying test scenarios, the enabled settings and the required options, see Chapter A, "Predefined Fading Settings", on page 229.

If one of the predefined parameters is modified, "User" is displayed. "User" is also the default setting.

Remote command:
`
[:SOURce<hw>]:FSIMulator:STANdard

[:SOURce<hw>]:FSIMulator:STANdard:REFerence` on page 161

### Configuration

Selects the fading configuration.
**Note:** The dynamic fading configurations "Birth Death Propagation", and "2 Channel Interferer" are disabled in MIMO configurations. Depending on which configuration is selected, the further settings the "Fading" dialog change, particularly the path table.

**Note:** A separate path table is associated with each configuration, i.e. each time you select a new configuration, the instrument changes not only the bandwidth but loads a new path table. Each changing in the configuration interrupts the fading process and restarts the calculation. If the instrument is fitted with more than one fading simulators, they are all affected.

"Standard/Fine Delay"

In the R&S SMW, the 20 fading paths are divided in 4 path groups. Each group consists of 3 fine and 2 standard delay paths. The standard and fine delay configurations differ in terms of the resolution of the path-specific delay, see Chapter 3.4, "Major Differences Between R&S SMW-B14 and R&S SMW-B15", on page 25. The "Standard/Fine Delay" configuration is sufficient for classical fading with simulation of the level fluctuations. A delay configuration with the provided characteristics occurs in the received signal as a result of a typical multipath propagation and the propagation conditions. The propagation conditions themselves vary depending on the location and timing.

"Birth Death Propagation"

Option: R&S SMW-K71

In the "Birth Death Propagation" configuration, the fading simulator simulates dynamic propagation conditions in conformity with the test case 3GPP, 25.104-320, annex B4. Two paths are simulated which appear ("Birth") or disappear ("Death") in alternation at arbitrary points in time (see Chapter 4.6, "Birth Death Propagation", on page 57).
"Moving Propagation"
Option: R&S SMW-K71
In the "Moving Propagation" configuration and number of "Moving Channels" set to "One", the fading simulator simulates dynamic propagation conditions in conformity with the test case 3GPP TS25.104, annex B3. Two paths are simulated: Path 1 has fixed delay, while the delay of path 2 varies slowly in a sinusoidal fashion.
Two additional predefined moving propagation scenarios according to the 3GPP TS36.141, annex B.4 can be configured: the "ETU200Hz Moving" and the "Pure Doppler Moving". To configure one of these scenarios for 3GPP or LTE, select the corresponding item under "Standard > 3GPP or LTE > Moving Propagation".

Note: The moving propagation conditions enabled by selecting the "Standard > 3GPP or LTE > Moving Propagation > Ref. + Mov. Channels" are identical to the conditions configured by enabling of "Moving Propagation Configuration" and number of "Moving Channels" set to "One".
See Chapter 4.7, "Moving Propagation", on page 63 for more information.

"2 Channel Interferer"
Option: R&S SMW-K71
In the "2 Channel Interferer" configuration, the fading simulator simulates test case 5 and 6 from MediaFlo.
Two paths are simulated: Path 1 has fixed delay, while the delay of path 2 varies slowly in a sinusoidal fashion or appears or disappears in alternation at arbitrary points in time (hopping).
See Chapter 4.8, "Two Channel Interferer", on page 71 for more information.

"High Speed Train"
Option: R&S SMW-K71
In the High-Speed Train configuration, the fading simulator simulates propagation conditions in conformity with the test case 3GPP 25.141, annex D.4A and 3GPP 36.141, annex B.3.
The instrument simulates all the three scenarios as defined in the test specification. Additionally, user-defined HST conditions can be configured by selecting different profile and setting up the speed and the initial distances.
See Chapter 4.10, "High-Speed Train", on page 79 for more information.

"Customized Dynamic"
Option: R&S SMW-K820
In this configuration, you can load dynamic fading list files that describe the variation of the fading parameters path loss, Doppler shift and delay over time. With suitable fading lists, customized High-Speed Train scenarios can be simulated.
See Chapter 4.9, "Customized Dynamic Fading", on page 77.
Remote command:
[:SOURce<hw>:FSIMulator:CONFiguration on page 144
[:SOURce<hw>:FSIMulator:BIRTHdeath:STATe on page 179
[:SOURce<hw>:FSIMulator:MDELay:STATe on page 188
[:SOURce<hw>:FSIMulator:TCINterferer[:STATe] on page 211
[:SOURce<hw>:FSIMulator:HSTRain:STATe on page 183
[:SOURce<hw>:FSIMulator:CDYNamic:STATe on page 226

Moving Channels
Option: R&S SMW-K71
This parameter determines whether only one or several moving channels are simulated.

"One" In this mode, the fading simulator simulates dynamic propagation conditions in conformity with the test case 3GPP TS25.104, annex B3.

"All" Per default, one moving channel with Rayleigh distribution and one tap is simulated. Additional taps and paths can be enabled and configured in the "Path Table".

Remote command:
[:SOURce<hw>:FSIMulator:MDELay:CHANnel:MODE on page 185

Fading Clock Rate
Displays the clock rate used by the fading simulator for the signal processing.
The value depends on the selected "System Configuration" and influences the bandwidth of the generated signal.

Remote command:
[:SOURce<hw>:FSIMulator:CLOCk:RATE? on page 146

Signal Dedicated To
Defines the frequency to that the signal of the whole Fader block is dedicated.
Example: How the R&S SMW determines the frequency used for the calculation of the Doppler Shift

This example shows how the R&S SMW determines the fader frequency in "Signal Dedicated To > Auto Detect Output" mode.

- In the "System Configuration > Fading/Baseband Config" dialog, enable a 2x2x2 MIMO configuration with "Baseband Sources > Coupled per Entity".
- In the "I/Q Stream Mapper":
  - route "Stream A/B > RF A/B", "Stream A/D und > BBMM 2" and "Stream B/C > BBMM 1" ("Combination > Add")
  - enable a "Frequency Offset = 5 MHz" for Stream D
- Connect an R&S® SGT100A to the BBMM2 connector of the R&S SMW.
  In the "External RF and IQ" dialog, configure this connection and set the frequency of the connected instrument, e.g. "RF Frequency = 1.950 GHz".
- In the Status Bar, set "Freq A = 2.143 GHz"

The settings of your instrument should resemble the example on Figure 4-1.

![Figure 4-1: Settings influencing the calculation of the Doppler Shift](image)

1a, 1d = Routing of Stream A ("master" for "Fading 1")
1b = Routing of Stream D ("master" stream for "Fading 2" but not for "Fading 1")
1c = Routing of Stream C; an external device is not connected
2a = Frequency RF A, i.e. the frequency of Stream A
2b = Parameters influencing the frequency of Stream D

In this configuration, Stream A is the "master" stream for the "Fading 1"; Stream D is the "master" for "Fading 2", because of the connected external device.

Note that:
- Although Stream C is first stream of "Fading 2" it is not the "master" one, because there is no external device connected to the BBMM1 or to the FAD3 connector.
- Although an external device is connected to BBMM2, it is not the "master" for the "Fading 1", because the streams are evaluated "left to right" and "up to down".

Observe the values of the parameter "Dedicated Frequency" for Fader 1 and Fader 2. The settings of your instrument should resemble the example on Figure 4-2.
Fading Settings

1 = Fader 1
2 = Fader 2
1a = "Dedicated Connector = RF A" because Stream A ("master") is routed to RF A
1b = "Dedicated Connector = BBMM 2" because Stream D is routed to BBMM 2 and an external instrument is connected to this interface
2a = "Dedicated Frequency = Freq A = 2.143 GHz"
2b = "Dedicated Frequency = RF Frequency + Frequency Offset = 1.95 GHz + 5 MHz = 1.955 GHz"

"Auto Detect Output"
The Doppler shift is calculated based on the actual RF frequency, that is dynamically detected depending on:
• The current signal routing in the "Stream Mapper", in particular the routing and the enabled "Frequency Offset" of the first ("master") stream of each "Fader"
  Note: The RF frequencies and the "Frequency Offset" of all other streams are ignored.
• The external instrument connected to the output interface the "master" stream is routed to ("System Configuration > External RF and I/Q")
• The "RF Frequency" of the connected instrument ("System Configuration > External RF and I/Q")
The R&S SMW continuously monitors these parameters, calculates the frequency and displays:
• The Dedicated Frequency
• The Dedicated Connector
A warning message informs you if the detection fails; the "Dedicated Frequency" is set to 1 GHz.

"Baseband Output"
Sets the fader frequency manually. The Doppler shift is calculated based on a select "Virtual RF" frequency.
If you use an external I/Q modulator to upconvert the generated faded baseband signal, set the value of the parameter Virtual RF to the modulation frequency of the external I/Q modulator.

Remote command:
[:SOURce<hw>]:FSIMulator:SDESTination on page 153
Dedicated Frequency
In Signal Dedicated To > "Auto Detect Output" mode, displays the dedicated RF frequency (incl. enabled "Frequency Offset" in the "I/Q Stream Mapper"), used for the calculation of the Doppler Shift.

A warning message informs you if the estimation fails; the "Dedicated Frequency" is set to 1 GHz.

See also:
- Example "How the R&S SMW determines the frequency used for the calculation of the Doppler Shift" on page 34
- Dedicated Connector.

Note: The "Dedicated Frequency" cannot be updated if the RF frequency varies fast, for example if an "RF Frequency Sweep" or a "List Mode" is active and the parameter Ignore RF Changes < 5PCT is disabled.

For more details, see the data sheet.

Remote command:
`:SOURce<hw>:FSIMulator:FREQuency` on page 146

Dedicated Connector
In Signal Dedicated To > "Auto Detect Output" mode, displays the connector used to determine the Dedicated Frequency.

See Example "How the R&S SMW determines the frequency used for the calculation of the Doppler Shift" on page 34.

Remote command:
`:SOURce<hw>:FSIMulator:FREQuency:DETect?` on page 154

Virtual RF
In Signal Dedicated To > "Baseband Output" mode, sets manually the frequency used for the calculation of the Doppler shift.

This parameter is useful if:
- A user-defined Fader frequency is required
- An external I/Q modulator is used to upconvert the generated faded baseband signal.

Remote command:
`:SOURce<hw>:FSIMulator:FREQuency` on page 146

Ignore RF Changes < 5PCT
This function is password-protected. Unlock the protection level 1 to access it.

Selects whether variation in the RF frequency (also in the frequency of connected external devices) that are smaller than 5% are to be ignored or not for the fading.

"On" Enables faster frequency hopping because small frequency changes do not result in a short-term switch-off of the fader and a restart of the fading process.

Remote command:
`:SOURce<hw>:FSIMulator:IGNore:RFChanges` on page 147
Freq. Hopping
This function is password-protected. Unlock the protection level 1 to access it.
Activates frequency hopping and determines the behavior of the fading simulator after a frequency hop.
In real-world receivers, one of the reasons for frequency hopping could be that due to a change in the location of the receiver, the original carrier is no longer accessible.
In the fading simulator, frequency hopping is implemented by switching of the carrier frequency. The fading simulator is temporarily deactivated until the variation in the RF frequency is completed. The fading process starts then again at the new frequency.
The instrument provides two modes for frequency hopping, that mainly differ in terms of the behavior when hopping back to a prior frequency.
Prior to activating frequency hopping, list mode must be activated in the "List Mode" dialog (State On). The target frequencies of the hops are determined by the frequency values in the selected list. The time until the next frequency hop is determined by the entered "Dwell Time". The HOP signal which marks the time point of the frequency hop can be output on one of the USER connectors. These settings are available only for the delay configurations.
For detailed information, refer to sections "Varying the RF Signal in List or Sweep Mode" and "Local and Global Connectors" in the R&S SMW user manual.
Remote command:
[:SOURce<hw>]:FSIMulator:HOPPIng:MODE on page 147

4.2 Restart Settings

Access:
► Select "Fading > Restart".

Mode ............................................................................................................................. 38
Running/Stopped ........................................................................................................... 38
Synchronization ............................................................................................................ 38
Global Connector Settings ........................................................................................... 38
Mode
Selects the event which leads to a restart of the fading.

To achieve repeatable test conditions, after each restart the fading process starts at a fixed starting point. The fading process then passes through identical random processes for a particular setting.

"Auto" The modulation signal is continually faded.

"Armed Auto" Not supported in the current version.

"Baseband Trigger"
Option: R&S SMW-K821
In MIMO scenarios, this setting restarts the fading process synchronize with the baseband trigger signal. Thus, the start of the baseband signal generation and the fading processes are synchronized. This setting is useful for triggering of the fading simulations in multi-instruments setups, for example when calculating 8x8 MIMO signals with two R&S SMW.

See R&S SMW User Manual, section "How to Generate a 8x8 MIMO Signal with Two R&S SMW"

Remote command:
[:,SOURce<hw>]:FSIMulator:RESTart:MODE on page 149

Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.

• "Running"
The signal is generated; a trigger was (internally or externally) initiated in triggered mode.

• "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command:
[:,SOURce<hw>]:FSIMulator:RESTart:RMODE? on page 149

Synchronization
Couples the fading simulators so that if both blocks are active, a subsequent restart event in any of them causes a simultaneous restart of the other.

Restart event can be caused by a start/stop alternation or a parameter change that results in a signal recalculation and therefore a process restart.

Remote command:
[:,SOURce]:FSIMulator:SYNChronize:STATe on page 153

Global Connector Settings
Provide a quick access to the related local and global connector settings.

For information, refer to the description R&S SMW User Manual, section "Local and Global Connectors".
4.3 Insertion Loss Configuration, Coupled Parameters and Global Fader Coupling

The fading process increases the crest factor of the signal, and this increase must be considered in the drive at the baseband level. Especially when multiple paths are superimposed or if there is statistical influences on a path, an insertion loss is required to provide a drive reserve. If the full drive level is reached nevertheless, the I/Q signals are limited to the maximum available level (clipping).

This section describes the setting, provided to control of the insertion loss and to simplify the operation in dual-channel fading.

Impact of the Fading Simulator on the Crest Factor of the Signal

The crest factor is a figure that measures the difference in level between the peak envelope power (PEP) and average power value (RMS) in dB. Hence, either increasing the peak value or decreasing the RMS value results in a higher crest factor. In this implementation, the instrument keeps the peak value as close as possible to the full drive level (multiplier peak > 1) but the fading simulator reduces the RMS value by the additional crest factor due to fading (multiplier RMS). The ratio of these two multipliers is a value, known as the \textit{insertion loss}.

The instrument derives the crest factor of the signal at the output of the fading simulator based on the crest factor of the signal at the input of the "Fading" block and the insertion loss.

Overview of the provided modes and the main differences between them

In the R&S SMW, the used insertion loss is not a fixed value but is dynamically adjusted for different measurement tasks. For any of the predefined standards/test cases, the instrument selects an optimal range for the insertion loss. In a user-defined fading configuration, you define the way the range for insertion loss is determined.

From the following available modes, select the one most fitting to your application:

- "Normal"
  In this mode, the instrument calculates the required insertion loss value in a way, that a full drive is permitted, i.e the signal is not clipped at the maximum level. The mode results in a high signal quality, but the RMS level is lower than the maximum level. Adjacent channel power (ACP) measurements, however, require a higher dynamic range and a lower insertion loss.

- "Low ACP"
  In this mode, the instrument outputs the signal with a higher level relative to the maximum drive, i.e. greater S/N ratio. However, this mode decreases the signal quality because of a higher percentage of clipping. It is recommended that you enable this mode only for fading paths with Rayleigh profile, as only this profile ensures a statistical distribution of level fluctuation. The
other fading profiles are characterized by a non-statistical level fluctuations and a "Low ACP" mode leads to an enormous increase of clipping.
Irrespective of the selected fading profile, you still can and have to monitor the percentage of clipped samples.

- "User"
  This mode relays on a manually defined value. Depending on your particular application, you can find a favorable insertion loss configuration with the desired signal dynamic range and acceptable clipping rate.

Regardless of the selected mode and the path loss settings, the instrument adjust the insertion loss within this range to keep the output power constant. However, the maximum available output power of the R&S SMW is reduced by up to 18 dB.

**Prerequisites for correct insertion loss adaptation**

For correct automatic adaptation of the insertion loss, the processes involved in the fading simulation have to be statistically independent of each other. This applys to the paths among themselves as well as the paths relative to the input signal. Correct automatic adaptation of the insertion loss is not possible, if statistically correlated processes occur. Examples if statistically correlated processes are the fading of modulation signals with symbol rates approximating the delay differences of the fading paths. A correlation requires, that you measure the level again and manually corrected it, e.g. by enabling of a suitable level offset.

The following are two examples explaining the possible reasons for correlation.

**Example: Correlated processes resulting from the used modulation signal and the selected fading configuration**

The instrument is configured to generate a QPSK signal with a symbol rate of 1 Msymbol/s is generated and the PRBS 9 sequence as the data source.

Enabled is a fading configuration, consisting of two paths with a Rayleigh profile, identical speed and a resulting delay of 0 us and 1 us, respectively.

The symbol rates of the modulation signal are in the range of the delay differences of the fading paths. The autocorrelation of the modulation data (PRBS 9) to the adjacent symbol is not equal to 0. The fading process is therefore statistically not independent of the process of generating the modulation signal. The automatic calculation of the insertion loss is not correct.

**Example: Correlated processes within the fading simulator**

Enabled is a fading configuration, consisting of two paths with a pure Doppler profile and a resulting Doppler shift of 100 Hz. The start phases of the two paths differ.

This causes super impositions, which in the worst case (e.g. with a phase setting of 0° and 180°) can lead to the deletion of the signal. Automatic calculation of the insertion loss is not possible.

The related settings are summarized in dialog "Fading > Insertion Loss Config/Coupled Parameters > Insertion Loss Configuration", see Chapter 4.3.1, "Insertion Loss Configuration Settings", on page 41.
**Coupling Fading Parameters**

In standard mode ("System Configuration > Mode > Standard"), you can couple a subset of parameters and adjust them jointly. With enabled coupling, the setting of one of the Fading blocks are transferred to the second fading simulator. A subsequent change in the settings of one of the fading simulators results in settings adaptation in the other.

Logically, coupled parameters are available in instruments equipped with more than one Fading Simulator (i.e. more than one R&S SMW-B14 options).

The related settings are grouped in dialog "Fading > Insertion Loss Config/Coupled Parameters > Coupled Parameters", see Chapter 4.3.2, "Coupled Parameters and Global Fader Coupling Settings", on page 42.

### 4.3.1 Insertion Loss Configuration Settings

**Access:**

► Select "Fading > Insertion Loss Config/Coupled Parameters".

**Insertion Loss Mode**

Sets the mode for determining the insertion loss.

"Mode Normal"  The insertion loss for a path of the fading simulator is automatically chosen so that even when lognormal fading is switched on, overdrive occurs only rarely in the fading simulator. This setting is recommended for bit error rate tests (BERTs). The current insertion loss is displayed under "Insertion Loss".

**Insertion Loss Configuration, Coupled Parameters and Global Fader Coupling Settings**
"Mode Low ACP"

The insertion loss is automatically chosen so that an overdrive occurs with an acceptable probability. "Low ACP" mode is only recommended for fading paths with Rayleigh profile as only in this case statistical distribution of level fluctuation is ensured. For other fading profiles, non-statistical level fluctuations occur which lead to an enormous increase of clipping. However, monitoring the percentage of clipped samples is recommended for Rayleigh paths also.
The current insertion loss is displayed under "Insertion Loss".

"Mode User"

Any value for the minimum insertion loss in the range from 0 dB to 18 dB can be selected. Desired value is entered under "Insertion Loss". This mode is provided to ensure optimization of the dynamic range and signal quality for any application. Display of the clipping rate for any value which is entered enables estimation of the signal quality for the specified signal dynamic range.

Remote command:
[[:SOURce<hw>:FSIMulator:ILOSs:MODE] on page 148

**Insertion Loss**
Displays the current insertion loss in the "Normal" and "Low ACP" modes.
Entry of the insertion loss in "User" mode.
Remote command:
[[:SOURce<hw>:FSIMulator:ILOSs[:LOSS] on page 148

**Clipped Samples**
Displays the samples whose level is clipped as a %.
If the full drive level is reached for an insertion loss which is too low, the I/Q signals are limited to the maximum available level (clipping).
Remote command:
[[:SOURce<hw>:FSIMulator:ILOSs:CSAmplpes? on page 148

0 ... 100 %
Graphically displays the samples whose level is clipped as a %. The scale resolution is determined by entering the maximum value as a %.

### 4.3.2 Coupled Parameters and Global Fader Coupling Settings

**Access:**

- Select "Fading > Insertion Loss Config/Coupled Parameters".
Coupled Parameters
(available in "System Configuration > Mode > Standard")

**Speed Setting Coupled** ← Coupled Parameters
Sets the speed of the paths for both faders. The parameter Common Speed For All Paths is also coupled.

Remote command: 
[:SOURce<hw>]:FSIMulator:COUPle:SPEed on page 164

**Local Constant Coupled** ← Coupled Parameters
With lognormal fading, the parameter Local Constant is coupled for the paths of both faders.

Remote command: 
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:LCONstant on page 163

**Standard Deviation Coupled** ← Coupled Parameters
With lognormal fading, the parameter Standard Deviation is coupled for the paths of both faders.

Remote command: 
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:CSTD on page 163
Start Seed
Enters the start seed for random processes inside the fading simulator. This value is
global for the instrument but each fading path uses a different start seed. The autocorre-
lation of different seeds is more than seven days apart. If two instruments run with
the same seed, fading processes will be identical after a retrigger of the fading simula-
tor.
While working in MIMO mode that requires two instruments, set the start seeds of the
instruments to different values.
Remote command:
[:SOURce<hw>]:FSIMulator:GLOBal:SEED on page 147

4.4 Path Table
The settings for configuration of the fading paths are grouped in a path table.
1. To access this dialog, select "Fading > Fading Settings > Path Table".
The path table comprises the individual path and group parameters.
Figure 4-3: Fading Path Table: Understanding the displayed information

1a/1b = Path group number (displayed in the first row) and path number (second row in the table header); the example shows 4 groups with different number of active paths (the first group is marked with a blue border)

2 = Fading profile, assigned per fading path

3/3a = Common group delay of a path group ("Basic Delay" is always 0 for group 1); adjustable for the other groups (light grey background)

4 = Resulting delay per path, calculated as the sum of the common group delay and the path-specific delay

5 = Adjustable parameter for paths with Rice, WM Rice of Gauss Doppler fading

6 = Adjustable parameter for paths with Pure Doppler and constant Phase fading

7 = For moving receivers, selected speed \( v \) or calculated as a function of the resulting Doppler shift \( f_D \)

8 = Set resulting Doppler shift \( f_D \) or calculated as \( f_D = f_{RF} \cdot \frac{v}{c} \), where \( f_{RF} \) is the selected RF and \( c \) the speed of light

9 = Frequency ratio \( \cos \phi \) is ratio of the actual Doppler shift \( f_A \) and the resulting Doppler shift \( f_D \)

10 = Actual Doppler shift \( f_A \) calculated as \( f_A = f_D \cdot \cos \phi \)

11 = Pure display parameters are on a dark background

11 = Access to a "Vector" or a "MIMO Matrix" for configuration of the correlation between the channels

2. To display all five paths per each group, change the settings as follows:

a) Select "Table Settings".
b) In the "Path Table Settings" dialog, select "Path Filter > All Paths".

Cross-reference between the fading parameters
Consider the following interdependencies:

- Delay parameters:
  \[ \text{Resulting Delay} = \text{Basic Delay} + \text{Additional Delay} \]
- Parameters influencing the Doppler shift calculation:
  \[ f_D = \left( \frac{\nu}{c} \right) f_{RF} \]
  - \( \nu \) is the Speed of the moving receiver
  - \( f_{RF} \) is the frequency of the RF output signal or the Virtual RF
  - \( c=2.998\times10^8 \text{ m/s} \) is the speed of light

For "Fading Profile > Pure Doppler, Gauss Doppler or Rice", the Actual Doppler Shift \( f_A \) calculated as:
  \[ f_A = f_D \cos \phi_t \]
  - \( \cos \phi_t \) is the Frequency Ratio and \( \phi \) is the angle of incidence
  - \( f_D \) is the Resulting Doppler Shift

4.4.1 Table Settings

To access this dialog, select "Fading > Fading Settings > Path Table > Table Settings".

The provided functions facilitate settings configuration and navigation in the path table, like suppression of the indication of disabled paths, quick change of the speed unit.
Path Filter
Suppresses the indication of the disabled paths.
Remote command:
n.a.

Speed Unit
Toggles between the available units for speed. The value always remains unchanged but the display is automatically adapted to the selected unit.
Note: The remote control command changes only the units displayed in the graphical user interface. While configuring the speed via remote control, the speed units must be specified.
Remote command:
[:SOURce<hw>]:FSIMulator:SPEed:UNIT on page 154

Keep Constant
Selects whether to keep the speed or the resulting Doppler shift constant in case of frequency changes. If a constant speed is selected, the Doppler shift is calculated as function of the speed and the frequency and vice versa.
Remote command:
[:SOURce<hw>]:FSIMulator:KCONstant on page 149

Common Speed For All Paths
In delay configurations, activates/deactivates the same speed in all paths.
If Speed Setting Coupled is enabled, this parameter is also coupled in both faders.
"On" In this default state, a change of speed in a path automatically results in a change of speed in all of the other paths.
"Off" When switching from "Off" to "On", the speed entry for path 1 of group 1 is used for all of the paths.
Remote command:
[:SOURce<hw>]:FSIMulator:CSpeed on page 164

4.4.2 Copy Path Group Settings
The provided "Copy Path Group" settings enable you to copy the settings of one to a second fading group.

Copy Path Group.......................................................................................................... 47
To.................................................................................................................................. 48
Copy..............................................................................................................................48

Copy Path Group
Selects a group whose settings are to be copied.
Remote command:
[:SOURce<hw>]:FSIMulator:COPY:SOURce on page 145
To
Selects a group whose setting is to be overwritten.
Remote command:
[:SOURce<hw>]:FSIMulator:COPY:DESTination on page 145

Copy
Triggers a copy procedure.
Remote command:
[:SOURce<hw>]:FSIMulator:COPY:EXECute on page 145

4.4.3 Path Table Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Path</td>
<td>48</td>
</tr>
<tr>
<td>Profile</td>
<td>49</td>
</tr>
<tr>
<td>Path Loss</td>
<td>51</td>
</tr>
<tr>
<td>Basic Delay</td>
<td>51</td>
</tr>
<tr>
<td>Additional Delay</td>
<td>51</td>
</tr>
<tr>
<td>Resulting Delay</td>
<td>51</td>
</tr>
<tr>
<td>Power Ratio</td>
<td>51</td>
</tr>
<tr>
<td>Frequency Spread</td>
<td>51</td>
</tr>
<tr>
<td>Frequency Shift</td>
<td>52</td>
</tr>
<tr>
<td>Const. Phase</td>
<td>52</td>
</tr>
<tr>
<td>Start Phase</td>
<td>52</td>
</tr>
<tr>
<td>Speed</td>
<td>52</td>
</tr>
<tr>
<td>Resulting Doppler Shift</td>
<td>53</td>
</tr>
<tr>
<td>Frequency Ratio</td>
<td>53</td>
</tr>
<tr>
<td>Actual Doppler Shift</td>
<td>54</td>
</tr>
<tr>
<td>Correlation Path</td>
<td>54</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>55</td>
</tr>
<tr>
<td>Correlation Coefficient Phase</td>
<td>55</td>
</tr>
<tr>
<td>Lognormal State</td>
<td>55</td>
</tr>
<tr>
<td>Local Constant</td>
<td>55</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>56</td>
</tr>
</tbody>
</table>

State Path
Activates a fading path.

After activating, the fading process is initiated for this path with the selected fading profile. However, the fading simulator must be switched on.

Remote command:
[:SOURce<hw>]:FSIMulator[:STATE] on page 161
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:STATE on page 174
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:STATE on page 174
[:SOURce<hw>]:FSIMulator:HSTRain:PATH:STATE on page 182
Profile
Determines the fading profile for the selected path. The fading profile determines which transmission path or which radio hop is simulated.

See also "Fading Profile" on page 24.

Depending on which profile is selected, certain parameters will be available in the path table and others will not be available.

With correlated paths, the profile setting must agree. When correlation is activated, the setting of the path for which correlation is switched on is accepted for both paths. Afterwards, the most recent modification applies to both paths (no matter in which path it was made).

"Static Path" Simulated is a static transmission path which can undergo attenuation (loss) or delay.

"Pure Doppler" Simulated is a transmission path with an individual direct connection from the transmitter to the moving receiver (discrete component). The actual Doppler shift is determined by the Speed and Frequency Ratio parameters.

Tip: In MIMO configuration, use the Relative Gain Vector Matrix Settings to configure beamforming.

"Rayleigh" Simulated is a radio hop in which many highly scattered subwaves arrive at a moving receiver.

"Rice" Simulated is a radio hop in which a strong direct wave (discrete component) arrives at a moving receiver in addition to many highly scattered subwaves. Use the parameter Power Ratio to set the ratio of the power of the two components (Rayleigh and pure Doppler).

"Const. Phase" Simulated is one transmission path with the set constant phase rotation, attenuation (loss) or delay.

"Gauss1" Option: R&S SMW-K72
Sum of two Gaussian functions and is used for excess delay times in the following range:
0.5 µs to 2 µs, (0.5 µs < τ < 2 µs).

\[ S(\tau, f) = G(A, -0.8f, 0.05f) + G(A_1, +0.4f, 0.1f) \]
where \( A_1 \) is 10 dB below \( A \).

"Gauss2" Option: R&S SMW-K72
Sum of two Gaussian functions and is used for paths with delays in excess of 2 µs, (τ > 2 µs).

\[ S(\tau, f) = G(B, +0.7f, 0.1f) + G(B_1, -0.4f, 0.15f) \]
where \( B_1 \) is 15 dB below \( B \).

"Gauss DAB" Option: R&S SMW-K72
Composed of a Gaussian function and is used for special DAB profiles.

\[ S(\tau, f) = G(A, \pm 0.7f, 0.1f) \]
where \( 0.7f \) applies for even path numbers and \( 0.7f_0 \) for odd, except path 1.
"Gauss Doppler"
Option: R&S SMW-K72
Sum of a Gaussian function and a pure Doppler component.
\[ S(\tau, f) = G(0.1A; 0; 0.08f_d) + \delta(f-0.5f_d) \]

"Gauss (0.08 fd)"
Option: R&S SMW-K72
Composed of a Gaussian function with a standard deviation of 0.08*f_d.
\[ S(\tau, f) = G(A; f; 0.08f_d) \]

"Gauss (0.1 fd)"
Option: R&S SMW-K72
Composed of a Gaussian function with a standard deviation of 0.1*f_d.
\[ S(\tau, f) = G(A; f; 0.1f_d) \]

"Gauss (Watters)"
Option: R&S SMW-K72
Gauss (Watterson) fading profile.

"WM Doppler"
Option: R&S SMW-K72
The WiMAX Doppler fading profile is a rounded Doppler PSD model according to IEEE 802.16a.

"WM Rice"
Option: R&S SMW-K72
The WiMAX Rice fading profile is according to IEEE 802.16a.

"Bell Shape tgn Indoor/Bell Shape tgn Moving Vehicle"
Option: R&S SMW-B14
Both Bell Shape fading profiles describe the indoor wireless channels according to IEEE 802.11n and IEEE 802.11ac.
The profiles are called after the resulting Doppler power spectrum that has a shape very similar to a "Bell". The second fading profile includes a Doppler component that represents a reflection from a moving vehicle.

"SCM"
Option: R&S SMW-K73
The SCM profile is a geometry-based channel model that improves the accuracy of the simulated channel model.
To access the settings, select "SCM Profile > SCM Data", see Chapter 6.3.7, "SCM Fading Profile", on page 112

"Custom"
Option: R&S SMW-K72
Customized Doppler fading profile developed by Cohda-Wireless; the profile describes the channels for testing of IEEE 802.11p signals.
To access the required settings, select "Custom", see Chapter 4.11, "Custom Fading Profile", on page 85.

Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PROFile
on page 173
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:PROFile
on page 173
Path Loss
Enters the loss for the selected path.
Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOSS
on page 172

Basic Delay
Option: R&S SMW-B14
Sets the basic delay.
Within a path group, all of the paths are jointly delayed by this value.
The path delay is calculated as:
Resulting Delay = Basic Delay + Additional Delay
The "Basic Delay" for group 1 is always 0. Thus, for the paths in group 1, the "Resulting Delay" is equal to the "Additional Delay".
See also Chapter 3.4, "Major Differences Between R&S SMW-B14 and R&S SMW-B15", on page 25.
Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:BDELay
on page 166

Additional Delay
Sets the Additional Delay per path.
Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:ADELay
on page 165

Resulting Delay
Displays the Resulting Delay for the path.
Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:RDELay?
on page 166

Power Ratio
("Fading Profile > Rice, WM Rice, Gauss Doppler")
Enteres the power ratio of the discrete component and distributed component.
The total power consisting of the two components is always constant. At a high power ratio, the discrete (Doppler) component prevails. At a low power ratio, the distributed (Rayleigh) component prevails.
Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PRATio
on page 173

Frequency Spread
("Fading Profile > Gauss Watterson")
Sets the frequency spread for the Gauss Watterson fading.
Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSPRead
on page 171

**Frequency Shift**
("Fading Profile > Gauss Watterson")
Enters the frequency shift for the Gauss Watterson fading.
Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSHift
on page 171

**Const. Phase**
Enters the phase by which the path is multiplied.
Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase
on page 168

**Start Phase**
("Fading Profile > Pure Doppler, WM Doppler")
A transmission path with the set start phase rotation is simulated which can undergo
total attenuation (loss) or delay.
Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase
on page 168

**Speed**
Enteres the speed $\nu$ of the moving receiver.
The Resulting Doppler Shift $f_D$ is calculated as:

$$f_D = (\nu/c) \times f_{RF}$$

where $f_{RF}$ is the frequency of the RF output signal or the virtual RF frequency and
$c = 2.998 \times 10^8$ m/s is the speed of light

**Example:**
If $\nu = 100$ km/h and $f_{RF} = 1$ GHz, the $f_D = 92.66$ Hz

Consider the following interdependencies:
- If the speed is changed, the resulting Doppler shift is automatically modified.
- If "Path Table Settings > Common Speed in All Paths > On", a change of speed in
  one path automatically results in a change of speed in all of the other paths of the
  fader.
- In the "Fading Profile > Pure Doppler/Rice/Gauss Doppler", the actual Doppler
  Shift $f_A$ is a function of the selected speed $\nu$ and also of the parameter Frequency
  Ratio.
  See also "Cross-reference between the fading parameters" on page 46
- In "System Configuration > Mode > Standard", you can couple the speed for the
  paths of both faders.
● With correlated paths, the speed setting must agree. When correlation is activated, the settings of the path for which correlation is switched on are accepted for both paths. Afterwards, the most recent modification applies to both paths (no matter in which path it was made). The same applies to all paths of the two faders when coupling is activated.

Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:SPEed
on page 174

Resulting Doppler Shift
If "Table Settings > Keep Constant > Speed", this parameter displays the resulting Doppler shift \( f_D \).

The value depends on the selected:
● Speed
● RF frequency \( f_{RF} \) or the Virtual RF
● For "Fading Profile > Pure, Gauss Doppler or Rice", the "Actual Doppler Shift" depends also on the selected Frequency Ratio.

See "Cross-reference between the fading parameters" on page 46.

To set the Doppler shift, enable "Table Settings > Keep Constant > Resulting Doppler Shift". In this case, the "Speed" is calculated as a function of the selected "Resulting Doppler Shift" and the RF frequency \( f_{RF} \).

Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler[:RESULTing] on page 169

Frequency Ratio
("Fading Profile > Pure, Gauss Doppler or Rice")

Sets the ratio of the actual Doppler Shift \( f_A \) to the Resulting Doppler Shift \( f_D \).

The actual Doppler shift is a function of the simulated angle of incidence of the discrete component (see Figure 4-4) and is calculated as:
\[ f_A = f_D \cos \phi \]

\( \cos \phi \) is the "Frequency Ratio" and \( f_D = \frac{v}{c} f_{RF} \) is the Resulting Doppler Shift.

Negative values indicate a receiver that is going away from the transmitter, and positive values a receiver that is approaching the transmitter.
See also "Cross-reference between the fading parameters" on page 46

With correlated paths, the speed setting of the Frequency Ratio must agree. When correlation is activated, the settings of the path for which correlation is switched on are accepted for both paths. Afterwards, the most recent modification applies to both paths (no matter in which path it was made).

Remote command:
```
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio
```
on page 170

**Actual Doppler Shift**

("Fading Profile > Pure Doppler, Gauss Doppler, Rice")

Displays the actual Doppler shift \(f_A\). The value depends on Frequency Ratio and Resulting Doppler Shift.

See also "Cross-reference between the fading parameters" on page 46.

Remote command:
```
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler:ACTual?
```
on page 170

**Correlation Path**

Switches on correlation to the corresponding path of the second fader for dual-channel fading.

Setting correlation necessitates synchronous signal processing on both channels. This means the settings of the following parameters for the correlated fading paths must agree:
- "Profile"
- "Speed"
- "Frequency Ratio"
- "Lognormal Parameters"
- "Resulting Doppler Shift"
- "Actual Doppler Shift"

When correlation is activated, the settings of the path for which correlation is switched on are accepted for both paths. Afterwards, the most recent modification applies to both paths (no matter in which path it was made).
Correlated paths in dual-channel fading with the same input signal simulate the receiving conditions experienced by a receiver having two antennas in which the received signals exhibit a certain degree of correlation due to a similar environment.

Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:STATe on page 168

**Correlation Coefficient**
Sets the magnitude of the complex correlation coefficient as a percentage.

The higher the entered percentage, the greater the correlation of the statistical fading processes for the two correlated paths. Highly correlated ambient conditions for the signal are simulated in this manner.

Each fader has a maximum of 20 paths.

With correlated paths, the coefficient setting must agree. When correlation is activated, the setting of the path for which correlation is switched on is accepted for both paths. Afterwards, the most recent modification applies to both paths (no matter in which path it was made).

Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:COEFficient on page 167

**Correlation Coefficient Phase**
Sets the phase of the complex correlation coefficient in degrees.

With correlated paths, the coefficient phase setting must agree. When correlation is activated, the setting of the path for which correlation is switched on is accepted for both paths. Afterwards, the most recent modification applies to both paths (no matter in which path it was made).

Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:PHASe on page 167

**Lognormal State**
Switches lognormal fading on/off (slow fading).

Simulated is an additional slow fluctuation of the received amplitude of a moving receiver. This can occur due to peculiarities in the landscape or topography (e.g. when driving through a depression). Lognormal fading has a multiplicative effect on the path loss. The multiplication factor is time-variable and logarithmically normally distributed. If a Rayleigh profile is set simultaneously, what we obtain is Suzuki fading.

**Note:** Since the slow level fluctuation is not taken into account statistically in the computation of the insertion loss, the output power can deviate from the displayed power.

Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:STATe on page 172

**Local Constant**
Enters the Local Constant for lognormal fading.
The Local Constant L and the speed v of the moving receiver determine the limit frequency \( f_L \) for lognormal fading:

\[ f_L = \frac{v}{L}. \]

The power density spectrum of an unmodulated carrier consists of a discrete spectral line at \( f_{RF} \) and a frequency-dependent continuous component for which the following applies:

\[ S(f) = const \cdot e^{-0.5 \left( \frac{f-f_{RF}}{f_L} \right)} \]

The lower setting limit is a function of the (virtual) RF frequency \( f_{RF} \) and is calculated as follows:

\[ L_{\text{min}} = \frac{12 \times 10^{9}}{f_{RF}} \]

Remote command:

```
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:LCONstant
```

**Standard Deviation**

Enters the standard deviation in dB for lognormal fading.

Remote command:

```
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:CSTD
```

### 4.5 Path Graph

To access the graphical representation of the configured path,

- select "Fading > Path Graph".

The path graph provides a quick overview of the paths as they are configured in the delay modes.
The signal delay is plotted on the x-axis. The minimum value is 0 s. The maximum value is equal to the maximum delay, determined by the sum of max. Basic Delay and max. Additional Delay. The relative path power is plotted on the y-axis, with 0 dB corresponding to the maximum power on the path (path loss = 0 dB).

Each path is represented by a bar. The color of the bar indicates the fading profile of the path. The color coding for the individual profiles is shown right next to the graphics. The "Path Loss" can be read off from the height of the bar. The minimum value is 0 dB, and the maximum value is – 50 dB.

4.6 Birth Death Propagation

In the "Birth Death Propagation" configuration, the fading simulator simulates dynamic propagation conditions in conformity with the test case 3GPP, 25.104-xxx, annex B4. Here, the behavior of a receiver is tested when it is confronted with the sudden disappearance and reappearance of a signal. This can occur, for example, when a pedestrian making a call walks around the corner of a building.

Two paths are simulated which appear ("Birth") or disappear ("Death") in alternation at arbitrary points in time. The points in time fall within a grid of integer delays [-5, -4, -3, -2, -1, 0, 1, 2, 3, 4, 5] µs. After a certain time ("Hopping Dwell"), a path disappears from a given grid position and appears simultaneously at another randomly chosen grid position. During this hop, the second path remains stable at its grid position. After a further "Hopping Dwell" elapses, the second path changes its position. Now, the first path remains at its position and so on. The two paths never appear at the same time position at the same time (see Figure 4-5).
Since it is not possible to generate negative time values (delays), the actual hop range is from 0 to 10 µs.

According to annex B4, each path has the same loss and phase and no Doppler shift. The time until the position of a path is changed is also specified (see Table 4-2).

**Table 4-2: Default parameter values (Birth Death Propagation)**

<table>
<thead>
<tr>
<th>&quot;Profile&quot;</th>
<th>Pure Doppler</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Path Loss&quot;</td>
<td>0 dB</td>
</tr>
<tr>
<td>&quot;Min. Delay&quot;</td>
<td>0 µs</td>
</tr>
<tr>
<td>&quot;Delay Grid&quot;</td>
<td>1 µs</td>
</tr>
<tr>
<td>&quot;Positions&quot;</td>
<td>11</td>
</tr>
<tr>
<td>&quot;Max. Delay&quot;</td>
<td>10 µs</td>
</tr>
<tr>
<td>&quot;Hopping Dwell&quot;</td>
<td>191 ms</td>
</tr>
<tr>
<td>&quot;Speed&quot;</td>
<td>0 m/s</td>
</tr>
<tr>
<td>&quot;Frequency Ratio&quot;</td>
<td>1.0</td>
</tr>
</tbody>
</table>

**Path Graph**

The graphical display of the fading paths in Birth Death Propagation mode shows as an example the changing positions of the two paths within the delay grid. The displayed position change does not correspond to the actual delay hops of the real signal. An arrow indicates the direction of the delay hop of the path that will next change its position, with the head of the arrow marking the new position.

The delay grid is plotted on the x-axis. The permissible delay range and the delay offset are shown in the graphics (see the "Min Delay" and the "Delay Range" indication on the graph). The path power is plotted on the y-axis, with 0 dB corresponding to the maximum power on the path (path loss = 0 dB). The scaling of the axes and the displayed path power match the real settings.

The scaling of the x-axis depends on the set delay range. It always starts at 0 µs and ranges up to 40 µs at the most (= maximum for delay range). The minimum delay corresponds to the start value of the delay range. The maximum delay is defined by the minimum delay, the delay grid and the number of possible hop positions.

\[
\text{Max Delay} = (\text{Positions} - 1) \times \text{Delay Grid} + \text{Min. Delay}
\]
The (mean) delay offset is calculated from the minimum and maximum delay \((\text{max. delay} - \text{min. delay})/2\).

The Table 4-2 lists the default values for Birth Death Propagation. However, these parameters can also be set for further tests in the fading path table.

Settings:

- **Profile**
- **Path Loss**
- **Min Delay**
- **Delay Grid**
- **Positions**
- **Maximum Delay**
Birth Death Propagation

Start Offset .................................................................................................................... 61
Hopping Dwell ................................................................................................................. 61
Speed ............................................................................................................................... 62
Resulting Doppler Shift ................................................................................................. 62
Frequency Ratio ............................................................................................................. 62
Actual Doppler Shift ....................................................................................................... 63

Profile
Displays the fading profile for birth death propagation. The fading profile has a fixed setting to “Pure Doppler”.

A transmission path is simulated in which there is an individual direct connection from the transmitter to the moving receiver (discrete component). The Doppler frequency shift is determined by the “Speed” and “Frequency Ratio” parameters.

Remote command:
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:PROFile on page 177

Path Loss
Enters the loss for the selected path.
Remote command:
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:LOSS on page 176

Min Delay
Enters the minimum delay for the two fading paths.
The minimum delay corresponds to the start value of the delay range.
The delay range is defined by the minimum delay, the delay grid and the number of possible hop positions. It can be in the range between 0 and 40 us.
0 us < (Positions – 1) x Delay Grid + Min. Delay < 40 us
The scaling of the X-axis is adapted according to the entry (see "Path Graph" on page 58).
Invalid entries are rejected, the next possible value is entered.
Remote command:
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MINimum on page 176

Delay Grid
Enters the delay grid. The value defines the resolution for the possible hop positions of the two fading paths in the delay range.
The scaling of the X-axis is adapted according to the entry (see "Path Graph" on page 58).
Invalid entries are rejected, the next possible value is entered.
Remote command:
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:GRID on page 175

Positions
Enters the number of possible hop positions in the delay range.
The scaling of the X-axis is adapted according to the entry (see "Path Graph" on page 58).
Invalid entries are rejected, the next possible value is entered.
Remote command:
`[:SOURce<hw>]:FSIMulator:BIRThdeath:POSitions` on page 177

**Maximum Delay**
Indication of the maximum delay. The maximum delay corresponds to the stop value of the delay range (see "Path Graph" on page 58).
The maximum delay is defined by the minimum delay, the delay grid and the number of possible hop positions.
Max Delay = (Positions – 1) x Delay Grid + Min. Delay
Remote command:
`[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MAXimum?` on page 176

**Start Offset**
Enters the timing offset by which the start of "Birth Death Propagation" is offset with respect to when fading is switched on or a restart as a result of a restart trigger.
This allows the user to precisely displace birth death events with respect to one another during two-channel fading. This is required in some 3GPP base station tests.
If the same hopping dwell time is entered in both faders, the offset will take place by a constant value.

Remote command:
`[:SOURce<hw>]:FSIMulator:BIRThdeath:SOFFset` on page 177

**Hopping Dwell**
Enters the time until the next change in the delay of a path (birth death event).
During two-channel fading, the dwell times of the two channels can be set independently. This causes the hop time points of the two channels to coincide repeatedly. This is a way of simulating tough receiving conditions as arise when two receiving channels simultaneously change frequency (see figure).

Remote command:
[:SOURce<hw>]:FSIMulator:BIRThdeath:HOPping:DWELL on page 176

Speed
Enters the speed $v$ of the moving receiver.

The resulting Doppler shift is dependent on the speed $v$ and the entered ratio of the actual Doppler shift to the set Doppler shift $f_D$. This ratio is determined in the "Frequency Ratio" line. The resulting Doppler frequency can be read off from the "Res. Doppler Shift" line. It may not exceed the maximum Doppler frequency.

If the speed is changed, the resulting Doppler shift is automatically modified.

Remote command:
[:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed on page 178

Resulting Doppler Shift
Displays the resulting Doppler shift.

Remote command:
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler? on page 179

Frequency Ratio
Enters the ratio of the actual Doppler shift to the Doppler shift set with the "Speed" parameter.

Remote command:
[:SOURce<hw>]:FSIMulator:BIRThdeath:FRATio on page 178
**Actual Doppler Shift**

Displays the actual Doppler shift.

The actual Doppler frequency is determined by the selected "Speed" and "Frequency Ratio" (i.e. the ratio of the actual Doppler frequency to the resulting Doppler frequency).

Remote command:

```
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler:ACTual?
```

on page 179

---

### 4.7 Moving Propagation

In the "3GPP/LTE Moving Propagation" configuration, the fading simulator simulates dynamic propagation conditions in conformity with the test case 3GPP TS25.104, annex B3 or 3GPP TS36.141, annex B.4.

The fading simulator enables configuration according to three predefined moving scenarios. The first one represents moving conditions with one reference and one moving channel whereas in the other two all paths are moving.

The predefined scenarios are as follow:

- "Ref. + Mov. Channel" - Simulation of moving propagation conditions in accordance to the 3GPP TS25.104, annex B3.
  (see Chapter 4.7.1, "Moving Propagation Conditions for Testing of Baseband Performance", on page 63)

- "ETU200Hz Moving" - Simulation of moving propagation conditions in accordance to the scenario 1 described in 3GPP TS36.141, annex B.4.
  (see Chapter 4.7.2, "Moving Propagation Conditions for Testing the UL Timing Adjustment Performance", on page 66)

- "Pure Doppler Moving" - Simulation of moving propagation conditions in accordance to the scenario 2 described in 3GPP TS36.141, annex B.4.
  (see Chapter 4.7.2, "Moving Propagation Conditions for Testing the UL Timing Adjustment Performance", on page 66)

It is also possible to adjust some of the parameters of these predefined scenarios and simulate user-definable moving propagation conditions.

---

#### 4.7.1 Moving Propagation Conditions for Testing of Baseband Performance

**Simulating moving propagation conditions for testing of baseband performance**

- To simulate moving propagation conditions for testing of baseband performance in accordance to the 3GPP TS25.104, annex B3:
  
  a) select "Configuration > Moving Propagation" and "Moving Channels > One" or
  
  b) select "Standard > 3GPP > Moving Propagation > Ref. + Mov. Channel".
Here, the behavior of a receiver is tested in response to slow delay variations in a signal. Two paths are simulated: Path 1 has fixed delay (Reference Path, P1), while the delay of path 2 varies slowly in a sinusoidal fashion (Moving Path, P2). The two paths have no fading profile. They have the same level, the same phase and no Doppler shift.

The following figure illustrates a baseband signal with ASK modulation (only one 1 bit, then many 0 bits) which was subjected to moving propagation. Path P1 remains still while path P2 moves in time relative to it. As a result of the luminescence setting on the oscilloscope, the way in which P2 wanders over time is clearly visible.

The graphical display of the fading paths in Moving Propagation mode shows as an example the changing positions of the moving path with respect to the stationary reference path. The displayed position change does not correspond to the actual delay changes of the real signal.

The delay grid is plotted on the x-axis. The permissible delay range for the moving path is shown in the graphics by the horizontal arrow. The grey path indicates the set start delay for the Moving Path. The path power is plotted on the y-axis, with 0 dB corresponding to the maximum power on the path (path loss = 0 dB). The scaling of the axes and the displayed path power match the real settings.
The delay $\Delta \tau_{\text{one}}$ of the moving path obeys the following equation:

$$\Delta \tau_{\text{one}} = \text{"Delay"} + \frac{\text{"Variation (Pk Pk)"}}{2} \cdot \sin \left( \frac{2\pi}{\text{"Variation Period"}} \right)$$

Where the values relate to the values proposed in the test case 3GPP, 25.104xxx, annex B3 as follows:

- Variation (Peak-Peak) = A
- Delay = $B + A/2$
- Variation Period = $2\pi / \Delta \omega$

The Table 4-3 list the settings required to attain the values proposed in the test case 3GPP TS25.104, annex B3.

**Table 4-3: Default parameter values (Moving Propagation)**

<table>
<thead>
<tr>
<th>Reference Path:</th>
<th>&quot;Delay&quot;</th>
<th>0 us</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Path Loss&quot;</td>
<td>0 dB</td>
</tr>
<tr>
<td></td>
<td>&quot;State&quot;</td>
<td>On</td>
</tr>
<tr>
<td>Moving Path:</td>
<td>&quot;Variation (Pk Pk)&quot;</td>
<td>5 us</td>
</tr>
<tr>
<td></td>
<td>&quot;Variation Period&quot;</td>
<td>157 s</td>
</tr>
<tr>
<td></td>
<td>&quot;Delay&quot;</td>
<td>3.5 us</td>
</tr>
<tr>
<td></td>
<td>&quot;Path Loss&quot;</td>
<td>0 dB</td>
</tr>
<tr>
<td></td>
<td>&quot;State&quot;</td>
<td>On</td>
</tr>
</tbody>
</table>

These default values can be changed in the Path Table dialog.
4.7.2 Moving Propagation Conditions for Testing the UL Timing Adjustment Performance

The purpose of the uplink timing adjustments testing is to verify whether the base station sends timing advance commands and whether the base station estimates appropriate the uplink transmission timing.

Simulating moving propagation conditions

To simulate moving propagation conditions for testing the UL timing adjustment performance in conformity with the test cases "Moving propagation conditions", as defined in 3GPP 36.141, annex B.4:

- Select "Standard > LTE > Moving Propagation > ETU200Hz Moving or Pure Doppler Moving"

The Figure 4-6 illustrates the moving propagation conditions for the test of the UL timing adjustment performance.

![Figure 4-6: Moving Propagation Conditions](image)

Use the parameter "Additional Delay" to configure the relative timing among all paths. The time difference between the reference timing and the first path is according to the following equation:

\[
\Delta \tau_{all} = \frac{Variation(Pk,Pk)}{2} \cdot \sin \left( \frac{2\pi}{Variation \ Period} \right)
\]

The 3GPP specification defines the uplink timing adjustments requirements for normal and extreme conditions. The following two scenarios for the testing of UL timing advance are specified:

- Scenario 1: ETU200 ("ETU200Hz Moving") is the scenario for testing in normal conditions.
  This scenario considers ETU channel model and UE speed of 120km/h.
- Scenario 2: AWGN ("Pure Doppler Moving") is the extreme conditions optional scenario.
  The scenario corresponds to AWGN channel model and UE speed of 350km/h.
The fading simulator generates the signals for these scenarios in accordance with the parameters defined in the 3GPP specification (see table Table 4-4). However, the fading simulator also allows the re-configuration of some of the predefined values.

Table 4-4: Default parameter values

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Scenario 1</th>
<th>Scenario 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Model</td>
<td>ETU200Hz Moving</td>
<td>Pure Doppler</td>
</tr>
<tr>
<td>UE speed</td>
<td>120 km/h</td>
<td>350 km/h</td>
</tr>
<tr>
<td>CP length</td>
<td>Normal</td>
<td>Normal</td>
</tr>
<tr>
<td>&quot;Variation (Peak-Peak)&quot;</td>
<td>10 μs</td>
<td>10 μs</td>
</tr>
<tr>
<td>Δω</td>
<td>0.04 1/s</td>
<td>0.13 1/s</td>
</tr>
<tr>
<td>&quot;Variation Period&quot; = 2π/Δω</td>
<td>157.1 s</td>
<td>48.3 s</td>
</tr>
</tbody>
</table>

4.7.2.1 Scenario 1

Here, the behavior of a moving receiver is tested, i.e. the simulated scenario represents a moving receiver that changes its distance to the base station. The Fading Simulator generates the signal as a sequence of complete cycles of approach towards the BS antenna and moving away from it.

Per default, three Rayleigh path groups with three paths each are simulated. All paths move.

The path group 1 has a fixed delay ("Basic Delay = 0 s"); the "Basic Delay" of the other two path groups can be configured. The relative timing among all paths is determined by the parameter "Additional Delay".

The three path groups have the same phase and speed; the Doppler shift is calculated as a function of the selected speed.
4.7.2.2 Scenario 2

One path without a fading profile (Pure Doppler) is simulated. The path has constant level and constant speed.

4.7.3 Path Tables Moving Propagation

The parameters available for configuration depend on the selected number of Moving Channels, one or all.

4.7.3.1 One Moving Channel

To access the settings for configuring the moving and the reference path for the moving propagation with one moving channel, perform on of the following:

a) select "Fading > Standard > 3GPP > Ref. + Mov. Channel"

b) select "Fading > Configuration > Moving Propagation" and "Moving Channels > One".

Settings:

- **Reference Path Settings**
  - State
  - Path Loss
  - Delay

- **Moving Path Settings**
  - State
  - Path Loss
Reference Path Settings
The following settings are provided:

State ← Reference Path Settings
Activates reference path P1 for moving propagation.
Remote command:
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:STATe on page 188

Path Loss ← Reference Path Settings
Enters the loss for the reference path.
Remote command:
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:LOSS on page 187

Delay ← Reference Path Settings
Enters the delay for the reference path.
Remote command:
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:DELay on page 187

Moving Path Settings
The following settings are provided:

State ← Moving Path Settings
Activates moving fading path P2 for moving propagation.
Remote command:
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:STATe on page 187

Path Loss ← Moving Path Settings
Enters the loss for the moving fading path.
Remote command:
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:LOSS on page 186

Delay ← Moving Path Settings
Enters the average delay for the moving fading path.
The delay of the moving path slowly varies sinusoidal within the set variation range around this delay.
Remote command:
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:MEAN on page 185

Variation (Peak-Peak) ← Moving Path Settings
Enters the range for the delay of the moving fading path for moving propagation. The delay of the moving path slowly varies sinusoidal within this range around the set mean delay.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELAY:MOVing:DELay:VARIation on page 186

**Variation Period — Moving Path Settings**
Period duration for delay variation. A complete variation cycle is passed through in this time.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELAY:MOVing:VPERiod on page 187

4.7.3.2 **All Moving Channels**

To access the settings for configuring the moving path groups and their paths, perform one of the following:

a) select "Fading > Standard > LTE > Moving Propagation > ETU200Hz Moving"
b) select "Fading > Standard > LTE > Moving Propagation > Pure Doppler Moving"
c) select "Fading > Configuration > Moving Propagation" and "Moving Channels > All".

The number and the parameters of the predefined paths depend on the selected scenario.

The most parameters in the "Path Table" correspond to the parameters described in Chapter 4.4, "Path Table", on page 44.
Settings:

Delay Variation (Peak-Peak)........................................................................................................71
Variation Period.........................................................................................................................71

Delay Variation (Peak-Peak)
Enters the range for the delay of the moving fading paths for moving propagation with all moving channels. The delay of the moving path slowly varies sinusoidal within this range around the set mean delay.

Remote command:
[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:DELay:VARiation on page 184

Variation Period
Period duration for delay variation. A complete variation cycle is passed through in this time.

Remote command:
[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:VPERiod on page 184

4.8 Two Channel Interferer

In the "2 Channel Interferer" configuration, the fading simulates dynamic propagation in conformity with the test cases 5 and 6 from MediaFlo. Here, path 1 has a fixed delay while the delay of path two either varies slowly in a sinusoidal way or appears in alternation at arbitrary points in time. Thus, 2 channel interferer fading can be considered as a combination of birth death propagation fading and moving propagation fading. The main difference is the broader range of propagation obtainable with 2 channel interferer fading.

Each of the fading profiles "Static Path", "Pure Doppler" and "Rayleigh" can be allocated to the two paths.

Predefined Setting

The Table 4-5 and Table 4-6 list the settings required to attain the values proposed in the MediaFlo test case 5 and 6.

Table 4-5: Test Case 5

<table>
<thead>
<tr>
<th>Reference Path:</th>
<th>&quot;Profile&quot;</th>
<th>Static Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Relative Delay&quot;</td>
<td>10 us</td>
<td></td>
</tr>
<tr>
<td>&quot;Average Power&quot;</td>
<td>-3 dB</td>
<td></td>
</tr>
<tr>
<td>&quot;Fading Type&quot;</td>
<td>Rayleigh, 60 km/h</td>
<td></td>
</tr>
<tr>
<td>&quot;Doppler Spectrum&quot;</td>
<td>Classic 6 dB</td>
<td></td>
</tr>
<tr>
<td>&quot;Static Delay&quot;</td>
<td>40 us</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Moving Path:</th>
<th>&quot;Profile&quot;</th>
<th>Hopping</th>
</tr>
</thead>
</table>
How to use the provides settings and configure a 2 channel interfering signal

The following are two examples on how to configure a "2 Channel Interferer" conditions. See how to:

- "To enable a hopped moving mode" on page 72
- "To enable a sliding moving mode" on page 73

To enable a hopped moving mode

Enable a 2 channel interfering signal with the following settings:

1. Reference Path:
   a) "Delay Min = 30 μs"
   b) "Profile = Static Path"
   c) "Path Loss = 0 dB"

2. Moving Path:
   a) "Delay Min = 0 μs"
   b) "Profile = Static Path"
   c) "Path Loss = 0 dB"
   d) "Delay Max = 100 μs"
   e) "Moving Mode > Hopping"

3. Enable "Reference Path > State > On" and "Moving Path > State > On"
4. Open the "Fading > Path Graph" view.

The following figure shows the resulting path graph.

To enable a sliding moving mode

1. Use the settings of "To enable a hopped moving mode" on page 72.
2. Change the "Moving Mode > Sliding".
3. Open the "Fading > Path Graph" view.

The moving path slides from the minimum delay (30 us) to the maximum delay (100 us) and back. The grey bar indicates the mean delay of the moving path. The horizontal arrow indicates the permissible delay range for the moving path. The displayed position change does not correspond to the actual delay changes of the real signal.
2 Channel Interferer Settings

The Table 4-5 and Table 4-6 list the default values for "2 Channel Interferer" configuration. You can use these default values and/or adjust the provided settings in the fading path table.

**Settings:**

State..............................................................................................................................74
Profile............................................................................................................................ 75
Path Loss...................................................................................................................... 75
Speed............................................................................................................................75
Freq. Ratio.................................................................................................................... 75
Res. Doppler Shift......................................................................................................... 75
Act. Doppler Shift........................................................................................................... 76
Delay Min...................................................................................................................... 75
Delay Max.................................................................................................................... 76
Moving Mode............................................................................................................... 76
Period/Dwell................................................................................................................. 76

State
Activates/deactivates either the reference path or the moving path for 2 channel interferer fading.

Remote command:
[:SOURce<hw>]:FSIMulator:TCINterferer[:STATe] on page 211
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:STATe on page 214
Profile
Selects the fading profile either for the reference path or the moving path to be used for 2 channel interferer fading.
Remote command:
\texttt{[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler?}
on page 213

Path Loss
Sets the attenuation of either the reference path or moving path to be used for 2 channel interferer fading.
Remote command:
\texttt{[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:LOSS}
on page 214

Speed
(Rayleigh only)
Enters the speed $v$ of the moving receiver. The unit for entering the speed under "Speed Unit" can be chosen in the upper section of the menu.
The resulting Doppler shift is dependent on the speed $v$ and the entered ratio of the actual Doppler shift to the set Doppler shift $f_D$. This ratio is determined in the "Frequency Ratio" line. The resulting Doppler frequency can be read off from the "Res. Doppler Shift" line. It may not exceed the maximum Doppler frequency.
If the speed is changed, the resulting Doppler shift is automatically modified.
Remote command:
\texttt{[:SOURce<hw>]:FSIMulator:TCINterferer:SPEed} on page 212

Freq. Ratio
Enters the ratio of the actual Doppler shift to the Doppler shift set with the "Speed" parameter.
Remote command:
\texttt{[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FRATio}
on page 214

Res. Doppler Shift
Displays the actual Doppler shift.
The actual Doppler frequency is determined by the entered "Speed" and the entered ratio of the actual Doppler frequency to the set Doppler frequency ("Frequency Ratio").
Remote command:
\texttt{[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler?}
on page 213

Delay Min
Enters the minimum delay for either the reference path or the moving path.
The minimum delay of the moving path corresponds to the start value of the delay range.
The delay range is defined by the minimum delay and the maximum delay.
The scaling of the x-axis is adapted according to the entry.
Invalid entries are rejected, the next possible value is entered.
Remote command:

**Act. Doppler Shift**
Displays the actual Doppler shift.
Remote command:
[:SOURce<hw>:FSIMulator:TCINterferer:REFerence|MOVing:FDOppler:ACTual?] on page 213

**Delay Max (Moving Path)**
Enters the maximum delay for the moving path.
The maximum delay of the moving path corresponds to the end value of the delay range.
The delay range is defined by the minimum delay and the maximum delay.
The scaling of the x-axis is adapted according to the entry.
Invalid entries are rejected, the next possible value is entered.
Remote command:
[:SOURce<hw>:FSIMulator:TCINterferer:MOVing:DELay:MAXimum] on page 211

**Moving Mode (Moving Path)**
Selects the Type of moving applied to the moving path.
"Sliding"  The reference path has a fix delay while the delay of the moving path varies slowly in a sinusoidal way.
"Hopping"  The reference path has a fix delay while the delay of the moving path appears or disappears in alternation at arbitrary points in time.
Remote command:
[:SOURce<hw>:FSIMulator:TCINterferer:MOVing:MMODE] on page 212

**Period/Dwell**
Enter either the dwell time or the period of a complete cycle for the moving path depending on the selected **Moving Mode (Moving Path)**.

<table>
<thead>
<tr>
<th>&quot;Moving Mode&quot;</th>
<th>&quot;Period Dwell&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Sliding&quot;</td>
<td>sets the period for a complete cycle of the moving path</td>
</tr>
<tr>
<td>&quot;Hopping&quot;</td>
<td>sets the dwell time of the moving path</td>
</tr>
</tbody>
</table>

The gradient of the delay/period ratio may not fall below $6\mu s/s$, that is, the minimum value of the period depends on the value of the delay.
If the value for the delay is increased in a way that the value for the gradient falls below $6\mu s/s$, the value for the period is recalculated automatically.
Example:

"Delay Min" = 20 us, "Delay Max" = 120 us, "Moving Mode = Sliding"

\[
\left(\frac{\text{Delay max} - \text{Delay min}}{2}\right)^2 \pi / \text{Period/Dwell} = 6
\]

"Period/Dwell" = 314/6 = 52.36 s

The value cannot be decreased below this value.

Remote command:

\text{[:SOURce<hw>:FSIMulator:TCINterferer:PERiod on page 212}

### 4.9 Customized Dynamic Fading

Customized dynamic fading (CDF) allows you to import dynamic fading list files and to vary the fading parameters path loss, Doppler shift and delay over time. This functionality requires option R&S SMW-K820

Customized dynamic fading is a suitable solution in the following cases:

- If advanced dynamic fading models like the customized high-speed train scenarios (cHST) are required
- If a simulation based on measured real-world channel conditions is required

Such requirements are for example the UE tests in the context of performance analysis.

Customized dynamic fading is available in SISO and MIMO configurations. This fading configuration consists of up to 12 fading paths that can be activated individually. All fading paths use rayleigh fading profile but a pure Doppler profile can also be assigned to the first four paths.

The dynamic fading list files are application-specific list files in a Rohde & Schwarz proprietary file format and with the predefined file extension *.fad_udyn. Such files can originate for example from drive test measurements. These measurement results have to be converted in the required file format.

Access:

1. Select "Fading > General Setting > Configuration > Customized Dynamic"
2. Select "Path Table".
Up to 12 fading paths can be configured. The displayed settings depend on the configuration (SISO or MIMO).

3. To load a fading list file, select "Filename > Select Predefined File". Select on of the predefined files, e.g. Urban_Pure Doppler.

**Settings:**

- **State**
  - If a fading list file is loaded, this parameter activates the path.
  - Each change of the state of a path causes a restart of the fader and therefore a restart of all dynamic lists.
  - Remote command:
    ```
    [:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:STATe
    ```
    on page 228

- **Profile**
  - Displays the used profile.
  - Per default, all fading path use Rayleigh profile. For fading paths 1 to 4, the fading profile pure Doppler can also be used.
  - Remote command:
    ```
    [:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:PROF
    ```
    on page 228

- **Filename**
  - You can load predefined or user-defined application-specific fading list files.
  - The fading list files are files in a Rohde & Schwarz proprietary file format and with the predefined file extension *.fad_udyn.
  - Such files can originate for example from drive test measurements. These measurement results have to be converted in the required file format.
Remote command:

[:SOURce<hw>]:FSIMulator:CDYNamic:CATalog? on page 227
[:SOURce<hw>]:FSIMulator:CDYNamic:CATalog:USER? on page 227
[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:DATA:DSELet on page 227
[:SOURce<hw>]:FSIMulator:CDYNamic:DELet on page 227

**Correlation**

In MIMO configurations, access dialogs to configure the correlation settings:

"Vector" For the "Pure Doppler" paths, opens the "Relative Tap Gain Vector" dialog where you can configure the phase shift of the selected path. For description, see Chapter 6.3.3, "Relative Gain Vector Matrix Settings", on page 102.

"Matrix" For the "Rayleigh" paths, opens the "Correlation Matrix" dialog. Available is only the "Matrix Mode > Individual", see Chapter 6.3.2, "Correlation Matrix Table", on page 100.

### 4.10 High-Speed Train

In the "High Speed Train" configuration, the fading simulator simulates propagation conditions in conformity with the test case "High-speed train conditions", as defined in 3GPP 25.141, annex D.4A and 3GPP 36.141, annex B.3. Here, the behavior of a receiver in high-speed train conditions is tested, i.e. the simulated scenario represents a fast moving receiver that drives past an antenna. The fading simulator generates the signal as a sequence of complete cycles of approach towards to the BS antenna and departure from it.

![Figure 4-7: High-speed train propagation](image)

Three high-speed scenarios are defined:
- Scenario 1: Open space
- Scenario 2: Tunnel with leaky cable
- Scenario 3: Tunnel for multi-antennas
4.10.1 Scenario 1 and Scenario 3

For each of the scenarios 1 and 3, one path without a fading profile is simulated (Pure Doppler). The path has constant level, no delay and variable Doppler shift.

The Doppler shift for these scenarios is calculated as follows:

\[ f_D(t) = f_D \cos \varphi(t) \]

Where \( f_D(t) \) is the actual Doppler shift and \( f_D \) is the maximum Doppler frequency.

The cosine of angle is given by:

\[ \cos \varphi(t) = \frac{D_S/2 - vt}{\sqrt{D_{\text{min}}^2 + (D_S/2 - vt)^2}}, \quad 0 \leq t \leq D_S/v \]

Where:
- \( D_S/2 \) is the distance in meters between the train and the BS at the beginning of the simulation
- \( D_{\text{min}} \) is the minimum distance in meters between the BS and the railway track
- \( v \) is the velocity of the train in m/s
- \( t \) is time in seconds

For scenario 1 and for BS with receiver diversity, the Doppler shift variation is the same between the antennas.

4.10.2 Scenario 2

Scenario 2 is not defined for EUTRA/LTE test cases.

For scenario 2, one Rician fading propagation channel with Rician factor \( K=10 \) dB and with one tap is simulated. The Rician factor \( K \) is defined as the ratio between the dominant signal power and the variant of the other weaker signals (see "K (Rician factor)" on page 84).

4.10.3 High-Speed Train Scenario Parameters

The Table 4-7 gives an overview of the parameters of the HST test scenarios according to the test case "High-speed train conditions".

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>( D_S )</td>
<td>1000 m</td>
</tr>
<tr>
<td>( D_{\text{min}} )</td>
<td>50 m</td>
</tr>
<tr>
<td>( K )</td>
<td>-</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>$v$</td>
<td>350 km/h</td>
</tr>
<tr>
<td>$f_0$</td>
<td>1340 Hz</td>
</tr>
</tbody>
</table>

The Figure 4-8 and Figure 4-9 show the trajectory of the Doppler shift for scenario 1 and 3 for the test parameters specified in the test case. For these two scenarios, the Doppler shift trajectories for any user-defined parameters are also displayed in the "3GPP HST" dialog.

**Figure 4-8: Doppler shift trajectory for scenario 1**

**Figure 4-9: Doppler shift trajectory for scenario 3**

**Doppler shift calculation**

The HST scenarios are defined for the UE and for the BS tests. In the fading simulator, the same standards are used for both test cases. Consider however, the following difference in the calculation of the Doppler shift:

- In **HST UE tests**, the resulting Doppler shift is based only on the used DL frequency.
- In **HST BS tests**, the DL signal itself already contains a Doppler shift. The UE synchronizes on this shifted DL frequency. The simulated UL signal contains a Doppler shift, too.
The resulting Doppler shift is then based on both, the UL and the DL frequency.

To enable the fading simulator to consider the DL Doppler shift, use the following two parameters:

- Consider DL RF
- Virtual DL RF

**General recommendations on performing HST BS tests**

The following is a list of the general steps required to enable the fading simulator to generate the signal required for the HST BS tests:

1. Set the "RF Frequency" of the instrument to the $F_{UL}$, as defined in the specification.
2. Enable a high-speed train scenario with extension "(DL+UL)" in its name.
3. If not enabled, activate the parameter "Fading > (HST) Path Table > Consider DL RF > On".
4. Set the value of the parameter "Fading > (HST) Path Table > Virtual DL RF" to the $F_{DL}$, as defined in the specification.

**Example: Configuring the fading simulator to generate an HST BS test signal according to 3GPP TS36.104**

For frequency band 1 tests, the specification defines: $F_{DL} = 2.14 \text{ GHz}$ and $F_{UL} = 1.95 \text{ GHz}$. The resulting Doppler shift is $F_D = 1140 \text{ Hz}$.

- In the status bar, select "Frequency = $F_{UL} = 1.95 \text{ GHz}$"
- Select "Fading A > Fading Settings > Standards" and navigate to the required high-speed train scenario "3GPP > High Speed Train > HST 3 Tunnel Multi Antenna (DL+UL)"
- If not enabled, activate the parameter "Fading > Path Table > Consider DL RF > On".
- Select "Fading > Path Table > Virtual DL RF = $F_{DL} = 2.14 \text{ GHz}$"
- Select "Fading > Fading Settings > State > On"
- Use the command [:SOURce<hw>:FSIMulator:HSTRain:FDOpller? to query the resulting Doppler shift.

Compare the example below and the Doppler shift trajectory specified in the 3GPP TS36.104.

**High-speed train scenario settings**

To access these settings:

1. Select "Fading > Fading Settings > Standards".
2. Navigate to the required high-speed train scenario, e.g. "3GPP > High Speed Train > HST 3 Tunnel Multi Antenna (DL+UL)"

The "3GPP HST" dialog displays the default values of the high-speed train scenarios and allows you to adjust them for further tests.
Settings:

State........................................................................................................................................... 83
Profile........................................................................................................................................... 83
Speed............................................................................................................................................ 84
D (min)........................................................................................................................................... 84
D (s).............................................................................................................................................. 84
K (Rician factor)............................................................................................................................... 84
Consider DL RF............................................................................................................................. 84
Virtual DL RF................................................................................................................................. 85

State
Activates/deactivates simulation of high-speed train propagation according to the selected scenario.

Remote command:
[:SOURce<hw>]:FSIMulator:HSTRain:STATe on page 183

Profile
Determines the fading profile for the selected scenario. The fading profile determines which transmission path is simulated.

Although both scenarios 1 and 3 are specified as pure Doppler paths without a fading profile and scenario 2 as a Rician fading, in this fading simulator you can change the fading profile.

"Static Path"  A static transmission path with no attenuation (loss) or delay is simulated.
"Pure Doppler"  A transmission path is simulated in which there is an individual direct connection from the transmitter to the moving receiver (discrete component).
The simulated path has a constant delay and attenuation (no loss). The Doppler frequency shift is determined only by the parameters Speed, \( D \) (min) and \( D \) (S).
**Tip:** Use the SCPI command [:SOURce<hw>]:FSIMulator:HSTRain:FDOPpler? to query the Doppler frequency shift.

"Rayleigh"  A radio hop is simulated in which many highly scattered subwaves arrive at a moving receiver.

"Rice"  One Rician fading propagation channel with K (Rician factor) and with one tap is simulated.

**Remote command:** [:SOURce<hw>]:FSIMulator:HSTRain:PROFile on page 182

**Speed**  Sets the velocity parameter, i.e. the speed of the moving receiver.
**Remote command:** [:SOURce<hw>]:FSIMulator:HSTRain:SPEed on page 181

**D (min)**  For "Profile > Static Path or Pure Doppler", sets the parameter \( D_{\text{min}} \) to define the distance between the BS and the railway track.
**Remote command:** [:SOURce<hw>]:FSIMulator:HSTRain:DISTance:MINimum on page 180

**D (S)**  For "Profile > Static Path or Pure Doppler", sets the parameter \( D_{\text{S}} \) and define the initial distance \( D_{\text{S}}/2 \) between the train and the BS at the beginning of the simulation.
**Remote command:** [:SOURce<hw>]:FSIMulator:HSTRain:DISTance:STARt on page 181

**K (Rician factor)**  For scenario 2, sets the Rician factor K that is defined as the ratio between the dominant signal power and the variant of the other weaker signals.
**Remote command:** [:SOURce<hw>]:FSIMulator:HSTRain:KFACtor on page 182

**Consider DL RF**  Enables the selection of virtual downlink frequency (DL RF).
By default, this parameter is enabled for the HST (DL+UL) standards. For detailed description, see "Doppler shift calculation" on page 81.

**Note:** While performing HST BS tests and "Consider DL RF > Off", the DL Doppler shift is not considered by the calculation of the UL Doppler shift.
Remote command:
[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe
on page 183

Virtual DL RF
Sets the virtual downlink frequency. For HST BS tests, enter the $F_{DL}$ defined in the specification. The value is used by the calculation of the UL Doppler shift.
For detailed description, see "Doppler shift calculation" on page 81
Remote command:
[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency on page 183

4.11 Custom Fading Profile

The custom fading profile requires R&S SMW-K72.

The custom fading profile allows you to modify the classical Jakes and Flat fading profiles. These modified profiles are required by the IEEE 802.11p channel models.

A frequency offset $f_{\text{offset}}$ can be applied to shift the spectrum of the original profile. Two cut-off frequencies, $f_l$ (lower) and $f_u$ (upper), can be configured to set the lower and upper cut-off frequencies of the resulting spectrum, see Figure 4-10.

![Figure 4-10: Resulting asymmetric Doppler spectrum](image)

In the fading simulator, all these required profile parameters are configurable, see "Custom fading profile settings" on page 86.
Custom fading profile settings

To access these settings:
1. Select "Fading > Fading Settings > Path Table"
2. Select "Profile > Custom"
3. Select "Custom Profile > Custom Data"

Settings:

Doppler Shape.............................................................................................................. 86
Bandwidth..................................................................................................................... 86
Frequency Offset...........................................................................................................87
Lower/Upper Cutoff Frequency..................................................................................... 87

Doppler Shape
Sets the Doppler shape ("Flat" or "Rayleigh") of the virtual profile.
Remote command:
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DSHape on page 215

Bandwidth
Sets the bandwidth of the original Doppler profile from which the resulting profile is cre-
eted, see Figure 4-10.
Remote command: 
[:SOURce<hw>:FSIMulator:DELa|DE:GROup<st>:PATH<ch>:CUSTom:DATA on page 215

**Frequency Offset**
Sets the frequency offset \( f_{\text{offset}} \) used to shift the original profile, see Figure 4-10.

Remote command: 
[:SOURce<hw>:FSIMulator:DELa|DE:GROup<st>:PATH<ch>:CUSTom:DATA on page 215

**Lower/Upper Cutoff Frequency**
Sets the lower and upper cut-off frequencies, \( f_l \) and \( f_u \), that depend on the original profile bandwidth \( \text{Bandwidth} \).

The following applies:
- \( f_u \leq f_{\text{offset}} + \frac{\text{Bandwidth}}{2} \)
- \( f_l \geq f_{\text{offset}} - \frac{\text{Bandwidth}}{2} \)
- \( f_u - f_l \geq 1 \text{ Hz} \)
- \( 50 \text{ Hz} \leq \text{Bandwidth} \geq 40 \text{ kHz} \)

Where the highest possible absolute cut-off frequency is 4 kHz.

Remote command: 
[:SOURce<hw>:FSIMulator:DELa|DE:GROup<st>:PATH<ch>:CUSTom:DATA on page 215
5 Signal Routing (non-MIMO) Settings

These settings are available in "System Configuration > Mode > Standard", i.e. in non-MIMO scenarios.

To access the signal routing settings, select "Fading > Signal Routing (non-MIMO)".

Signal Routing
In "System Configuration > Mode > Standard", defines the signal routing for the fading signal at the output of the fading simulator.

**Note:** Signal routing for MIMO setups is performed with the settings provided in section "MIMO > System Configuration" (see also Chapter 6.2, "Signal Routing Settings in MIMO Configuration", on page 92).

In remote control, however, all available signal routing settings are configured with the command `[:SOURce<hw>]:FSIMulator:ROUTe`.

In "System Configuration > Mode > Standard", the input signal of the fading simulator is defined by the setting "Baseband > Signal Routing". An instrument equipped with two fading simulators and two baseband blocks, the input signal of each of the fading simulator can be:
- the signal from a single baseband block,
- the summation signal from both baseband blocks or
- each a signal from one of the two baseband blocks.

The following is a list of the routing settings for an instruments equipped with two baseband blocks, two signal paths and two options Fading Simulator (R&S SMW-B14).
"A to A/ B to B"  Dual-channel fading. The fading signal from fader A is output on baseband path A and the fading signal from fader B is output on baseband path B. The R&S SMW can be operated like two instruments; two independently configured signals are routed to the instrument's output. This configuration is also suitable for transmit or receive diversity tests:
- Use the signal of one of the baseband generators to simulate the receiving conditions of a receiver with two antennas, like a high-quality car radio, UMTS base station, etc.
- Correlate the paths of the two fading simulatores, i.e. the two fading channels, to simulate the conditions of receiver with two antennas which receive statistically correlated signals, like a car with two antennas in which the two received signals exhibit a certain degree of correlation due to a similar environment such as an underpass, hill, etc.

"A to A/B to A"  Dual-channel fading. The fading signal from fader A and the fading signal from fader B are both output on baseband path A. This configuration is suitable for the simulation of a mobile radio network handover in the handheld device or for testing of filtering out the own signal in case of simultaneous presence of a strong signal from another standard. To simulate the required conditions, configure each of the baseband signals according to the desired standard and route them to the fading simulator. After fading, the two signals with widely divergent signal strengths are output on a common output path.

"A to B / B to B"  Dual-channel fading. The fading signal from fader A and the fading signal from fader B are both output on baseband path B.

"A to A and B / B to A and B"  Dual-channel fading. The fading signal from fader A and the fading signal from fader B are output on baseband path A and baseband path B. The possible applications are basically analogous to the "A to A / B to A" routing. With this routing however, the signal at the output of the fading simulator is split up and routed to both paths; the processing of these two paths after the fading can be differently. To simulate a further degradation of the receiving conditions, for instance, use the provided function to superimpose the signal of one of the paths by noise or destroy it.

"A to A and B / B (open)"  The fading signal from fader A is output on baseband path A and baseband path B. The signal from fader B is not output, the signal flow of baseband B is interrupted.

"A (open)/ B to A and B"  The fading signal from fader B is output on baseband path A and baseband path B. The signal from fader A is not output, the signal flow of baseband A is interrupted.
Remote command:
[:SOURce<hw>]:FSIMulator:ROUTe on page 150
6 Multiple Input Multiple Output (MIMO)

Provided that the instrument is equipped with the required options, the R&S SMW supports versatile MIMO configurations.

Section Chapter 3.1, "Required Options", on page 19 provides an overview; for detailed information, refer to the R&S SMW data sheet.

Multiple Input Multiple Output (MIMO) refers to a multi-channel method where two or more simultaneous channel inputs and channel outputs are being used for boosting data rates. The benefits of an MIMO system became visible only if the data signal is tested in fading conditions. The MIMO fading option considers this special form of multipath propagation in channel simulation.

Depending on the number of the transmitting and receiving antennas used in a MIMO system, different MxN MIMO test configurations are specified. The term MxN is a representation of a MIMO system, where M is the number of the transmitting Tx antennas and N the number of the receiving Rx antennas. Throughout this description, we also use the term LxMxN as a short form of the used system configuration, where L represents the Number of Entities, M the Number of Basebands (Tx Antennas) and N the Number of Stream (Rx Antennas).

Normally, the simulation of a system with two or more transmitting and/or receiving antennas requires two or more signal generators and/or fading simulator. The MIMO Fading option (R&S SMW-K74) in combination with up to four Fading Simulator options (R&S SMW-B14) enables you to simulate MIMO receiver tests scenarios with up to 8 Tx or up to 8 Rx antennas with one single instrument (see also Chapter 6.1, "Multiple Entity MxN MIMO Test Configurations", on page 92).

Configurations with more than two entities as well as the higher order MIMO configurations require the additional options Multiple Entities (R&S SMW-K76) and Higher Order MIMO (R&S SMW-K75).

Abstract representation of the signal routing

<table>
<thead>
<tr>
<th>2x2 MIMO system</th>
<th>Preview diagram</th>
<th>Block diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="2x2 MIMO system" /></td>
<td><img src="image" alt="Preview diagram" /></td>
<td><img src="image" alt="Block diagram" /></td>
</tr>
</tbody>
</table>

Illustration of the principle
- Detailed representation of the signal processing
- Each F_{Tx=Rx} block represents one MIMO channel

"High level" representation
- The Fading Simulator is displayed as one single block; the number of the input Basebands (M) and the output Streams (N) indicate the MxN MIMO configuration.
The representation of a multi-entity MIMO configuration is even more abstract (see also Chapter 6.1, "Multiple Entity MxN MIMO Test Configurations", on page 92).

### 6.1 Multiple Entity MxN MIMO Test Configurations

Equipped with the MIMO Fading option (R&S SMW-K74), the instrument enables the simulation of versatile MIMO tests scenarios with one single instrument.

The supported MIMO scenarios depend on the installed options, in particular on the number of options fading simulator (R&S SMW-B14), i.e. the number of the available [Fader] boards and on the availability of the options Multiple Entities (R&S SMW-K76) and and Higher Order MIMO (R&S SMW-K75).

For more information, see data sheet.

### 6.2 Signal Routing Settings in MIMO Configuration

You have to select and configure a MIMO scenario before you can define the further fading settings or the signal routing through the instrument.

**To enable a MIMO scenario**

1. Select "Fading > MIMO > System Configuration"
2. In the "System Configuration > Fading/Baseband Configuration" dialog, enable "Mode > Advanced"
3. Define the MIMO scenario, e.g. to configure a 1x4x4 MIMO select:
   a) "Entities (Users, Cells) = 1"
   b) "Basebands (Rx Antennas) = 4"
   c) "Streams (Tx Antennas) = 4"
   d) "BB Source Config > Coupled Sources"

The preview diagram displays a detailed view of the signal routing for the current selected configuration, together with short description of the possible application of this configuration.
4. Select "Fading/Baseband Configuration > Apply" to trigger the instrument to use the selected configuration and close the dialog.

The block diagrams displays the configured signal routing.

5. To enable a multiple-entities configuration, select "System Configuration > Fading/Baseband Configuration" and enable for example:
   a) "Mode > Advanced"
   b) "Entities (Users, Cells) = 4", "Basebands (Rx Antennas) = 2", "Streams (Tx Antennas) = 2"
   c) "BB Source Config > Coupled Sources per Entity"
   d) "Apply".
Refer to Chapter 6.3, "Fading Settings in MIMO Configuration", on page 94 for description on the provided MIMO Fading settings.

Refer to section "Signal Routing and System Configuration" in the R&S SMW user manual for comprehensive description of the settings in the "System Configuration" dialog as well as information on how to define the I/Q stream mapping, connect external instruments, etc.

To define the signal routing in MIMO mode

In MIMO mode, the signal routing is performed upon the selected MIMO configuration.

Configure the instrument for a MIMO scenario, see "To enable a MIMO scenario" on page 92.

The signal routing is fixed and depends on the selected MIMO configuration.

### 6.3 Fading Settings in MIMO Configuration

The MIMO Fading settings are available if a MIMO scenario is configured.

1. Configure the instrument for a MIMO scenario, see "To enable a MIMO scenario" on page 92.

2. You can access the dialog for configuring the MIMO settings of all MIMO channel via each of the "Fading" blocks.

Select "Fading > Fading Settings".
In "System Configurations" with multiple entities (L > 1), the dialog consists of more than one side tabs; one tab per entity. The tab name indicates the fader state the settings are related to.

3. Select "Path Table".

---

**Figure 6-1: General settings in "System Configuration > 2x2x2" (multi entity mode, L=2)**

**Figure 6-2: Path table settings in single entity mode (L=1): Understanding the displayed information**
1a/1b = Path group number (displayed in the first row) and path number (second row in the table header); the example shows 4 groups with different number of active paths (the first group is marked with a blue border)

2 = Fading profile, assigned per fading path

3/3a = Common group delay of a path group ("Basic Delay" is always 0 for group 1); adjustable for the other groups (light grey background)

4 = Resulting delay per path, calculated as the sum of the common group delay and the path-specific delay.

5 = Adjustable parameter for paths with Rice fading

6 = Pure display parameters are on a dark background

7 = Access to a "Vector" or a "MIMO Matrix" for configuration of the correlation between the channels

4. In the path table, navigate to the row "Coefficient". For the corresponding path, select "Matrix" or "Vector".

The "Fading: Correlation Matrix" dialog comprises the parameters necessary to adjust the correlation between the channels. You can define the correlation in one of the following ways:

- In "Matrix Mode > Individual"

![Figure 6-3: Correlation matrix in an individual matrix mode](image)

In this mode, you can adjust the matrix coefficients directly in the coefficient matrix.

- In "Matrix Mode > Kronecker"
The definition of the correlation matrix settings is based on the Kronecker assumption, i.e. defined are the Rx and Tx antenna correlation coefficients. The instrument calculates automatically the resulting correlation matrix and displays it.

See Chapter 6.3.4, "Kronecker Mode Correlation Coefficients", on page 104.

- In "Matrix Mode > AoA/AoD"

See Chapter 6.3.5, "TGn/TGac Channel Models Settings", on page 106.

- In "Matrix Mode > SCME/WINNER"
See:
– Chapter 6.3.6, "SCME/WINNER Model Settings", on page 108
– Chapter 6.3.8, "MIMO OTA Testing Related Settings", on page 123

- For static paths and paths with Pure Doppler fading profile, the corresponding settings are grouped in the "Relative Tap Gain Vector" dialog.

**Figure 6-6: Relative tap gain vector**

This dialog provides additional parameters to simulate a gain weighting and phase shift between the signals with constant fading transmitted among the different Tx antennas.

See Chapter 6.3.3, "Relative Gain Vector Matrix Settings", on page 102.
6.3.1 Current Path (Tap) Settings

**Prev**
Displays the previous tap relative to the current tap. If tap 1 is the current tap, this button is disabled.

Remote command:
n.a.

**Copy To Prev**
Copies the matrix values of the current tap to the next lower tap. If tap 1 is the current tap, this button is disabled.

Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:COPY:PREVIOUS on page 190

**Current Path (Tap) #**
Selects the tap to be displayed.

Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP on page 191

**Copy To Next**
Copies the matrix values of the current tap to the next higher tap. If the current tap is the last tap, this button is disabled.

Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:COPY:NEXT on page 190

**Copy To All**
Copies the matrix values of the current tap all taps.

Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL on page 190

**Next**
Displays the next tap relative to the current tap. If the current tap is the last tap, this button is disabled.

Remote command:
n.a.

**Matrix Mode**
Selects the input mode for the Rx and Tx correlation values.

"Individual" Allows entering the correlation values individually.

"Kronecker" Opens additional input fields for entering the Rx correlation and Tx correlation values, see Chapter 6.3.4, "Kronecker Mode Correlation Coefficients", on page 104.
The matrix values are calculated automatically.
"AoA / AoD" Opens additional input fields for defining the Rx and TX correlation parameters based on the Spatial Channel Model (SCM), see Chapter 6.3.5, "TGn/TGac Channel Models Settings", on page 106. The matrix values are calculated automatically.

"SCME / WINNER" Opens additional input fields for defining the parameters of the Spatial Channel Model Extended (SCME) model, see Chapter 6.3.6, "SCME/WINNER Model Settings", on page 108. The matrix values are calculated automatically.

Remote command:
[:SOURce<hw>:FSIMulator:MIMO:TAP<ch>:MATRix:MODE on page 195

Polarization, Antenna Modeling
Accesses the corresponding tab in the "Antenna Model" dialog, see Chapter 6.3.6, "SCME/WINNER Model Settings", on page 108.

Data Format
Selects the matrix representation format. The data format can be changed at every time. The matrix table is updated immediately.

"Magnitude-Phase" Displays the matrix values as value pairs of magnitude and phase.

"Real-Imag" Displays the matrix values as complex numbers.

Remote command:

n.a.

6.3.2 Correlation Matrix Table

The correlation matrix table displays the values for the transmitter/receiver correlation. The correlation matrix is valid for the selected fading path. To adjust the values, edit the matrix elements directly, use the correlation coefficients of the Kronecker Mode, define the TGn/TGac parameters of the AoA /AoD mode or use the SCME/WINNER mode.

To access the settings of the correlation matrix in table form:

1. Enable a MIMO configuration
2. Select the "Fading > Path Table > Matrix" and navigate to "Fading: Correlation Matrix > Matrix".
Defining the matrix values individually

In individual matrix mode, you have to define the matrix values manually. Irrespective of the selected data format, you have to enter valid correlation values.

Impossible calculation and conflict settings

The individual direct definition of the matrix elements may lead to impossible calculation due to inappropriate values and/or settings conflict. You have to change the corresponding values.

The Figure 6-7 uses a 2x2 MIMO matrix to depict the basic configuration principle.

To define the matrix, set the only the value pairs in the diagonal and upper triangle (a total of 10 value pairs in this example, see Figure 6-7). The instrument exploits the complex conjugate symmetry across the diagonal and determines automatically the remaining value pairs in the lower triangle.

By default, the values in the matrix diagonal are set to 1. Use values different than 1 to simulate antennas with different power level (steering).
Settings:

Real/Magnitude ................................................................. 102
Phase/Imag ................................................................. 102
Conflict ................................................................. 102
Accept ................................................................. 102

Real/Magnitude
Enters the value for the real/ratio part of the correlation.
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:MAGNitude on page 196

Phase/Imag
Enters the value for the phase/imaginary part of the correlation.
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:PHAse on page 195

Conflict
Indicates a matrix conflict.
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:CONFLICT? on page 195

Accept
Accepts the values for the phase/imaginary and the real/ratio part of the correlation.
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ACCEPT on page 194

6.3.3 Relative Gain Vector Matrix Settings

The "Fading: Relative Tap Gain Vector" dialog is available for static paths and paths with "Pure Doppler Fading Profile". This dialog provides additional parameters to simulate a gain weighting or phase shift between the signals with constant fading transmitted over the different Tx antennas.

Access:
1. Enable a MIMO configuration and select "Fading > Path Table > Profile > Static or Pure Doppler".
2. Select "Path Table > Coefficient > Vector".
Use this function to simulate beamforming signal.

Example:
This example illustrates the phase shift between the signals with a start phase of 45 degrees, power level of 2 dB, and the gain and phase settings as follow:

- "AA Gain > 0", "AA Phase > 0"
- "AB Gain > -1", "AB Phase > 10"
- "BA Gain > -2", "BA Phase > 20"
- "BB Gain > -3", "BB Phase > 350"

Resulting simulation:

```
Settings:
Set to Unity....................................................103
Gain,.........................................................104
Phase.......................................................104

Set to Unity
Presets the vector matrix to an unitary matrix.
```
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:PRESet on page 196

**Gain**
(disabled if customized dynamic fading R&S SMW-K820 is used)
Defines the relative gain of the selected path.
A gain value of 0 dB means no loss, and e.g. -3 dB is loss in this path.
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:GAIN on page 196

**Phase**
Defines the phase shift of the selected path.
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:PHASE on page 197

### 6.3.4 Kronecker Mode Correlation Coefficients

To access the settings of the correlation matrix in Kronecker mode, enable a MIMO configuration, select the "Fading > Path Table > Matrix" and select "Fading: Correlation Matrix > Matrix Mode > Kronecker".

![Correlation matrix in Kronecker mode](image)

**Figure 6-8: Correlation matrix in Kronecker mode**

**Calculating of the matrix values based on the Kronecker assumption**

In Kronecker mode, it is sufficient that you specify one Tx and one Rx correlation per MIMO channel. The instrument automatically computes the full correlation matrix according to the formula:
Multiple Input Multiple Output (MIMO)

$R_j = R_{TX}^{(l)} \otimes R_{RX}^{(l)}$, where $R_{TX}^{(l)} = \begin{bmatrix} 1 & \rho_{TX}^{(l)} \\ \rho_{TX}^{(l)*} & 1 \end{bmatrix}$ and $R_{RX}^{(l)} = \begin{bmatrix} 1 & \rho_{RX}^{(l)} \\ \rho_{RX}^{(l)*} & 1 \end{bmatrix}$

where $\rho_{RX}^{(l)}$ and $\rho_{TX}^{(l)}$ are the $R_x$ and $T_x$ correlations.

The evaluation of the Kronecker product $\otimes$ leads to:

$$R_l = \begin{bmatrix} 1 & \rho_{RX}^{(l)} & \rho_{TX}^{(l)} & \rho_{TX}^{(l)} \rho_{RX}^{(l)} \\ \rho_{RX}^{(l)*} & 1 & \rho_{TX}^{(l)*} & \rho_{TX}^{(l)} \rho_{RX}^{(l)*} \\ \rho_{TX}^{(l)*} & \rho_{TX}^{(l)*} & 1 & \rho_{TX}^{(l)} \rho_{RX}^{(l)*} \\ \rho_{TX}^{(l)*} \rho_{RX}^{(l)*} & \rho_{TX}^{(l)*} \rho_{RX}^{(l)*} & \rho_{TX}^{(l)} \rho_{RX}^{(l)*} & 1 \end{bmatrix}$$

Which and how many coefficients are available, depends on the selected MIMO configuration, e.g. any of the 2x2, 4x2, and 3x2 MIMO configurations, requires only one Rx correlation coefficient $AB$, whereas there are six Rx correlation coefficients in case of 2x4 MIMO configuration.

**Settings:**

**Tx Correlation Coefficients, Magnitude/Real...............................................................105**

**Tx Correlation Coefficients, Phase/Imag.....................................................................105**

**Rx Correlation Coefficients, Magnitude/Real..............................................................106**

**Rx Correlation Coefficients, Phase/Imag....................................................................106**

**Tx Correlation Coefficients, Magnitude/Real**

Enters the value for the real/ratio part of the transmitter correlation ($\rho_{TX}^{(l)}$).

The available Tx correlation coefficients depends on the selected MIMO mode.

Remote command:

For "Data Format > Magnitude-Phase"

$\text{[:SOURce<hw>:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:COLumn<st>:MAGNitude on page 194}$

For "Data Format > Real-Imag"

$\text{[:SOURce<hw>:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:COLumn<st>:REAL on page 194}$

**Tx Correlation Coefficients, Phase/Imag**

Enters the value for the phase/imaginary part of the transmitter correlation ($\rho_{TX}^{(l)}$).

The available Tx correlation coefficients depends on the selected MIMO mode.

Remote command:

For "Data Format > Ratio-Phase"

$\text{[:SOURce<hw>:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:COLumn<st>:PHASE on page 193}$
For "Data Format > Real-Imag"

Rx Correlation Coefficients, Magnitude/Real
Enters the value for the real/ratio part of the receiver correlation ($\rho_{\text{Rx}}^\text{Re}$).

The available Rx correlation coefficients depends on the selected MIMO mode.

Remote command:
For "Data Format > Magnitude-Phase"
For "Data Format > Real-Imag"

Rx Correlation Coefficients, Phase/Imag
Enters the value for the phase/imaginary part of receiver correlation ($\rho_{\text{Rx}}^\text{Im}$).

The available Rx correlation coefficients depends on the selected MIMO mode.

Remote command:
For "Data Format > Ratio-Phase"
For "Data Format > Real-Imag"

6.3.5 TGn/TGac Channel Models Settings

TGn and TGac channel models are specified for the evaluation of IEEE 802.11n and IEEE 802.11ac systems respectively.

These channel models are based on the so called rays, which are defined at the BS and MS side by their AoA (Angle of Arrival) and the AoD (Angle of Departure). The rays are distributed according to the selected statistic function and angle spread (AS).

In this implementation, one fading path consists by default of one ray but you can define up to six rays per path. The AoA (Angle of Arrival) / AoD (Angle of Departure) parameters, i.e. AoA/AoD angles, angle spreads (AS) and distribution of the rays, as well as the distances between the antennas at the Tx and the Rx side, are configurable.

To access the dialog with TGn/TGac settings
1. Enable a MIMO configuration, select the "Fading > Path Table > Matrix".
2. Select "Fading: Correlation Matrix > Matrix Mode > AoA/AoD".
Settings:

RX/TX Antenna Distance
Determines the distance between the Tx and Rx antennas as function of the wave length \( \lambda \) and is calculated as follow:

\[ \text{Physical Antenna Distance} = \frac{\text{RX/TX Antenna Distance} \times \lambda}{100} \]

where \( \lambda \) is the wavelength in meters and \( \text{Frequency} \) is in Hz. The speed of light \( c \) is used in the formula.

Remote command:

[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX on page 198
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX on page 198

Ray State
Enables/disables the selected ray.

Remote command:

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:STATe on page 200

Relative Gain /dB
Sets the relative gain (in dB) of the selected ray.

Remote command:

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:GAIN on page 199
Angle of Arrival (AoA)
Sets the AoA (Angle of Arrival) of the selected ray.
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:ANGLE on page 199

AoA Spread
Sets the AoA (Angle of Arrival) spread (AS) of the selected ray.
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:SPRead on page 199

Angle of Departure (AoD)
Sets the AoD (Angle of Departure) of the selected ray.
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:ANGLE on page 199

AoD Spread
Sets the AoD (Angle of Departure) spread (AS) of the selected ray.
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:SPRead on page 199

Distribution
Select one of the proposed statistical functions to determine the distribution of the selected ray.
Tip: Use this parameter to simulate ray scattering due to obstacles with different surface (see also Chapter 7.7, "TGn Settings", on page 197).
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:DISTribution on page 198

6.3.6 SCME/WINNER Model Settings
Option: R&S SMW-K72/-K73
The SCME and WINNER II channel models are developed by WINNER [1]. The original model is the SCM (Spatial Channel Model) and the SCME (SCM Extension) is its first extension. The WINNER II is the final published model.
The SCME and WINNER II channel models offer Cluster Delay Line (CDL) models for reduced complexity simulations. These CDL models can be simulated in the SCME/WINNER matrix mode. A channel correlation matrix is calculated from the CDL parameters and the channel is stochastically simulated.
This section describes the settings of the SCME/WINNER model. For information on the antenna modeling and polarization, see:
• Chapter 6.3.8, "MIMO OTA Testing Related Settings", on page 123.
See also Chapter A.16, "SCM and SCME Channel Models for MIMO OTA", on page 296.

Access:

1. Enable a MIMO configuration.  
   See "To enable a MIMO scenario" on page 92.

2. Select "Fading > Path Table > Matrix"

3. In the required "Tap", select "Fading: Correlation Matrix > Matrix Mode > SCME / WINNER"

With the provided settings, you can define up to 20 clusters, each of which comprising of up to 3 subclusters. A cluster is defined with its AoA (Angle of Arrival) / AoD (Angle of Departure) parameters. These are the AoA/AoD angles, angle spreads (AS) and a relative gain. If a subcluster is enabled, it is also attenuated. The three subclusters powers are fixed ratios of the total cluster power (see Subcluster > Relative Gain /dB)

Different Power Azimuth Spectrum (PAS) distributions can be used to describe the distribution of the selected cluster. However, usually the clusters simulated in one path have the same distribution.

Settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS Speed</td>
<td>110</td>
</tr>
<tr>
<td>MS DoT (Direction of Travel)</td>
<td>110</td>
</tr>
<tr>
<td>Cluster State</td>
<td>110</td>
</tr>
<tr>
<td>Relative Gain /dB</td>
<td>110</td>
</tr>
<tr>
<td>Subcluster &gt; State</td>
<td>110</td>
</tr>
<tr>
<td>Subcluster &gt; Relative Gain /dB</td>
<td>110</td>
</tr>
</tbody>
</table>
Angle of Departure (AoD)............................................................................................ 111
AoD Spread.................................................................................................................. 111
Angle of Arrival (AoA).............................................................................................. 111
AoA Spread.................................................................................................................. 111
Distribution.................................................................................................................. 111

**MS Speed**
Sets the speed of the mobile station.
This value determines the value of the parameter "Speed" (see Path Table > Speed).
Remote command:
\[ [:SOURce<hw>:FSIMulator:MIMO:SCWI:TAP<st>:SPEed \]
on page 203

**MS DoT (Direction of Travel)**
Sets the direction of travel of the mobile station.
If LOS (line-of-sight) is simulated, then this parameter sets the value of the parameter
Frequency Ratio for the Rice fading profile.
Remote command:
\[ [:SOURce<hw>:FSIMulator:MIMO:SCWI:TAP<st>:DOT \]
on page 203

**Cluster State**
Enables/disables the selected cluster.
Remote command:
\[ [:SOURce<hw>:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:STATe \]
on page 203

**Relative Gain /dB**
Sets the relative gain (in dB) of the selected cluster.
Remote command:
\[ [:SOURce<hw>:FSIMulator:MIMO:SCWI:CLUSter<ch>:GAIN \]
on page 203

**Subcluster > State**
If the corresponding cluster is enabled, you can enable up to 3 subclusters.
A cluster is composed of 20 spatially separated subpaths with equal powers. The subpaths are occasionally split to subsets or subclusters (also known as mid-paths) having different resolvable delays. In the SCME and WINNER II models, one cluster can be split into 3 subclusters. Each subcluster consists of 10, 6 and 4 subpaths. Hence, the subcluster power is 10/20, 6/20 and 4/20 relative power to the total cluster power.
See also "Relative Gain /dB" on page 110.
Remote command:
\[ [:SOURce<hw>:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:SUBCluster<di>:STATe \]
on page 205

**Subcluster > Relative Gain /dB**
Displays the resulting relative attenuation, applied on an enabled subcluster. The value is determined based on the select "Relative Gain" of the cluster and is calculated as follows:
RelativeGain\textsubscript{Sub-Cluster} = RelativeGain\textsubscript{Cluster} + GainFactor

The used gain factors are values in dB and are listed in Table 6-1.

The values are part of the SCME Urban Micro-Cell (SCME UMi) and SCME Urban Macro-Cell (SCME UMa) models according to TR 37.977.

<table>
<thead>
<tr>
<th>Sub-Cluster number</th>
<th>Gain Factor, W</th>
<th>Gain Factor, dB</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10/20</td>
<td>-3.01</td>
</tr>
<tr>
<td>2</td>
<td>6/20</td>
<td>-5.229</td>
</tr>
<tr>
<td>3</td>
<td>4/20</td>
<td>-6.99</td>
</tr>
</tbody>
</table>

Remote command:
```
```

**Angle of Departure (AoD)**

Sets the AoD (Angle of Departure) of the selected cluster.

Remote command:
```
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:ANGLe on page 204
```

**AoD Spread**

Sets the AoD (Angle of Departure) spread (AS) of the selected cluster.

Remote command:
```
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:SPRead on page 204
```

**Angle of Arrival (AoA)**

Sets the AoA (Angle of Arrival) of the selected cluster.

Remote command:
```
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:ANGLe on page 204
```

**AoA Spread**

Sets the AoA (Angle of Arrival) spread (AS) of the selected cluster.

Remote command:
```
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:SPRead on page 204
```

**Distribution**

To set the distribution of the selected cluster, select one of the power azimuth spectrum (PAS) distributions. All clusters of the same tap must have the same distribution.

Tip: Use this parameter to simulate rays scattered due to obstacles with different surface (see also Chapter 7.7, "TGn Settings", on page 197).
Remote command:
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DISTribution

6.3.7 SCM Fading Profile

Option: R&S SMW-K73

The spatial channel model (SCM) is a geometry-based channel model specified in the 3GPP TR 25.996.

In the SCM fading profile, the channel coefficients are not calculated from a MIMO correlation matrix but given by an equation. This equation depends on geometrical parameters, like the angle of arrival and departure, and angular spread and their statistical behavior. The illustration on Figure 6-9 outlines the main SCM parameters. For detailed description of the SCM model, see TR 25.996.

![Figure 6-9: SCM angular parameters (simplified representation)](image)

BS = Base station antenna array
MS = Mobile station antenna array
N = North: absolute reference direction used to define the antenna orientation (array broadside)
DoT = Direction of travel of the mobile station
LOS = Line-of-sight
AoD = Angle of departure
AoA = Angle of arrival
Cluster = Group of 20 spatially separated subpaths with equal powers; one cluster can be split into three subclusters, where the subclusters consist of 10, 6 and 4 subpaths.

Access:

1. Enable a MIMO configuration.
   See "To enable a MIMO scenario" on page 92.

2. Select "Fading > Path Table > Path# > Profile > SCM".
3. Select “SCM Profile > SCM Data”.

The provided parameters are similar to the parameters in SCME/WINNER matrix mode, like the angle, channel polarization and antenna modeling settings provided for MIMO-OTA testing. You can configure one SCM cluster per fading path but the channel and antenna parameters are common for all paths.

For background information on the antenna modeling and channel polarization, see:
- "Antenna Modeling" on page 124
- "Channel polarization" on page 126

- SCM Cluster Settings........................................................................................................... 113
- 3D Channel Model.................................................................................................................. 115
- Channel Polarization Settings................................................................................................ 115
- Antenna Modeling Settings................................................................................................... 117
- LOS Component Settings...................................................................................................... 120
- Subpath Start Phases............................................................................................................. 121

6.3.7.1 SCM Cluster Settings

MS Speed.................................................................................................................................. 114
MS DoT (Direction of Travel).................................................................................................... 114
\( \sigma \)....................................................................................................................................... 114
Relative Gain /dB....................................................................................................................... 114
Subcluster > State..................................................................................................................... 114
Subcluster > Relative Gain /dB.................................................................................................. 114
Angle of Departure (AoD)......................................................................................................... 115
AoD Spread................................................................................................................................ 115
Angle of Arrival (AoA).................................................................................................. 115
AoA Spread.................................................................................................................. 115
Distribution.................................................................................................................115

**MS Speed**
Sets the speed of the mobile station.
This value determines the value of the parameter "Speed" (see "Path Table" > Speed).
Remote command:
[:SOURce<hw>]:FSIMulator:SCM:SPEed on page 218

**MS DoT (Direction of Travel)**
Sets the direction of travel of the mobile station, see Figure 6-9.
Remote command:
[:SOURce<hw>]:FSIMulator:SCM:DOT on page 219

$\sigma_{SF}$
Sets the lognormal shadow fading standard deviation, applied as a common parameter to the paths.
Remote command:
[:SOURce<hw>]:FSIMulator:SCM:SIGMa on page 219

**Relative Gain /dB**
Sets the relative gain (in dB) of the selected cluster.
Remote command:
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:GAIN on page 220

**Subcluster > State**
Enables up to 3 subclusters.
A cluster is composed of 20 spatially separated subpaths with equal powers. The subpaths are occasionally split to subsets or subclusters (also known as mid-paths) having different resolvable delays. In the SCM model, one cluster can be split into 3 subclusters, where the subclusters consist of 10, 6 and 4 subpaths. Hence, the subcluster power is 10/20, 6/20 and 4/20 relative power to the total cluster power.
See also "Subcluster > Relative Gain /dB" on page 114.
Remote command:
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:STATe on page 220

**Subcluster > Relative Gain /dB**
Displays the resulting relative attenuation, applied on an enabled subcluster. The value is determined based on the select "Relative Gain" of the cluster and is calculated as follows:

$\text{RelativeGain}_{\text{Sub-Cluster}} = \text{RelativeGain}_{\text{Cluster}} + \text{GainFactor}$

The used gain factors are values in dB and are listed in "Subcluster > Relative Gain /dB" on page 114.
Table 6-2: Overview: Gain factors and default relative gain values per subcluster

<table>
<thead>
<tr>
<th>Sub-Cluster number</th>
<th>Gain factor, W</th>
<th>Subpath number</th>
<th>Gain factor, dB</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10/20</td>
<td>1, 2, 3, 4, 5, 6, 7, 8, 19, 20</td>
<td>-3.01</td>
</tr>
<tr>
<td>2</td>
<td>6/20</td>
<td>9, 10, 11, 12, 17, 18</td>
<td>-5.229</td>
</tr>
<tr>
<td>3</td>
<td>4/20</td>
<td>13, 14, 15, 16</td>
<td>-6.99</td>
</tr>
</tbody>
</table>

Remote command:
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:GAIN on page 220

Angle of Departure (AoD)
Sets the AoD (angle of departure) of the cluster.
Remote command:
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ANGLe on page 219

AoD Spread
Sets the AoD (angle of departure) spread (AS) of the cluster.
Remote command:
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:SPRead on page 220

Angle of Arrival (AoA)
Sets the AoA (angle of arrival) of the cluster.
Remote command:
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ANGLe on page 219

AoA Spread
Sets the AoA (angle of arrival) spread (AS) of the cluster.
Remote command:
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:SPRead on page 220

Distribution
Displays the distribution of the cluster.

6.3.7.2 3D Channel Model
Reserved for future use.

6.3.7.3 Channel Polarization Settings

Access:
1. Enable a MIMO configuration.
   See "To enable a MIMO scenario" on page 92.
2. Select "Fading > Path Table > Path# > Profile > SCM".
3. Select "SCM Profile > SCM Data"
4. Select "Polarization".
5. Select "Channel Polarization > On".
6. Set the XPR (cross polarization power ratios) values.

![Antenna Model A](image)

### Settings:

**Note:** In multi-entity configurations, like for example 2x4x4 or 4x2x2, the settings in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" **apply to all entities.**

- **Channel Polarization State**
- **Vertical/Horizontal Cross Polarization Power Ratio**

#### Channel Polarization State
Enables/disables simulation of channel polarization.

Remote command:

```
[:SOURce<hw>]:FSIMulator:SCM:POLarization:STATe
```

#### Vertical/Horizontal Cross Polarization Power Ratio
Sets the cross polarization power ratio (XPR) in dB.

\[
XPR_v = \frac{P}{P_{vhv}} \text{ and } XPR_h = \frac{P}{P_{hvh}}, \text{ where } XPR_v = XPR_h = XPR.
\]

Remote command:

```
[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:HORizontal
```
```
[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:VERTical
```
6.3.7.4 Antenna Modeling Settings

Access:

1. Enable a MIMO configuration.
   See "To enable a MIMO scenario" on page 92.
2. Select "Fading > Path Table > Path# > Profile > SCM".
3. Select "SCM Profile > SCM Data"
4. Select "Antenna Modeling".
5. Configure the base station (BS) antenna settings, for example:
   - "Tx Antenn Array Structure > Calculation Mode > Spacing", if the spacing (i.e. the physical distance) between the antenna elements is a known value.
   - "Horizontal Spacing = 0.5*λ"
     For mobile devices, however, the measured characteristics are the antenna radiation pattern, gain and relative phase.
     To use the relative phase instead of the antenna spacing, provide the relative phase information in the antenna pattern file. When this file is loaded, the relative phase information is extracted from it and used in the calculations. See also Figure 6-14.

   a) To load custom antenna pattern for the transmit or the receive antenna:
      - "Select Antenna Pattern > User Defined".
      - For each antenna element, navigate to the antenna pattern file and load it.

The selected 2D antenna pattern file describes the BS and MS antenna gains of each array element.
A figure displays the structure of the current antenna array. The number of columns and rows in the array are set automatically, depending on the selected MIMO configuration.

Settings:

**Number of Rows (M)/Columns (N)**
Sets the number of rows (M) and the number of columns (N) in the antenna array, see "Antenna Modeling" on page 124.

The number of Tx and Rx antennas is set automatically according to the selected MxN MIMO configuration ("System Configuration > LxMxN").

See section "Signal Routing and System Configuration" in the R&S SMW user manual.

Remote command:

- `[:SOURce]:FSIMulator:SCM:ANTenna:RX:COLumns[:SIZE]` on page 222
- `[:SOURce]:FSIMulator:SCM:ANTenna:RX:ROWS[:SIZE]` on page 222
- `[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:COLumns[:SIZE]` on page 222
- `[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ROWS[:SIZE]` on page 222

**Calculation Mode**
Selects whether the phase information is calculated from the spacing between the antenna elements or it is retrieved from the antenna pattern file.

See Figure 6-14.

- "Spacing" The spacing (i.e. the physical distance) between the antenna elements is set with the parameter Horizontal Spacing.

- "Relative Phase" If the loaded antenna pattern file contains the required information, the relative phase is extracted from the antenna pattern file.

  See:
  - "Antenna element spacing or relative phase" on page 125

Remote command:

- `[:SOURce]:FSIMulator:SCM:ANTenna:RX:CALC:MODE` on page 222
- `[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:CALC:MODE` on page 222

**Horizontal Spacing**
For "Calculation Mode > Spacing", sets the distance (d_h) between the antennas in the antenna array normalized by the wavelength λ.

It is calculated as follows:

\[ d_h = \text{"Horizontal Spacing"} \times \lambda \]
Multiple Input Multiple Output (MIMO)

Where:
- $\lambda$ is the wavelength calculated as $\lambda = \frac{c}{\text{Frequency}}$
- $c$ is the speed of light
- "Frequency" is the center frequency.

See also "Antenna element spacing or relative phase" on page 125.

Remote command:
```
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ESPacing:HORizontal
```
on page 223
```
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ESPacing:HORizontal
```
on page 223

Antenna array
Graphical representation of the current antenna array.
Each dot indicates a single antenna element.
The spacing between the antenna elements is indicated, if "Calculation Mode > Spacing" is used.

Antenna Pattern
Antenna patterns are files that describe the 2D antenna radiation pattern.
The following predefined antenna patterns are available:
- "Isotropic"
- "Dipole"
- "3 Sectors" and "6 Sectors"
  These two sector antenna patterns are required for the BS testing, as specified in the TR 25.996.

You can also load custom antenna pattern, see "User Defined Antenna Patterns per Row, Column" on page 119.

Remote command:
```
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:PATTern
```
on page 223
```
[:SOURce]:FSIMulator:SCM:ANTenna:RX:PATTern
```
on page 223

User Defined Antenna Patterns per Row, Column
Indicates the custom antenna pattern file per antenna element.
To change the used file for an antenna element:
- Select a predefined or "User File"
- Navigate to the antenna pattern file and load it.

Antenna pattern files are XML files with file predefined file syntax and extension *.ant_pat.
They describe the antenna pattern as an array with typical resolutions of 1 degree to 5 degrees for the azimuth. These files contain the gain values for a given azimuth. For an isotropic antenna radiating energy equally in all directions, the array elements are all 0 dB.

Remote command:
```
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ANTenna<di>:PFILe
```
on page 223
```
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ANTenna<di>:PFILe
```
on page 223
6.3.7.5 LOS Component Settings

Access:

1. Enable a MIMO configuration.
   See "To enable a MIMO scenario" on page 92.

2. Select "Fading > Path Table > Path# > Profile > SCM".

3. Select "SCM Profile > SCM Data"

4. Select "LOS Component".

The LOS modeling is based on the ricean K factor. It is defined as the ratio of power in the LOS component to the total power in the diffused non line-of-sight (NLOS) component.

Settings:

- **Use LOS Component**: Adds a line-of-sight (LOS) component to the cluster.
  The LOS component is supported only in the first fading path.
  To activate the LOS component:
  - Set "Path Table > Fading Path#1 > State > On" and set "Profile > SCM".
  - Set "SCM Data > LOS Component Settings > Use LOS Component > On".
Remote command:
[[:SOURce<hw>]:FSIMulator:SCM:LOS:STATe on page 224

**LOS Angle of Departure (AoD)**
Sets the AoD (angle of departure) of the LOS component.
Remote command:
[[:SOURce<hw>]:FSIMulator:SCM:LOS:DEParture[:ANGLE] on page 224

**LOS Angle of Arrival (AoA)**
Sets the AoA (angle of arrival) of the LOS component.
Remote command:
[[:SOURce<hw>]:FSIMulator:SCM:LOS:ARRival[:ANGLE] on page 224

**K Factor**
Sets the ricean K factor.
The K factor is defined as the ratio of power in the LOS component to the total power in the diffused non line-of-sight (NLOS) component.
Remote command:
[[:SOURce<hw>]:FSIMulator:SCM:LOS:KFACtor on page 224

**Use Random Phases**
If enabled, random subpath start phases are selected.
Remote command:
[[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:STATe on page 224

**LOS Start Phases**
Sets the start phase in degree of the LOS signal per MIMO channel.
Remote command:
[[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:VV on page 225
[[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:HH on page 225
[[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:VH on page 225
[[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:HV on page 225

### 6.3.7.6 Subpath Start Phases

**Access:**
1. Enable a MIMO configuration.
   See "To enable a MIMO scenario" on page 92.
2. Select "Fading > Path Table > Path# > Profile > SCM".
3. Select "SCM Profile > SCM Data"
4. Select "Subpath Start Phases".
Fading Settings in MIMO Configuration

**Use Random Phases**
If enabled, random start phases are selected.
Remote command:

```
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath:STATe on page 221
```

**Subpath # > VV/HH/VH/HV Phase**
Sets the phase per subpath.
A total number of 20 subpaths are supported.
Remote command:

```
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:HH on page 225
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:HV on page 225
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:VH on page 225
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:VV on page 225
```
6.3.8 MIMO OTA Testing Related Settings

The MIMO OTA testing is a term describing radiated testing of mobile devices. The signal is transmitted over-the-air (OTA) to a mobile device placed in an anechoic chamber. The mobile devices are tests in a real-world like conditions.

This section introduces the main concept of the two-stage method. You find the complete description of this method in the TR 37.977 specification.

About the MIMO OTA two stage method

According to TR 37.977, the method consists of two stages:

- Acquiring the complex antenna radiation pattern of the DUT

![Figure 6-10: MIMO OTA testing: stage 1 [TR 37.977]]

1 = Base station (BS) emulator
2 = Test chamber
3 = Reference antenna
4 = MIMO DUT (mobile device)
5 = Anechoic material
6 = Measurement result: antenna radiation pattern

The measurement is performed in an over-the-air (OTA) test setup. The DUT is placed in an anechoic chamber.

The antenna radiation pattern is measured of each antenna element.

- Convolving the antenna pattern with the channel model

The measured antenna pattern is loaded into the MIMO channel emulator. The DUT performance is measured with throughput tests.

![Figure 6-11: MIMO OTA testing: stage 2 (conducted setup)]

1 = BS emulator
2 = Channel emulator
3 = DUT with standard antenna ports (as for conducted conformance tests)
4 = Connection between the BS and the channel emulator ([DIG I/Q] interface)
The measurements in this second stage can be performed in a conducted or in a radiated (OTA) setup. The radiated tests assure that the self-interference effects between the antenna elements of the DUT are also considered.

The test setup consists of a BS emulator, a channel emulator, a DUT placed in an anechoic or a reverberation chamber and a reference antenna. In the examples on Figure 6-10, Figure 6-11 and Figure 6-12, the R&S®CMW acts as BS emulator and the R&S SMW as a channel simulator. Approved RF cables are used for all connections.

In the two-stage method, the R&S SMW takes over the convolving of the antenna pattern with standard compliant channel model (SCME UMi and UMa). If the channel matrix \( H \) of the chamber is known, the R&S SMW can apply the inverse channel matrix \( H^{-1} \). The signal received at the DUT antennas is thus the same as in the cable-conducted method.

**Antenna Modeling**

The antenna modeling includes the definition of the:

- Antenna array structure  
  (see "Antenna array" on page 125)
- Antenna polarization  
  (see "Antenna polarization" on page 125)
- Antenna radiation pattern
Antenna array

The antenna model is based on a 2D planar antenna array structure. The antenna elements are placed in the vertical and horizontal direction in an array composed of N columns and M rows (see Figure 6-13). The antenna elements are uniformly spaced. The horizontal and vertical spacings between the antenna columns are \(d_h\lambda\) and \(d_v\lambda\). The spacing between the antenna pairs of cross-polarized antennas is denoted as cross polarized antenna spacing \(d_{xp}\lambda\).

In the current firmware version, the antenna elements are placed on a single row and vertical spacing is not supported.

Figure 6-13: 2D planar antenna array structure where each column is a cross-polarized 45° antenna with \(d_{xp}= 0^\circ\lambda\)

The user interface illustrates the selected antenna array similarly.

Antenna element spacing or relative phase

If the spacing between the antenna elements is unknown, the antenna relative phase can be used instead (see Figure 6-14). Which information is used is defined with the parameter Calculation Mode.

If Calculation Mode > "Relative Phase", the following applies:
- If all selected antenna pattern files contain the relative phase information, it is extracted from there. (see Chapter B, "Antenna Pattern File Format", on page 329)
- If one of the selected antenna pattern files contain relative phase information, this information is used. The relative phase values in all other selected antenna pattern files are assumed to be zero.
- If none of the selected antenna pattern files contain relative phase information, the following settings apply: "Spacing = 0.5λ".

Antenna polarization

The polarization of an antenna describes the orientation of the electric wave radiated by the antenna.

According to TR 25.996, using antenna polarization requires that the antenna complex response for both vertical and horizontal components is known.
Provide the antenna polarization information in one of the following ways:

- **Described in the antenna pattern file** and extracted from there
  
  To use this way:
  - Create and load an antenna pattern file containing both the horizontal and vertical polarization antenna radiation patterns (see Chapter B, "Antenna Pattern File Format", on page 329).
  - Activate channel polarization Channel Polarization State > "On".
  - Select Antenna Polarization Mode > "Separate AP".

- **Selected with the parameter "Antenna Polarization Slant Angle"**
  
  To use this way:
  - Load an antenna pattern file containing only one antenna pattern.
  - Activate channel polarization Channel Polarization State > "On".
  - Select Antenna Polarization Mode > "Single AP with Slant Angle".
  - Set the parameter "Antenna Polarization Slant Angle".

Available polarization angles are:

- Horizontal polarization
- Vertical polarization
- Cross-polarization 90°
- Cross-polarization 45°

**Channel polarization**

The channel correlation polarization matrix is computed from the antenna element polarization angles and the XPR (cross polarization power ratio of a propagation channel) values.

See:

- "Antenna polarization" on page 125
- "Vertical/Horizontal Cross Polarization Power Ratio" on page 129.

**Channel correlation matrix**

The total channel correlation matrix $R$ is the result of the element-wise product of the polarization correlation matrix $R_P$ and the spatial correlation matrix $R_S$:

$$R = R_P \cdot R_S.$$

In the following, we assume that:

- The elements of the channel polarization matrix are uncorrelated
- The transmitter and the receiver ends are uncorrelated

The polarization and spatial correlation matrices, $R_P$ and $R_S$ are calculated as follows:

- **Spatial correlation matrix $R_S$**
  
  The spatial correlation matrix depends on the spatial characteristics of the channel:
  - Antenna radiation patterns at the transmitter and the receiver ends
  - Antenna spacing
The correlation between antenna array elements \( n \) and \( m \) is calculated according to the Schumacher model [2].

\[
\rho_{n,m} = \frac{\int_{-\pi}^{\pi} e^{-j2\pi \frac{d}{\lambda} \sin \Theta} P_{\text{AS}}(\Theta) \sqrt{G_n(\Theta) G_m(\Theta)} d\Theta}{\sqrt{\int_{-\pi}^{\pi} P_{\text{AS}}(\Theta) G_n(\Theta) d\Theta} \sqrt{\int_{-\pi}^{\pi} P_{\text{AS}}(\Theta) G_m(\Theta) d\Theta}}
\]

**Figure 6-14: Schumacher model for calculation the correlation between antenna array elements** [2]

- \( \rho_{n,m} \) = Correlation between antenna array elements
- \( m, n \) = Antenna array elements
- \( d \) = Antenna spacing between the two antenna elements
- \( \lambda \) = Wavelength of the signal
- \( P_{\text{AS}}(\Theta) \) = Power azimuth spectrum of the impinging signal
- \( G_n(\Theta), G_m(\Theta) \) = Antenna radiation patterns, characterized by a power gain, for antenna elements \( n \) and \( m \)

**Note:** The magnitude \( e^{j2\pi \frac{d}{\lambda} \sin \Theta} \) is also the relative phase resulting from the spacing \( d \) and the angle \( \Theta \). For a known relative phase \( \varphi \), the magnitude is calculated as \( e^{j\varphi} \).

If the transmitter and the receiver ends are uncorrelated, then the total spatial channel correlation matrix is the Kroneker product of the two correlation matrices.

\[
R_S = R_{R_x} \otimes R_{T_x}
\]

- **Polarization correlation matrix** \( R_P \)

Three matrices describe the polarization of the system: channel polarization \( S \), the transmitter and the receiver antenna array polarizations \( P_{T_x} \) and \( P_{R_x} \).

**Related settings**

See:

- Chapter 6.3.8.2, "Antenna Model Settings", on page 130
- Chapter 6.3.8.1, "Channel Polarization Settings", on page 127
- Chapter 6.3.9, "Inverse Channel Matrix", on page 137

See also:

- Chapter B, "Antenna Pattern File Format", on page 329
- Chapter 6.3.6, "SCME/WINNER Model Settings", on page 108
- Chapter A.16, "SCM and SCME Channel Models for MIMO OTA", on page 296

**6.3.8.1 Channel Polarization Settings**

**Access:**

1. Enable a MIMO configuration, e.g. a 2x2 MIMO scenario.
   
   See "To enable a MIMO scenario" on page 92.
2. Select "Fading > Path Table > Matrix"

3. In the required "Tap", select "Fading: Correlation Matrix > Matrix Mode > SCME / WINNER"

4. Select "Fading: Correlation Matrix > Polarization".

5. Select "Channel Polarization > On".

6. Set the XPR (cross polarization power ratios) values.

   **Note:** In multi-entity configurations, like for example 2x4x4 or 4x2x2, the settings in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all entities.

7. Set the parameter "Antenna Polarization Mode", depending on the information in the used antenna pattern files.

   For example, if your files contain both vertical and horizontal gain information, select "Antenna Polarization Mode > Separate AP".

8. Load the antenna pattern files.

   See "User Defined Antenna Patterns per Row, Column" on page 136.

   The calculated channel polarization matrix is displayed.

   See also:
   - Chapter B, "Antenna Pattern File Format", on page 329
   - "Channel correlation matrix" on page 126
Settings:

Channel Polarization State........................................................................................................129
Antenna Polarization Mode......................................................................................................129
Vertical/Horizontal Cross Polarization Power Ratio...................................................................129
S........................................................................................................................................130

Channel Polarization State
Enables/disables simulation of channel polarization.
Remote command:
[:SOURce<hw>:FSIMulator:MIMO:ANTenna:MODeling[:STATe] on page 206

Antenna Polarization Mode
Sets way the software extracts or calculates the antenna polarization patterns.
"Single AP with Slant Angle"
The antenna pattern file contains one antenna radiation pattern.
The antenna polarization is calculated from the provided antenna pattern and the polarization angle, as selected with the parameter
Antenna Polarization Slant Angle.
See also "Antenna polarization" on page 125.

" Separate AP"
Option: R&S SMW-K73
The antenna pattern file has to describe two antenna radiation patterns, one for each polarization (see Chapter B, "Antenna Pattern File Format", on page 329).
The correlation between any two channels for the same path is calculated as follows [3]:

\[
E\{h_{pm}(t)h_{qn}^{*}(t)\} = \sqrt{P_{pm}P_{qn}} \left( \gamma_{mn}^{\text{Tx}} \gamma_{pq}^{\text{Rx}} + \frac{1}{XPD} \gamma_{mn}^{\text{Tx}} \gamma_{pq}^{\text{Rx}} \right)
\]

Figure 6-15: Calculation of the correlation between channels [3]
P_{pm}, P_{qn} = Powers transferred through the subchannels (Tx_m - Rx_m) and (Tx_n - Rx_n);
in this implementation, P_{pm} = P_{qn} = 1
\gamma_{mn}^{\text{Tx}}, \gamma_{pq}^{\text{Rx}} = Correlation coefficient between antenna elements in the transmitter and receiver array; values per polarization
Tx, Rx = Transmitter and receiver array
v, h = Vertical and horizontal polarization
m, n, p, q = Antenna elements in the transmitter/receiver array

Remote command:
[:SOURce<hw>:FSIMulator:MIMO:ANTenna:PATTern:MODE on page 206

Vertical/Horizontal Cross Polarization Power Ratio
Sets the cross polarization power ratio (XPR) in dB.
XPR_v = P/P_{vvhv} and XPR_h = P/P_{hhvh}, where XPR_v = XPR_h = XPR.
The resulting channel polarization matrix S is displayed.
Remote command:
[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:HORizontal
on page 206
[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical
on page 206

\( S \)
Displays the resulting channel polarization matrix \( S \) calculated as:

\[
S = \begin{bmatrix}
S_{vv} & S_{vh} \\
S_{hv} & S_{hh}
\end{bmatrix}
\]

Where:
- \( S_{vv} = S_{hh} = 1 \)
- \( S_{vh} \) and \( S_{hv} \) are commonly designated as \( S_{xy} \) and are calculated from the equation

\[
E(S_{xy}^2) = P_{xy}
\]

where:
- \( E \) is the expectation, i.e. the mean power per polarization component
- \( P_{xy} \) values are derived from the selected Vertical/Horizontal Cross Polarization Power Ratio XPR.
- It is assumed that the elements of the channel polarization matrix are uncorrelated, i.e.:

\[
E(S_{ij}S_{lk}^*) = 0 \quad \text{for } i \neq j, \ k \neq l
\]

6.3.8.2 Antenna Model Settings

Access:

1. Enable a MIMO configuration, e.g. a 2x2 MIMO scenario.
   See "To enable a MIMO scenario" on page 92.
2. Select "Fading > Path Table > Matrix"
3. In the required "Tap", select "Fading: Correlation Matrix > Matrix Mode > SCME / WINNER"
4. Select "Fading: Correlation Matrix > Antenna Modeling".
5. Configure the base station (BS) antenna settings, for example:
   - "Antenna Polarization Slant Angle > Cross 45°"
   - "Calculation Mode > Spacing", if the spacing (i.e. the physical distance) between the antenna elements is a known value.
   - "Horizontal Spacing = 4*\( \lambda \)"
   - "Antenna Pattern > 3Sector"
A figure displays the structure of the current antenna array. The number of columns and rows in the array are set automatically, depending on the selected MIMO configuration.

6. To configure the mobile station (MS) antenna settings, select "Rx Antenna Array Structure".

Note: In multi-entity configurations, like for example 2x4x4 or 4x2x2, the settings in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all entities.
Sometimes, it is difficult to determine the antenna spacing of the mobile device; instead the relative phase is measured.

To use the relative phase instead of the antenna spacing, provide the relative phase information in the antenna pattern file. When this file is loaded, the relative phase information is extracted from it and used in the calculations.

See also Figure 6-14.

7. To load custom antenna pattern for the transmit or the receive antenna:

- "Select Antenna Pattern > User File".
- For each antenna element, navigate to the antenna pattern file and load it.

The selected 2D antenna pattern file describes the BS and MS antenna gains of each array element.

Depending on its format, the antenna pattern file contains the following information:

- Antenna gain information only
- Antenna gain and phase information
- Horizontal and vertical gain information
- Horizontal and vertical gain and phase information.

See also:

- Chapter B, "Antenna Pattern File Format", on page 329
- "Antenna Modeling" on page 124.
- "Channel correlation matrix" on page 126
Settings:

- **Antenna Polarization Slant Angle**
- **Number of Rows (M)/Columns (N)**
- **Calculation Mode**
- **Horizontal Spacing**
- **Cross-Polarized Antenna Spacing**
- **Antenna Array**
- **Antenna Pattern**
- **User Defined Antenna Patterns per Row, Column**

### Antenna Polarization Slant Angle

The information on the antenna polarization at the Tx and Rx ends is required to calculate the channel polarization.

**Note:** In multi-entity configurations, like for example 2x4x4 or 4x2x2, the settings in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all entities.

If channel polarization is activated (Channel Polarization State > "On"), specify the antenna polarization in one of the following ways:

- Described in the [antenna pattern file](#) and extracted from there. One antenna radiation pattern for each polarization if necessary. (The parameter "Antenna Polarization Slant Angle" is not necessary and not available.)
- Selected with the parameter "Antenna Polarization Slant Angle"

For information on the prerequisites and how to use these two ways, see "Antenna polarization" on page 125.

The following polarizations are available:

- Horizontal polarization
- Vertical polarization
- Cross-polarization 90°
- Cross-polarization 45°

A graph displays the structure of the current antenna array.

See also:

- Chapter A.16, "SCM and SCME Channel Models for MIMO OTA", on page 296

Remote command:

```plaintext
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLe
```

on page 206

```plaintext
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:POLarization:ANGLe
```

on page 206

### Number of Rows (M)/Columns (N)

Sets the number of rows (M) and the number of columns (N) in the antenna array, see "Antenna Modeling" on page 124.

**Note:** In this firmware version, only one-dimensional arrays are supported. The antenna elements are placed in one row and only the horizontal spacing is considered.

The number of Tx and Rx antennas is set automatically according to the selected MxN MIMO configuration ("System Configuration > LxMxN").
See section "Signal Routing and System Configuration" in the R&S SMW user manual.

**Note:** In multi-entity configurations, like for example 2x4x4 or 4x2x2, the settings in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all entities.

**Example:**

In an 1x4x2 MIMO configuration, there are 4 Tx and 2 Rx antennas.

The "Tx Antenna Array" consists of 4 antennas:
- if "Antenna Polarization Slant Angle > Horizontal/Vertical", these 4 antennas are placed in a row (4x1 array)
- if "Antenna Polarization Slant Angle > Cross-Polarization 45°/90°", there are exact 2 columns and 1 row.

The "Rx Antenna Array" contains exact 2 antennas, that can be distributed in one the following ways:
- if "Antenna Polarization Slant Angle > Horizontal/Vertical", in 2 columns and 1 row (2x1 array)
- if "Antenna Polarization Slant Angle > Cross-Polarization 45°/90°", there is exact 1 column and 1 row

In both arrays, a spacing \(d_x\) can also exist between the cross polarized antenna elements.

Remote command:

\[:\text{SOURce}\]:\text{FSIMulator}:\text{MIMO}:\text{ANTenna}:\text{RX}:\text{COLumn}:\text{SIZE}\] on page 207
\[:\text{SOURce<hw>}:\text{FSIMulator}:\text{MIMO}:\text{ANTenna}:\text{TX}:\text{ROWS}:\text{SIZE}\] on page 207

**Calculation Mode**

Selects how the correlation between the antenna elements is calculated: based on the spacing between the antenna elements or on the relative phase.

See Figure 6-14.

**Note:** In multi-entity configurations, like for example 2x4x4 or 4x2x2, the settings in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all entities.

"Spacing" The spacing (i.e. the physical distance) between the antenna elements is set with the parameter Horizontal Spacing or Cross-Polarized Antenna Spacing.

"Relative Phase"

Option: R&S SMW-K73

If the loaded antenna pattern file contains the required information, the relative phase is extracted from the antenna pattern file.

See:
- "Antenna element spacing or relative phase" on page 125

Remote command:

\[:\text{SOURce}\]:\text{FSIMulator}:\text{MIMO}:\text{ANTenna}:\text{RX}:\text{CALC}:\text{MODE}\] on page 207
\[:\text{SOURce<hw>}:\text{FSIMulator}:\text{MIMO}:\text{ANTenna}:\text{TX}:\text{CALC}:\text{MODE}\] on page 207
**Horizontal Spacing**

For "Calculation Mode > Spacing", sets the distance \( d_h \) between the antennas in the antenna array normalized by the wavelength \( \lambda \).

It is calculated as follows:

\[
d_h = \text{"Horizontal Spacing" \times \lambda}
\]

Where the wavelength is \( \lambda = c/\text{"Frequency"} \) and \( c \) is the speed of light.

See also "Antenna element spacing or relative phase" on page 125.

**Note:** In multi-entity configurations, like for example 2x4x4 or 4x2x2, the settings in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all entities.

Remote command:

\[
[:\text{SOURce<hw>}:\text{FSIMulator:MIMO:ANTenna:TX:ESPacing:HORizontal}}
\]

\[
[:\text{SOURce}:\text{FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontal}}
\]

**Cross-Polarized Antenna Spacing**

For "Calculation Mode > Spacing", set the distance \( d_{xp} \) between the two antenna elements of a cross-polarized antenna pair normalized by the wavelength \( \lambda \).

It is calculated as follows:

\[
d_{xp} = \text{"Cross Polarized Antenna Spacing" \times \lambda}
\]

Where the wavelength is \( \lambda = c/\text{"Frequency"} \) and \( c \) is the speed of light.

**Note:** In multi-entity configurations, like for example 2x4x4 or 4x2x2, the settings in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all entities.

Remote command:

\[
[:\text{SOURce<hw>}:\text{FSIMulator:MIMO:ANTenna:TX:ESPacing:CROSSs}}
\]

\[
[:\text{SOURce}:\text{FSIMulator:MIMO:ANTenna:RX:ESPacing:CROSSs}}
\]

**Antenna Array**

Graphical representation of the current antenna array.

Each dot indicates a single antenna element. Small lines indicate the used polarization, if "Antenna Polarization Mode > Single AP with Slant Angle" is used.

The spacing between the antenna elements is indicated, if "Calculation Mode > Spacing" is used.

**Antenna Pattern**

Antenna patterns are files that describe the 2D antenna radiation pattern.

**Note:** In multi-entity configurations, like for example 2x4x4 or 4x2x2, the settings in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all entities.

The following predefined antenna patterns are available:

- "Isotropic"
- "Dipole"
- "3 Sectors" and "6 Sectors"
These two sector antenna patterns are required for the BS testing, as specified in the TR 25.996.

- "Dipole +45°/-45°"

The predefined files do not contain polarization and relative phase information. They are suitable, in the following cases:

- **Calculation Mode** > "Spacing" or "Relative Phase"
  (See "Antenna element spacing or relative phase" on page 125 for information on file handling in the second case.)
- **Antenna Polarization Mode** > "Single AP with Slant Angle"
- **Standard / Test Case** > "3GPP/LTE MIMO" > "SCME UMa/Umi"

You can also load custom antenna pattern, see "User Defined Antenna Patterns per Row, Column" on page 136.

Remote command:

```plaintext
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:PATTern on page 209
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:PATTern on page 209
```

**User Defined Antenna Patterns per Row, Column**

Indicates the custom antenna pattern file per antenna element.

**Note:** In multi-entity configurations, like for example 2x4x4 or 4x2x2, the settings in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" **apply to all entities.**

To change the used file for an antenna element:

- Select a predefined or "User File"
- Navigate to the antenna pattern file and load it.

Antenna pattern files are XML files with file predefined file syntax and extension *.ant_pat.

They describe the antenna pattern as an array with typical resolutions of 1 degree to 5 degrees for the azimuth. These files contain the gain values for a given azimuth. For an isotropic antenna radiating energy equally in all directions, the array elements are all 0 dB.

Antenna pattern files can also contain the following information:

- Separate antenna patterns per antenna polarization
- Relative phase description, also per antenna polarization.

**Note:** Always use antenna pattern files that are suitable for the current setting. The following features require a fully described antenna pattern file

- **Calculation Mode** > "Relative Phase"
- **Antenna Polarization Mode** > "Separate AP"
- **Use Inverse Channel Matrix** > "On".

For description of the file format, see Chapter B, "Antenna Pattern File Format", on page 329.

Remote command:

```plaintext
[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog? on page 208
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ANTenna<di>:PFILe on page 209
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ANTenna<di>:PFILe on page 209
```
6.3.9 **Inverse Channel Matrix**

Option: R&S SMW-K73

Some test cases, like for example the MIMO OTA tests, specify actions to be taken to counteract the channel response of the channel between the test equipment and the DUT.

The process includes measuring the channel response matrix and applying the inverted version of this channel matrix to the generated signal. In the MIMO OTA tests using radiated tests for instance, signal generated in this way is received by the DUT as if a conducted test is used.

The inverse channel matrix is specified for the following test situations but can apply inverse channel matrix in any 2x2 MIMO scenario:

- MIMO OTA radiated testing
  - See
- Applying SCM fading profiles
  - See Chapter 6.3.7, "SCM Fading Profile", on page 112.

Access:
1. Enable a **2x2 MIMO** configuration.
2. Select "Fading > Inverse Channel Matrix"

---

**How to counteract the channel matrix of an anechoic chamber**

To counteract the anechoic chamber channel matrix of the setup on Figure 6-12 for example, apply the inverse channel matrix of the radiated channel. The radiated channel is the channel between the antenna probes and the DUT antennas inside the chamber.

Perform the following general steps:
1. Establish a radiated (over-the-air) MIMO connection to the DUT.
2. Measure the transmission matrix in the anechoic chamber.
3. Calculate the inverse matrix ($H^{-1}$). Enter the inverse matrix values.
4. In the R&S SMW, enable a 2x2 MIMO configuration.
5. Select "Fading > Inverse Channel Matrix"
6. Select "Use Inverse Channel Matrix > On".
7. Enter the calculated inverse matrix values.

The complex elements of the inverse channel matrix are applied on the transmitted signal to compensate for chamber effects.

**Settings**

- **Use Inverse Channel Matrix**: Applies a 2x2 inverse channel matrix on the signal to compensate for chamber effects. Enter the four inverse matrix values, see Complex Matrix Elements (Real/Imag).
- **Complex Matrix Elements (Real/Imag)**: Sets the 4 complex elements ($h_{00}$, $h_{01}$, $h_{10}$, $h_{11}$) of the inverse channel matrix.

\[
\begin{bmatrix}
A_{out} \\
B_{out}
\end{bmatrix} =
\begin{bmatrix}
h_{00} & h_{01} \\
h_{10} & h_{11}
\end{bmatrix}
\begin{bmatrix}
A_{in} \\
B_{in}
\end{bmatrix}
\]

$A_{in}$, $B_{in}$ = Faded channel signals
$A_{out}$, $B_{out}$ = Output signal of the channel emulator

The supported matrix size is 2x2.

**Remote command:**

\[
[:\text{SOURce<hw>}:\text{FSIMulator}:\text{MIMO}:\text{ANTenna}:\text{INVerse}:\text{MATRix}:\text{STATe}]
\]

\[
[:\text{SOURce<hw>}:\text{FSIMulator}:\text{MIMO}:\text{ANTenna}:\text{INVerse}:\text{MATRix}:\text{ROW<st>}:\text{COLumn<ch>:REAL}]
\]

\[
[:\text{SOURce<hw>}:\text{FSIMulator}:\text{MIMO}:\text{ANTenna}:\text{INVerse}:\text{MATRix}:\text{ROW<st>}:\text{COLumn<ch>:IMAGin}]
\]

### 6.4 Bypassing a Deactivated Fading Simulator

To access this setting, proceed as follow:

1. Enable "Fading > Signal Routing (MIMO) > System Configuration > Mode > Advanced".
2. Select "Fading > Off".

3. Select "Fading > Bypass if Fading Off > On".

The fading simulator is disabled and the input basebands bypass it.

Impact of the parameter on the calculation of the output streams

The parameter determines the way the output streams are calculated, if the fading simulator is disabled:

- Disabled parameter "Bypass if Fading Off" (default state)
  The fading simulator itself is disabled, but each output stream is still the linear combination of the input baseband signals and depend on the current MIMO configuration.
Example:

In a 4x2 MIMO system, for instance, the two output streams A and B are calculated from all the four input basebands. This instrument state is indicated by the sum symbols at each output streams.

Table 6-3: Representation of the instrument state "Bypass if Fading Off > Off"

<table>
<thead>
<tr>
<th>In the &quot;System Configuration&quot; preview diagram</th>
<th>In the block diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td><img src="image" alt="Block Diagram" /></td>
</tr>
</tbody>
</table>

- Enabled parameter "Bypass if Fading Off"
  Bypasses the "Fading" block, i.e. the fading simulator is disabled and the basebands bypass unchanged the fading block. Depending on the MIMO configuration, the block diagram visualizes this behavior different (see Table 6-4). The absence of the sum symbols confirm the selection, too.

Example:

- In a 4x2 MIMO system, for instance, the two output streams A and B are identical to the two input baseband signals A and B. The Basebands C and D are not processed.
- Vice versa, in a 3x4 MIMO system, the three output streams A, B and C are identical to the three basebands. The stream D is a zero stream that starts after the "Fading" block.
### Table 6-4: "Bypass if Fading Off > On": Representation in the block diagram

<table>
<thead>
<tr>
<th>MxN MIMO configuration, where M&gt;N</th>
<th>MxN MIMO configuration, where M&lt;N</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Diagram 1" /></td>
<td><img src="image2" alt="Diagram 2" /></td>
</tr>
</tbody>
</table>

**"Bypass if Fading Off > ON" during troubleshooting**

While performing troubleshooting, enable this parameter to exclude the impact of the fading in the signal processing.

SCPI command:

`:SOURce:FSIMulator:BYPass:STATe` on page 144
7 Remote-Control Commands

This subsystem contains the commands necessary to configure the fading simulator in a remote environment. We assume that the R&S SMW has already been set up for remote operation in a network as described in the R&S SMW documentation. A knowledge about the remote control operation and the SCPI command syntax are assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see section "Remote Control Commands" in the R&S SMW user manual.

Required Options
All SCPI commands described in this section, require at least the R&S SMW-B14 option. For better overview, this option is not listed at each command. Additionally required options, however, are listed.

The dynamic fading configurations (Birth Death, Moving Propagation, 2 Channel Interferer and High Speed Train) are available with option R&S SMW-K71.

See also Chapter 3.1, "Required Options", on page 19.

Common Suffixes
The following common suffixes are used in remote commands:

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Value range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTity&lt;ch&gt;</td>
<td>1 .. 8</td>
<td>entity in a multiple entity configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENTity3</td>
</tr>
<tr>
<td>SOURce&lt;hw&gt;</td>
<td>[1]</td>
<td>2 to 8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SOURce3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>only SOURce1 possible, if the keyword ENTity is used</td>
</tr>
<tr>
<td>GROup&lt;st&gt;</td>
<td>[1]</td>
<td>2 to 4</td>
</tr>
<tr>
<td>PATH&lt;ch&gt;</td>
<td>[1]</td>
<td>2 to 4</td>
</tr>
<tr>
<td>TAP&lt;ch&gt;</td>
<td>[1] to 10</td>
<td>available MIMO taps</td>
</tr>
<tr>
<td>RAY&lt;st&gt;</td>
<td>[1] to 6</td>
<td>available TGn clusters-rays</td>
</tr>
<tr>
<td>CLUSTER&lt;ch&gt;</td>
<td>[1] to 20</td>
<td>available SCME/WIMMER clusters</td>
</tr>
</tbody>
</table>

Using SCPI command aliases for advanced mode with multiple entities
You can address multiple entities configurations by using the SCPI commands starting with the keyword SOURce or the alias commands starting with the keyword ENTity.

Note that the meaning of the keyword SOURce<hw> changes in the second case.

For details, see section "SCPI Command Aliases for Advanced Mode with Multiple Entities" in the R&S SMW user manual.
Programming examples

This description provides simple programming examples. The purpose of the examples is to present all commands for a given task. In real applications, one would rather reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an environment for the development and execution of remote tests. To keep the example as simple as possible, only the "clean" SCPI syntax elements are reported. Non-executable command lines (e.g. comments) start with two // characters.

At the beginning of the most remote control program, an instrument (p)reset is recommended to set the instrument to a definite state. The commands *RST and SYSTEM:PRESet are equivalent for this purpose. *CLS also resets the status registers and clears the output buffer.

The following commands specific to the fading simulator are described here:

- General Settings................................................................................................... 143
- Delay Modes......................................................................................................... 165
- Birth Death............................................................................................................ 175
- High Speed Train.................................................................................................. 179
- Moving Propagation.............................................................................................. 183
- MIMO Settings...................................................................................................... 188
- TGn Settings......................................................................................................... 197
- SCME/WINNER and Antenna Model Settings......................................................200
- 2 Channel Interferer.............................................................................................. 210
- Custom Fading Profile...........................................................................................215
- SCM Fading Profile...............................................................................................216
- Customized Dynamic Fading................................................................................ 225

7.1 General Settings

[:SOURce]:FSIMulator:BYPass:STATe........................................................................144
[:SOURce<hw>:FSIMulator:CONFiguration..........................................................144
[:SOURce<hw>:FSIMulator:SISO:COPY................................................................145
[:SOURce<hw>:FSIMulator:COPY:DESTination....................................................145
[:SOURce<hw>:FSIMulator:COPY:EXECute..........................................................145
[:SOURce<hw>:FSIMulator:COPY:SOURce................................................................145
[:SOURce<hw>:FSIMulator:FREQuency.................................................................146
[:SOURce<hw>:FSIMulator:CLOCk:RATE?............................................................146
[:SOURce<hw>:FSIMulator:GLOBal:SEED............................................................147
[:SOURce<hw>:FSIMulator:HOPPing:MODE.......................................................147
[:SOURce<hw>:FSIMulator:IGNone:RFCHanges..................................................147
[:SOURce<hw>:FSIMulator:ILOSs:CSAMPles?.......................................................148
[:SOURce<hw>:FSIMulator:ILOSs:MODE.............................................................148
[:SOURce<hw>:FSIMulator:ILOSs[LOSS]...............................................................148
[:SOURce<hw>:FSIMulator:KCONstant.................................................................149
[:SOURce<hw>:FSIMulator:PRESet........................................................------------149
[:SOURce<hw>:FSIMulator:RESTart:MODE.........................................................149
Remote-Control Commands

Remote-Control Commands

[:SOURce<hw>]:FSIMulator:RESTart:RMODE?

[:SOURce<hw>]:FSIMulator:ROUTE

[:SOURce<hw>]:FSIMulator:SYNChronize:STAtE

[:SOURce<hw>]:FSIMulator:SDESTination

[:SOURce<hw>]:FSIMulator:FREQuency:DETECT?

[:SOURce<hw>]:FSIMulator:SPEED:UNIT

[:SOURce<hw>]:FSIMulator:STANDARD

[:SOURce<hw>]:FSIMulator:STANDARD:REFERENCE

[:SOURce<hw>]:FSIMulator[:STATE]

[:SOURce<hw>]:FSIMulator:CATALog?

[:SOURce<hw>]:FSIMulator:LOAD

[:SOURce<hw>]:FSIMulator:DELETE

[:SOURce<hw>]:FSIMulator:STORE

[:SOURce<hw>]:FSIMulator:COUPLE:LOGNormal:CSTD

[:SOURce<hw>]:FSIMulator:COUPLE:LOGNormal:LCONstant

[:SOURce<hw>]:FSIMulator:CSPeed

[:SOURce<hw>]:FSIMulator:BYPass:STAtE <BypState>

[:SOURce<hw>]:FSIMulator:CONFiguration <Configuration>

Enables/disables bypassing of the fading simulator if the simulator is deactivated.

Parameters:

<table>
<thead>
<tr>
<th>BypState</th>
<th>0</th>
<th>1</th>
<th>OFF</th>
<th>ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>RST:</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Selects the fading configuration.

To activate the selected fading configuration, use the command for switching the state.

Parameters:

<table>
<thead>
<tr>
<th>Configuration</th>
<th>STANdard</th>
<th>BIRTHdeath</th>
<th>MDELay</th>
<th>TCInterferer</th>
<th>HSTRain</th>
<th>CDYNa nic</th>
</tr>
</thead>
</table>

Defines the configuration: Standard delay, birth death propagation, moving propagation, two channel interferer, high-speed train and customized dynamic fading propagation.

RST: STANdard

Example:

SOURce1:FSIMulator:CONFiguration MDELay
SOURce1:FSIMulator:MDELay:STAtE ON

Selects and activates the moving propagation configuration

Options:

BIRTHdeath|MDELay|TCInterferer|HSTRain require R&S SMW-K71
CDYNamic requires R&S SMW-K820

Manual operation: See "Configuration" on page 30
[:SOURce<hw>]:FSIMulator:SISO:COPY <CopyToDest>

In "System Configurations" with multiple entities (L > 2), copies the settings of the current fading simulator to all or to the selected entities.

Parameters:
  <CopyToDest>  FADB | FADA | FADC | FADF | FADE | FADG | FADH | ALL
  *RST:        ALL

Example: SOURcel:FSIMulator:SISO:COPY ALL

Options: R&S SMW-K76

Manual operation: See "Copy To / Entity" on page 29

[:SOURce<hw>]:FSIMulator:COPY:DESTination <Destination>

Selects a group whose settings will be overwritten.

Parameters:
  <Destination>  integer
  Range:        1 to 4 (Standard Delay)/ 8 (Fine Delay)
  *RST:         2

Example: See [:SOURce<hw>]:FSIMulator:COPY:SOURce on page 145

Manual operation: See "To" on page 48

[:SOURce<hw>]:FSIMulator:COPY:EXECute

Copies the settings of a fading path group to the selected one.

Example: See [:SOURce<hw>]:FSIMulator:COPY:SOURce on page 145

Usage: Event

Manual operation: See "Copy" on page 48

[:SOURce<hw>]:FSIMulator:COPY:SOURce <Source>

Sets the group whose settings are to be copied.

Parameters:
  <Source>  integer
  Range:    1 to 8
  *RST:     1
Example:
```
FSIM:DEL:STAT ON
FSIM:COPY:DEST 4
FSIM:COPY:SOUR 1
FSIM:COPY:EXEC
// copies the settings from group 1 to group 4
```

Manual operation: See "Copy Path Group" on page 47

```
[:SOURce<hw>]:FSIMulator:FREQuency <Frequency>
```
- If [:SOURce<hw>]:FSIMulator:SDESTination RF is selected, queries the estimated RF frequency.
- If [:SOURce<hw>]:FSIMulator:SDESTination BB is selected, sets the frequency used for the calculation of the Doppler shift.

Parameters:
```plaintext
<Frequency> float
Range: 1E5 to 100E9
Increment: 0.01
*RST: 1E9
Default unit: Hz
```

Example:
```
SOURce1:FSIMulator:SDESTination RF
SOURce1:FSIMulator:FREQuency?
SOURce1:FSIMulator:SDESTination BB
SOURce1:FSIMulator:FREQuency 2143200000
```

Manual operation: See "Dedicated Frequency" on page 36
See "Virtual RF" on page 36

```
[:SOURce<hw>]:FSIMulator:CLOCk:RATE?
```
Queries the clock rate the fading simulator is using for the signal processing.

Return values:
```plaintext
<ClocRate> CR200 | CR100 | CR050 | CR025 | CR250 | CR125 | CR062
CR200 = 200 MHz, CR100 = 100 MHz, CR050 = 50 MHz, CR025 = 25 MHz
CR250 = 250 MHz, CR125 = 125 MHz, CR062 = 62.5 MHz
The value depends on the selected "System Configuration" and influences the bandwidth of the generated signal.
*RST: depends on the installed options*
') CR200M (R&S SMW-B10)/CR250M (R&S SMW-B9)
```

Usage: Query only

Manual operation: See "Fading Clock Rate" on page 33
[:SOURce<hw>]:FSIMulator:GLOBal:SEED <Seed>
This command enters the fading start seed. This value is global for the instrument.

Parameters:
<Seed> integer
Range: 0 to 9
*RST: 0

Example: FSIM:GLOB:SEED 2
Sets the start seed to 2

Manual operation: See “Start Seed” on page 44

[:SOURce<hw>]:FSIMulator:HOPping:MODE <Mode>
This is a password-protected function. Unlock the protection level 1 to access it.
Activates frequency hopping and determines how fading is resumed after a frequency hop.

Note: Activate list mode and load the frequency table before activating frequency hopping.

Parameters:
<Mode> OFF | IBANd | OOBand

OFF
Frequency hopping is deactivated.

IBANd
Activates an in-band frequency hopping.

OOBand
Activates an out of band frequency hopping.

*RST: OFF

Example: FSIM:HOPP:MODE OFF

Manual operation: See "Freq. Hopping" on page 37

[:SOURce<hw>]:FSIMulator:IGNore:RFCHanges <RfChanges>
This is a password-protected function. Unlock the protection level 1 to access it.
Sets if frequency changes < 5% are ignored. This enables faster frequency hopping.

Parameters:
<RfChanges> 0 | 1 | OFF | ON

*RST: 0

Example: FSIM:IGN:RFCH ON
Ignores frequency changes < 5% for the fading.

Manual operation: See "Ignore RF Changes < 5PCT" on page 36
[:SOURce<hw>]:FSIMulator:ILOSs:CSAMples?

This command queries the share of samples which were clipped due to the insertion loss setting.

**Return values:**

<CSamples> string

**Example:**

FSIM:ILOS:CSAM?

Queries the share of samples which were clipped.

Response: 11

11% of the samples were clipped.

**Usage:**

Query only

**Manual operation:**

See "Clipped Samples" on page 42

[:SOURce<hw>]:FSIMulator:ILOSs:MODE <Mode>

This command sets the insertion loss of the fading simulator.

**Parameters:**

<Mode> NORMal | LACP | USER

**NORMal**

The minimum insertion loss for a path of the fading simulator is set to a fixed value of 18 dB.

*RST: NORMal

**Example:**

FSIM:ILOS:MODE USER

Chooses the user-defined setting for the insertion loss.

FSIM:ILOS 4 dB

sets the minimum insertion loss to 4 dB.

**Manual operation:**

See "Insertion Loss Mode" on page 41

[:SOURce<hw>]:FSIMulator:ILOSs[:LOSS] <Loss>

This command sets the user-defined insertion loss of the fading simulator when "User" is selected.

In the "Normal" and "Low ACP" modes, the current setting of the value can be queried.

**Parameters:**

<Loss> float

**Range:** -3 to 30

**Increment:** 0.1

*RST: 0

**Default unit:** dB

**Example:**

FSIM:ILOS:MODE USER

Chooses the user-defined setting for the insertion loss.

FSIM:ILOS 4 dB

sets the minimum insertion loss to 4 dB.
Remote-Control Commands

Manual operation: See "Insertion Loss" on page 42

[:SOURce<hw>]:FSIMulator:KCONstant <KConstant>

Selects whether to keep the speed or the resulting Doppler shift constant in case of frequency changes.

Parameters:
<KConstant> SPEed | DSHift
*RST: SPEed

Example: FSIM:KCON SPE
 Keeps the speed constant in case of frequency changes.

Manual operation: See "Keep Constant" on page 47

[:SOURce<hw>]:FSIMulator:PRESet

Sets the default settings (*RST values) for fading simulation.

Example: SOURcel:FSIMulator:PRESet

Usage: Event

Manual operation: See "Set to Default" on page 29

[:SOURce<hw>]:FSIMulator:REStart:MODE <Mode>

Selects how a restart of fading simulation is triggered.

Parameters:
<Mode> AUTO | BBTRigger | AAUT
BBTRigger
Restarts the fading process synchronously with received baseband trigger signal.
AAUT
Not supported in the current version.
*RST: AUTO

Options: BBTRigger requires R&S SMW-K821

Manual operation: See "Mode" on page 38

[:SOURce<hw>]:FSIMulator:REStart:RMODE?

Queries the signal generation status.

Return values:
<RunMode> STOP | RUN
*RST: STOP

Usage: Query only
Manual operation: See "Running/Stopped" on page 38

[:SOURce<hw>]:FSIMulator:ROUTe <Route>

Selects on which baseband path the faded signal is output. The input signal of the fader is selected with command SOURce:BB:ROUTe.

For one-path instruments this command is query only. It returns value FAA (Fader A always outputs the signal on baseband A).

Note: All MIMO configurations are enabled only in :SCONfiguration:MODE ADVanced.

<table>
<thead>
<tr>
<th>:SCONfiguration: MODE</th>
<th>:SCONfiguration:FADing &lt;FadConfig&gt;</th>
<th>[:SOURce&lt;hw&gt;]:FSIMulator:ROUTe</th>
</tr>
</thead>
<tbody>
<tr>
<td>STANdard FAAFBNone</td>
<td>FAAFB None</td>
<td>FAAFBNone</td>
</tr>
<tr>
<td></td>
<td>FAAFBB</td>
<td>FAAFB</td>
</tr>
<tr>
<td></td>
<td>FAAFBA</td>
<td>FAAFBA</td>
</tr>
<tr>
<td></td>
<td>FABFBB</td>
<td>FABFBB</td>
</tr>
<tr>
<td></td>
<td>FAABFBN</td>
<td>FAAXAXAB</td>
</tr>
<tr>
<td></td>
<td>FANFBAB</td>
<td>FBMAMAB</td>
</tr>
<tr>
<td></td>
<td>FAABFBAB</td>
<td>FAABFBAB</td>
</tr>
<tr>
<td>ADVanced MIMO1X2</td>
<td>FA1A2BFB1A2B12</td>
<td>FA1A2BFB1A2B12</td>
</tr>
<tr>
<td>MIMO1X3</td>
<td>FA1A2BFB1A2B13</td>
<td>FA1A2BFB1A2B13</td>
</tr>
<tr>
<td>MIMO1X4</td>
<td>FA1A2BFB1A2B14</td>
<td>FA1A2BFB1A2B14</td>
</tr>
<tr>
<td>MIMO2X2</td>
<td>FA1A2BFB1A2B15</td>
<td>FA1A2BFB1A2B15</td>
</tr>
<tr>
<td>MIMO2X3</td>
<td>FA1A2BFB1A2B16</td>
<td>FA1A2BFB1A2B16</td>
</tr>
<tr>
<td>MIMO2X4</td>
<td>FA1A2BFB1A2B17</td>
<td>FA1A2BFB1A2B17</td>
</tr>
<tr>
<td>MIMO3X1</td>
<td>FA1A2BFB1A2B18</td>
<td>FA1A2BFB1A2B18</td>
</tr>
<tr>
<td>MIMO3X2</td>
<td>FA1A2BFB1A2B19</td>
<td>FA1A2BFB1A2B19</td>
</tr>
<tr>
<td>MIMO3X3</td>
<td>FA1A2BFB1A2B20</td>
<td>FA1A2BFB1A2B20</td>
</tr>
<tr>
<td>MIMO3X4</td>
<td>FA1A2BFB1A2B21</td>
<td>FA1A2BFB1A2B21</td>
</tr>
<tr>
<td>MIMO4X1</td>
<td>FA1A2BFB1A2B22</td>
<td>FA1A2BFB1A2B22</td>
</tr>
<tr>
<td>MIMO4X2</td>
<td>FA1A2BFB1A2B23</td>
<td>FA1A2BFB1A2B23</td>
</tr>
<tr>
<td>MIMO4X3</td>
<td>FA1A2BFB1A2B24</td>
<td>FA1A2BFB1A2B24</td>
</tr>
<tr>
<td>MIMO4X4</td>
<td>FA1A2BFB1A2B25</td>
<td>FA1A2BFB1A2B25</td>
</tr>
<tr>
<td>MIMO1X8</td>
<td>FA1A2BFB1A2B26</td>
<td>FA1A2BFB1A2B26</td>
</tr>
<tr>
<td>MIMO8X1</td>
<td>FA1A2BFB1A2B27</td>
<td>FA1A2BFB1A2B27</td>
</tr>
<tr>
<td>MIMO2X8</td>
<td>FA1A2BFB1A2B28</td>
<td>FA1A2BFB1A2B28</td>
</tr>
<tr>
<td>MIMO8X2</td>
<td>FA1A2BFB1A2B29</td>
<td>FA1A2BFB1A2B29</td>
</tr>
<tr>
<td>MIMO2X1</td>
<td>FA1A2BFB1A2B30</td>
<td>FA1A2BFB1A2B30</td>
</tr>
<tr>
<td>MIMO4X8</td>
<td>FA1A2BFB1A2B31</td>
<td>FA1A2BFB1A2B31</td>
</tr>
<tr>
<td>MIMO8X4</td>
<td>FA1A2BFB1A2B32</td>
<td>FA1A2BFB1A2B32</td>
</tr>
</tbody>
</table>
### Remote-Control Commands

#### General Settings

<table>
<thead>
<tr>
<th>:SCONfiguration: MODE</th>
<th>:SConfiguration:FADing [:SOURce&lt;hw&gt;]:FSIMulator:ROUTe</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIMO2X1X2</td>
<td>FAA1A2BFB1A2BM212</td>
</tr>
<tr>
<td>MIMO2X2X1</td>
<td>FAA1A2BFB1A2BM221</td>
</tr>
<tr>
<td>MIMO2X2X2</td>
<td>FAA1A2BFB1A2BM222</td>
</tr>
<tr>
<td>MIMO2X1X3</td>
<td>FAA1A2BFB1A2BM213</td>
</tr>
<tr>
<td>MIMO2X1X4</td>
<td>FAA1A2BFB1A2BM214</td>
</tr>
<tr>
<td>MIMO2X2X3</td>
<td>FAA1A2BFB1A2BM223</td>
</tr>
<tr>
<td>MIMO2X3X1</td>
<td>FAA1A2BFB1A2BM231</td>
</tr>
<tr>
<td>MIMO2X3X2</td>
<td>FAA1A2BFB1A2BM232</td>
</tr>
<tr>
<td>MIMO2X4X1</td>
<td>FAA1A2BFB1A2BM241</td>
</tr>
<tr>
<td>MIMO3X1X2</td>
<td>FAA1A2BFB1A2BM312</td>
</tr>
<tr>
<td>MIMO3X2X1</td>
<td>FAA1A2BFB1A2BM321</td>
</tr>
<tr>
<td>MIMO3X2X2</td>
<td>FAA1A2BFB1A2BM322</td>
</tr>
<tr>
<td>MIMO4X1X2</td>
<td>FAA1A2BFB1A2BM412</td>
</tr>
<tr>
<td>MIMO4X2X1</td>
<td>FAA1A2BFB1A2BM421</td>
</tr>
<tr>
<td>MIMO4X2X2</td>
<td>FAA1A2BFB1A2BM422</td>
</tr>
<tr>
<td>SISO3X1X1</td>
<td>FAAFB311</td>
</tr>
<tr>
<td>SISO4X1X1</td>
<td>FAAFB411</td>
</tr>
<tr>
<td>SISO5X1X1</td>
<td>FAAFB511</td>
</tr>
<tr>
<td>SISO6X1X1</td>
<td>FAAFB611</td>
</tr>
<tr>
<td>SISO7X1X1</td>
<td>FAAFB711</td>
</tr>
<tr>
<td>SISO8X1X1</td>
<td>FAAFB811</td>
</tr>
<tr>
<td>MIMO2X2X4</td>
<td>FAA1A2BFB1A2BM224</td>
</tr>
<tr>
<td>MIMO2X4X2</td>
<td>FAA1A2BFB1A2BM242</td>
</tr>
<tr>
<td>MIMO2X4X4</td>
<td>FAA1A2BFB1A2BM244</td>
</tr>
<tr>
<td>MIMO2X3X3</td>
<td>FAA1A2BFB1A2BM233</td>
</tr>
<tr>
<td>MIMO2X3X4</td>
<td>FAA1A2BFB1A2BM234</td>
</tr>
<tr>
<td>MIMO2X4X3</td>
<td>FAA1A2BFB1A2BM243</td>
</tr>
<tr>
<td>MIMO8X8</td>
<td>FAA1A2BFB1A2BM88</td>
</tr>
</tbody>
</table>

#### Parameters:

- FAA
- FAMAXAB
- FAAFBA
- FAAFB4B
- FABFBB
- FBMAXAB
- FAAFBAB
- FA1A2BFB1A2B
- FA1A2BFB1A2BM2
- FA1A2BFB1A2BM24
- FA1A2BFB1A2BM42
- FA1A2BFB1A2BM23
- FA1A2BFB1A2BM32
- FA1A2BFB1A2BM12
- FA1A2BFB1A2BM33
- FA1A2BFB1A2BM43
- FA1A2BFB1A2BM44
- FA1A2BFB1A2BM18
- FA1A2BFB1A2BM81
- FA1A2BFB1A2BM28
- FA1A2BFB1A2BM82
- FA1A2BFB1A2BM21
- FA1A2BFB1A2BM12
- FA1A2BFB1A2BM22
- FA1A2BFB1A2BM13
- FA1A2BFB1A2BM31
- FA1A2BFB1A2BM14
- FA1A2BFB1A2BM41
- FAMAXA
- FA1A2BFB1A2BM24
The faded modulation signal of fader A is placed on baseband path A.

FAAFBB
The faded modulation signal of fader A is placed on baseband path A and the faded modulation signal of fader B is placed on baseband path B.

FAAFBA
The faded modulation signal of fader A and B is placed on baseband path A.

FABFBB
The faded modulation signal of fader A and B is placed on baseband path B.

FAAFBABBAB
The faded modulation signal of fader A and B is placed on baseband paths A and B.

FAMAXA
The faded modulation signal of fader A is placed on baseband path A.

FBMAXB
The faded modulation signal of fader B is placed on baseband path B.

FAMAXAB
The faded modulation signal of fader A is placed on baseband paths A and B.

FBMAXAB
The faded modulation signal of fader B is placed on baseband paths A and B.

SOURce1:FSIMulator:CAPability?
// "M2X2,M2X4,M4X2,M2X3,M3X2,M1X2,..."
SOURce1:FSIMulator:ROUTe FA1A2BFB1A2BM24
// selects a 1x2X4 MIMO configuration

Example: SOURce1:FSIMulator:MIMO:CAPability?
// "M2X2,M2X4,M4X2,M2X3,M3X2,M1X2,..."
SOURce1:FSIMulator:ROUte FA1A2BFB1A2BM24
// selects a 1x2X4 MIMO configuration

Options: 1xMxN MIMO configurations require option R&S SMW-K74
Higher order MIMO configurations require option R&S SMW-K75. LxMxN configurations with L > 2 require option R&S SMW-K76. LxMxN configurations with more than 16 channels require option R&S SMW-B14. MIMO8X8 requires R&S SMW-K821.

**Manual operation:** See "Signal Routing" on page 88

[:SOURce]:FSIMulator:SYNChronize:STATe <State>

Couples the fading simulators so that if both blocks are active, a subsequent restart event in any of them causes a simultaneous restart of the other.

Restart event can be caused by a start/stop alternation or a parameter change that results in a signal recalculation and therefore a process restart.

**Parameters:**

<State> 0 | 1 | OFF | ON

*RST: 0

**Example:**

SOURce1:FSIMulator:STATe 1
SOURce2:FSIMulator:STATe 1
SOURce:FSIMulator:SYNChronize:STATe 1
SOURce1:FSIMulator:STATe 0
SOURce2:FSIMulator:STATe 1
// the fading simulators restart simultaneously

**Manual operation:** See "Synchronization" on page 38

[:SOURce<hw>]:FSIMulator:SDEStination <SDestination>

Defines the frequency to that the signal of the whole Fader block is dedicated.

**Parameters:**

<SDestination> RF | BB

RF

The Doppler shift is calculated based on the actual RF frequency, that is *dynamically estimated*.

To query the estimated dedicated frequency, use the command [:SOURce<hw>]:FSIMulator:FREQuency.

To query the output connector, use the command [:SOURce<hw>]:FSIMulator:FREQuency:DETect? on page 154.

BB

Set the fader frequency *manually* by means of the command [:SOURce<hw>]:FSIMulator:FREQuency.

*RST: RF

**Example:**

See [:SOURce<hw>]:FSIMulator:FREQuency on page 146

**Manual operation:** See "Signal Dedicated To" on page 33
[:SOURce<hw>]:FSIMulator:FREQuency:DETeXt?

Queries the output interface the steam used to estimate the dedicated frequency is mapped to.

Return values:

<DetectMaster>  RFA | BBMM1 | RFB | BBMM2 | IQOUT1 | IQOUT2 | FAD1 | FAD2 | FAD4 | FAD3 | DEF

Example:  :SOURc1:FSIMulator:FREQ:DETeXt?

Usage:  Query only

Manual operation:  See "Dedicated Connector" on page 36

[:SOURce<hw>]:FSIMulator:SPEed:UNIT <Unit>

This command chooses the default unit for the parameter speed as displayed in the dialog.

Note:  The remote control command changes only the units displayed in the graphical user interface. While configuring the speed via remote control, the speed units must be specified.

Parameters:

<Unit>  MPS | KMH | MPH | NMPH

*RST:  KMH

Example:  FSIM:SPE:UNIT MPS

Sets meters per second as the default unit for the speed parameter as displayed in the graphical user interface.

Manual operation:  See "Speed Unit" on page 47

[:SOURce<hw>]:FSIMulator:STANdard <Standard>

Selects a predefined fading simulator setting which complies with the test specifications found in the common mobile radio standards.

For a detailed summary of all of the default settings, see Chapter A, "Predefined Fading Settings", on page 229.
### General Settings

<table>
<thead>
<tr>
<th>Standard / Test Case</th>
<th>&lt;Predefined_Standard&gt;</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>USER</td>
<td>USER parameter cannot be set. A query returns this value if a user-defined Fading setting was loaded or if one of the associated settings was changed subsequent to the selection of a standard</td>
</tr>
<tr>
<td>CDMA</td>
<td>CDMA0</td>
<td>CDMA3</td>
</tr>
<tr>
<td>See Chapter A.1, &quot;CDMA Standards&quot;, on page 229</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GSM</td>
<td>GTU1P5</td>
<td>G6TU1P5</td>
</tr>
<tr>
<td>See Chapter A.2, &quot;GSM Standards&quot;, on page 232</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GHT100</td>
<td>G6HT100</td>
<td>GHT120</td>
</tr>
<tr>
<td>GRA130</td>
<td>GRA250</td>
<td>GRA300</td>
</tr>
<tr>
<td>GET50</td>
<td>GET60</td>
<td>GET100</td>
</tr>
<tr>
<td>GTI5</td>
<td>GSM typical case for very small cells, 5 km/h, 2 path</td>
<td></td>
</tr>
<tr>
<td>NADC</td>
<td>NADC8</td>
<td>NADC50</td>
</tr>
<tr>
<td>See Chapter A.3, &quot;NADC Standards&quot;, on page 237</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DCS1800/PCS1900</td>
<td>P6TU1</td>
<td>PTU1</td>
</tr>
<tr>
<td>See Chapter A.4, &quot;PCN Standards&quot;, on page 238</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P6HT100</td>
<td>PHT100</td>
<td>Hilly Terrain 100 km/h, 6 and 12 path</td>
</tr>
<tr>
<td>PRA130</td>
<td>Rural Area 130 km/h, 6 path</td>
<td></td>
</tr>
<tr>
<td>PET50</td>
<td>PET100</td>
<td>Equal Test 50/100 km/h, 6 path</td>
</tr>
<tr>
<td>TETRA</td>
<td>TTU</td>
<td>T6TU</td>
</tr>
<tr>
<td>See Chapter A.5, &quot;TETRA Standards&quot;, on page 243</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TBU</td>
<td>TETRA 2 path</td>
<td></td>
</tr>
<tr>
<td>THT</td>
<td>T6HT</td>
<td>TETRA Hilly Terrain 200 km/h, 2 path and 6 path</td>
</tr>
<tr>
<td>T4ET</td>
<td>TETRA Equal Test 200 km/h, 4 path</td>
<td></td>
</tr>
<tr>
<td>TDR</td>
<td>TETRA Direct Mode Rural Propagation Model 1 path</td>
<td></td>
</tr>
<tr>
<td>Standard / Test Case</td>
<td>&lt;Predefined_Standard&gt;</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TDU</td>
<td></td>
<td>TETRA Mode Urban Propagation Model 1 path</td>
</tr>
<tr>
<td>3GPP FDD</td>
<td>G3C1</td>
<td>G3C2</td>
</tr>
<tr>
<td></td>
<td>G3UEC1</td>
<td>G3UEC2</td>
</tr>
<tr>
<td></td>
<td>G3UEC7SE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>G3UEC7BE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>G3UEC8CQ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>G3UEPA3</td>
<td>G3UEPB3</td>
</tr>
<tr>
<td></td>
<td>G3UEVA3</td>
<td>G3UEVA30</td>
</tr>
<tr>
<td></td>
<td>G3MBSFN3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>G3TU3</td>
<td>G3TU50</td>
</tr>
<tr>
<td></td>
<td>G3HT120</td>
<td></td>
</tr>
<tr>
<td></td>
<td>G3RA120</td>
<td>G3RA250</td>
</tr>
<tr>
<td></td>
<td>BD1</td>
<td></td>
</tr>
<tr>
<td>Moving Propagation</td>
<td>MD1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MPLTEPDOPP</td>
<td></td>
</tr>
<tr>
<td>3GPP High Speed Train scenarios</td>
<td>G3HST1OS</td>
<td>G3HST1OSDU</td>
</tr>
<tr>
<td>See Chapter A.14, &quot;3GPP/LTE High Speed Train&quot;, on page 292</td>
<td>G3HST2TLC</td>
<td>G3HST2TLCDU</td>
</tr>
<tr>
<td>Standard / Test Case</td>
<td>&lt;Predefined_Standard&gt;</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>G3HST3TMA</td>
<td>G3HST3TMADU</td>
<td>3GPP HST3 &quot;Tunnel for multi-antennas&quot;, according to the test case 3GPP TS25.141, annex D.4A and 3GPP TS36.141, annex B.3</td>
</tr>
<tr>
<td>G3SCMEUMA3</td>
<td>G3SCMEUMA30</td>
<td>SCME/Geo SCME Urban Micro/Macro-Cell Channel, 3 km/h and 30 km/h</td>
</tr>
<tr>
<td>G3SCMEUMI3</td>
<td>G3SCMEUMI30</td>
<td></td>
</tr>
<tr>
<td>GEOSCMEUMA3</td>
<td>GEOSCMEUMA30</td>
<td></td>
</tr>
<tr>
<td>GEOSCMEUMI3</td>
<td>GEOSCMEUMI30</td>
<td></td>
</tr>
<tr>
<td>SCME/Geo SCME UMi 3kmh/30kmh</td>
<td></td>
<td>See Chapter A.16, &quot;SCM and SCME Channel Models for MIMO OTA&quot;, on page 296</td>
</tr>
<tr>
<td>SCME/Geo SCME UMa 3kmh/30kmh</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WLAN</td>
<td>HL2A</td>
<td>HL2B</td>
</tr>
<tr>
<td>DAB</td>
<td>DABRA04</td>
<td>DABRA06</td>
</tr>
<tr>
<td>DABTU12</td>
<td>DABTU06</td>
<td>DAB Typical Urban 12 and 6 path</td>
</tr>
<tr>
<td>DABSFN</td>
<td></td>
<td>DAB Single Frequency Network (in the VHF range) 7 path</td>
</tr>
<tr>
<td>WMSUI1A360P90</td>
<td>WMSUI1A360P75</td>
<td>WMSUI1A030P90</td>
</tr>
<tr>
<td>WMSUI2A360P90</td>
<td>WMSUI2A360P75</td>
<td>WMSUI2A030P90</td>
</tr>
<tr>
<td>WMSUI3A360P90</td>
<td>WMSUI3A360P75</td>
<td>WMSUI3A030P90</td>
</tr>
<tr>
<td>WMSUI4A360P90</td>
<td>WMSUI4A360P75</td>
<td>WMSUI4A030P90</td>
</tr>
<tr>
<td>WMSUI5A360P90</td>
<td>WMSUI5A360P75</td>
<td>WMSUI5A030P90</td>
</tr>
<tr>
<td>WMSUI5A360P50</td>
<td>WMSUI5A030P50</td>
<td></td>
</tr>
<tr>
<td>WMSUI5A030P50</td>
<td>WMSUI5A030P75</td>
<td></td>
</tr>
<tr>
<td>WiMAX</td>
<td>WMSUI6A360P90</td>
<td>WMSUI6A360P75</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P50</td>
<td>WMSUI6A030P75</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P75</td>
<td>WMSUI6A030P75</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P50</td>
<td>WMSUI6A030P75</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P50</td>
<td>WMSUI6A030P50</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P75</td>
<td>WMSUI6A030P75</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P50</td>
<td>WMSUI6A030P50</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P75</td>
<td>WMSUI6A030P75</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P50</td>
<td>WMSUI6A030P50</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P75</td>
<td>WMSUI6A030P75</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P50</td>
<td>WMSUI6A030P50</td>
</tr>
<tr>
<td></td>
<td>WMSUI6A030P75</td>
<td>WMSUI6A030P75</td>
</tr>
<tr>
<td>Standard / Test Case</td>
<td>&lt;Predefined_Standard&gt;</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>WIMAX-MIMO</td>
<td>WMITUPB3L</td>
<td>WMITUPB3M</td>
</tr>
<tr>
<td>LTE</td>
<td>LTEPA1</td>
<td>LTEPA5</td>
</tr>
<tr>
<td>LTE-MIMO</td>
<td>LMEPA1L</td>
<td>LMEPA1M</td>
</tr>
<tr>
<td>1xEVDO</td>
<td>EVDO1CH1</td>
<td>EVDO1CH1BC5</td>
</tr>
<tr>
<td>WATTERSON</td>
<td>WATTI1</td>
<td>WATTI3</td>
</tr>
<tr>
<td>802.11n-SISO</td>
<td>WLANNSMODA</td>
<td>WLANNSMODB</td>
</tr>
<tr>
<td>802.11n-MIMO</td>
<td>WLANNMODA</td>
<td>WLANNMODB</td>
</tr>
<tr>
<td>802.11ac-SISO</td>
<td>WLANACSMODA</td>
<td>WLANACSMODB</td>
</tr>
<tr>
<td>802.11ac-MIMO</td>
<td>WLANACMODA</td>
<td>WLANACMODB</td>
</tr>
<tr>
<td>Standard / Test Case</td>
<td>&lt;Predefined_Standard&gt;</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>802.11p</td>
<td>WLANPRURALLOS</td>
<td>WLANPRURBA-NAPLOS</td>
</tr>
<tr>
<td></td>
<td>802.11p Channel models: Rural LOS, Urban Approaching LOS, Urban Crossing NLOS, Highway LOS, Highway NLOS</td>
<td></td>
</tr>
<tr>
<td>5G NR</td>
<td>TDLA30D5L</td>
<td>TDLA30D5M</td>
</tr>
<tr>
<td></td>
<td>5G New Radio models</td>
<td>TDLA30-5/10 Hz, TDLB100-400 Hz, TDLC300-100 Hz, TDLA30-75/300 Hz Low/Medium/Medium A/High</td>
</tr>
<tr>
<td></td>
<td>TDLA30-5/10 Hz, TDLB100-400 Hz, TDLC300-100 Hz, TDLA30-75/300 Hz SISO</td>
<td></td>
</tr>
</tbody>
</table>

See Chapter A.22, "802.11p Channel Models", on page 323

See Chapter A.23, "5G NR Standards", on page 325
**Parameters:**

*<Standard>*

- USER | CDMA8 | CDMA30 | C1DMA30 | CDMA100 | CDMA0 |
- CDMA3 | G6TU3 | GTU3 | G6TU50 | GTU50 | G6HT100 |
- GHT100 | GRA250 | GET50 | GET100 | HL2A | HL2B | HL2C |
- HL2D | HL2E | NADC8 | NADC50 | NADC100 | P6TU1 | PTU1 |
- P6TU50 | PTU50 | P6HT100 | PHT100 | PRA130 | PET50 |
- PET100 | TDU | TDR | WMITUVA120 | WMITUVA60 | WMITUVA600 |
- T60 | G6HT120 | G6HT200 |
- GRA130 | GRA300 | GRA500 | G6TU1P5 | G6TU3P6 | G6TU6 |
- G6TU60 | G6TU100 | GHT120 | GHT200 | GTU1P5 | GTU3P6 |
- GTU6 | GTU60 | GTU100 | LMEPA5L | LMEPA5M | LMEPA5H |
- LMEVA5L | LMEVA5M | LMEVA5H | LMEVA70L | LMEVA70M |
- LMEVA70H | LMETU70L | LMETU70M | LMETU70H |
- LMETU300 | LMETU300M | LMETU300H | WMITUPB3L |
- WMITUPB3M | WMITUPB3H | WMITUVA60L | WMITUVA60M |
- WMITUVA60H | EVDO1CH1 | EVDO1CH1BC5 | EVDO1CH2 |
- EVDO1CH2BC5 | EVDO1CH3 | EVDO1CH3BC5 | EVDO1CH4 |
- EVDO1CH4BC5 | EVDO1CH5 | EVDO1CH5BC5 | G3HST1OS |
- G3HST2TLC | G3HST3TMA | MPLTEU200 | MPLTEPDOPP |
- T6TU | T6HT | LTEEA5 | LTEVA5 | LTEVA70 | LTEU70 |
- LTEU300 | G3UEC1 | G3UEC2 | G3UEC3 | G3UEVA3 |
- G3BSFN3 | WATTI1 | WATTI3 | WATTI2 | GTI5 |
- G3HST1OSDU | G3HST2TLC | G3HST3TMA |
- LTEU300 | LTEU300L | LMETU300L |
- WLANNMODA | WLANNMB | WLANNMBD |
- WLANNMOD | WLANNMODD | WLANNMODE |
- WLANNMODF | WLANNMOSA | WLANNMOSB |
- WLANNMOSC | WLANNMOSD | WLANNMODE |
- WLANNMOSF | WLANNMOSGA | WLANNMOSGB |
- WLANNMOD | WLANNMOSD | WLANNMODE |
- WLANNMOSF | WLANNMOSGA | WLANNMOSGB |
- WLANNMOSC | WLANNMOSD | WLANNMODE |
- WLANNMOSF | WLANNMOSGA | WLANNMOSGB |
- WLANNMOSC | WLANNMOSD | WLANNMODE |
- WLANNMOSF | WLANNMOSGA | WLANNMOSGB |
- WLANNMOSC | WLANNMOSD | WLANNMODE |
- WLANNMOSF | WLANNMOSGA | WLANNMOSGB |
- WLANNMOSC | WLANNMOSD | WLANNMODE |
Example:  
FSIM:STAN THT

Manual operation:  
See "Standard / Test Case" on page 30

Option:  see the corresponding section in Chapter A, "Predefined Fading Settings", on page 229.

[:SOURce<hw>:]:FSIMulator:STANdard:REFerence <Reference>

Queries the reference in the standard for the selected test case.

Parameters:
<Reference> string

Example:
FSIM:STAN WC1BUP2
// Selects settings in acc. with 3GPP FDD Test Case 1 (2 fading paths)
FSIM:STAN:REF?
// "3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2"

Manual operation:  See "Standard / Test Case" on page 30

[:SOURce<hw>:]:FSIMulator[:STATe] <State>

Activates fading simulation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example:  
Option: R&S SMW-B14
FSIM ON
// Activates fading simulation
Example: Option: R&S SMW-B15
SConfig:MODE ADV
SConfig:APPLY
FSIM ON
// Activates fading simulation

Manual operation: See "State" on page 29
See "State Path" on page 48

[:SOURce]:FSIMulator:CATalog?
Queries the files with settings in the default directory. Listed are files with the file extension *.fad.

Return values:
<String> <filename1>,<filename2>...
Returns a string of filenames separated by commas.

Example:
SOURcel:FSIMulator:STORE "/var/user/delay_3gpp"
*RST
SOURcel:FSIMulator:CATalog?
// Birth_3gpp, delay_3gpp, fad_test
SOURcel:FSIMulator:LOAD "/var/user/fad_test"
SOURcel:FSIMulator:STATe 1
SOURcel:FSIMulator:DELETE "Birth_3gpp"

Usage: Query only

Manual operation: See "Save/Recall" on page 30

[:SOURce<hw>]:FSIMulator:LOAD <Filename>
Loads the selected file from the default or the specified directory. Loaded are files with extension *.fad.

Setting parameters:
<String> <filename>"
Filename or complete file path; file extension can be omitted

Example: See [:SOURce]:FSIMulator:CATalog? on page 162.

Usage: Setting only

Manual operation: See "Save/Recall" on page 30

[:SOURce]:FSIMulator:DELETE <Filename>
Deletes the specified file containing a fading setting from the default directory. The default directory is set with the command MMEM:CDIRectory. A path can also be specified. Only files with the file ending *.fad are deleted.

Note: This command is only valid with DELETE in the long form as DEL is used as short form of header keyword DELay.
Remote-Control Commands

Setting parameters:
<Filename> string

Example: See [:SOURce]:FSIMulator:CATalog? on page 162

Usage: Setting only

Manual operation: See "Save/Recall" on page 30

[:SOURce<hw>]:FSIMulator:STORE <Filename>
Saves the current settings into the selected file; the file extension (*.fad) is assigned automatically.

Setting parameters:
<Filename> "<filename>"
Filename or complete file path

Example: See [:SOURce]:FSIMulator:CATalog? on page 162.

Usage: Setting only

Manual operation: See "Save/Recall" on page 30

[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:CSTD <Cstd>
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:LCONstant <LConstant>
(available in "System Configuration > Mode > Standard")
Couples the lognormal fading setting.

Parameters:
<LConstant> 0 | 1 | OFF | ON
*RST: 0
Remote-Control Commands

Example:

```
S CONFIGURATION:MODE STANDARD
S FSIMULATOR:CONFiguration STAN
S FSIMULATOR:DEL:GROup1:PATH1:PROFile PDOP
S FSIMULATOR:DEL:GROup1:PATH1:SPeed 1111.111
S FSIMULATOR:STATe 1
S FSIMULATOR:COUPle:SPeed 1

S FSIMULATOR:CONFiguration STAN
S FSIMULATOR:STATe 1
S FSIMULATOR:DEL:GROup1:PATH1:SPeed?
// 1111.111

S FSIMULATOR:COUPle:LOGNormal:LCONSTant 1
S FSIMULATOR:COUPle:LOGNormal:CSTD 1
S FSIMULATOR:DEL:GROup1:PATH1:LOGNormal:STATe 1
S FSIMULATOR:DEL:GROup1:PATH1:LOGNormal:LCONSTant 150
S FSIMULATOR:DEL:GROup1:PATH1:LOGNormal:CSTD?
// 150
S FSIMULATOR:DEL:GROup1:PATH1:LOGNormal:LCONSTant 2
S FSIMULATOR:DEL:GROup1:PATH1:LOGNormal:CSTD?
// 2
```

Manual operation: See "Local Constant Coupled" on page 43

```
[:SOURce<hw>]:FSIMulator:COUPle:SPeed <Speed>
```

(available in "System Configuration > Mode > Standard")

Couples the setting for the speed for the paths of both faders.

Parameters:

<table>
<thead>
<tr>
<th>&lt;Speed&gt;</th>
<th>0</th>
<th>1</th>
<th>OFF</th>
<th>ON</th>
</tr>
</thead>
</table>

*RST: 0

Example: See [:SOURce<hw>]:FSIMulator:COUPle:LOGNormal: LCONSTant on page 163

Manual operation: See "Speed Setting Coupled" on page 43

```
[:SOURce<hw>]:FSIMulator:CSPeed <CSpeed>
```

Determines whether the same speed is set for all of the activated fading paths.

Parameters:

<table>
<thead>
<tr>
<th>&lt;CSpeed&gt;</th>
<th>0</th>
<th>1</th>
<th>OFF</th>
<th>ON</th>
</tr>
</thead>
</table>

*RST: 1

Example: See [:SOURce<hw>]:FSIMulator:COUPle:LOGNormal: LCONSTant on page 163

Manual operation: See "Common Speed For All Paths" on page 47
7.2 Delay Modes

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:ADELay

Sets the path-specific delay ("Additional Delay") of the selected path.

Parameters:

<ADelay> float

Range: depends on the installed options*
Increment: depends on the installed options*

*RST: 0

Example:

```
SOURcel:FSIMulator:CONFiguration STAN
SOURcel:FSIMulator:DEL:GROup2:PATH2:STATe 1
SOURcel:FSIMulator:DEL:GROup2:PATH2:ADElay 1E-6
// sets a delay of 10 us for path 2 of the fading group 2
```

**Manual operation:** See "Additional Delay" on page 51

```
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:BDElay <BDelay>
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:BDElay <BDelay>
```

Sets the basic group delay.

**Parameters:**

- `<BDelay>`
  - **Type:** float
  - **Range:** depends on the installed options*
  - **Increment:** depends on the installed options*
  - **RST:** 0

**Example:**

```
SOURcel:FSIMulator:CONFiguration STAN
SOURcel:FSIMulator:DEL:GROup2:PATH2:STATe 1
SOURcel:FSIMulator:DEL:GROup2:PATH2:ADElay 1E-3
// sets a delay of 1 ms for path 2 of the fading group 2
```

**Options:** R&S SMW-B14

**Manual operation:** See "Basic Delay" on page 51

```
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:RDElay?
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:RDElay?
```

Queries the resulting delay of the paths for the selected fading configuration. The Resulting Delay is the sum of the Basic Delay (`SOURce:FSIM:...:BDElay`) and the Additional Delay (`SOURce:FSIM:...:ADElay`).

**Return values:**

- `<RDelay>`
  - **Type:** float
  - **Sum of the values set with the commands `[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:BDElay` and `[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:ADElay`.
  - **Range:** depends on the installed options*
  - **Increment:** 10E-9
  - **RST:** 0
Example:

SOURce1:FSIMulator:CONFiguration STAN
SOURce1:FSIMulator:DEL:GROup2:PATH1:STATe 1
SOURce1:FSIMulator:DEL:GROup2:PATH2:BDElay 2E-4
// sets a delay of 200 us for the fading group 2
SOURce1:FSIMulator:DEL:GROup2:PATH2:ADElay 1E-5
// sets an additional delay
SOURce1:FSIMulator:DEL:GROup2:PATH2:RDELay?
// 0.00021

Usage: Query only
Manual operation: See "Resulting Delay" on page 51

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:COEFFicient <Coefficient>

Determines the magnitude of the complex correlation coefficient. The higher the entered percentage, the greater the correlation of the statistical fading processes for the two paths. Highly correlated ambient conditions for the signal are simulated in this manner.

Sets the correlation coefficient of the correlated path of the second fader also to the entered value.

Parameters:

<Coefficient>
float
Range: 0 to 100
Increment: 0.1
*RST: 100
Default unit: PCT

Example:

FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO2:PATH:CORR:STAT ON
switches on the correlation of fading path 1 of group 2 of fader A to fading path 1 of group 2 of fader B.
FSIM:DEL:GRO2:PATH:CORR:COEF 95
specifies a correlation coefficient of 95% for the two paths.

Manual operation: See "Correlation Coefficient" on page 55

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:PHASe <Phase>

Determines the phase of the complex correlation coefficient.

Sets the phase of the correlation coefficient of the correlated path of the second fader also to the entered value.
Remote-Control Commands

Parameters:
<Phase> float
Range: 0 to 359.9
Increment: 0.05
*RST: 0
Default unit: DEG

Example:
FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO2:PATH:CORR:STAT ON
switches on the correlation of fading path 1 of group 2 of fader A to fading path 1 of group 2 of fader B.
FSIM:DEL:GRO2:PATH:CORR:PHAS 5
specifies a phase of the correlation coefficient equal to 5 DEG for the two paths.

Manual operation: See "Correlation Coefficient Phase" on page 55

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:STATe <State>

Enables correlation of the paths of the first fader. The suffix in SOURce defines the fader on which path settings the correlation is based.

When correlation is activated, the settings of the correlation parameters, the profile, the speed and the lognormal parameters are the same for both paths.

Parameters:
<State> 0 | 1 | OFF | ON
*RST: 0

Example:
SOURce1:FSIMulator:DELay:STATe ON
SOURce1:FSIMulator:DELay:GROup2:PATH1:CORRelation:STATe ON
Enables correlation of fading path 1 of group 2 of fader A to fading path 1 of group 2 of fader B.

Manual operation: See "Correlation Path" on page 54

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase <CPhase>

Sets the start phase rotation.

Parameters:
<CPhase> float
Range: 0 to 359.9
Increment: 0.1
*RST: 0
Default unit: DEG
Example:

1. FSIM:DEL:STAT ON
   Activates the Standard Delay fading configuration.
2. FSIM:DEL:GRO1:PATH1:PROF RICE
   Selects the Rice fading profile for fading path 1 of group 1.
3. FSIM:DEL:GRO1:PATH:CPH 5DEG
   Sets a start phase rotation of 5 DEG for fading path 1 of group 2.
   The path is multiplied by this phase.

Manual operation:

See "Const. Phase" on page 52
See "Start Phase" on page 52

[:SOURce<hw>]:FSIMulator:MDELAY:DELAY:GROUp<st>:PATH<ch>:FDOPpler

Queries the resulting Doppler frequency for the fading configuration.

The Doppler frequency is determined by the selected speed ([:SOURce<hw>]:FSIMulator:DELAY:GROUp<st>:PATH<ch>:SPEed).

For the Pure Doppler and Rice Fading profiles, the actual Doppler shift is a function of the selected ratio of the Doppler shift to the Doppler frequency ([:SOURce<hw>]:FSIMulator:DELAY:GROUp<st>:PATH<ch>:FRATio). Use the command [:SOURce<hw>]:FSIMulator:DELAY:GROUp<st>:PATH<ch>:FDOPpler:ACTual? to query the actual Doppler shift.

Parameters:

- <FDoppler> float
  - Range: 0 to max*
  - Increment: 0.01
  - RST: 0

*) Option:
- R&S SMW-B14 max = 4000
- R&S SMW-B15 max depends on the System Configuration
  - LxMxN as follows:
    - Lx1x1 with L = 1 to 8: max = 4000
    - 1x2x2/2x2x2/2x2x1/2x1x2: max = 2000
    - 3x2x2/4x2x2: max = 800
    - 1x2x4/1x4x2: max = 1000
    - 2x2x4/2x4x2: max = 600
    - 1x2x8/1x8x2/1x4x4: max = 300
Remote-Control Commands

Example:

Example:

Manual operation:

Usage:

Manual operation:

Parameters:

Manual operation:

Manual operation:
Example: See [:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler[:RESULTing] on page 169

Manual operation: See "Frequency Ratio" on page 53

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FShift <FShift>

Sets the frequency shift for the Gauss Watterson fading.

Parameters:
- <FShift> float
  - Range: -10 to 10
  - Increment: 0.0001
  - RST: 0


Manual operation: See "Frequency Shift" on page 52

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSPread <FSpread>

Sets the frequency spread for the Gauss Watterson fading.

Parameters:
- <FSpread> float
  - Range: 1E-4 to 10
  - Increment: 1E-4
  - RST: 0.1


Manual operation: See "Frequency Spread" on page 51

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal: CSTD <Cstd>

Sets the standard deviation for lognormal fading.

Parameters:
- <Cstd> integer
  - Range: 0 to 12
  - RST: 0
  - Default unit: dB
Example:

```
FSIM:DEL:STAT ON
Activates the Standard Delay fading configuration.
FSIM:DEL:GRO:PATH2:LOGN:STAT ON
selects lognormal fading for fading path 2 of group 1.
FSIM:DEL:GRO:PATH2:LOGN:CSTD 2
sets a standard deviation of 2 dB for fading path 2 of group 1.
```

Manual operation:  See "Standard Deviation " on page 56

```
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
   LCONstant <LConstant>
```

Sets the Local Constant for lognormal fading.

Parameters:

- `<LConstant>`: float
  - Range: 0 to 200
  - Increment: 0.1
  - *RST: 100
  - Default unit: m

Example:

```
FSIM:DEL:STAT ON
Activates the Standard Delay fading configuration.
FSIM:DEL:GRO:PATH2:LOGN:STAT ON
selects lognormal fading for fading path 2 of group 1.
FSIM:DEL:GRO:PATH2:LOGN:LCON 100
sets a Local Constant of 100 m for the second fading path of group 1.
```

Manual operation:  See "Local Constant" on page 55

```
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
   STATe <State>
```

Enables/disables a lognormal fading.

Parameters:

- `<State>`: 0 | 1 | OFF | ON
  - *RST: 0

Example:

```
FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:LOGN:STAT ON
activates lognormal fading for fading path 2 of group 1.
```

Manual operation:  See "Lognormal State" on page 55

```
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:LOSS <Loss>
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOSS <Loss>
```

Sets the loss of the paths.
Parameters:  
<Loss>  
float  
Range: 0 to 50  
Increment: 0.001  
*RST: 10|0  
Default unit: dB  

Example:  
FSIM:DEL:STAT ON  
Activates the "Standard Delay" fading configuration.  
FSIM:DEL:GRO:PATH2:LOSS 2 dB  
sets a loss of 2 dB for fading path 2 of group 1.  

Manual operation:  
See "Path Loss" on page 51

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PRATio <PRatio>  
Sets the power ratio of the discrete and distributed components for Rice fading  

Parameters:  
<PRatio>  
float  
Range: -30 to 30  
Increment: 0.01  
*RST: 0  
Default unit: dB  

Example:  
FSIM:DEL:STAT ON  
Activates the "Standard Delay" fading configuration.  
FSIM:DEL:GRO:PATH2:PROF RICE  
sets the Rice fading profile for fading path 2 of group 1.  
FSIM:DEL:GRO:PATH2:PRAT -15  
sets a power ratio of –15 dB. The distributed (Rayleigh) component prevails. The total power of the two components remains constant.  

Manual operation:  
See "Power Ratio" on page 51

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:PROFile <Profile>  
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PROFile <Profile>  
Selects the fading profile for the paths.  

Parameters:  
<Profile>  
SPATh | RAYleigh | PDOPpler | RICE | CPHase | OGAUs |  
TGAUs | DGAUs | WDOPler | WRt | GDOPpler | GFD8 |  
GFD1 | WATTerson | CUSTom | SCM | BELLindoor | BELVehicle  
SPAT  
static transmission path  
PDOPpler | RAYleigh | RICE | CUSTom | SCM  
pure Doppler | Rayleigh | Rice | Custom | SCM
**Remote-Control Commands**

**Delay Modes**

**CPHase**
constant phase

**OGAUs | TGAUs | DGAUs | GDOPpler | GFD8 | GFD1**
GAUS1 | GAUS2 | GAUSDAB | Gauss Doppler | Gauss (0.08 f_d) 
| Gauss (0.01 f_d)

**WATTerson**
Gauss (Watterson)

**WDOPpler | WRICe**
WiMAX Doppler | WiMAX Rice

**BELLindoor | BELVehicle**
Bell Shape tgn Indoor, Bell Shape tgn Moving Vehicle

*RST: RAYLeigh

**Options:**
OGAUs|TGAUs|DGAUs|GDOPpler|GFD8|GFD1|WATTerson |
WDOPpler|WRICe require R&S SMW-K72
BELLindoor|BELVehicle require R&S SMW-B14
SCM require R&S SMW-K73
CUSTom require R&S SMW-K820

**Manual operation:** See "Profile" on page 49

---

```plaintext
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:SPEed <Speed>
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:SPEed <Speed>
```

Sets the speed v of the moving receiver.

**Parameters:**

<Speed> float
- Range: 0 to dynamic
- Increment: 0.001
- *RST: 0.83333

**Example:**

```
FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO PATH2:SPE 2MPS
```

sets a speed of 2 m/s for the moving receiver for fading path 2 of group 1.

**Manual operation:** See "Speed" on page 52

---

```plaintext
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:STATe <State>
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:STATe <State>
```

Activates the selected path.

**Parameters:**

<State> 0 | 1 | OFF | ON
- *RST: 0
Example:

FSIM:DEL:STAT ON
Activates the “Standard Delay” fading configuration.
FSIM:DEL:GRO:PATH2:STAT ON
Activates fading path 2 in group 1.

Manual operation:
See “State Path” on page 48

[:SOURce<hw>]:FSIMulator:DELay|DEL:STATe <State>
Activates the fading configurations.

Note: Changing the configuration will cause an interruption in the fading process, followed by a restart after about one second.

Parameters:

<table>
<thead>
<tr>
<th>&lt;State&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
</tr>
</tbody>
</table>

*RST: 0

Example:

FSIM:DEL:STAT ON
Activates the “Standard Delay” fading configuration for fader A and switches on fading for path A.

7.3 Birth Death

Option: R&S SMW-K71

[:SOURce<hw>]:FSIMulator:BIrTDeath:DELay:GRID
[:SOURce<hw>]:FSIMulator:BIrTDeath:DELay:MINimum
[:SOURce<hw>]:FSIMulator:BIrTDeath:DELay:MAXimum?
[:SOURce<hw>]:FSIMulator:BIrTDeath:HOPping:DWELL
[:SOURce<hw>]:FSIMulator:BIrTDeath:PATH<ch>:LOSS
[:SOURce<hw>]:FSIMulator:BIrTDeath:PATH<ch>:PROFile
[:SOURce<hw>]:FSIMulator:BIrTDeath:POsitions
[:SOURce<hw>]:FSIMulator:BIrTDeath:SOFFset
[:SOURce<hw>]:FSIMulator:BIrTDeath:SPeed
[:SOURce<hw>]:FSIMulator:BIrTDeath:FRATio
[:SOURce<hw>]:FSIMulator:BIrTDeath:PATH<ch>:FDOPpler?
[:SOURce<hw>]:FSIMulator:BIrTDeath:PATH<ch>:FDOPpler:ACTual?
[:SOURce<hw>]:FSIMulator:BIrTDeath:STATe

[:SOURce<hw>]:FSIMulator:BIrTDeath:DELay:GRID <Grid>
Sets the delay grid for both paths with birth death propagation fading.

Parameters:

<table>
<thead>
<tr>
<th>&lt;Grid&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>float</td>
</tr>
</tbody>
</table>

Range: 1E-9 to dynamic
Increment: 1E-9

*RST: 1E-6
Example:  
FSIM:BIRT:DEL:GRID 0.00001  
Sets a delay grid of 10 us.

Manual operation:  See "Delay Grid" on page 60

[[:SOURce<hw>]:FSlMulator:BIRThdeath:DELay:MINimum <Minimum>  
[:SOURce<hw>]:FSlMulator:BIRThdeath:DELay:MAXimum?]

Queries the minimum/maximum delay for both paths with birth death propagation fading.

Return values:

<Maximum>  
float
Range: 0 to max

Example:  
FSIM:BIRT:DEL:MIN 0.000012  
Sets a minimum delay of 12 us.
FSIM:BIRT:DEL:GRID 0.000002  
sets a delay grid of 2 us.
FSIM:BIRT:POS 9  
s sets 9 possible hop positions.
FSIM:BIRT:DEL:MAX?  
queries the maximum delay.
Response: 0.000028  
the maximum delay is 28 us. The delay range lies between +12 and +28 us. There are 9 hop positions on a 2 us grid available.

Usage:  
Query only

Manual operation:  See "Maximum Delay" on page 61

[[:SOURce<hw>]:FSlMulator:BIRThdeath:HOPPing:DWELl <Dwell>]

Sets the time until the next change in the delay of a path (birth death event).

Parameters:

<Dwell>  
float
Range: 1E-3 to 429.49672950  
Increment: 100E-9  
*RST: 191E-3

Example:  
FSIM:BIRT:HOPP:DWEL 210 ms  
Sets a dwell time of 210 ms until the next change in the delay of a fading path.

Manual operation:  See "Hopping Dwell" on page 61

[[:SOURce<hw>]:FSlMulator:BIRThdeath:PATH<ch>:LOSS <Loss>]

Sets the loss of the paths with birth death propagation.
**Parameters:**

<Loss>
- **Type:** float
- **Range:** 0 to 50
- **Increment:** 0.001
- **RST:** 0
- **Default unit:** dB

**Example:**

```
FSIM:BIRT:PATH2:LOSS 4 dB
```

Sets a loss of 4 dB for the second fading path.

**Manual operation:** See "Path Loss" on page 60

---

**[:SOURce<hw>]:FSIMulator:BIRTdeath:PATH<ch>:PROFile <Profile>**

This command queries the fading profile. In birth death propagation, the pure Doppler profile is used.

**Parameters:**

<Profile>
- **Type:** PDOPpler
- **RST:** PDOPpler

**Example:**

```
FSIM:BIRT:PATH2:PROF?
```

Queries the profile of the second fading path.

**Manual operation:** See "Profile" on page 60

---

**[:SOURce<hw>]:FSIMulator:BIRTdeath:POSitions <Positions>**

Sets the number of possible hop positions in the delay range.

```
0 us < ( . . .:BIRT:POS – 1) x . . .:DEL:GRID + . . .:DEL:MIN < 40 us
```

**Parameters:**

<Positions>
- **Type:** integer
- **Range:** 3 to 50
- **RST:** 11

**Example:**

```
FSIM:BIRT:POS 11
```

Sets 11 possible delay positions.

**Manual operation:** See "Positions" on page 60

---

**[:SOURce<hw>]:FSIMulator:BIRTdeath:SOFFset <Soffset>**

Sets the time until the start of the next birth death event. With dual-channel fading, this allows the user to intentionally displace the birth death events of the two faders with respect to one another.
Parameters:  
<Soffset>  
float  
Range: 0 to 429  
Increment: 100E-9  
*RST: 0  
Example:  
FSIM:BIRT:SOFF 21E-6  
Sets a start offset of 21 us.  
Manual operation:  
See "Start Offset" on page 61

[:SOURce<hw>]:FSIMulator:BIRTHdeath:SPEed <Speed>  
Sets the speed of the moving receiver for birth death propagation.  
The default speed unit is m/s. Units different than the default one must be specified.  
Parameters:  
<Speed>  
float  
Range: 0 to dynamic  
Increment: 0.001  
*RST: 0  
Default unit: m/s  
Example:  
SOURce1:FSIMulator:BIRTHdeath:SPEed 100 KMH  
SOURce1:FSIMulator:BIRTHdeath:PATH1:FDOPpler?  // 92.6574343641427  
SOURce1:FSIMulator:BIRTHdeath:FRATio 1  
SOURce1:FSIMulator:BIRTHdeath:FRATio 0.5  
SOURce1:FSIMulator:BIRTHdeath:PATH1:FDOPpler:ACTual?  // 46.33  
Manual operation:  
See "Speed" on page 62

[:SOURce<hw>]:FSIMulator:BIRTHdeath:FRATio <FRatio>  
Sets the ratio of the actual Doppler frequency to the set Doppler frequency with birth death propagation fading.  
Parameters:  
<FRatio>  
float  
Range: -1 to 1  
Increment: 0.0001  
*RST: 1  
Example:  
See [:SOURce<hw>]:FSIMulator:BIRTHdeath:SPEed on page 178  
Manual operation:  
See "Frequency Ratio" on page 62
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler?

Queries the resulting Doppler frequency with birth death propagation.

Return values:
- `<FDoppler>` float
  - Range: 0 to 1000
  - Increment: 0.01
  - *RST: 0

Example: See [:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed on page 178

Usage: Query only

Manual operation: See "Resulting Doppler Shift" on page 62

[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler:ACTual?

Queries the actual Doppler frequency.

Return values:
- `<ActDoppler>` float
  - Range: -1600 to 1600
  - Increment: 0.01
  - *RST: 0

Example: See [:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed on page 178

Usage: Query only

Manual operation: See "Actual Doppler Shift" on page 63

[:SOURce<hw>]:FSIMulator:BIRThdeath:STATe <State>

This command selects the birth death propagation fading configuration and switches the fading simulation on and off.

Parameters:
- `<State>` 0 | 1 | OFF | ON
  - *RST: 0

Example: SOUR2:FSIM:BIRT:STAT ON
Selects birth death propagation for fader B and switches on fading in path B.

Manual operation: See "Configuration" on page 30

# 7.4 High Speed Train

Option: R&S SMW-K71.
Example: Enabling and configuring a high speed train propagation

The following is an example on how to configure the settings without using a predefined standard.

SOURce1:FSIMulator:CONFiguration HSTRain
SOURce1:FSIMulator:HSTRain:PROFile PDOPpler
SOURce1:FSIMulator:HSTRain:SPEed 100kmh
SOURce1:FSIMulator:HSTRain:DISTance:MINimum 20m
SOURce1:FSIMulator:HSTRain:DISTance:STARt 2000m
SOURce1:FSIMulator:HSTRain:PATH:STATe ON
SOURce1:FSIMulator:HSTRain:STATe ON
SOURce1:FSIMulator:HSTRain:FDOPpler?
  // 92.657 Hz

Example: Configuring a high speed train scenario for BS tests

The following is an example on how to configure fading simulator to generate a HST BS test signal according to 3GPP TS36.104.

For frequency Band 1 tests, the specification defines:

\[ F_{DL} = 2.14 \text{ GHz}, \quad F_{UL} = 1.95 \text{ GHz} \]

and \( F_D = 1140 \text{ Hz} \)

SOURce1:FSIMulator:PRESet
SOURce1:FSIMulator:STANdard G3HST1OSDU
SOURce1:FREQuency:CW 1.95E9
SOURce1:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe ON
SOURce1:FSIMulator:HSTRain:DOWNlink:FREQuency 2.14E9
SOURce1:FSIMulator:HSTRain:PATH:STATe ON
SOURce1:FSIMulator:HSTRain:STATe ON
SOURce1:FSIMulator:HSTRain:FDOPpler?
  // 1136.89307687654

[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:MINimum <Minimum>

Sets the parameter \( D_{min} \), i.e. the distance between the BS and the railway track.
Parameters:

- **<Minimum>**
  - **float**
  - **Range:** 1 to 100
  - **Increment:** 0.1
  - **RST:** 2

Example:

- See Example "Enabling and configuring a high speed train propagation" on page 180

Manual operation:

- See "D (min)" on page 84

---

`[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:STARt <Start>`

Sets the parameter $D_S$, i.e. the initial distance $D_S/2$ between the train and the BS at the beginning of the simulation.

Parameters:

- **<Start>**
  - **integer**
  - **Range:** 20 to 2000
  - **RST:** 300

Example:

- See Example "Enabling and configuring a high speed train propagation" on page 180

Manual operation:

- See "D (S)" on page 84

---

`[:SOURce<hw>]:FSIMulator:HSTRain:SPEed <Speed>`

Sets the velocity parameter , i.e. the speed of the moving receiver in m/s.

Parameters:

- **<Speed>**
  - **float**
  - **Range:** 0.001 to dynamic
  - **Increment:** 0.001
  - **RST:** 83.333

Example:

- See Example "Enabling and configuring a high speed train propagation" on page 180

Manual operation:

- See "Speed" on page 84

---

`[:SOURce<hw>]:FSIMulator:HSTRain:FDOPpler?`

Queries the maximum Doppler Shift for the selected configuration.

Return values:

- **<FDoppler>**
  - **float**
  - **Range:** 0 to 1000
  - **Increment:** 0.01
  - **RST:** 0
Example: See Example “Configuring a high speed train scenario for BS tests” on page 180

Usage: Query only

Manual operation: See “Profile” on page 83

[:SOURce<hw>]:FSIMulator:HSTRain:PATH:STATe <State>
Activates/deactivates the selected path for the High Speed Train fading configurations.

Parameters:
<State> 0 | 1 | OFF | ON
*RST: 1

Example: See Example “Enabling and configuring a high speed train propagation” on page 180

Manual operation: See “State Path” on page 48

[:SOURce<hw>]:FSIMulator:HSTRain:PROFile <Profile>
Determines the fading profile for the selected scenario. The fading profile determines which transmission path is simulated.

Parameters:
<Profile> SPATH | PDOPpler | RAYleigh
*RST: PDOPpler

Example: See Example “Enabling and configuring a high speed train propagation” on page 180

Manual operation: See “Profile” on page 83

[:SOURce<hw>]:FSIMulator:HSTRain:KFACtor <KFactor>
Sets the Rician factor K for high speed train scenario 2.

Parameters:
<KFactor> float
Range: -30 to 30
Increment: 0.01
*RST: 10


Manual operation: See “K (Rician factor)” on page 84
[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe \<HstDlFreqState>

Enables the definition of virtual downlink frequency.

Parameters:
\<HstDlFreqState> 0 | 1 | OFF | ON
*RST: 0

Example: See Example "Configuring a high speed train scenario for BS tests" on page 180

Manual operation: See "Consider DL RF" on page 84

[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency \<HstDlFreq>

Sets the virtual downlink frequency, necessary to calculate the UL Doppler shift.

Parameters:
\<HstDlFreq> float
Range: 100E3 to 6E9
Increment: 0.01
*RST: 1E9

Example: See Example "Configuring a high speed train scenario for BS tests" on page 180

Manual operation: See "Virtual DL RF" on page 85

[:SOURce<hw>]:FSIMulator:HSTRain:STATe \<State>

Activates/deactivates simulation of High Speed Train propagation according to the selected scenario 1 or 3.

Parameters:
\<State> 0 | 1 | OFF | ON
*RST: 0

Example: See Example "Enabling and configuring a high speed train propagation" on page 180

Manual operation: See "Configuration" on page 30
See "State" on page 83

### 7.5 Moving Propagation

Option: R&S SMW-K71.

[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:VPERiod
[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:DELay:VARiation
[:SOURce<hw>]:FSIMulator:MDELay:CHANnel:MODE
Moving Propagation

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:CPHase ............................. 185
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DElay:MEAN ............................................. 185
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DElay:VARiation ........................................... 186
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:LOSS ......................................................... 186
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:STATE ..................................................... 187
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:VPERiod ................................................... 187
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:DElay .................................................... 187
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:LOSS .................................................... 187
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:STATE .................................................. 188
[:SOURce<hw>]:FSIMulator:MDELay:STATE ................................................................. 188

[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:VPERiod <VPeriod>

Sets the speed of the delay variation of the moving fading paths for moving propagation with all moving channels. A complete cycle comprises one pass through this "Variation Period".

Parameters:

<VPeriod> float
Range: 5 to 200
Increment: 0.1
*RST: 25

Example:
FSIM:CONF MDEL
Selects a moving propagation configuration.
FSIM:MDEL:CHAN:MODE ALL
enables all moving channels.
FSIM:MDEL:STAT ON
activates the moving propagation for fader A.
FSIM:MDEL:ALL:MOV:VPER 50 s
sets the period for the delay variation to 100 s.

Manual operation: See "Variation Period" on page 71

[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:DElay:VARiation <Variation>

This command enters the range for the delay of the moving fading paths for moving propagation with all moving channels. The delay of the moving path slowly varies sinusoidally within this range.

Parameters:

<Variation> float
Range: 0.3E-6 to 10E-6
Increment: 10E-9
*RST: 5E-6

Manual operation: See "Delay" on page 71
Example:

FSIM:CONF MDEL
Selects a moving propagation configuration.
FSIM:MDEL:CHAN:MODE ALL
enables all moving channels.
FSIM:MDEL:STAT ON
activates the moving propagation for fader A.
sets the range 10 us for the delay of the moving fading path.

Manual operation: See "Delay Variation (Peak-Peak)" on page 71

[:SOURce<hw>]:FSImulator:MDELay:CHANnel:MODE <Mode>
Determines whether only one or several moving channels are simulated.

Parameters:
<Mode> ONE | ALL
*RST: ONE

Example:

FSIM:CONF MDEL
Selects a moving propagation configuration.
FSIM:MDEL:CHAN:MODE ALL
enables all moving channels.

Manual operation: See "Moving Channels" on page 33

[:SOURce<hw>]:FSImulator:MDELay:DEL30:GROup<st>:PATH<ch>:CPHase
These commands determine the phase for constant phase fading for the "Standard Delay", and "Moving Propagation All Moving Channels" fading configurations.

Parameters:
<CPhase> float
Range: 0 to 359.9
Increment: 0.1
*RST: 0

Example:

FSIM:DEL:STAT ON
Activates the Standard Delay fading configuration.
FSIM:DEL:GRO2:PATH:PROF CPH
selects the Constant Phase fading profile for fading path 1 of group 2.
FSIM:DEL:GRO2:PATH:CPH 5DEG
sets a phase of 5 DEG for fading path 1 of group 2. The path is multiplied by this phase.

[:SOURce<hw>]:FSImulator:MDELay:MOVing:DELay:MEAN <Mean>
Sets the mean delay of the moving fading path for moving propagation.
Parameters:
<Mean> float
Range: 0 to 40E-6
Increment: 10E-9
*RST: 3.5E-6

Example:
FSIM:MDEL:STAT ON
Sets moving propagation.
sets the range 10 us (+/- 5 us) for the variation of the delay of the moving fading path.
FSIM:MDEL:MOV:MEAN 9E-6
sets the mean delay of the moving path to 9 us.
FSIM:MDEL:MOV:VPER 105
sets a period of 105 s for the sinusoidal variation of the delay of the moving path. The delay of the moving path now varies once sinusoidal in 105 s between 4 us and 14 us.

Manual operation: See "Delay" on page 69

[:SOURce<hw>]:FSIMulator:MDELAY:MOVing:DELAY:VARIation <Variation>
Enters the range for the delay of the moving fading path for moving propagation. The delay of the moving path slowly varies sinusoidal within this range.

Parameters:
<Variation> float
Range: 0.3E-6 to dynamic
Increment: 10E-9
*RST: 5E-6

Example:
Sets the range 10 us for the delay of the moving fading path.

Manual operation: See "Variation (Peak-Peak)" on page 69

[:SOURce<hw>]:FSIMulator:MDELAY:MOVing:LOSS <Loss>
Sets the insertion loss of the moving path for moving propagation.

Parameters:
<Loss> float
Range: 0 to 50
Increment: 0.001
*RST: 0

Example:
FSIM:MDEL:MOV:LOSS 12 dB
Sets the loss for the moving fading path.

Manual operation: See "Path Loss" on page 69
[:SOURce<hw>]:FSIMulator:MDELAY:MOVing:STATE <State>

This command activates the moving fading path for moving propagation.

Parameters:

<table>
<thead>
<tr>
<th>&lt;State&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
</tr>
</tbody>
</table>

*RST:  1

Example:

FSIM:MDEL:STAT ON
Sets moving propagation.
FSIM:MDEL:MOV:STAT ON
activates the moving path for moving propagation.

Manual operation: See "State" on page 69

[:SOURce<hw>]:FSIMulator:MDELAY:MOVing:VPERiod <VPeriod>

This command sets the speed of the delay variation of the moving fading path for moving propagation. A complete cycle comprises one pass through this "Variation Period".

Parameters:

| <VPeriod> | float |
|-----------|
| Range: 10 to 500 |
| Increment: 0.1 |

*RST:  157

Example:

FSIM:MDEL:MOV:VPER 100 s
Sets the period for the delay variation to 100 s.

Manual operation: See "Variation Period" on page 70

[:SOURce<hw>]:FSIMulator:MDELAY:REFERENCE:DELAY <Delay>

This command enters the delay of the reference path for moving propagation.

Parameters:

| <Delay> | float |
|---------|
| Range: 0 to 40E-6 |
| Increment: 10E-9 |

*RST:  0

Example:

FSIM:MDEL:REF:DEL 1E-5
Sets the range to 10 us for the delay of the reference path.

Manual operation: See "Delay" on page 69

[:SOURce<hw>]:FSIMulator:MDELAY:REFERENCE:LOSS <Loss>

Sets the loss of the reference path for moving propagation.
Parameters:

<Loss> float
Range: 0 to 50
Increment: 0.001
*RST: 0

Example: FSIM:MDEL:REF:LOSS 12 dB
Sets the insertion loss for the reference path.

Manual operation: See "Path Loss" on page 69

[:SOURce<hw>]:FSIMulator:MDELay:REFerence:STATe <State>

This command activates the reference path for moving propagation.

Parameters:

<State> 0 | 1 | OFF | ON
*RST: 1

Example: FSIM:MDEL:STAT ON
Sets moving propagation.
FSIM:MDEL:REF:STAT ON
activates the reference path for moving propagation.

Manual operation: See "State" on page 69

[:SOURce<hw>]:FSIMulator:MDELay:STATe <State>

This command activates the moving propagation fading configuration. The paths and the fading simulator must be switched on separately (SOURce:FSIMulator:MDELay:MOVing|REFerence:STATe ON and SOURce:FSIMulator ON).

Parameters:

<State> 0 | 1 | OFF | ON
*RST: 0

Example: FSIM:MDEL:STAT ON
Sets moving propagation for fader A.

Manual operation: See "Configuration" on page 30

7.6 MIMO Settings

The MIMO configurations require additional options:

• For up to 2x2 MIMO configurations, 2x option R&S SMW-B14/B15 and R&S SMW-K74
• The LxMxN MIMO configurations with M > 2 or N > 2 require 4xR&S SMW-B14/B15 and R&S SMW-K74
- Higher order MIMO configurations require R&S SMW-K75
- Multi entity LxMxN configurations with L > 2 require also R&S SMW-K76

These options apply to all commands in this section. If further options are required, there are listed in the corresponding command.

- [:SOURce<hw>:FsiMulator:MIMO:CAPability?]
- [:SOURce<hw>:FsiMulator:MIMO:COPY:NEXT]
- [:SOURce<hw>:FsiMulator:MIMO:COPY:ALL]
- [:SOURce<hw>:FsiMulator:MIMO:COPY:PREVious]
- [:SOURce<hw>:FsiMulator:MIMO:MDLoad]
- [:SOURce<hw>:FsiMulator:MIMO:MDSTore]
- [:SOURce<hw>:FsiMulator:MIMO:TAP]
- [:SOURce<hw>:FsiMulator:MIMO:TAP<ch>:MATRix:ACCept]
- [:SOURce<hw>:FsiMulator:MIMO:TAP<ch>:MATRix:MODE]
- [:SOURce<hw>:FsiMulator:MIMO:TAP<ch>:GVEctor:PRESet]
- [:SOURce<hw>:FsiMulator:MIMO:TAP<ch>:GVEctor<st>:GAIN]
- [:SOURce<hw>:FsiMulator:MIMO:TAP<ch>:GVEctor<st>:PHASE]

### [:SOURce<hw>:FsiMulator:MIMO:CAPability?]

Queries the supported MIMO configurations.

**Return values:**

- `<MimoCapability>` string

**Example:**

```plaintext
:SOURce1:FsiMulator:MIMO:CAPability?
Response: "M2X2,M2X4,M4X2,M2X3,M3X2,M1X2,..."
```

**Usage:** Query only
[:SOURce<hw>]:FSIMulator:MIMO:COPY:NEXT
Copies the matrix values of the current tap to the subsequent tap. If the current tap is the last tap, the command is discarded.

See also [:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL on page 190.

Usage: Event
Manual operation: See "Copy To Next" on page 99

[:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL
Applies the matrix values of the current tap to all taps.

Usage: Event
Manual operation: See "Copy To All" on page 99

[:SOURce<hw>]:FSIMulator:MIMO:COPY:PREVious
This command copies the matrix values of the current tap to the next lower tap.

Example: FSIM:MIMO:COPY:PREV
Copies the settings of the current tap to the next lower tap.

Usage: Event

[:SOURce<hw>]:FSIMulator:MIMO:MDLoad <MDLoad>
Loads file with saved MIMO settings.

Setting parameters:
<MDLoad> string

Example: FSIM:MIMO:MDL 'MIMO_Settings'
Loads the settings file.

Usage: Setting only

[:SOURce<hw>]:FSIMulator:MIMO:MDSTore <MDStore>
Saves the MIMO settings in a file.

Setting parameters:
<MDStore> string

Example: FSIM:MIMO:MDST 'MIMO_Settings'
Saves the MIMO settings in a file.

Usage: Setting only
[:SOURce<hw>]:FSIMulator:MIMO:TAP <Tap>

Sets the current tap.

Parameters:
<Tap>  TAP1 | TAP2 | TAP3 | TAP4 | TAP5 | TAP6 | TAP7 | TAP8 | TAP9 | TAP10 | TAP11 | TAP12 | TAP13 | TAP14 | TAP15 | TAP16 | TAP17 | TAP18 | TAP19 | TAP20
*RST: TAP1

Example:  SOURce1:FSIMulator:MIMO:TAP TAP15


[:SOURce<hw>]:FSIMulator:MIMO:SUBSet <Subset>

In 8x8 MIMO configuration, sets the subset of MIMO channels that is calculated by the particular R&S SMW.

Parameters:
<Subset>  ALL | SET2 | SET1
*RST: SET1
Example:

In the following, we assume that the two R&S SMW are connected and configured as required. The example uses R&S SGS as RF extensions and the internal baseband signal of the first R&S SMW as trigger source for both instruments. If you use common external trigger source, consider to adapt the proposed configuration.

*RST
// Select 8x8 MIMO and set MIMO subset
SCONfiguration:MODE ADV
SOURce1:FSIMulator:ROUTE FA1A2BF1A2BM88
SOURce1:FSIMulator:MIMO:SUBSet SET1
SCONfiguration:APPLY
// the instrument generates streams A to D
// configure connectors for synchronous baseband triggering
// alternatively, use an external common trigger source
SOURce1:INPut:USER6:DIRection OUTP
OUTPut1:USER6:SIGNal MTR
// configure the fading simulator
// enable synchronization of the fading process to the baseband trigger
SOURce1:FSIMulator:RESTart:MODE BBTR
SOURce1:FSIMulator:STATe 1
// configure the baseband signal
// incl trigger settings required for the synch. baseband triggering
// if external common trigger is used,
// consider to adapt the configuration
SOURce1:BB:EUTRa:TRIGger:SEQuence ARET
SOURce1:BB:EUTRa:TRIGger:SOURce EGT1
SOURce1:BB:EUTRa:STATe 1
// set RF and level
SOURce1:FREQuency:CW 1950000000
SOURce2:FREQuency:CW 1950000000
SOURce1:POWer:POWer -50
SOURce2:POWer:POWer -50
// connect and configure the RF extensions
// for example R&S SGS
SOURce1:IQ:OUTPut:ANALog:STATe 1
SOURce2:IQ:OUTPut:ANALog:STATe 1
...
// activate the outputs
SOURce2:IQ:STATe 1
SOURce1:IQ:STATe 1
OUTPut2:STATe 1
OUTPut1:STATe 1
// save the configuration
*SAV 1
:MMEMory:STORE:STATe 1,"/var/user/8x8_MIMO_Subset1.savrcl.txt"
// transfer to file to the second instrument
// load the configuration and change the subset
SOURcel:FSIMulator:MIMO:SUBSet SET2

// trigger the baseband signal generation and hence the fading process
OUTPut1:USER6:TRIGger:IMMediate

Options: R&S SMW-K821

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
  ROW<di>:COLumn<st>:IMAGinary <Imaginary>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
  ROW<di>:COLumn<st>:IMAGinary <Imaginary>

Sets the value for the imaginary part of the receiver/transmitter correlation.

Note: If the values for the real part and the imaginary part are both set to 0, the phase value is set to 0 when changing the data format.

Parameters:
<Imaginary> float
  Range: -1 to 1
  Increment: 0.001
  *RST: 0

Example: SOURcel:FSIMulator:MIMO:TAP2:KRONecker:
  CORRelation:TX:ROW1:COLumn2:IMAGinary 0.5
  Sets the imaginary part of the Tx correlation AB to 0.5.

Manual operation: See "Tx Correlation Coefficients, Phase/Imag" on page 105

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
  ROW<di>:COLumn<st>:PHASe <Phase>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
  ROW<di>:COLumn<st>:PHASe <Phase>

Sets the value for the phase of the receiver/transmitter correlation.

Note: If the values for the real part and the imaginary part are both set to 0, the phase value is set to 0 when changing the data format.

Parameters:
<Phase> float
  Range: 0 to 360
  Increment: 0.02
  *RST: 0

Example: SOURcel:FSIMulator:MIMO:TAP2:KRONecker:
  CORRelation:TX:ROW1:COLumn2:PHASe 30
  Sets the phase of the Tx correlation AB to 30 degrees.

Manual operation: See "Tx Correlation Coefficients, Phase/Imag" on page 105
Sets the ratio of the receiver/transmitter correlation.

**Note:** If the values for the real part and the imaginary part are both set to 0, the phase value is set to 0 when changing the data format.

**Parameters:**
- `<Magnitude>`: float
  - Range: 0 to 1
  - Increment: 1E-4
  - *RST*: 0

**Example:**
```
```
Sets the ratio of the Tx correlation AB to 0.5.

**Manual operation:** See "Tx Correlation Coefficients, Magnitude/Real" on page 105

---

Sets the value for the real part of the receiver/transmitter correlation.

**Note:** If the values for the real part and the imaginary part are both set to 0, the phase value is set to 0 when changing the data format.

**Parameters:**
- `<Real>`: float
  - Range: -1 to 1
  - Increment: 0.001
  - *RST*: 0

**Example:**
```
SOURcel:FSIMulator:MIMO:TAP2:KRONecker:CORRelation:TX:ROW1:COLumn2:REAL 0.5
```
Sets the value for the real part of the Tx correlation AB to 0.5.

**Manual operation:** See "Tx Correlation Coefficients, Magnitude/Real" on page 105

---

Accepts the values for the phase/imaginary and the real/ration part of the correlation.

**Example:**
```
FSIM:MIMO:TAP2:MATR:ACC
```

**Usage:** Event

**Options:** R&S SMW-K71/-K74

**Manual operation:** See "Accept" on page 102
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:CONFLICT?
Queries whether there is a matrix conflict or not.

Return values:
<Conflict> 0 | 1 | OFF | ON

Example: FSIM:MIMO:TAP2:MATR:CONF?
Queries whether there is a matrix conflict or not

Usage: Query only

Options: R&S SMW-K71/-K74

Manual operation: See "Conflict" on page 102

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:MODE <Mode>
Sets the input mode for the Rx and Tx correlation values (matrix mode).

Parameters:
<Mode> INDividual | KRONecker | AOAaod | SCWI
*RST: INDividual

Example: FSIM:MIMO:TAP2:MATR:MODE IND
Selects the matrix mode individual.

Options: R&S SMW-K71/-K74

Manual operation: See "Matrix Mode" on page 99

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>: PHASE <Phase>
Sets the value for the phase/imaginary part of the correlation.

Suffix:
<di> 1 to 4
<st> 1 to 4

Parameters:
<Phase> float
Range: 0 to 360
Increment: 0.02
*RST: 0

Example: FSIM:MIMO:TAP2:MATR:ROW1:COL1:PHAS 90
Sets the correlation value to the specified value.

Options: R&S SMW-K71/-K74

Manual operation: See "Phase/Imag" on page 102
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:MAGNitude <Magnitude>

Determines the value for the real/magnitude part of the correlation.

**Suffix:**
- `<di>`: 1 to 4
- `<st>`: 1 to 4

**Parameters:**
- `<Magnitude>`: float
  - Range: 0 to 1
  - Increment: 0.0001
  - *RST: 1

**Example:**
```
FSIM:MIMO:TAP2:MATR:ROW1:COL1:MAGN 0.5
```
Sets the correlation value to the specified value.

**Options:**
R&S SMW-K71/-K74

**Manual operation:** See "Real/Magnitude" on page 102

---

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:PRESet

The command presets the vector matrix to an unitary matrix.

**Example:**
```
FSIM:MIMO:TAP2:GVEC:PRES
```
Resets the gain vector matrix.

**Usage:**
Event

**Manual operation:** See "Set to Unity" on page 103

---

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:GAIN <Gain>

Sets the relative gain in the selected path.

**Suffix:**
- `<st>`: 1 to 8

**Parameters:**
- `<Gain>`: float
  - Range: -50 to 0
  - Increment: 0.01
  - *RST: 0

**Example:**
```
SOURce1:FSIMulator:MIMO:TAP2:GVECtor1:GAIN -3
```
Decreases the level in path AA by 3 dB.

**Manual operation:** See "Gain" on page 104
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:PHASe <Phase>

Sets the phase shift of the selected path.

Suffix:
<st> 1 to 8

Parameters:
<Phase> float
Range: 0 to 360
Increment: 0.02
*RST: 0

Example: SOURc1:FSIMulator:MIMO:TAP2:GVECtor1:PHASe 45
Shifts the phase in path AA by 45 degree.

Options: R&S SMW-K820

Manual operation: See "Phase" on page 104

7.7 TGn Settings

Option: R&S SMW-K74.

Example: Simulating one path TGn fading with two rays with different distributions
In the following example we assume that a MIMO fading configuration is enabled, e.g 2x2 MIMO. One MIMO path is activated, the default path settings are used.

```
// ******************************************************************
// Enable the corresponding matrix mode and set the relevant SCM settings
// ******************************************************************
SOURce:FSIMulator:MIMO:TAP:MATRix:MODE AOAaod
SOURce:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX 0.5
SOURce:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX 0.5

// ******************************************************************
// Set ray#1 to simulate signal scattered by obstacles causing static fading distribution, e.g. a building
// ******************************************************************
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:GAIN 0
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:ARRival:ANGLe 72
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:DEParture:ANGLe 15
SOURce:FSIMulator:MIMO:TAP:TGN:DISTRIBUTion EQUal
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:STATe ON

// ******************************************************************
```
// Set ray#2 to simulate signal scattered by obstacles causing Gaussian fading distribution, e.g. a tree
// ******************************************************************
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:GAIN -10
SOURce:FSIMulator:MIMO:TAP:TGN:DISTRIBUTion GAUSs
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:STATE ON
// ******************************************************************
// Query the resulting matrix correlation coefficients with the SOURce:FSIMulator:MIMO:TAP:MATRix:... commands
// ******************************************************************
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX ........................................ 198
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX ........................................ 198
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:DISTRIBUTion ..........................................198
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:ANGLE .......................199
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:ANGLE ................... 199
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:SPRead ..................... 199
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:SPRead ..................199
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:GAIN ...................................... 199
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:STATE .....................................200

[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX <DistanceRx>
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX <DistanceTx>

Sets the RX/TX antenna distance in the SCM fading model.

Parameters:
<DistanceTx>  float
Range: 0.1 to 2
Increment: 0.1
*RST: 0.5

Example:  See Example "Simulating one path TGn fading with two rays with different distributions" on page 197.

Manual operation:  See "RX/TX Antenna Distance" on page 107

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:DISTRIBUTion <Distribution>

Selects one of the proposed statistical functions to determine the distribution of the selected cluster.

Parameters:
<Distribution>  LAPLace | GAUSs | EQUal
*RST: EQUal
Remote-Control Commands

Example: See Example “Simulating one path TGn fading with two rays with different distributions” on page 197.

Manual operation: See "Distribution" on page 108

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:ANGLE <DepAngle>

Sets the AoA (Angle of Arrival) / AoD (Angle of Departure) of the selected ray.

Parameters:
<DepAngle> float
Range: 0 to 359.999
Increment: 0.001
*RST: 0

<ArrAngle> float
Range: 0 to 359.999
Increment: 0.001
*RST: 0

Example: See Example “Simulating one path TGn fading with two rays with different distributions” on page 197.

Manual operation: See "Angle of Departure (AoD)" on page 108

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:SPRead <ArrSpread>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:SPRead <DepSpread>

Sets the AoD (Angle of Departure) / AoA (Angle of Arrival) spread (AS) of the selected ray.

Parameters:
<DepSpread> float
Range: 0.1 to 75
Increment: 0.001
*RST: 0.1

Example: See Example “Simulating one path TGn fading with two rays with different distributions” on page 197.

Manual operation: See "AoD Spread" on page 108

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:GAIN <Gain>

Sets the relative gain (in dB) of the selected ray.
Parameters:

<Gain>  
float  
Range:  -50 to 0  
Increment:  0.001  
*RST:  0  

Example:  See Example “Simulating one path TGn fading with two rays with different distributions” on page 197.  

Manual operation:  See "Relative Gain /dB" on page 107

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGn:RAY<st>:STATe <RayState>

Enables/disables the selected ray.

Parameters:  
<RayState>  0 | 1 | OFF | ON  
*RST:  0  

Example:  See Example “Simulating one path TGn fading with two rays with different distributions” on page 197.  

Manual operation:  See "Ray State" on page 107

7.8 SCME/WINNER and Antenna Model Settings

Option: R&S SMW-K72/-K73.

Example: Configuring the settings in SCME/WINNER mode

The following is a simple example on how to configure the settings.
You can also load the configuration of predefined SCME models automatically, see:

- Chapter A.16, "SCM and SCME Channel Models for MIMO OTA", on page 296  
- [:SOURce<hw>]:FSIMulator:STANdard on page 154

// Enable 2x2 MIMO configuration  
SConfiguration:MODE ADVanced  
SConfiguration:FADing MIMO2X2  
SConfiguration:APPLY  

// select SCME/WINNER matrix mode  
// configure the spacial channel model  
SOURce1:FSIMulator:MIMO:TAP TAP1  
SOURce1:FSIMulator:MIMO:TAP1:MATRix:MODE SCWI  
SOURce1:FSIMulator:MIMO:SCWI:TAP1:SPEed 30kmh  
SOURce1:FSIMulator:DEL:GROup1:PATH1:SPEed?  
// Response:  8.333  
SOURce1:FSIMulator:MIMO:SCWI:TAP1:DOT 120  
SOURce1:FSIMulator:DEL:GROup1:PATH1:FRATio?  

//
Example: Configuring MIMO-OTA settings

The following is a simple example on how to configure and enable an antenna model.

```plaintext
SOURce:FSIMulator:STANdard G3SCMEUMI30
SOURce:FSIMulator:MIMO:TAP1:MATRix:MODE SCWI

// configure the Tx antenna array (BS)
SOURce:FSIMulator:MIMO:ANTenna:TX:PATTern SEC3
SOURce:FSIMulator:MIMO:ANTenna:TX:CALC:MODE SPAC
SOURce:FSIMulator:MIMO:ANTenna:TX:ESPacing:HORIZontal 0.5
SOURce:FSIMulator:MIMO:ANTenna:TX:COLumn:SIZE?
   // ANT02
SOURce:FSIMulator:MIMO:ANTenna:TX:ROWS:SIZE?
   // ANT02

SOURce:FSIMulator:MIMO:ANTenna:RX:PATTern ISO
SOURce:FSIMulator:MIMO:ANTenna:RX:COLumn:SIZE?
   // ANT02
SOURce:FSIMulator:MIMO:ANTenna:RX:ROWS:SIZE?
   // ANT02

SOURce:FSIMulator:MIMO:ANTenna:RX:CALC:MODE REL
// query predefined antenna pattern files (*.ant_pat)
SOURce:FSIMulator:MIMO:ANTenna:PATTern:CATalog?
   // 3Sector, 6Sector, Dipole, Isotropic
// query existing user defined antenna pattern files (*.ant_pat)
   // ant1_phases_pol, ant2_phases_pol
SOURce:FSIMulator:MIMO:ANTenna:RX:CALC:MODE USER
SOURce:FSIMulator:MIMO:ANTenna:RX:ANTenna1:PFILe "/var/user/ant1_phases_pol"
SOURce:FSIMulator:MIMO:ANTenna:RX:ANTenna2:PFILe "/var/user/ant2_phases_pol"
```
// apply inverse channel matrix
SOURce:FSIMulat:MI:ANTenna:INVerse:MATRix:STATe 1
SOURce:FSIMulat:MI:ANTenna:INVerse:MATRix:ROW1:COLumn2:REAL 0.3
SOURce:FSIMulat:MI:ANTenna:INVerse:MATRix:ROW2:COLumn1:IMAGin -0.82

// enable channel polarization
SOURce:FSIMulat:MI:ANTenna:MODeling:STATe 1
SOURce:FSIMulat:MI:ANTenna:POLarization:PRATio:VERTical 9
SOURce:FSIMulat:MI:ANTenna:POLarization:PRATio:HORizontal 9

// SOURce:FSIMulat:MI:ANTenna:TX:POLarization:ANGLe POLCROSS45

// SOURce:FSIMulat:MI:ANTenna:TX:ESPacing:CROSs 0

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:SPEed <Speed>
Sets the speed of the mobile station.
Parameters:
<Speed> float
Range: 0 to 27778
Increment: 0.001
*RST: 0.83333
Example: See Example "Configuring the settings in SCME/WINNER mode" on page 200
Manual operation: See "MS Speed" on page 110

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:DOT <DotAngle>
Sets the direction of travel of the mobile station.
Parameters:
<DotAngle> float
Range: 0 to 359.9
Increment: 0.1
*RST: 90
Example: See Example "Configuring the settings in SCME/WINNER mode" on page 200
Manual operation: See "MS DoT (Direction of Travel)" on page 110

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:STATe <State>
Enables/disables the selected cluster.
Parameters:
<State> 0 | 1 | OFF | ON
*RST: 0
Example: See Example "Configuring the settings in SCME/WINNER mode" on page 200
Manual operation: See "Cluster State" on page 110

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:GAIN <Gain>
Sets the relative gain (in dB) of the selected cluster.
Remote-Control Commands

SCME/WINNER and Antenna Model Settings

Parameters:
Gain
float
Range: -50 to 0
Increment: 0.001
*RST: 0

Example: See Example "Configuring the settings in SCME/WINNER mode" on page 200

Manual operation: See "Relative Gain /dB" on page 110

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:ANGLe <Angle>
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:ANGLe <Angle>
Sets the AoA (angle of arrival) / AoD (angle of departure) of the selected cluster.

Parameters:
Angle
float
Range: 0 to 359.999
Increment: 0.001
*RST: 0

Example: See Example "Configuring the settings in SCME/WINNER mode" on page 200

Manual operation: See "Angle of Departure (AoD)" on page 111

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:SPRead
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:SPRead
Sets the AoA (angle of arrival) / AoD (angle of departure) spread (AS) of the selected cluster.

Parameters:
Spread
float
Range: 1 to 75
Increment: 0.001
*RST: 1

Example: See Example "Configuring the settings in SCME/WINNER mode" on page 200

Manual operation: See "AoD Spread" on page 111

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DIStribution <Distribution>
Sets one of the Power Azimuth Spectrum (PAS) distributions.
Parameters:
<Distribution> LAPlace | GAUSs | EQUal
*RST: EQUal
Example: See Example "Configuring the settings in SCME/WINNER mode" on page 200
Manual operation: See "Distribution" on page 111

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:SUBCluster<di>:STATe <State>

If the corresponding cluster is enabled, enables the sub-clusters.

Suffix: <di> 1 to 3 sub-cluster number
Parameters: <State> 0 | 1 | OFF | ON
*RST: 0
Example: SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:SUBCluster2:STATe 1
Manual operation: See "Subcluster > State" on page 110

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:SUBCluster<di>:GAIN?

Queries the resulting relative gain of an enabled sub-cluster.

Suffix: <di> 1 to 3 sub-cluster number
Return values: <Gain> float
Range: -50 to 0 Increment: 0.001
*RST: 0
Example: SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:SUBCluster2:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:GAIN 0
// Response: -5.299
Usage: Query only
Manual operation: See "Subcluster > Relative Gain /dB" on page 110
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:MODeling[:STATe] <AntennaState>
Enables/disables simulation of channel polarization.

Parameters:

<AntennaState> 0 | 1 | OFF | ON
*RST: 0

Example: See Example "Configuring MIMO-OTA settings" on page 201

Manual operation: See "Channel Polarization State" on page 129

[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:PATTern:MODE <AntModPatMode>
Sets way the software extracts or calculates the antenna polarization patterns.

Parameters:

<AntModPatMode> SEParate | SINGle
*RST: SINGle

Example: See Example "Configuring MIMO-OTA settings" on page 201

Options: SEParate requires option R&S SMW-K73

Manual operation: See "Antenna Polarization Mode" on page 129

[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:HORizontal <AntPolPowRatHor>
[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical <AntPolPowRatVer>
Sets the cross polarization power ratio (XPR) in dB.

Parameters:

<AntPolPowRatVer> float
Range: 0 to 20
Increment: 0.001
*RST: 9

Example: See Example "Configuring MIMO-OTA settings" on page 201

Manual operation: See "Vertical/Horizontal Cross Polarization Power Ratio" on page 129

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLe <AntRxPolAngle>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:POLarization:ANGLe <AntTxPolAngle>
Set the antenna element polarization slant angle.

Parameters:

<AntTxPolAngle> POLCROSS45 | POLCROSS90 | POLCO0 | POLCO90
POLCROSS45 | POLCROSS90
cross-polarization 45°/90°

POLCO0 | POLCO90
co-polarization 0°/90° (vertical/horizontal polarization)

*RST: POLCO0

Example: See Example "Configuring MIMO-OTA settings" on page 201

Manual operation: See "Antenna Polarization Slant Angle" on page 133

Sets the number of rows and the number of columns in the antenna array.

Parameters:
<AntModRxRowSize> ANT01 | ANT02 | ANT03 | ANT04 | ANT08
*RST: ANT01

Example: See Example "Configuring MIMO-OTA settings" on page 201

Manual operation: See "Number of Rows (M)/Columns (N)" on page 133

Sets how the distance between the antenna elements is defined: based on the physical distance or on the relative phase.

Parameters:
<AntModCalcRxMod> SPACing | RELativphase

SPACing
To set the distance, use the corresponding command, for example [:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:HORizontal.

RELativphase
Load an antenna pattern file that contains the relative phase description.
See Chapter B, "Antenna Pattern File Format", on page 329

*RST: SPACing

Example: See Example "Configuring MIMO-OTA settings" on page 201

Options: RELativphase requires option R&S SMW-K73

Manual operation: See "Calculation Mode" on page 134
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:CROSs <Cross>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:CROSs <Cross>
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontal
    <AntRxEspacHori>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:HORizontal
    <AntTxEspacHori>

Sets the polarized distance between the antennas in the antenna array.

Parameters:

<AntTxEspacHori> float
  Range: 0 to 10
  Increment: 0.01
  *RST: 0.5

<Cross> float
  Range: 0 to 10
  Increment: 0.01
  *RST: 0

Example: See Example "Configuring MIMO-OTA settings" on page 201.

Manual operation: See "Horizontal Spacing" on page 135

[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog?

Queries the available predefined antenna pattern files (*.ant_pat).

To query the user-defined antenna pattern files, use the command [:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER?.

Return values:

<Catalog> string
  Files names without file extension.

Example: See Example "Configuring MIMO-OTA settings" on page 201

Usage: Query only

Manual operation: See "User Defined Antenna Patterns per Row, Column" on page 136


Queries the user-defined antenna pattern files (*.ant_pat) in the specified directory.

Query parameters:

<CatDir> string
  File path

Return values:

<Catalog> string
  Files names without file extension.
Example: See Example "Configuring MIMO-OTA settings" on page 201
Manual operation: See "User Defined Antenna Patterns per Row, Column" on page 136

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:PATTern <AntRxPattDesc>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:PATTern <AntTxPattDesc>

Sets the antenna pattern mode.

Parameters:
<AntTxPattDesc> ISOtropic | USER | SEC3 | SEC6 | DIPole
*RST: ISOtropic

Example: See Example "Configuring MIMO-OTA settings" on page 201
Manual operation: See "Antenna Pattern" on page 135

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ANTenna<di>:PFILe <RxPattern>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ANTenna<di>:PFILe <TxPattern>

Selects the antenna pattern file (*.ant_pat) per antenna.

Query the existing files with the command [:SOURce]:FSIMulator:MIMO:
ANTenna:PATTern:CATalog:USER?.

Suffix:
<di> 1 to 8
Value range depends on the selected system configuration, i.e. the number of Tx and Rx antennas in the antenna array

Parameters:
<TxPattern> string
Complete file path, incl. the filename; the file extension can be omitted

Example: See Example "Configuring MIMO-OTA settings" on page 201
Manual operation: See "User Defined Antenna Patterns per Row, Column" on page 136

[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:STATE <AntModInvMatrix>

Applies the inverse channel matrix to compensate for chamber effects.

To set the matrix values, use the commands [:SOURce<hw>]:FSIMulator:MIMO:
7.9 2 Channel Interferer

Option: R&S SMW-K71.

Example: Enabling a two channel interferer fading configuration

The following is a simple example on how to configure and enable a two channel interferer fading configuration.

```
SOURce1:FSIMulator:CONFigure TCI
SOURce1:FSIMulator:TCInterferer:REference:PROFile PDOP
SOURce1:FSIMulator:TCInterferer:REference:LOSS 1
SOURce1:FSIMulator:TCInterferer:REference:SPeed 2
SOURce1:FSIMulator:TCInterferer:REference:FRATio 0.5
SOURce1:FSIMulator:TCInterferer:REference:DELay:MINimum 0.00003
SOURce1:FSIMulator:TCInterferer:PERiod 160
```
Activates the 2 channel interferer fading configuration.

The paths and the fading simulator must be switched on separately, see [:SOURce<hw>:FSIMulator:TCInterferer:STATe] and [:SOURce<hw>:FSIMulator:STATE].

Parameters:

<table>
<thead>
<tr>
<th>&lt;State&gt;</th>
<th>0</th>
<th>1</th>
<th>OFF</th>
<th>ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>RST:</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example: See Example "Enabling a two channel interferer fading configuration" on page 210

Manual operation: See "Configuration" on page 30
See "State" on page 74

Sets the maximum delay for the moving path.
Parameters:
Maximum: float
Range: dynamic to 0.001
Increment: 20E-9
*RST: 110E-6

Example: see Example "Enabling a two channel interferer fading configuration" on page 210

Manual operation: See "Delay Max (Moving Path)" on page 76

[:SOURce<hw>]:FSIMulator:TCINterferer:MOVing:MMODe <MMode>
Selects the type of moving applied to the moving path.

Parameters:
MMode: SLIDing | HOPPing
*RST: HOPPing

Example: see Example "Enabling a two channel interferer fading configuration" on page 210

Manual operation: See "Moving Mode (Moving Path)" on page 76

[:SOURce<hw>]:FSIMulator:TCINterferer:PERiod <Period>
Sets either the dwell time or the period for a complete cycle of the moving path.

Parameters:
Period: float
Range: 0.1 to 10
Increment: 0.01
*RST: 2.9 s (for hopping mode) / 160 s (for sliding mode)

Example: See Example "Enabling a two channel interferer fading configuration" on page 210

Manual operation: See "Period/Dwell" on page 76

[:SOURce<hw>]:FSIMulator:TCINterferer:SPEed <Speed>
Sets the speed v of the moving receiver for 2 channel interferer fading.

Parameters:
Speed: float
Range: 0 to 27778 (dynamic)
Increment: 0.001
*RST: 0.83333

Example: See Example "Enabling a two channel interferer fading configuration" on page 210

Manual operation: See "Speed" on page 75
[:SOURce<hw>]:FSIMulator:TCINterferer:REFe rence|MOVing:DE Lay:MINimum

Sets the minimum delay for the reference path and the moving path.

**Parameters:**

<Minimum>

- **float**
- **Range:** 0 to dynamic
- **Increment:** 20E-9
- **RST:** 0

**Example:** See Example "Enabling a two channel interferer fading configuration" on page 210

**Manual operation:** See "Delay Min" on page 75

[:SOURce<hw>]:FSIMulator:TCINterferer:REFe rence|MOVing:FDOPpler?

Queries the Doppler frequency of the reference and moving path with 2 channel interferer fading.

**Return values:**

<FDoppler>

- **float**
- **Range:** 0 to 1000
- **Increment:** 0.01
- **RST:** 0

**Example:** See Example "Enabling a two channel interferer fading configuration" on page 210

**Usage:** Query only

**Manual operation:** See "Profile" on page 75
See "Res. Doppler Shift" on page 75

[:SOURce<hw>]:FSIMulator:TCINterferer:REFe rence|MOVing:FDOPpler:ACTual?

Queries the actual Doppler shift.

**Return values:**

<ActDoppler>

- **float**
- **Range:** -1600 to 1600
- **Increment:** 0.01
- **RST:** 0

**Example:** See Example "Enabling a two channel interferer fading configuration" on page 210.

**Usage:** Query only

**Manual operation:** See "Act. Doppler Shift" on page 76
[:SOURce<hw>]:FSIMulato:TCINterfer:REFerence|MOVing:FRATio <FRatio>

Sets the ratio of the actual Doppler frequency to the set Doppler frequency for the reference and moving path with 2 channel interferer fading.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Range</th>
<th>Increment</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;FRatio&gt;</td>
<td>float</td>
<td>-1 to 1</td>
<td>0.0001</td>
</tr>
</tbody>
</table>

Example: 
See Example "Enabling a two channel interferer fading configuration" on page 210

Manual operation: 
See "Freq. Ratio" on page 75

[:SOURce<hw>]:FSIMulato:TCINterfer:REFerence|MOVing:LOSS <Loss>

Sets the loss of the reference and moving path with 2 channel interferer fading.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Range</th>
<th>Increment</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Loss&gt;</td>
<td>float</td>
<td>0 to 50</td>
<td>0.1</td>
</tr>
</tbody>
</table>

Example: 
See Example "Enabling a two channel interferer fading configuration" on page 210

Manual operation: 
See "Path Loss" on page 75

[:SOURce<hw>]:FSIMulato:TCINterfer:REFerence|MOVing:PROFile <Profile>

Sets the fading profile to be used for the reference and moving path with 2 channel interferer fading.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Profile&gt;</td>
<td>SPATH</td>
</tr>
</tbody>
</table>

Example: 
See Example "Enabling a two channel interferer fading configuration" on page 210

[:SOURce<hw>]:FSIMulato:TCINterfer:REFerence|MOVing:STATe <State>

Activate the reference and moving path of the 2 channel interferer fading configuration.

The 2 channel interferer fading configuration and the fading simulator must be switched on separately, see [:SOURce<hw>]:FSIMulato:TCINterferer[:STATe] on page 211 and [:SOURce<hw>]:FSIMulato[:STATe]
7.10 Custom Fading Profile

Option: R&S SMW-K72.

Example: Enabling, configuring and disabling a custom fading profile
The following is a simple example on how to configure, enable and disable a custom profile.

SOURce1:FSIMulator:DELay|DEL:GROup1:PATH2:PROFile CUSTom
SOURce1:FSIMulator:DEL:GROup1:PATH2:CUSTom:DATA 200,100,100,200
SOURce1:FSIMulator:DEL:GROup1:PATH2:CUSTom:DSHape FLAT
SOURce1:FSIMulator:DEL:GROup1:PATH2:CUSTom:DSHape RAYLeigh

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:DSHape <DopplerShape>

Sets the doppler shape of the virtual profile.

Parameters:
<DopplerShape> FLAT | RAYLeigh
*RST: RAYLeigh

Example: See Example "Enabling, configuring and disabling a custom fading profile" on page 215

Manual operation: See "Doppler Shape" on page 86

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:DATA <Bandwidth>, <OffsetFreq>, <LowerCutFreq>, <UpperCutFreq>

Sets the parameters of the custom fading profile.
Parameters:

- **<Bandwidth>**
  - Type: float
  - Range: 50 to 40000
  - Increment: 1
  - *RST: 200
  - Default unit: Hz

- **<OffsetFreq>**
  - Type: float
  - Range: -23950 to 23950
  - Increment: 1
  - *RST: 0
  - Default unit: Hz

- **<LowerCutFreq>**
  - Type: float
  - Range: -4000 to 3950
  - Increment: 1
  - *RST: 0
  - Default unit: Hz

- **<UpperCutFreq>**
  - Type: float
  - Range: -3950 to 4000
  - Increment: 1
  - *RST: 100
  - Default unit: Hz

Example:
See Example "Enabling, configuring and disabling a custom fading profile" on page 215

Manual operation:
See "Bandwidth" on page 86
See "Frequency Offset" on page 87
See "Lower/Upper Cutoff Frequency" on page 87

### 7.11 SCM Fading Profile

Option: R&S SMW-K73.

**Example: Configuring the SCM fading profile settings**
The following is a simple example on how to configure the settings.

```
// Enable 2x2 MIMO configuration
SCONfiguration:MODE ADV
SCONfiguration:FADing MIMO2X2
SCONfiguration:APPLy

// select SCM fading profile
SOURce1:FSIMulator:DELi:GROup1:PATH1:PROFile SCM
SOURce1:FSIMulator:MIMO:TAP1 TAP1
SOURce1:FSIMulator:SCM:SPEed 8.333
SOURce1:FSIMulator:SCM:DOT 120
```
Remote-Control Commands

SOURce1:FSIMulator:SCM:SIGMa 8
SOURce1:FSIMulator:SCM:TAP1:DEParture:ANGLe 6.6
SOURce1:FSIMulator:SCM:TAP1:DEParture:SPRead 5
SOURce1:FSIMulator:SCM:TAP1:ARRival:ANGLe 25
SOURce1:FSIMulator:SCM:TAP1:ARRival:SPRead 1
SOURce1:FSIMulator:SCM:TAP1:SUBCluster1:STATe 1
SOURce1:FSIMulator:SCM:TAP1:SUBCluster2:STATe 1
SOURce1:FSIMulator:SCM:TAP1:SUBCluster3:STATe 1
SOURce1:FSIMulator:SCM:TAP1:SUBCluster1:GAIN?
  // -3.0129995663981
  // SOURce1:FSIMulator:SCM:TAP1:SUBPath1:STATe 0
  // SOURce1:FSIMulator:SCM:TAP1:SUBPath1:PHASe:VV 135
SOURce1:FSIMulator:SCM:TAP1:SUBPath1:STATe 1
SOURce1:FSIMulator:SCM:LOS:STATe 1
SOURce1:FSIMulator:SCM:LOS:DEParture:ANGLe 5
SOURce1:FSIMulator:SCM:LOS:ARRival:ANGLe 30
SOURce1:FSIMulator:SCM:LOS:KFACTOR -15
SOURce1:FSIMulator:SCM:LOS:RANDom:PHASe:STATe 1
  // configure the Tx antenna array (BS)
SOURce1:FSIMulator:SCM:ANTenna:TX:COLumn:SIZE?
  // R02
SOURce1:FSIMulator:SCM:ANTenna:TX:ROWS:SIZE?
  // R01
SOURce1:FSIMulator:SCM:ANTenna:TX:CALC:MODE SPAC
SOURce1:FSIMulator:SCM:ANTenna:TX:ESPacing:HORizontal 0.5
SOURce1:FSIMulator:SCM:ANTenna:TX:PATTern SEC3
  // configure the Rx antenna array (MS)
SOURce1:FSIMulator:SCM:ANTenna:RX:CALC:MODE REL
SOURce1:FSIMulator:SCM:ANTenna:RX:PATTern ISO
  // apply inverse channel matrix
SOURce1:FSIMulator:MIMO:ANTenna:INVerse:MATRix:STATe 1
SOURce1:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW1:COLumn2:REAL 0.3
SOURce1:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW2:COLumn1:IMAGin -0.82
  // enable channel polarization
SOURce1:FSIMulator:SCM:POLarization:STATe 1
SOURce1:FSIMulator:SCM:POLarization:PRATio:VERTical 9
SOURce1:FSIMulator:SCM:POLarization:PRATio:HORizontal 9
SOURce1:FSIMulator:STATe 1
[:SOURce<hw>]:FSIMulator:SCM:SPEed <Speed>

Sets the speed of the mobile station.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Range</th>
<th>Increment</th>
<th>*RST</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Speed&gt;</td>
<td>float</td>
<td>0 to 27778</td>
<td>0.001</td>
<td>0.83333</td>
</tr>
</tbody>
</table>
Example: See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation: See "MS Speed" on page 114

[::SOURce<hw>]:FSIMulator:SCM:DOT <DirOfTravel>

Sets the direction of travel of the mobile station.

Parameters:
<DirOfTravel> float
Range: 0 to 359.9
Increment: 0.1
*RST: 90

Example: See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation: See "MS DoT (Direction of Travel)" on page 114

[::SOURce<hw>]:FSIMulator:SCM:SIGMa <Sigma>

Sets the lognormal shadow fading standard deviation, applied as a common parameter to the paths.

Parameters:
<Sigma> float
Range: 0 to 20
Increment: 0.01
*RST: 8

Example: See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation: See "σSF" on page 114

[::SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ANGLe <Angle>
[::SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ANGLe <Angle>

Sets the AoA (angle of arrival) / AoD (angle of departure) of the cluster.

Parameters:
<Angle> float
Range: 0 to 359.999
Increment: 0.001
*RST: 0

Example: See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation: See "Angle of Departure (AoD)" on page 115
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:SPRead <Spread>
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:SPRead <Spread>
Sets the AoA (angle of arrival) / AoD (angle of departure) spread (AS) of the cluster.

Parameters:
<Spread>  float
Range: 1 to 75
Increment: 0.001
*RST: 1

Example: See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation: See "AoD Spread" on page 115

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:GAIN <Gain>
Sets the relative gain (in dB) of the cluster.

Parameters:
<Gain>  float
Range: -50 to 0
Increment: 0.001
*RST: 0

Example: See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation: See "Relative Gain /dB" on page 114

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:STATe <State>
Enables the sub-clusters.

Suffix:
<di>  1 to 3
sub-cluster number

Parameters:
<State>  0 | 1 | OFF | ON
*RST: 0

Example: See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation: See "Subcluster > State" on page 114

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:GAIN <Gain>
Queries the resulting relative gain of an enabled sub-cluster.
Suffix:  
<di>  
1 to 3  
sub-cluster number

Parameters:  

<Gain>  
float  
Range: -50 to 0  
Increment: 0.001  
*RST: 0

Example:  See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation:  See "Subcluster > Relative Gain /dB" on page 114

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath:STATe <State>

If enabled, random start phases are selected.

Parameters:  

<State>  
0 | 1 | OFF | ON  
*RST: 1

Example:  See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation:  See "Use Random Phases" on page 122

[:SOURce<hw>]:FSIMulator:SCM:POLarization:STATe <State>

Enables/disables simulation of channel polarization.

Parameters:  

<State>  
0 | 1 | OFF | ON  
*RST: 0

Example:  See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation:  See "Channel Polarization State" on page 116

[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:HORizontal  
[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:VERTical <RatioVertical>

Sets the cross polarization power ratio (XPR) in dB.

Parameters:  

<RatioVertical>  
float  
Range: 0 to 20  
Increment: 0.001  
*RST: 9
Example: See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation: See "Vertical/Horizontal Cross Polarization Power Ratio" on page 116

[:SOURce]:FSIMulator:SCM:ANTenna:RX:CALC:MODE <Mode>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:CALC:MODE <Mode>

Set how the distance between the antenna elements is defined: based on the physical distance or on the relative phase.

Parameters:

<Mode>

SPACing | RELativphase

SPACing
To set the distance, use the corresponding command, for example [:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ESPacing:HORizontal.

RELativphase
Load an antenna pattern file that contains the relative phase description.
See Chapter B, "Antenna Pattern File Format", on page 329

*RST: SPACing

Example: See Example "Configuring the SCM fading profile settings" on page 216.

Options: R&S SMW-K73

Manual operation: See "Calculation Mode" on page 118

[:SOURce]:FSIMulator:SCM:ANTenna:RX:COLumns[:SIZE] <NumRxCol>
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ROWS[:SIZE]?
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:COLumns[:SIZE] <NumTxCol>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ROWS[:SIZE]?

Queries the number of rows and the number of columns in the antenna array.

Return values:

<NumTxRows> R01 | R02 | R03 | R04 | R08
*RST: R02

Example: See Example "Configuring the SCM fading profile settings" on page 216.

Usage: Query only

Manual operation: See "Number of Rows (M)/Columns (N)" on page 118
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ESPacing:HORizontal <SpacingHoriz>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ESPacing:HORizontal <Horizontal>

Sets the distance between the antennas in the antenna array.

Parameters:
<Horizontal>  float
  Range:  0  to  10
  Increment:  0.01
  *RST:  0.5

Example:  See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation:  See "Horizontal Spacing" on page 118

[:SOURce]:FSIMulator:SCM:ANTenna:RX:PATTern <TypeOfPattern>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:PATTern <Pattern>

Sets the antenna pattern mode.

Parameters:
<PATTERN>  ISOtropic | USER | SEC3 | SEC6 | DIpole
  *RST:  ISOtropic

Example:  See Example "Configuring the SCM fading profile settings" on page 216.

Manual operation:  See "Antenna Pattern" on page 119

[:SOURce]:FSIMulator:SCM:ANTenna:RX:ANTenna<di>:PFILe <Filename>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ANTenna<di>:PFILe <Filename>

Selects the antenna pattern file (*.ant_pat) per antenna.

Query the existing files with the command [:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER?.

Suffix:
<di>  1 to 8
  Value range depends on the selected system configuration, i.e. the number of Tx and Rx antennas in the antenna array

Parameters:
<Filename>  string
  Complete file path, incl. the filename; the file extension can be omitted

Example:
// query existing user defined antenna pattern files (*.ant_pat)
// ant1,ant2
SOURce:FSIMulator:SCM:ANTenna:TX:PATTern USER
SOURce:FSIMulator:SCM:ANTenna:TX:ANTenna1:PFILe */var/user/ant1
SOURce:FSIMulator:SCM:ANTenna:TX:ANTenna2:PFILe */var/user/ant2
Remote-Control Commands

**SCM Fading Profile**

**Manual operation:** See "User Defined Antenna Patterns per Row, Column" on page 119

```plaintext
[:SOURce<hw>]:FSIMulator:SCM:LOS:STATe <State>
```

Adds a line-of-sight (LOS) component to the cluster.

**Parameters:**

- `<State>`
  - 0 | 1 | OFF | ON
  - *RST:* 0

**Example:** See Example "Configuring the SCM fading profile settings" on page 216.

---

**Manual operation:** See "Use LOS Component" on page 120

```plaintext
[:SOURce<hw>]:FSIMulator:SCM:LOS:ARRival[:ANGLe] <Angle>
[:SOURce<hw>]:FSIMulator:SCM:LOS:DEParture[:ANGLe] <Angle>
```

Sets the AoD and AoA of the LOS component.

**Parameters:**

- `<Angle>`
  - float
  - Range: 0 to 359.999
  - Increment: 0.001
  - *RST:* 0

**Example:** See Example "Configuring the SCM fading profile settings" on page 216.

---

**Manual operation:** See "LOS Angle of Departure (AoD)" on page 121

```plaintext
[:SOURce<hw>]:FSIMulator:SCM:LOS:KFACtor <Factor>
```

Sets the ricean K factor.

**Parameters:**

- `<Factor>`
  - float
  - Range: -50 to 0
  - Increment: 0.001
  - *RST:* 0

**Example:** See Example "Configuring the SCM fading profile settings" on page 216.

---

**Manual operation:** See "K Factor" on page 121

```plaintext
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:STATe <State>
```

If enabled, random subpath start phases are selected.
7.12 Customized Dynamic Fading

Option: R&S SMW-K820.
Example: Configuring the customized dynamic fading settings

SCONfiguration:MODE ADV
SCONfiguration:FADing MIMO2X2
SCONfiguration:APPLY

SOURce1:FSIMulator:CONFiguration CDYN
SOURce1:FSIMulator:CDYNamic:PATH1:PROF PDOPpler
SOURce1:FSIMulator:CDYNamic:PATH5:PROF?
   // RAYLeigh
SOURce1:FSIMulator:CDYNamic:CATalog?
   // Urban_PureDoppler, Urban_Rayleigh_1, Urban_Rayleigh_2

SOURce1:FSIMulator:CDYNamic:PATH1:DATA:DSELect "Urban_PureDoppler.fad_udyn"
SOURce1:FSIMulator:CDYNamic:PATH5:DATA:DSELect "Urban_Rayleigh_1"

MMEMory:CDIRectory "/var/user/cdf"
SOURce1:FSIMulator:CDYNamic:CATalog:USER?
   // dynList_sys1_ch1_PG1_path1, my_cdf
SOURce1:FSIMulator:CDYNamic:DELeete "/var/user/cdf/my_cdf"

SOURce1:FSIMulator:CDYNamic:PATH3:DATA:DSELect "/var/user/cdf/dynList_sys1_ch1_PG1_path1"

SOURce1:FSIMulator:MIMO:TAP1 TAP5
SOURce1:FSIMulator:MIMO:TAP5:MATRix:ROW1:COlumn1:MAGNitude 0.5
SOURce1:FSIMulator:MIMO:TAP5:MATRix:ROW1:COlumn1:PHASe 0
SOURce1:FSIMulator:MIMO:TAP5:MATRix:ACCept
SOURce1:FSIMulator:CDYNamic:PATH1:STATe 1
SOURce1:FSIMulator:STATe 1

[:SOURCE<hw>]:FSIMulator:CDYNamic:STATe <State> ................................................................. 226
[:SOURCE<hw>]:FSIMulator:CDYNamic:CATalog? .......................................................... 227
[:SOURCE<hw>]:FSIMulator:CDYNamic:PATH<ch>:DATA:DSELect ...................................... 227
[:SOURCE<hw>]:FSIMulator:CDYNamic:DELeete ............................................................ 227
[:SOURCE<hw>]:FSIMulator:CDYNamic:PATH<ch>:PROF ............................................... 228
[:SOURCE<hw>]:FSIMulator:CDYNamic:PATH<ch>:STATe ................................................ 228

[:SOURCE<hw>]:FSIMulator:CDYNamic:STATe <State>
Activates the customized dynamic fading configuration.

Parameters:
<State> 0 | 1 | OFF | ON
*RST: 0

Example: See Example "Configuring the customized dynamic fading settings" on page 226

Manual operation: See "Configuration" on page 30
Customized Dynamic Fading

[[:SOURce<hw>]:FSIMulator:CDYNamic:CATalog?]  
Queries the predefined files with customized dynamic fading settings. Listed are files with the file extension *.fad_udyn.

Return values:  
<FileNames>  
Returns a string of filenames separated by commas.

Example:  
See Example "Configuring the customized dynamic fading settings" on page 226

Usage:  
Query only

Manual operation:  
See "Filename" on page 78

[[:SOURce<hw>]:FSIMulator:CDYNamic:CATalog:USER?]  
Queries the files with user-defined customized dynamic fading settings in the default directory. Listed are files with the file extension *.fad_udyn.

Return values:  
<FileNames>  
Returns a string of filenames separated by commas.

Example:  
See Example "Configuring the customized dynamic fading settings" on page 226

Usage:  
Query only

Manual operation:  
See "Filename" on page 78

[[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:DATA:DSELect <Filename>]  
Loads the selected file from the default or the specified directory. Loaded are files with extension *.fad_udyn.

Suffix:  
<ch>  
1 to 12  
Fading path

Parameters:  
<Filename>  
"<filename>"  
Filename or absolute file path; file extension can be omitted.

Example:  
See Example "Configuring the customized dynamic fading settings" on page 226

Manual operation:  
See "Filename" on page 78

[[:SOURce<hw>]:FSIMulator:CDYNamic:DELete <Filename>]  
Deletes the specified file. Deleted are user-defined files with file extension *.fad_udyn.
Setting parameters:
<Filename> "<filename>"
Complete file path and file name; file extension can be omitted.

Example: See Example "Configuring the customized dynamic fading settings" on page 226

Usage: Setting only

Manual operation: See "Filename" on page 78

[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:PROF <Prof>
Sets the fading profile.

Suffix: <ch> 1 to 12 Fading path

Parameters: <Prof> PDOPpler | RAYleigh
Pure Doppler is available in the first four paths (PATH1|2|3|4)
*RST: PDOPpler

Example: See Example "Configuring the customized dynamic fading settings" on page 226

Manual operation: See "Profile" on page 78

[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:STATE <State>
Activates the selected path, if a customized dynamic file is selected.

Suffix: <ch> 1 to 12 Fading path

Parameters: <State> 0 | 1 | OFF | ON
*RST: 0

Example: See Example "Configuring the customized dynamic fading settings" on page 226

Manual operation: See "State" on page 78
Annex

A Predefined Fading Settings

The predefined fading settings correspond to the test scenarios defined in the common mobile radio standards. The following tables provide a listing of the predefined standards along with the underlying test scenarios and the enabled settings.

As listed in Table 3-1 and Table 3-2, there is a difference in the system clocks and the delay resolutions depending on which of the options is installed. These differences also affect the used fading paths and the preset values in some of the predefined fading profiles.

The values listed in the following sections apply for both options R&S SMW-B14 and R&S SMW-B15. If there is a difference in the used paths, both path numbers are given, where the path number in brackets corresponds to path used if R&S SMW-B15 is installed.

- CDMA Standards ................................................................. 229
- GSM Standards ................................................................. 232
- NADC Standards ............................................................. 237
- PCN Standards ................................................................. 238
- TETRA Standards ............................................................ 243
- 3GPP Standards ............................................................... 247
- WLAN Standards ........................................................... 258
- DAB Standards ............................................................... 263
- WIMAX Standards .......................................................... 266
- LTE Standards ............................................................... 278
- LTE-MIMO Standards .................................................... 282
- WIMAX-MIMO Standards ............................................. 283
- 1xEVDO Standards ......................................................... 288
- 3GPP/LTE High Speed Train ........................................... 292
- 3GPP/LTE Moving Propagation ....................................... 294
- SCM and SCME Channel Models for MIMO OTA .......... 296
- Watterson Standards ....................................................... 299
- 802.11n-SISO Standards ................................................. 301
- 802.11n-MIMO Standards ............................................. 301
- 802.11ac-MIMO Standards ............................................ 312
- 802.11ac-SISO Standards .............................................. 323
- 802.11p Channel Models ............................................... 323
- 5G NR Standards .......................................................... 325

A.1 CDMA Standards

Option: R&S SMW-B14/B15
A.1.1 CDMA 1 (8km/h - 2 Path)

Table A-1: C.S0011-A_MS_Minimum_Performance_Spec.pdf

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>2000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Correlated with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>

also with 15km/h in band class 5

A.1.2 CDMA 2 (30km/h - 2 Path)

Table A-2: C.S0011-A_MS_Minimum_Performance_Spec.pdf

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>2000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Correlated with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>30</td>
<td>30</td>
</tr>
</tbody>
</table>

also with 14km/h in band classes 1,4,6,8
also with 58km/h in band class 5

A.1.3 CDMA 3 (30km/h - 1 Path)

Table A-3: C.S0011-A_MS_Minimum_Performance_Spec.pdf

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
</tr>
</tbody>
</table>
### A.1.4 CDMA 4 (100km/h - 3 Path)

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rateleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>2000</td>
<td>14500</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Correlated with:</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

Also with 58km/h in band class 5.

### A.1.5 CDMA 5 (0km/h - 2 Path)

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rateleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>2000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Correlated with:</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Also with 192km/h in band class 5.
### A.1.6 CDMA 6 (3km/h - 1 Path)

**Table A-6: C.S0011-A_MS_Minimum_Performance_Spec.pdf**

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0</td>
</tr>
</tbody>
</table>

#### A.2 GSM Standards

Option: R&S SMW-B14/B15

### A.2.1 GSM TU3 (6 Path)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>3</td>
<td>0</td>
<td>2</td>
<td>6</td>
<td>8</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>200</td>
<td>500</td>
<td>1600</td>
<td>2300</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>
### A.2.2 GSM TU50 (6 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>3</td>
<td>0</td>
<td>2</td>
<td>6</td>
<td>8</td>
<td>10</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>200</td>
<td>500</td>
<td>1600</td>
<td>2300</td>
<td>5000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

### A.2.3 GSM HT100 (6 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>1.5</td>
<td>4.5</td>
<td>7.5</td>
<td>8</td>
<td>17.7</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>100</td>
<td>300</td>
<td>500</td>
<td>15000</td>
<td>17200</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

### A.2.4 GSM RA250 (6 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rice</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>4</td>
<td>8</td>
<td>12</td>
<td>16</td>
<td>20</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>100</td>
<td>200</td>
<td>300</td>
<td>400</td>
<td>500</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>6.88</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0.7</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>250</td>
<td>250</td>
<td>250</td>
<td>250</td>
<td>250</td>
<td>250</td>
</tr>
</tbody>
</table>
There has been a change in the specifications TS8916B, Baseline Change from 5.1.0 to 5.2.0. The power ratio for path 1 with Rice fading is now no longer referred only to Rayleigh of path 1. Instead, it is referred to the total power of all of the paths.

The preset value used in the instrument of 6.88 fulfills this requirement. It does not conform to the value given in the specification since the instrument always determines the power ratio for one path. By taking into account the power of the other paths in calculating this value, however, the required power ratio for all six paths is achieved.

### A.2.5 GSM ET50 (EQ50) (6 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>3200</td>
<td>6400</td>
<td>9600</td>
<td>12800</td>
<td>16000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

### A.2.6 GSM ET60 (EQ60) (6 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>3200</td>
<td>6400</td>
<td>9600</td>
<td>12800</td>
<td>16000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
</tr>
</tbody>
</table>
### A.2.7 GSM ET100 (EQ100) (6 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>3200</td>
<td>6400</td>
<td>9600</td>
<td>12800</td>
<td>16000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

### A.2.8 GSM TU3 (12 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
<th>Path 11</th>
<th>Path 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>4</td>
<td>3</td>
<td>0</td>
<td>2.6</td>
<td>3</td>
<td>5</td>
<td>7</td>
<td>5</td>
<td>6.5</td>
<td>8.6</td>
<td>11</td>
<td>10</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>100</td>
<td>300</td>
<td>500</td>
<td>800</td>
<td>1100</td>
<td>1300</td>
<td>1700</td>
<td>2300</td>
<td>3100</td>
<td>3200</td>
<td>5000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>
### A.2.9 GSM TU50 (12 Path)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>4</td>
<td>3</td>
<td>0</td>
<td>2.6</td>
<td>3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>100</td>
<td>300</td>
<td>500</td>
<td>800</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

### A.2.10 GSM HT100 (12 Path)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>10</td>
<td>8</td>
<td>6</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>100</td>
<td>300</td>
<td>500</td>
<td>700</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

---

GSM Standards
A.2.11 GSM T15

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay [ns]</td>
<td>1300</td>
<td>15000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

A.3 NADC Standards

Option: R&S SMW-B14/B15

Path 2 should be placed in its own group (delay max. 40 000 ns).

A.3.1 NADC 8 (2 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>41200</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>

User Manual 1175.6826.02 — 20
### Predefined Fading Settings

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>

#### A.3.2 NADC 50 (2 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
<td>41200</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

#### A.3.3 NADC 100 (2 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
<td>41200</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

#### A.4 PCN Standards

Option: R&S SMW-B14/B15
## A.4.1 PCN TU1.5 (6 Path)

Same as GSM Tux

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rayleigh</td>
<td>3</td>
<td>0</td>
<td>2</td>
<td>6</td>
<td>8</td>
<td>10</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>200</td>
<td>500</td>
<td>1600</td>
<td>2300</td>
<td>5000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.5</td>
<td>1.5</td>
<td>1.5</td>
<td>1.5</td>
<td>1.5</td>
<td>1.5</td>
</tr>
</tbody>
</table>

## A.4.2 PCN TU50 (6 Path)

Same as GSM TU50

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rayleigh</td>
<td>3</td>
<td>0</td>
<td>2</td>
<td>6</td>
<td>8</td>
<td>10</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>200</td>
<td>500</td>
<td>1600</td>
<td>2300</td>
<td>5000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

## A.4.3 PCN HT100 (6 Path)

Same as GSM

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rayleigh</td>
<td>0</td>
<td>1.5</td>
<td>4.5</td>
<td>7.5</td>
<td>8</td>
<td>17.7</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>100</td>
<td>300</td>
<td>500</td>
<td>15000</td>
<td>17200</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>Path 1</td>
<td>Path 2</td>
<td>Path 3</td>
<td>Path 4</td>
<td>Path 5</td>
<td>Path 6</td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Freq Ratio:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Speed [km/h]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

### A.4.4 PCN RA130 (6 Path)

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rice</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Loss [dB]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>4</td>
<td>8</td>
<td>12</td>
<td>16</td>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Delay [ns]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>100</td>
<td>200</td>
<td>300</td>
<td>400</td>
<td>500</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LogNormal</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Corr with</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power Ratio [dB]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>6,47</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Freq Ratio:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>0,7</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Speed [km/h]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>130</td>
<td>130</td>
<td>130</td>
<td>130</td>
<td>130</td>
<td>130</td>
<td>130</td>
</tr>
</tbody>
</table>

### A.4.5 PCN ET50 (EQ50) (6 Path)

Same as GSM

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Loss [dB]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Delay [ns]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>3200</td>
<td>6400</td>
<td>9600</td>
<td>12800</td>
<td>16000</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LogNormal</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Corr with</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power Ratio [dB]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Freq Ratio:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Speed [km/h]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

### A.4.6 PCN ET60 (EQ60) (6 Path)

Same as GSM
### A.4.7 PCN ET100 (EQ100) (6 Path)

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>3200</td>
<td>6400</td>
<td>9600</td>
<td>12800</td>
<td>16000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
</tr>
</tbody>
</table>

### A.4.8 PCN TU1.5 (12 Path)

Same as GSM Tux

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>4</td>
<td>3</td>
<td>0</td>
<td>2.6</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>100</td>
<td>300</td>
<td>500</td>
<td>800</td>
<td>1100</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>
### A.4.9 PCN TU50 (12 Path)

Same as GSM

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>4</td>
<td>3</td>
<td>0</td>
<td>2.6</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>100</td>
<td>300</td>
<td>500</td>
<td>800</td>
<td>1100</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Path 7</td>
<td>Path 8</td>
<td>Path 9</td>
<td>Path 10</td>
<td>Path 11</td>
<td>Path 12</td>
<td></td>
</tr>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td></td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>7</td>
<td>5</td>
<td>6.5</td>
<td>8.6</td>
<td>11</td>
<td>10</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>1300</td>
<td>1700</td>
<td>2300</td>
<td>3100</td>
<td>3200</td>
<td>5000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.5</td>
<td>1.5</td>
<td>1.5</td>
<td>1.5</td>
<td>1.5</td>
<td>1.5</td>
</tr>
</tbody>
</table>
Predefined Fading Settings

R&S®SMW-B14/-B15/-K71/-K72/-K73/-K74/-K75/-K820/-K821

TETRA Standards

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

A.4.10  PCN HT100 (12 Path)

Same as GSM

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>10</td>
<td>8</td>
<td>6</td>
<td>4</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>100</td>
<td>300</td>
<td>500</td>
<td>700</td>
<td>1000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
<th>Path 11</th>
<th>Path 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>4</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>12</td>
<td>14</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>1300</td>
<td>15000</td>
<td>15200</td>
<td>15700</td>
<td>17200</td>
<td>20000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

A.5  TETRA Standards

Option: R&S SMW-B14/B15
### A.5.1 TETRA TU50 (2 Path)

EN300 392-2

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>22.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>5000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

### A.5.2 TETRA TU50 (6 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>3.00</td>
<td>0</td>
<td>2.0</td>
<td>6.0</td>
<td>8.0</td>
<td>10.0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

### A.5.3 TETRA BU50 (2 Path)

EN300 392-2

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>5000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>
### A.5.4 TETRA HT200 (2 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

### A.5.5 TETRA HT200 (6 Path)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>0</td>
<td>2</td>
<td>4</td>
<td>7</td>
<td>6</td>
<td>12</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
<td>200</td>
<td>400</td>
<td>600</td>
<td>15000</td>
<td>17200</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>200.02</td>
<td>200.02</td>
<td>200.02</td>
<td>200.02</td>
<td>200.02</td>
<td>200.02</td>
</tr>
</tbody>
</table>

### A.5.6 TETRA ET200 (4 Path)

EN300 392-2, Equalizer Test
Note: Path 3 and 4 should be placed in their own group (delay max. 40 000 ns)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>0</td>
<td>10.2</td>
<td>16</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>11600</td>
<td>73200</td>
<td>99300</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
</tr>
</tbody>
</table>

**A.5.7 TETRA DU 50 (1Path)**

ETSI EN 300 396-2 V1.2.1

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rice</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.7</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>50</td>
</tr>
</tbody>
</table>

**A.5.8 TETRA DR 50 (1Path)**

ETSI EN 300 396-2 V1.2.1

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
</tr>
</tbody>
</table>
A.6 3GPP Standards

Option: R&S SMW-K71

VAx are typical fading profiles, with x representing the speed, such as VA3 represents 3 km/h.

These standards define a certain combination of channels with a specific doppler frequency. Basically, the maximum possible doppler frequency of a path is determined by the RF output frequency and the speed of the moving mobile receiver. However, if you change the RF frequency in a VAx standard, the doppler frequency remains the same, thus resulting in individual speed settings.

Refer also to Chapter A.6.12, "3GPP Mobile VA3, 3GPP Mobile VA30, 3GPP Mobile VA120", on page 252 for VAx fading profiles.

A.6.1 3GPP Case 1 (UE/BS)

Table A-7: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0 (2003-09), annex D.2

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
<td>976</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>
### A.6.2 3GPP Case 2 (UE/BS)

Table A-8: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0 (2003-09), annex D.2

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>976</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>Off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>Off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

### A.6.3 3GPP Case 3 (UE/BS)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0 (2003-09), annex D.2

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>260</td>
<td>521</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>120</td>
<td>120</td>
<td>120</td>
</tr>
</tbody>
</table>

### A.6.4 3GPP Case 4 (UE)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
</tr>
</tbody>
</table>
### A.6.5 3GPP Case 5 (UE)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

#### A.6.6 3GPP Case 6 (UE) and Case 4 (BS)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0 (2003-09), annex D.2

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>3</td>
<td>6</td>
<td>9</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>260</td>
<td>521</td>
<td>781</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>250</td>
<td>250</td>
<td>250</td>
<td>250</td>
</tr>
</tbody>
</table>
### A.6.7 3GPP Mobile Case 7 (UE-Sector)

Table A-9: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
<tr>
<td>2</td>
<td>4.3</td>
<td>260</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
<tr>
<td>3</td>
<td>6.6</td>
<td>1040</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>4690</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
<tr>
<td>5</td>
<td>7</td>
<td>7290</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
<tr>
<td>6</td>
<td>7.5</td>
<td>14580</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
</tbody>
</table>

### A.6.8 3GPP Mobile Case 7 (UE-Beam)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Rayleigh</td>
<td>0</td>
<td>4690</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
<tr>
<td>5</td>
<td>Rayleigh</td>
<td>0.3</td>
<td>7290</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
<tr>
<td>6</td>
<td>Rayleigh</td>
<td>0.9</td>
<td>14580</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
</tbody>
</table>

### A.6.9 3GPP Mobile Case 8 (UE, CQI)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, Table B.1C;

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rayleigh</td>
<td>0</td>
<td>0</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
<tr>
<td>2</td>
<td>Rayleigh</td>
<td>10</td>
<td>976</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
</tbody>
</table>
### A.6.10 3GPP Mobile PA3

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, ITU Pedestrian A (HSDPA)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>30</td>
<td>30</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### A.6.11 3GPP Mobile PB3

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, ITU Pedestrian B (HSDPA)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>0.9</td>
<td>4.9</td>
<td>8</td>
<td>7.8</td>
<td>23.9</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>200</td>
<td>800</td>
<td>1200</td>
<td>2300</td>
<td>3700</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>
### A.6.12 3GPP Mobile VA3, 3GPP Mobile VA30, 3GPP Mobile VA120

**Table A-10: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, ITU vehicular A (HSDPA)**

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>1</td>
<td>9</td>
<td>10</td>
<td>15</td>
<td>20</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>310</td>
<td>710</td>
<td>1090</td>
<td>1730</td>
<td>2510</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>3</td>
<td>30</td>
<td>120</td>
<td>3</td>
<td>30</td>
<td>120</td>
</tr>
</tbody>
</table>

1) Speed of the respective standard VAx: VA3 = 3 km/h, VA30 = 30 km/h and VA120 = 120 km/h.

### A.6.13 3GPP MBSFN Propagation Channel Profile (18 Path)

**Table A-11: 3GPP 3GPP TS 36.521-1 respectively TS36.101 V9.8.0**

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>1.5</td>
<td>1.4</td>
<td>3.6</td>
<td>0.6</td>
<td>7.0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>30</td>
<td>150</td>
<td>310</td>
<td>370</td>
<td>1090</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Frequency [Hz]: *</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

**Table A-12: 3GPP 3GPP TS 36.521-1 respectively TS36.101 V9.8.0 (Cont.)**

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
<th>Path 11</th>
<th>Path 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]</td>
<td>10.0</td>
<td>11.5</td>
<td>11.4</td>
<td>13.6</td>
<td>10.6</td>
<td>17.0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>12490</td>
<td>12520</td>
<td>12640</td>
<td>12800</td>
<td>12860</td>
<td>13580</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
<th>Path 11</th>
<th>Path 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Frequency [Hz]: *</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

**Table A-13: 3GPP 3GPP TS 36.521-1 respectively TS36.101 V9.8.0 (Cont.)**

<table>
<thead>
<tr>
<th>Path 13</th>
<th>Path 14</th>
<th>Path 15</th>
<th>Path 16</th>
<th>Path 17</th>
<th>Path 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>20.0</td>
<td>21.5</td>
<td>21.4</td>
<td>23.6</td>
<td>20.6</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>27490</td>
<td>27520</td>
<td>27640</td>
<td>27800</td>
<td>27860</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Frequency [Hz]: *</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

### A.6.14 3GPP Birth Death

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.4

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Static</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0…10us</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>1</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0</td>
</tr>
</tbody>
</table>

Dwell: 191ms

(Means)-Offset: 5 us
### A.6.15 3GPP TUx

**Table A-14: 3GPP TS 25.943 V5.1.0 (2002-06)**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rayleigh</td>
<td>7.6</td>
<td>217</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>Rayleigh</td>
<td>10.1</td>
<td>512</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>Rayleigh</td>
<td>10.2</td>
<td>514</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>Rayleigh</td>
<td>5.7</td>
<td>0</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>5</td>
<td>Rayleigh</td>
<td>16.3</td>
<td>1230</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
</tbody>
</table>

**Table A-15: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Rayleigh</td>
<td>10.2</td>
<td>517</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>7</td>
<td>Rayleigh</td>
<td>11.5</td>
<td>674</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>8</td>
<td>Rayleigh</td>
<td>13.4</td>
<td>882</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>9</td>
<td>Rayleigh</td>
<td>21.5</td>
<td>1820</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>10</td>
<td>Rayleigh</td>
<td>21.6</td>
<td>1840</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
</tbody>
</table>

**Table A-16: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Rayleigh</td>
<td>16.9</td>
<td>1287</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>12</td>
<td>Rayleigh</td>
<td>17.1</td>
<td>1311</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>13</td>
<td>Rayleigh</td>
<td>17.4</td>
<td>1349</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>14</td>
<td>Rayleigh</td>
<td>22.1</td>
<td>1880</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>15</td>
<td>Rayleigh</td>
<td>22.6</td>
<td>1940</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
</tbody>
</table>
### Table A-17: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>Rayleigh</td>
<td>19</td>
<td>1533</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>17</td>
<td>Rayleigh</td>
<td>19</td>
<td>1535</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>18</td>
<td>Rayleigh</td>
<td>19.8</td>
<td>1622</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>19</td>
<td>Rayleigh</td>
<td>23.5</td>
<td>2050</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>20</td>
<td>Rayleigh</td>
<td>24.3</td>
<td>2140</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
</tbody>
</table>

### A.6.16 3GPP HTx

### Table A-18: 3GPP TS 25.943 V5.1.0 (2002-06)

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rayleigh</td>
<td>8.9</td>
<td>356</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>2</td>
<td>Rayleigh</td>
<td>10.2</td>
<td>441</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>3</td>
<td>Rayleigh</td>
<td>11.5</td>
<td>528</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>4</td>
<td>Rayleigh</td>
<td>3.6</td>
<td>0</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>5</td>
<td>Rayleigh</td>
<td>17.6</td>
<td>15000</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>6</td>
<td>Rayleigh</td>
<td>11.8</td>
<td>546</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>7</td>
<td>Rayleigh</td>
<td>12.7</td>
<td>609</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>8</td>
<td>Rayleigh</td>
<td>13</td>
<td>625</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>9</td>
<td>Rayleigh</td>
<td>25.8</td>
<td>16880</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>10</td>
<td>Rayleigh</td>
<td>26.2</td>
<td>16980</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
</tbody>
</table>

### Table A-19: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

<table>
<thead>
<tr>
<th>Path</th>
<th>Profile [Type]</th>
<th>Loss [dB]</th>
<th>Speed [km/h]</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Rayleigh</td>
<td>16.2</td>
<td>100</td>
</tr>
<tr>
<td>12</td>
<td>Rayleigh</td>
<td>17.3</td>
<td>100</td>
</tr>
<tr>
<td>13</td>
<td>Rayleigh</td>
<td>17.7</td>
<td>100</td>
</tr>
<tr>
<td>14</td>
<td>Rayleigh</td>
<td>29</td>
<td>100</td>
</tr>
<tr>
<td>15</td>
<td>Rayleigh</td>
<td>29.9</td>
<td>100</td>
</tr>
<tr>
<td>16</td>
<td>Rayleigh</td>
<td>22.7</td>
<td>100</td>
</tr>
<tr>
<td>17</td>
<td>Rayleigh</td>
<td>24.1</td>
<td>100</td>
</tr>
<tr>
<td>18</td>
<td>Rayleigh</td>
<td>25.8</td>
<td>100</td>
</tr>
<tr>
<td>19</td>
<td>Rayleigh</td>
<td>30</td>
<td>100</td>
</tr>
<tr>
<td>20</td>
<td>Rayleigh</td>
<td>30.7</td>
<td>100</td>
</tr>
</tbody>
</table>
### A.6.17 3GPP RAx

#### Table A-20: 3GPP TS 25.943 V5.1.0 (2002-06)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Pure Dop</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>5.2</td>
<td>6.4</td>
<td>8.4</td>
<td>9.3</td>
<td>10</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>42</td>
<td>101</td>
<td>129</td>
<td>149</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.7</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>250</td>
<td>250</td>
<td>250</td>
<td>250</td>
<td>250</td>
</tr>
</tbody>
</table>

#### Table A-21: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

<table>
<thead>
<tr>
<th></th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>13.1</td>
<td>15.3</td>
<td>18.5</td>
<td>20.4</td>
<td>22.4</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>245</td>
<td>312</td>
<td>410</td>
<td>469</td>
<td>528</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
### A.6.18 3GPP Birth Death

3GPP TS 25.101 V6.2.0 (2003-09), annex B.2.4

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Static</td>
<td>Static</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0…10us</td>
<td>0…10us</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Dwell: 191ms  
(Mean)-Offset: 5 us

### A.6.19 Reference + Moving Channel


### A.6.20 HST1 Open Space, HST1 Open Space (DL+UL)

See Chapter A.14.1, "HST1 Open Space, HST1 Open Space (DL+UL)", on page 292.

### A.6.21 HST2 Tunnel Leaky Cable

See Chapter A.14.2, "HST2 Tunnel Leaky Cable, HST2 Tunnel Leaky Cable (DL+UL)", on page 293.

### A.6.22 HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL+UL)

See Chapter A.14.3, "HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL+UL)", on page 293.
## A.7 WLAN Standards

Option: R&S SMW-B14/B15

### A.7.1 WLAN / HyperLan/2 Model A

<table>
<thead>
<tr>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3 (Path 1)</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
<th>Path 7 (Path 10)</th>
<th>Path 8</th>
<th>Path 9</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile</strong></td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Profile Type</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>0</td>
<td>0.9</td>
<td>1.7</td>
<td>2.6</td>
<td>3.5</td>
<td>4.3</td>
<td>5.2</td>
<td>6.1</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
<td>50</td>
<td>60</td>
<td>70</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Path 10 (Path 7)</th>
<th>Path 11</th>
<th>Path 12</th>
<th>Path 13</th>
<th>Path 14</th>
<th>Path 15</th>
<th>Path 16</th>
<th>Path 17</th>
<th>Path 18</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile</strong></td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Profile Type</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>7.8</td>
<td>4.7</td>
<td>7.3</td>
<td>9.9</td>
<td>12.5</td>
<td>13.7</td>
<td>18</td>
<td>22.4</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>90</td>
<td>110</td>
<td>140</td>
<td>170</td>
<td>200</td>
<td>240</td>
<td>290</td>
<td>340</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Corresp. to a typical office environment for NLOS conditions and an average rms delay spread of 50ns

### A.7.2 WLAN / HyperLan/2 Model B

<table>
<thead>
<tr>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3 (Path 5)</th>
<th>Path 4 (Path 1)</th>
<th>Path 5 (Path 3)</th>
<th>Path 6</th>
<th>Path 7 (Path 10)</th>
<th>Path 8</th>
<th>Path 9</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Freq Ratio:</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]:</strong></td>
<td>10.8</td>
<td>10.8</td>
<td>10.8</td>
<td>10.8</td>
<td>10.8</td>
<td>10.8</td>
<td>10.8</td>
<td>10.8</td>
</tr>
</tbody>
</table>

### Profile [Type]
- Rayleigh
- LogNormal
- Correlated

### Loss [dB]:
- 2.6
- 3
- 3.5
- 3.9
- 0
- 1.3
- 2.6
- 3.9
- 3.4

### Delay [ns]:
- 0
- 10
- 20
- 30
- 50
- 80
- 110
- 140
- 180

### Power Ratio [dB]:
- 0
- 0
- 0
- 0
- 0
- 0
- 0
- 0
- 0

### Speed [km/h]:
- 10.8
- 10.8
- 10.8
- 10.8
- 10.8
- 10.8
- 10.8
- 10.8
- 10.8

### Profile [Type]
- Rayleigh
- LogNormal
- Correlated

### Loss [dB]:
- 5.6
- 7.7
- 9.9
- 12.1
- 14.3
- 15.4
- 18.4
- 20.7
- 24.6

### Delay [ns]:
- 230
- 280
- 330
- 380
- 430
- 490
- 560
- 640
- 730

### LogNormal
- off
- off
- off
- off
- off
- off
- off
- off
- off
## A.7.3 WLAN / HyperLan/2 Model C

<table>
<thead>
<tr>
<th>Path 1 (Path 4)</th>
<th>Path 2 (Path 5)</th>
<th>Path 3 (Path 1)</th>
<th>Path 4 (Path 3)</th>
<th>Path 5 (Path 3)</th>
<th>Path 6 (Path 3)</th>
<th>Path 7 (Path 10)</th>
<th>Path 8 (Path 10)</th>
<th>Path 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
</tr>
</tbody>
</table>

Corresp. to a typical large open space and office environments for NLOS conditions and an average rms delay spread of 100ns.
### A.7.4 WLAN / HyperLan/2 Model D

<table>
<thead>
<tr>
<th></th>
<th>Path 1 (Path 4)</th>
<th>Path 2 (Path 5)</th>
<th>Path 3 (Path 1)</th>
<th>Path 4 (Path 3)</th>
<th>Path 5 (Path 2)</th>
<th>Path 6</th>
<th>Path 7 (Path 10)</th>
<th>Path 8 (Path 11)</th>
<th>Path 9 (Path 14)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rice</td>
<td>Rayleigh</td>
<td>Rice</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>0</td>
<td>10</td>
<td>10,3</td>
<td>10,6</td>
<td>6,4</td>
<td>7,2</td>
<td>8,1</td>
<td>9</td>
<td>7,9</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>50</td>
<td>80</td>
<td>110</td>
<td>140</td>
<td>180</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>10</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio:</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
</tr>
</tbody>
</table>
Corresponds to a typical office environment for "LOS" conditions. A 10db spike at 0 delay has been added resulting in an average rms delay spread of 140ns

### A.7.5 WLAN / HyperLan/2 Model E

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1 (Path 5)</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4 (Path 1)</th>
<th>Path 5 (Path 3)</th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]</td>
<td>4,9</td>
<td>5,1</td>
<td>5,2</td>
<td>0,8</td>
<td>1,3</td>
<td>1,9</td>
<td>0,3</td>
<td>1,2</td>
<td>2,1</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>40</td>
<td>70</td>
<td>100</td>
<td>140</td>
<td>190</td>
<td>240</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Path 1 (Path 5)</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5 (Path 1)</th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
<th>Path 11</th>
<th>Path 12 (Path 15)</th>
<th>Path 13</th>
<th>Path 14 (Path 12)</th>
<th>Path 15</th>
<th>Path 16</th>
<th>Path 17</th>
<th>Path 18</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Loss [dB]:</strong></td>
<td>0</td>
<td>1,9</td>
<td>2,8</td>
<td>5,4</td>
<td>7,3</td>
<td>10,6</td>
<td>13,4</td>
<td>17,4</td>
<td>20,9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Delay [ns]:</strong></td>
<td>320</td>
<td>430</td>
<td>560</td>
<td>710</td>
<td>880</td>
<td>1070</td>
<td>1280</td>
<td>1510</td>
<td>1760</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Power Ratio [dB]:</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Freq Ratio:</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Speed [km/h]:</strong></td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td>10,8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Corresponds to a typical large open space environment for NLOS conditions and an average rms delay spread of 250ns

### A.8 DAB Standards

Option: R&S SMW-K72

#### A.8.1 DAB RA (4Tabs)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rice</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Loss [dB]:</strong></td>
<td>0</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td><strong>Delay [ns]:</strong></td>
<td>0</td>
<td>200</td>
<td>400</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]:</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
### A.8.2 DAB RA (6 Tabs)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rice</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>0</td>
<td>4</td>
<td>8</td>
<td>12</td>
<td>16</td>
<td>20</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
<td>100</td>
<td>200</td>
<td>300</td>
<td>400</td>
<td>500</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong>:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>120</td>
<td>120</td>
<td>120</td>
<td>120</td>
<td>120</td>
<td>120</td>
</tr>
</tbody>
</table>

Tap 2: S(d) = 0,1 +/- 0,02

### A.8.3 DAB TU (12 Tabs)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Gaus1</td>
<td>Gaus1</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>4</td>
<td>3</td>
<td>0</td>
<td>2,6</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
<td>100</td>
<td>300</td>
<td>500</td>
<td>800</td>
<td>1100</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong>:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>25</td>
<td>25</td>
<td>25</td>
<td>25</td>
<td>25</td>
<td>25</td>
</tr>
</tbody>
</table>

Path 7 | Path 8 | Path 9 | Path 10 | Path 11 | Path 12
Profile [Type] | Gaus1 | Gaus1 | Gaus2 | Gaus2 | Gaus2 | Gaus2
DAB Standards

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]: 7</td>
<td>5</td>
<td>6.5</td>
<td>8.6</td>
<td>11</td>
<td>10</td>
</tr>
<tr>
<td>Delay [ns]: 1300</td>
<td>1700</td>
<td>2300</td>
<td>3100</td>
<td>3200</td>
<td>5000</td>
</tr>
<tr>
<td>LogNormal off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]: 0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio: 0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]: 25</td>
<td>25</td>
<td>25</td>
<td>25</td>
<td>25</td>
<td>25</td>
</tr>
</tbody>
</table>

Tap 6: $S(d) = 1.0 \pm 0.1$

A.8.4 DAB TU (6 Tabs)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type] Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Gaus1</td>
<td>Gaus2</td>
<td>Gaus2</td>
</tr>
<tr>
<td>Loss [dB]: 3</td>
<td>0</td>
<td>2</td>
<td>6</td>
<td>8</td>
<td>10</td>
</tr>
<tr>
<td>Delay [ns]: 0</td>
<td>200</td>
<td>500</td>
<td>1600</td>
<td>2300</td>
<td>5000</td>
</tr>
<tr>
<td>LogNormal off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]: 0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio: 0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]: 25</td>
<td>25</td>
<td>25</td>
<td>25</td>
<td>25</td>
<td>25</td>
</tr>
</tbody>
</table>

Tap 3: $S(d) = 1.0 \pm 0.1$

A.8.5 DAB SFN (VHF)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
<th>Path 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type] Rayleigh</td>
<td>GausDAB</td>
<td>GausDAB</td>
<td>GausDAB</td>
<td>GausDAB</td>
<td>GausDAB</td>
<td>GausDAB</td>
</tr>
<tr>
<td>Loss [dB]: 0</td>
<td>13</td>
<td>18</td>
<td>22</td>
<td>26</td>
<td>31</td>
<td>32</td>
</tr>
<tr>
<td>Delay [ns]: 0</td>
<td>100000</td>
<td>220000</td>
<td>290000</td>
<td>385000</td>
<td>480000</td>
<td>600000</td>
</tr>
<tr>
<td>LogNormal off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>
Predefined Fading Settings

Path 1  Path 2  Path 3  Path 4  Path 5  Path 6  Path 7
Corr with: off  off  off  off  off  off  off
Power Ratio [dB]: 0  0  0  0  0  0  0
Freq Ratio: 0  0  0  0  0  0  0
Speed [km/h]: 60  60  60  60  60  60  60

Needs both Fading Boards combined, i.e. Signal Routing "A->A(max paths) || B->B(unfaded)" or "A->A(unfaded) || B->B(max paths)".
Do not use Group 5.

A.9 WIMAX Standards

- WiMAX SUI x
  Option: R&S SMW-K72
- WiMAX ITU
  Option: R&S SMW-B14/B15

A.9.1 SUI 1 (omni ant., 90%)

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>15</td>
<td>20</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>400</td>
<td>900</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>6,026</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0,4</td>
<td>0,3</td>
<td>0,5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0,05</td>
<td>0,04</td>
<td>0,06</td>
</tr>
</tbody>
</table>

K-fact. = 4 ->> 10lg4 = 6,02
### A.9.2 SUI 1 (omni ant., 75%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>15</td>
<td>20</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>400</td>
<td>900</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>13.0103</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.4</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.05</td>
<td>0.04</td>
<td>0.06</td>
</tr>
</tbody>
</table>

### A.9.3 SUI 1 (30° ant., 90%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>21</td>
<td>32</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>400</td>
<td>900</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>12.0412</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.4</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.05</td>
<td>0.04</td>
<td>0.06</td>
</tr>
</tbody>
</table>

### A.9.4 SUI 1 (30° ant., 75%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>21</td>
<td>32</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>400</td>
<td>900</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>18.57332</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.4</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.05</td>
<td>0.04</td>
<td>0.06</td>
</tr>
</tbody>
</table>
K-fact. = 72

**A.9.5 SUI 2 (omni ant., 75%)**

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>12</td>
<td>15</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>400</td>
<td>1100</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>10.41393</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.2</td>
<td>0.15</td>
<td>0.25</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.03</td>
<td>0.02</td>
<td>0.03</td>
</tr>
</tbody>
</table>

**A.9.6 SUI 2 (30° ant., 90%)**

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>18</td>
<td>27</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>400</td>
<td>1100</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>9.0309</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.2</td>
<td>0.15</td>
<td>0.25</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.03</td>
<td>0.02</td>
<td>0.03</td>
</tr>
</tbody>
</table>

K=8

**A.9.7 SUI 2 (30° ant., 75%)**

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>18</td>
<td>27</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>400</td>
<td>1100</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>15,56303</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.2</td>
<td>0.15</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.03</td>
<td>0.02</td>
</tr>
</tbody>
</table>

K=36

#### A.9.8 SUI 3 (omni ant., 90%)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>400</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.4</td>
<td>0.3</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.05</td>
<td>0.04</td>
</tr>
</tbody>
</table>

#### A.9.9 SUI 3 (omni ant., 75%)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>400</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>8.45098</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.4</td>
<td>0.3</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.05</td>
<td>0.04</td>
</tr>
</tbody>
</table>

K=7
### A.9.10 SUI 3 (30° ant., 90%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>11</td>
<td>22</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>400</td>
<td>900</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>4.771213</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0.4</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>0.05</td>
<td>0.04</td>
<td>0.06</td>
</tr>
</tbody>
</table>

K=3

### A.9.11 SUI 3 (30° ant., 75%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>11</td>
<td>22</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>400</td>
<td>900</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>12.78754</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0.4</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>0.05</td>
<td>0.04</td>
<td>0.06</td>
</tr>
</tbody>
</table>

K=19

### A.9.12 SUI 4 (omni ant., 90%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMDopp</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>4</td>
<td>8</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>1500</td>
<td>4000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>
Predefined Fading Settings

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.2</td>
<td>0.15</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.03</td>
<td>0.02</td>
</tr>
</tbody>
</table>

K=0 (no Rice-component)

A.9.13 **SUI 4 (omni ant., 75%)**

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>1500</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.2</td>
<td>0.15</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.03</td>
<td>0.02</td>
</tr>
</tbody>
</table>

K=1

A.9.14 **SUI 4 (30° ant., 90%)**

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>400</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.2</td>
<td>0.15</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.03</td>
<td>0.02</td>
</tr>
</tbody>
</table>

K=1
A.9.15 SUI 4 (30° ant., 75%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>10</td>
<td>20</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>400</td>
<td>1100</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>6.9897</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0.2</td>
<td>0.15</td>
<td>0.25</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>0.03</td>
<td>0.02</td>
<td>0.03</td>
</tr>
</tbody>
</table>

K=5

A.9.16 SUI 5 (omni ant., 90%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMDopp</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>4000</td>
<td>10000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0.2</td>
<td>0.15</td>
<td>0.25</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>0.03</td>
<td>0.02</td>
<td>0.03</td>
</tr>
</tbody>
</table>

K=0 (no Rice-component)

A.9.17 SUI 5 (omni ant., 75%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMDopp</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>4000</td>
<td>10000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>
Predefined Fading Settings

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.2</td>
<td>0.15</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.03</td>
<td>0.02</td>
</tr>
</tbody>
</table>

K=0 (no Rice-component)

A.9.18  SUI 5 (omni ant., 50%)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>4000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>3.0103</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.2</td>
<td>0.15</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.03</td>
<td>0.02</td>
</tr>
</tbody>
</table>

K=2

A.9.19  SUI 5 (30° ant., 90%)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>11</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>4000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.2</td>
<td>0.15</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.03</td>
<td>0.02</td>
</tr>
</tbody>
</table>

K=0 (no Rice-component)
### A.9.20 SUI 5 (30° ant., 75%)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>11</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>4000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>3,0103</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0,2</td>
<td>0,15</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>0,03</td>
<td>0,02</td>
</tr>
</tbody>
</table>

K=2

### A.9.21 SUI 5 (30° ant., 50%)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>11</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>4000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>8,45098</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0,2</td>
<td>0,15</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>0,03</td>
<td>0,02</td>
</tr>
</tbody>
</table>

K=7

### A.9.22 SUI 6 (omni ant., 90%)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>14000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>

WIMAX Standards
Predefined Fading Settings

### A.9.23 SUI 6 (omni ant., 75%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
<td>0.4</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>0.05</td>
<td>0.04</td>
<td>0.06</td>
</tr>
</tbody>
</table>

K=0 (no Rice-component)

### A.9.24 SUI 6 (omni ant., 50%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>0</td>
<td>10</td>
<td>14</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
<td>14000</td>
<td>20000</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
<td>0.4</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>0.05</td>
<td>0.04</td>
<td>0.06</td>
</tr>
</tbody>
</table>

K=1
A.9.25  SUI 6 (30° ant., 90%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMDopp</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]: 0</td>
<td>16</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>Delay [ns]: 0</td>
<td>14000</td>
<td>20000</td>
<td></td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.4</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.05</td>
<td>0.04</td>
<td>0.06</td>
</tr>
</tbody>
</table>

K=0 (no Rice-component)

A.9.26  SUI 6 (30° ant., 75%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]: 0</td>
<td>16</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>Delay [ns]: 0</td>
<td>14000</td>
<td>20000</td>
<td></td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>3.0103</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0.4</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.05</td>
<td>0.04</td>
<td>0.06</td>
</tr>
</tbody>
</table>

K=2

A.9.27  SUI 6 (30° ant., 50%)

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>WMRice</td>
<td>WMDopp</td>
<td>WMDopp</td>
</tr>
<tr>
<td>Loss [dB]: 0</td>
<td>16</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>Delay [ns]: 0</td>
<td>14000</td>
<td>20000</td>
<td></td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>
### A.9.28 ITU OIP-A

<table>
<thead>
<tr>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4 (Path 1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>9.7</td>
<td>19.2</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>110</td>
<td>190</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### A.9.29 ITU OIP-B

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0.9</td>
<td>4.9</td>
<td>8</td>
<td>7.8</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>200</td>
<td>800</td>
<td>1200</td>
<td>2300</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
### A.9.30 ITU V-A 60

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4 (Path 1)</th>
<th>Path 5 (Path 7)</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>1</td>
<td>9</td>
<td>10</td>
<td>15</td>
<td>20</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>310</td>
<td>710</td>
<td>1090</td>
<td>1730</td>
<td>2510</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
</tr>
</tbody>
</table>

### A.9.31 ITU V-A 120

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4 (Path 1)</th>
<th>Path 5 (Path 7)</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>1</td>
<td>9</td>
<td>10</td>
<td>15</td>
<td>20</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>310</td>
<td>710</td>
<td>1090</td>
<td>1730</td>
<td>10000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>120</td>
<td>120</td>
<td>120</td>
<td>120</td>
<td>120</td>
<td>120</td>
</tr>
</tbody>
</table>

### A.10 LTE Standards

Option: R&S SMW-B14/B15
### A.10.1 CQI 5Hz

CQI Tests according to 3GPP 36.521.1 Version 9.1.0, B2.4

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Const. Phase</td>
<td>0</td>
<td>0</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pure Doppler</td>
<td>0</td>
<td>450</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
<td>5 Hz</td>
</tr>
</tbody>
</table>

### A.10.2 EPA (Extended Pedestrian A)

*Table A-22: 3GPP TR36.803*

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rayleigh</td>
<td>0</td>
<td>0</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Rayleigh</td>
<td>1</td>
<td>30</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Rayleigh</td>
<td>2</td>
<td>70</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Rayleigh</td>
<td>3</td>
<td>90</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Rayleigh</td>
<td>8</td>
<td>110</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rayleigh</td>
<td>17.2</td>
<td>190</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Rayleigh</td>
<td>20.8</td>
<td>410</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rayleigh</td>
<td>0</td>
<td>0</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Rayleigh</td>
<td>0</td>
<td>0</td>
<td>off</td>
<td>off</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

*User Manual 1175.6826.02 — 20 279*
A.10.3  EVA (Extended Vehicular A)

Table A-23: 3GPP TR36.803

<table>
<thead>
<tr>
<th></th>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4 (Path 1)</th>
<th>Path 5 (Path 11)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>1.5</td>
<td>1.4</td>
<td>3.6</td>
<td>0.6</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>30</td>
<td>150</td>
<td>310</td>
<td>370</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Frequency [Hz]:</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Path 6</td>
<td>Path 7</td>
<td>Path 8</td>
<td>Path 9 (Path 12)</td>
<td>Path 10</td>
</tr>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>9.1</td>
<td>7</td>
<td>12</td>
<td>16.9</td>
<td></td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>710</td>
<td>1090</td>
<td>1730</td>
<td>2510</td>
<td></td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td></td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td></td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Frequency [Hz]:</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A.10.4  ETU (Extended Typical Urban)

Table A-24: 3GPP TR36.803

<table>
<thead>
<tr>
<th></th>
<th>Path 1 (Path 5)</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5 (Path 1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>50</td>
<td>120</td>
<td>200</td>
<td>230</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Path 5)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Frequency [Hz]: *</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>3</td>
<td>5</td>
<td>7</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>500</td>
<td>1600</td>
<td>2300</td>
<td>5000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Frequency [Hz]: *</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) Frequency [Hz] = 1 Hz, 30 Hz, 70 Hz, 300 Hz or 600 Hz

#### A.10.5 MBSFN Propagation Channel Profile (5 Hz)


* All fading paths use "Frequency = 5 Hz" and "Speed = 5.4 km/h".

#### A.10.6 HST1 Open Space

See Chapter A.14.1, "HST1 Open Space, HST1 Open Space (DL+UL)", on page 292.

#### A.10.7 HST3 Tunnel Multi Antennas

See Chapter A.14.3, "HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL +UL)", on page 293.

#### A.10.8 ETU 200Hz Moving

## A.10.9 Pure Doppler Moving


## A.11 LTE-MIMO Standards

Option: R&S SMW-K74

### A.11.1 EPA (Extended Pedestrian A)

See Chapter A.10.2, "EPA (Extended Pedestrian A)", on page 279.

### A.11.2 EVA (Extended Vehicular A)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4 (Path 11)</th>
<th>Path 5 (Path 12)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>1.5</td>
<td>1.4</td>
<td>3.6</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>30</td>
<td>150</td>
<td>310</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Frequency [Hz]: *</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9 (Path 13)</th>
<th>Path 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>9.1</td>
<td>7</td>
<td>12</td>
<td>16.9</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>710</td>
<td>1090</td>
<td>1730</td>
<td>2510</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Frequency [Hz]: *</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A.11.3 ETU (Extended Typical Urban)

See Chapter A.10.4, "ETU (Extended Typical Urban)", on page 280.

A.11.4 MIMO Parameter

**Table A-25: R-High**

<table>
<thead>
<tr>
<th>Real</th>
<th>Imaginary</th>
<th>Real</th>
<th>Imaginary</th>
<th>Real</th>
<th>Imaginary</th>
<th>Real</th>
<th>Imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>-0.4193</td>
<td>0.24</td>
<td>0.5297</td>
<td>0.7013</td>
<td>-0.3904</td>
<td>-0.1669</td>
</tr>
<tr>
<td>-0.4193</td>
<td>-0.24</td>
<td>1</td>
<td>0</td>
<td>-0.0538</td>
<td>-0.4212</td>
<td>0.5297</td>
<td>0.7013</td>
</tr>
<tr>
<td>0.5297</td>
<td>-0.7013</td>
<td>-0.0538</td>
<td>0.4212</td>
<td>1</td>
<td>0</td>
<td>-0.4193</td>
<td>0.24</td>
</tr>
<tr>
<td>-0.3904</td>
<td>0.1669</td>
<td>0.5297</td>
<td>-0.7013</td>
<td>-0.4193</td>
<td>-0.24</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

**Table A-26: R-Medium**

<table>
<thead>
<tr>
<th>Real</th>
<th>Imaginary</th>
<th>Real</th>
<th>Imaginary</th>
<th>Real</th>
<th>Imaginary</th>
<th>Real</th>
<th>Imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.7264</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0.7264</td>
<td>0</td>
</tr>
<tr>
<td>0.7264</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>-0.7264</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

**Table A-27: R-Low**

<table>
<thead>
<tr>
<th>Real</th>
<th>Imaginary</th>
<th>Real</th>
<th>Imaginary</th>
<th>Real</th>
<th>Imaginary</th>
<th>Real</th>
<th>Imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

The MIMO correlation matrices for the high, medium and low antenna correlation for the 1x2, 2x2 and 4x2 MIMO configurations are calculated according to 3GPP TS36.101, annex B2.3.2.

A.11.5 HST3 Tunnel Multi Antennas

See Chapter A.14.3, "HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL +UL)", on page 293.

A.12 WIMAX-MIMO Standards

Option: R&S SMW-K74
### A.12.1 ITU Pedestrian B 3

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0,9</td>
<td>4,9</td>
<td>8</td>
<td>7,8</td>
<td>23,9</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>200</td>
<td>800</td>
<td>1200</td>
<td>2300</td>
<td>3700</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

#### Table A-28: MIMO Parameter - High Correlation

<table>
<thead>
<tr>
<th>TAP 1</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>-0,1468</td>
<td>0,4156</td>
<td>0,0303</td>
<td>0,7064</td>
<td>-0,298</td>
<td>-0,0911</td>
<td></td>
</tr>
<tr>
<td>-0,1468</td>
<td>-0,4156</td>
<td>1</td>
<td>0</td>
<td>0,28913</td>
<td>-0,1163</td>
<td>0,0303</td>
<td>0,7064</td>
<td></td>
</tr>
<tr>
<td>0,0303</td>
<td>-0,7064</td>
<td>0,28913</td>
<td>0,11629</td>
<td>1</td>
<td>0</td>
<td>-0,1468</td>
<td>0,4156</td>
<td></td>
</tr>
<tr>
<td>-0,298</td>
<td>0,09111</td>
<td>0,0303</td>
<td>-0,7064</td>
<td>-0,1468</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 2</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>-0,4467</td>
<td>0,4227</td>
<td>-0,4007</td>
<td>-0,6073</td>
<td>0,4357</td>
<td>0,10191</td>
<td></td>
</tr>
<tr>
<td>-0,4467</td>
<td>-0,4227</td>
<td>1</td>
<td>0</td>
<td>-0,0777</td>
<td>0,44066</td>
<td>-0,4007</td>
<td>-0,6073</td>
<td></td>
</tr>
<tr>
<td>-0,4007</td>
<td>0,6073</td>
<td>-0,0777</td>
<td>-0,4407</td>
<td>1</td>
<td>0</td>
<td>-0,4467</td>
<td>0,4227</td>
<td></td>
</tr>
<tr>
<td>0,4357</td>
<td>-0,1019</td>
<td>-0,4007</td>
<td>0,6073</td>
<td>-0,4467</td>
<td>-0,4227</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 3</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>-0,2906</td>
<td>0,4347</td>
<td>-0,6664</td>
<td>0,262</td>
<td>0,07976</td>
<td>-0,3658</td>
<td></td>
</tr>
<tr>
<td>-0,2906</td>
<td>-0,4347</td>
<td>1</td>
<td>0</td>
<td>0,30755</td>
<td>0,21355</td>
<td>-0,6664</td>
<td>0,262</td>
<td></td>
</tr>
<tr>
<td>-0,6644</td>
<td>-0,262</td>
<td>0,30755</td>
<td>-0,2135</td>
<td>1</td>
<td>0</td>
<td>-0,2906</td>
<td>0,4347</td>
<td></td>
</tr>
<tr>
<td>0,07976</td>
<td>0,36582</td>
<td>-0,6664</td>
<td>-0,262</td>
<td>-0,2906</td>
<td>-0,4347</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 4</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>-0,4273</td>
<td>0,4259</td>
<td>-0,6522</td>
<td>0,2088</td>
<td>0,18976</td>
<td>-0,367</td>
<td></td>
</tr>
<tr>
<td>-0,4273</td>
<td>-0,4259</td>
<td>1</td>
<td>0</td>
<td>0,36761</td>
<td>0,18855</td>
<td>-0,6522</td>
<td>0,2088</td>
<td></td>
</tr>
<tr>
<td>-0,6522</td>
<td>-0,2088</td>
<td>0,36761</td>
<td>-0,1886</td>
<td>1</td>
<td>0</td>
<td>-0,4273</td>
<td>0,4259</td>
<td></td>
</tr>
<tr>
<td>0,18976</td>
<td>0,36699</td>
<td>-0,6522</td>
<td>-0,2088</td>
<td>-0,4273</td>
<td>-0,4259</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 5</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>-0,7026</td>
<td>-0,3395</td>
<td>-0,5378</td>
<td>-0,4866</td>
<td>0,21266</td>
<td>0,52447</td>
<td></td>
</tr>
<tr>
<td>-0,7026</td>
<td>0,3395</td>
<td>1</td>
<td>0</td>
<td>0,54306</td>
<td>0,1593</td>
<td>-0,5378</td>
<td>-0,4866</td>
<td></td>
</tr>
<tr>
<td>-0,5378</td>
<td>0,4866</td>
<td>0,54306</td>
<td>-0,1593</td>
<td>1</td>
<td>0</td>
<td>-0,7026</td>
<td>-0,3395</td>
<td></td>
</tr>
<tr>
<td>0,21266</td>
<td>-0,5245</td>
<td>-0,5378</td>
<td>0,4866</td>
<td>-0,7026</td>
<td>0,3395</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
### Table A-29: MIMO Parameter - Medium Correlation

<table>
<thead>
<tr>
<th>TAP 6</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>-0.45</td>
<td>0.4222</td>
<td>-0.4564</td>
<td>0.5655</td>
<td>0.44413</td>
<td>0.06178</td>
</tr>
<tr>
<td></td>
<td>-0.45</td>
<td>-0.4222</td>
<td>1</td>
<td>0</td>
<td>-0.0334</td>
<td>0.44717</td>
<td>-0.4564</td>
<td>-0.5655</td>
</tr>
<tr>
<td></td>
<td>-0.4564</td>
<td>0.5655</td>
<td>-0.0334</td>
<td>-0.4472</td>
<td>1</td>
<td>0</td>
<td>-0.45</td>
<td>0.4222</td>
</tr>
<tr>
<td></td>
<td>0.44413</td>
<td>-0.0618</td>
<td>-0.4564</td>
<td>0.5655</td>
<td>-0.45</td>
<td>-0.4222</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

### Table A-30: MIMO Parameter - Low Correlation

<table>
<thead>
<tr>
<th>TAP 1 - TAP 6</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0.7264</td>
<td>0</td>
</tr>
<tr>
<td>0.7264</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>-0.7264</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 1</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0,02201</td>
<td>0,51313</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0.022</td>
<td>-0.5131</td>
</tr>
<tr>
<td></td>
<td>0,02201</td>
<td>-0,5131</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>-0.022</td>
<td>0,51313</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 2</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0,2911</td>
<td>-0,4111</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0,29107</td>
<td>0,41114</td>
</tr>
<tr>
<td>-0,2911</td>
<td>0,41114</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0,29107</td>
<td>-0,4111</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 3</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0,4841</td>
<td>0,19032</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0,48407</td>
<td>-0,1903</td>
</tr>
<tr>
<td>-0,4841</td>
<td>0,19032</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0,48407</td>
<td>0,19032</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 4</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0,4738</td>
<td>0,15167</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0,47376</td>
<td>-0,1517</td>
</tr>
<tr>
<td>-0,4738</td>
<td>0,15167</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0,47376</td>
<td>0,15167</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 5</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0,3907</td>
<td>-0,3535</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
## A.12.2 ITU Vehicular A-60

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4 (Path 7)</th>
<th>Path 5 (Path 8)</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>0</td>
<td>1</td>
<td>9</td>
<td>10</td>
<td>15</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
<td>310</td>
<td>710</td>
<td>1090</td>
<td>1730</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
</tr>
</tbody>
</table>

### Table A-31: MIMO Parameter - High Correlation

<table>
<thead>
<tr>
<th>TAP 1</th>
<th>TAP 2</th>
<th>TAP 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>real</td>
<td>imagi-</td>
<td>real</td>
</tr>
<tr>
<td>-0.3907</td>
<td>0.35347</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0.39066</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>-0.3315</td>
<td>0.41078</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0.33153</td>
</tr>
<tr>
<td>0.6883</td>
<td>-0.1211</td>
<td>-0.1106</td>
</tr>
<tr>
<td>-0.2151</td>
<td>-0.2681</td>
<td>0.6883</td>
</tr>
<tr>
<td>0.1388</td>
<td>0.2343</td>
<td>0.2343</td>
</tr>
<tr>
<td>0.1388</td>
<td>-0.2343</td>
<td>1</td>
</tr>
<tr>
<td>-0.3508</td>
<td>0.5926</td>
<td>-0.1875</td>
</tr>
<tr>
<td>0.09016</td>
<td>0.16445</td>
<td>-0.3508</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>-0.6443</td>
</tr>
<tr>
<td>-0.6443</td>
<td>-0.365</td>
<td>1</td>
</tr>
<tr>
<td>real</td>
<td>imaginary</td>
<td>real</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>0,3884</td>
<td>0,5604</td>
<td>-0,4548</td>
</tr>
<tr>
<td>-0,0457</td>
<td>-0,5028</td>
<td>0,3884</td>
</tr>
<tr>
<td>TAP 4</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0,362</td>
<td>-0,4331</td>
</tr>
<tr>
<td></td>
<td>0,1899</td>
<td>-0,6795</td>
</tr>
<tr>
<td></td>
<td>-0,363</td>
<td>0,16373</td>
</tr>
<tr>
<td>TAP 5</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0,7074</td>
<td>-0,3372</td>
</tr>
<tr>
<td></td>
<td>-0,3933</td>
<td>0,565</td>
</tr>
<tr>
<td></td>
<td>0,46874</td>
<td>-0,2671</td>
</tr>
<tr>
<td>TAP 6</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0,4405</td>
<td>-0,4238</td>
</tr>
<tr>
<td></td>
<td>-0,4383</td>
<td>0,58</td>
</tr>
<tr>
<td></td>
<td>0,43888</td>
<td>-0,0697</td>
</tr>
</tbody>
</table>

Table A-32: MIMO Parameter - Medium Correlation

<table>
<thead>
<tr>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAP 1- TAP 6</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0,7264</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0,7264</td>
<td>0</td>
</tr>
<tr>
<td>0,7264</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>-0,7264</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Table A-33: MIMO Parameter - Low Correlation

<table>
<thead>
<tr>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAP 1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0,49998</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0,49998</td>
<td>-0,088</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>-0,5</td>
<td>0,08797</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>TAP 2</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0,2548</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-0,2548</td>
<td>0,43046</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0,25482</td>
<td>-0,4305</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
### A.13 1xEVDO Standards

Option: R&S SMW-B14/B15

According to 3GPP2 C.S0032-A v2.0

#### A.13.1 1xEVDO Chan. 1

<table>
<thead>
<tr>
<th>TAP 3</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0,28213</td>
<td>-0,4071</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0,2821</td>
<td>0</td>
<td>-0,40707</td>
</tr>
<tr>
<td></td>
<td>0,28213</td>
<td>0,40707</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>-0,2821</td>
<td>-0,4071</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 4</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0,13794</td>
<td>0,49359</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>-0,1379</td>
<td>-0,4936</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0,13794</td>
<td>-0,4936</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>-0,1379</td>
<td>0,49359</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 5</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0,3907</td>
<td>-0,3535</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0,39066</td>
<td>0,35347</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0,3907</td>
<td>0,35347</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0,39066</td>
<td>-0,3535</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAP 6</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
<th>real</th>
<th>imaginary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-0,3184</td>
<td>-0,4213</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0,31838</td>
<td>0,42131</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0,3184</td>
<td>0,42131</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0,31838</td>
<td>-0,4213</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
</tr>
</tbody>
</table>
### A.13.2 1xEVDO Chan. 1 (Bd. 5, 11)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio:</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>15</td>
</tr>
</tbody>
</table>

### A.13.3 1xEVDO Chan. 2

<table>
<thead>
<tr>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
</tr>
<tr>
<td>Loss [dB]:</td>
</tr>
<tr>
<td>Delay [ns]:</td>
</tr>
<tr>
<td>LogNormal</td>
</tr>
<tr>
<td>Corr with</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
</tr>
<tr>
<td>Freq Ratio:</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
</tr>
</tbody>
</table>

### A.13.4 1xEVDO Chan. 2 (Bd. 5, 11)

<table>
<thead>
<tr>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
</tr>
<tr>
<td>Loss [dB]:</td>
</tr>
<tr>
<td>Delay [ns]:</td>
</tr>
</tbody>
</table>
### A.13.5 1xEVDO Chan. 3

<table>
<thead>
<tr>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
</tr>
</tbody>
</table>

### A.13.6 1xEVDO Chan. 3 (Bd. 5, 11)

<table>
<thead>
<tr>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
</tr>
<tr>
<td><strong>Freq Ratio</strong></td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
</tr>
</tbody>
</table>
### A.13.7 1xEVDO Chan. 4

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>2000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

### A.13.8 1xEVDO Chan. 4 (Bd. 5, 11)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>2000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>192</td>
<td>192</td>
</tr>
</tbody>
</table>

### A.13.9 1xEVDO Chan. 5

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>0</td>
</tr>
</tbody>
</table>
### A.13.10 1xEVDO Chan. 5 (Bd. 5, 11)

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Rayleigh</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>0</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>0</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
</tr>
<tr>
<td><strong>Power Ratio [dB]</strong></td>
<td>0</td>
</tr>
<tr>
<td><strong>Freq Ratio</strong>:</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td>0</td>
</tr>
</tbody>
</table>

### A.14 3GPP/LTE High Speed Train

Option: R&S SMW-K74 and R&S SMW-K71

#### A.14.1 HST1 Open Space, HST1 Open Space (DL+UL)

3GPP TS25.141, annex D.4A "High Speed Train" and 3GPP TS36.141, annex B.3 "High Speed Train"

The HST DL+UL standards consider the downlink and the uplink. That is, if a doppler shift occurs in the downlink, the mobile receiver synchronizes to that shifted frequency. The uplink to the base station then results in a doppler shift enlarged by a factor based on the sum of the DL and UL frequency.

<table>
<thead>
<tr>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
</tr>
</tbody>
</table>
A.14.2 HST2 Tunnel Leaky Cable, HST2 Tunnel Leaky Cable (DL+UL)

3GPP TS25.141, annex D.4A "High Speed Train"

The HST DL+UL standards consider the downlink and the uplink. That is, if a doppler shift occurs in the downlink, the mobile receiver synchronizes to that shifted frequency. The uplink to the base station then results in a doppler shift enlarged by a factor based on the sum of the DL and UL frequency.

<table>
<thead>
<tr>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Ratio [dB]: -</td>
</tr>
<tr>
<td>Freq Ratio:</td>
</tr>
<tr>
<td>Speed [km/h]: 350km/h</td>
</tr>
<tr>
<td>D_{\text{min}}: 50m</td>
</tr>
<tr>
<td>D_{s}: 1000m</td>
</tr>
</tbody>
</table>

A.14.3 HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL+UL)

3GPP TS25.141, annex D.4A "High Speed Train" and 3GPP TS36.141, annex B.3A "High Speed Train"

The HST DL+UL standards consider the downlink and the uplink. That is, if a doppler shift occurs in the downlink, the mobile receiver synchronizes to that shifted frequency. The uplink to the base station then results in a doppler shift enlarged by a factor based on the sum of the DL and UL frequency.

<table>
<thead>
<tr>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]: Rice</td>
</tr>
<tr>
<td>Loss [dB]: 10</td>
</tr>
<tr>
<td>Delay [ns]: 0</td>
</tr>
<tr>
<td>LogNormal: off</td>
</tr>
<tr>
<td>Corr with: off</td>
</tr>
<tr>
<td>Power Ratio [dB]: 0</td>
</tr>
<tr>
<td>Freq Ratio: 1</td>
</tr>
<tr>
<td>Speed [km/h]: 300km/h</td>
</tr>
</tbody>
</table>
### A.15 3GPP/LTE Moving Propagation

Option: R&S SMW-K71

#### A.15.1 Reference + Moving Channel

*Table A-34: 3GPP TS 25.101, annex B2.3*

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Pure Doppler</td>
<td>Static</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
<td>1... 6us</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]</td>
<td>-</td>
<td>0</td>
</tr>
<tr>
<td>Freq Ratio</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>300km/h</td>
<td>0</td>
</tr>
<tr>
<td>$D_{\text{min}}$</td>
<td>2m</td>
<td></td>
</tr>
<tr>
<td>$D_{\text{s}}$</td>
<td>300m</td>
<td></td>
</tr>
</tbody>
</table>

Period: $157,0796s = 2\pi/0.04$

(Mean)-Delay: $3.5\mu$s
A.15.2 ETU 200Hz Moving (UL Timing Adjustment, Scenario 1)

Table A-35: 3GPP TS36.141, annex B.4 "Moving Propagation Conditions"

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>50</td>
<td>120</td>
<td>200</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Doppler [Hz]:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>120</td>
<td>120</td>
<td>120</td>
<td>120</td>
</tr>
</tbody>
</table>

Path 6

<table>
<thead>
<tr>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>500</td>
<td>1600</td>
<td>2300</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Doppler [Hz]:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>120</td>
<td>120</td>
<td>120</td>
</tr>
</tbody>
</table>

Period: 157.0796s = 2*PI/0.04
Amplitude: 5us = 10us/2

A.15.3 Pure Doppler Moving (UL Timing Adjustment, Scenario 2)

Table A-36: 3GPP TS36.141, annex B.4 "Moving Propagation Conditions"

<table>
<thead>
<tr>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
</tr>
<tr>
<td>Loss [dB]:</td>
</tr>
<tr>
<td>Delay [ns]:</td>
</tr>
<tr>
<td>LogNormal</td>
</tr>
<tr>
<td>Corr with</td>
</tr>
<tr>
<td>Power Ratio [dB]:</td>
</tr>
</tbody>
</table>
**A.16 SCM and SCME Channel Models for MIMO OTA**

Option: R&S SMW-K72

The SCM/SCME models define 6 clusters characterized by the delay, the AoA/AoD, AS and PAS shape.

These channel models are defined for 2x2 MIMO configuration and cannot be loaded in other MIMO configurations.

### SCME models

The following antenna polarization and antenna pattern settings apply for all SCME models.

<table>
<thead>
<tr>
<th>Antenna settings</th>
<th>Polarization</th>
<th>Distance (d_a)</th>
<th>Antenna pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tx</td>
<td>Cross 45°</td>
<td>0</td>
<td>Dipole</td>
</tr>
<tr>
<td>Rx</td>
<td>Horizontal</td>
<td>0.5λ</td>
<td>Isotropic</td>
</tr>
</tbody>
</table>

### Geo SCME models

The following antenna polarization and antenna pattern settings apply for all Geo SCME:

- "Polarization = On"
- "LOS component = Off"
- "σSF = 8 dB"
- "Use random start phases = On"

<table>
<thead>
<tr>
<th>Antenna settings</th>
<th>Distance (d_a)</th>
<th>Antenna pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tx</td>
<td>0</td>
<td>Dipole +45°/-45°</td>
</tr>
<tr>
<td>Rx</td>
<td>0.5λ</td>
<td>Vertical dipole</td>
</tr>
</tbody>
</table>
### A.16.1 SCME/Geo SCME Urban Micro-Cell Channel (UMi) 3 km/h and 30 km/h

<table>
<thead>
<tr>
<th>Tap</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>Profile [type]:</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>3</td>
<td>5.2</td>
<td>7</td>
<td>4.3</td>
<td>6.5</td>
<td>8.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>5</td>
<td>10</td>
<td>285</td>
<td>290</td>
<td>295</td>
</tr>
<tr>
<td>Fine delay required:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>AoA [°]:</td>
<td>0.7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-13.2</td>
</tr>
<tr>
<td>AoD [°]:</td>
<td>6.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>14.1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
<th>Path 11</th>
<th>Path 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>Profile [type]:</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>5.7</td>
<td>7.9</td>
<td>9.7</td>
<td>7.3</td>
<td>9.5</td>
<td>11.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>205</td>
<td>210</td>
<td>215</td>
<td>660</td>
<td>665</td>
<td>670</td>
</tr>
<tr>
<td>Fine delay required:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>AoA [°]:</td>
<td>146.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-30.5</td>
</tr>
<tr>
<td>AoD [°]:</td>
<td>50.8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>38.4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap</th>
<th>Path 13</th>
<th>Path 14</th>
<th>Path 15</th>
<th>Path 16</th>
<th>Path 17</th>
<th>Path 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>Profile [type]:</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>9</td>
<td>11.2</td>
<td>13</td>
<td>11.4</td>
<td>13.6</td>
<td>15.4</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>805</td>
<td>810</td>
<td>815</td>
<td>925</td>
<td>930</td>
<td>935</td>
</tr>
<tr>
<td>Fine delay required:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>AoA [°]:</td>
<td>-11.4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-1.1</td>
</tr>
<tr>
<td>AoD [°]:</td>
<td>6.7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>40.3</td>
</tr>
</tbody>
</table>

- Delay spread [ns]: 294
- Cluster AS AoD / AS AoA [°]: 5 / 35
Cluster PAS shape: Laplacian
Total AS AoD / AS AoA [\(^\circ\)]: 18.2 / 67.8
Mobile speed [km/h] / direction of travel [\(^\circ\)]: 3, 30 / 120
XPR\(^1\) [dB]: 9

\(^1\) XPR = cross polarization power ratio in the selected propagation channel

### A.16.2 SCME/Geo SCME Urban Macro-Cell Channel (UMa) 3 km/h and 30 km/h

<table>
<thead>
<tr>
<th>Tap</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>Profile [type]:</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>3</td>
<td>5.2</td>
<td>7</td>
<td>5.2</td>
<td>7.4</td>
<td>9.2</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>5</td>
<td>10</td>
<td>360</td>
<td>365</td>
<td>370</td>
</tr>
<tr>
<td>Fine delay required:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>AoA [(^\circ)]:</td>
<td>66</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>46</td>
</tr>
<tr>
<td>AoD [(^\circ)]:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>82</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
<th>Path 11</th>
<th>Path 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>Profile [type]:</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>4.7</td>
<td>6.9</td>
<td>8.7</td>
<td>8.2</td>
<td>10.4</td>
<td>12.2</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>255</td>
<td>260</td>
<td>265</td>
<td>1040</td>
<td>1045</td>
<td>1050</td>
</tr>
<tr>
<td>Fine delay required:</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>AoA [(^\circ)]:</td>
<td>143</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>33</td>
</tr>
<tr>
<td>AoD [(^\circ)]:</td>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>99</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap</th>
<th>Path 13</th>
<th>Path 14</th>
<th>Path 15</th>
<th>Path 16</th>
<th>Path 17</th>
<th>Path 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>5</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile [type]:</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Loss [dB]:</td>
<td>12.1</td>
<td>14.3</td>
<td>16.1</td>
<td>15.5</td>
<td>17.7</td>
<td>19.5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>2730</td>
<td>2735</td>
<td>2740</td>
<td>4600</td>
<td>4605</td>
<td>4610</td>
</tr>
</tbody>
</table>
### A.17 Watterson Standards

Option: R&S SMW-K72

#### A.17.1 Watterson I1

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile [Type]</strong></td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
</tr>
<tr>
<td><strong>Loss [dB]</strong></td>
<td>4.1</td>
<td>4.3</td>
<td>1.2</td>
<td>7.2</td>
</tr>
<tr>
<td><strong>Delay [ns]</strong></td>
<td>40000</td>
<td>40000</td>
<td>40000</td>
<td>290000</td>
</tr>
<tr>
<td><strong>LogNormal</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Corr with</strong></td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td><strong>Freq. Spread</strong></td>
<td>0.0073</td>
<td>0.0318</td>
<td>0.0272</td>
<td>0.144</td>
</tr>
<tr>
<td><strong>Freq Shift [Hz]</strong></td>
<td>0.0022</td>
<td>0.017</td>
<td>0.0094</td>
<td>0.0089</td>
</tr>
<tr>
<td><strong>Speed [km/h]</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Tap 2: S(d) = 0.1 +/- 0.02

---

1) XPR = cross polarization power ratio in the selected propagation channel
### A.17.2 Watterson I2

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>4.1</td>
<td>5.5</td>
<td>1.7</td>
<td>5.9</td>
<td>17.6</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>40000</td>
<td>40000</td>
<td>40000</td>
<td>290000</td>
<td>590000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Freq. Spread</td>
<td>0.0064</td>
<td>0.0084</td>
<td>0.0153</td>
<td>0.18</td>
<td>0.334</td>
</tr>
<tr>
<td>Freq Shift [Hz]</td>
<td>-0.0008</td>
<td>0.0127</td>
<td>0.0071</td>
<td>0.0159</td>
<td>0.108</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Tap 3: S(d) = 0.1 +/- 0.02

### A.17.3 Watterson I3

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>3.8</td>
<td>5.7</td>
<td>1.6</td>
<td>10.8</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>445000</td>
<td>445000</td>
<td>445000</td>
<td>750000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Freq. Spread</td>
<td>0.034</td>
<td>0.032</td>
<td>0.0658</td>
<td>0.0104</td>
</tr>
<tr>
<td>Freq Shift [Hz]</td>
<td>0.0764</td>
<td>0.0134</td>
<td>0.0989</td>
<td>0.121</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
<td>Gauss-Watterson</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>7.7</td>
<td>12.9</td>
<td>10.4</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>750000</td>
<td>1088000</td>
<td>1088000</td>
</tr>
<tr>
<td>LogNormal</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>Corr with</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>
### A.18 802.11n-SISO Standards

Option: R&S SMW-B14/B15

These fading profiles are implemented as the IEEE 802.11n-MIMO models, expect that:

- Correlation Path = Off
- Coefficient, % = 100
- Phase, deg = 0

See Chapter A.19, "802.11n-MIMO Standards", on page 301.

### A.19 802.11n-MIMO Standards

Option: R&S SMW-K71

According to IEEE 802.11-03/940r4

Rx Antenna Distance = 1

Tx Antenna Distance = 0.5

Distribution = Laplace

Profile = Bell Shape tgn Indoor, exception Model F, Path 3 where the Profile = Bell Shape tgn Moving Vehicle

Speed = 1.2 km/h, exception Model F, Path 3 where Speed = 40 km/h

#### A.19.1 Model A

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
</tr>
</tbody>
</table>
## A.19.2 Model B

### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>AoA</td>
<td>45</td>
</tr>
<tr>
<td>AS (A)</td>
<td>40</td>
</tr>
<tr>
<td>AoD</td>
<td>45</td>
</tr>
<tr>
<td>AS (D)</td>
<td>40</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
</tr>
</tbody>
</table>

### Path 1 (Path 4)

<table>
<thead>
<tr>
<th>Cluster</th>
<th>1</th>
<th>2</th>
<th>1</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>0</td>
<td>10.8</td>
<td>3.2</td>
<td>16.2</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>20</td>
<td>20</td>
<td>30</td>
</tr>
<tr>
<td>AoA:</td>
<td>4.3</td>
<td>4.3</td>
<td>118.4</td>
<td>4.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>14.4</td>
<td>14.4</td>
<td>25.4</td>
<td>14.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>225.1</td>
<td>225.1</td>
<td>106.5</td>
<td>225.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>14.4</td>
<td>14.4</td>
<td>25.4</td>
<td>14.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Path 2 (Path 1)

<table>
<thead>
<tr>
<th>Cluster</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>5.4</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>20</td>
</tr>
<tr>
<td>AoA:</td>
<td>4.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>14.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>225.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>14.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Path 3 (Path 4)

<table>
<thead>
<tr>
<th>Cluster</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>10.8</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>20</td>
</tr>
<tr>
<td>AoA:</td>
<td>4.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>14.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>225.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>14.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Path 4 (Path 1)

<table>
<thead>
<tr>
<th>Cluster</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>3.2</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>30</td>
</tr>
<tr>
<td>AoA:</td>
<td>4.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>14.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>225.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>14.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Path 5 (Path 4)

<table>
<thead>
<tr>
<th>Cluster</th>
<th>1</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td></td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>21.7</td>
<td>12.5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>40</td>
<td>50</td>
</tr>
<tr>
<td>AoA:</td>
<td>4.3</td>
<td>118.4</td>
</tr>
<tr>
<td>AS (A):</td>
<td>14.4</td>
<td>25.2</td>
</tr>
<tr>
<td>AoD:</td>
<td>225.1</td>
<td>106.5</td>
</tr>
<tr>
<td>AS (D):</td>
<td>14.4</td>
<td>25.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
<td></td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Path 6 (Path 1)

<table>
<thead>
<tr>
<th>Cluster</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>9.4</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>40</td>
</tr>
<tr>
<td>AoA:</td>
<td>4.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>14.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>225.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>14.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Path 7 (Path 4)

<table>
<thead>
<tr>
<th>Cluster</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>12.5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>50</td>
</tr>
<tr>
<td>AoA:</td>
<td>4.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>14.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>225.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>14.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Path 8 (Path 1)

<table>
<thead>
<tr>
<th>Cluster</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>15.6</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>60</td>
</tr>
<tr>
<td>AoA:</td>
<td>4.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>14.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>225.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>14.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Path 9 (Path 1)

<table>
<thead>
<tr>
<th>Cluster</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>18.7</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>70</td>
</tr>
<tr>
<td>AoA:</td>
<td>4.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>14.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>225.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>14.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
</tr>
</tbody>
</table>
### A.19.3 Model C

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4 (Path 1)</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>0</td>
<td>2.1</td>
<td>4.3</td>
<td>6.5</td>
<td>8.6</td>
<td>10.8</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
<td>50</td>
</tr>
<tr>
<td>AoA:</td>
<td>290.3</td>
<td>290.3</td>
<td>290.3</td>
<td>290.3</td>
<td>290.3</td>
<td>290.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>24.6</td>
<td>24.6</td>
<td>24.6</td>
<td>24.6</td>
<td>24.6</td>
<td>24.6</td>
</tr>
<tr>
<td>AoD:</td>
<td>13.5</td>
<td>13.5</td>
<td>13.5</td>
<td>13.5</td>
<td>13.5</td>
<td>13.5</td>
</tr>
<tr>
<td>AS (D):</td>
<td>24.7</td>
<td>24.7</td>
<td>24.7</td>
<td>24.7</td>
<td>24.7</td>
<td>24.7</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 7 (Path 10)</th>
<th>Path 7 (Path 10)</th>
<th>Path 8</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>13</td>
<td>5</td>
<td>15.2</td>
<td>7.2</td>
<td>17.3</td>
<td>9.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>60</td>
<td>60</td>
<td>70</td>
<td>70</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>AoA:</td>
<td>290.3</td>
<td>332.3</td>
<td>290.3</td>
<td>332.3</td>
<td>290.3</td>
<td>332.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>24.6</td>
<td>22.4</td>
<td>24.6</td>
<td>22.4</td>
<td>24.6</td>
<td>22.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>13.5</td>
<td>56.4</td>
<td>13.5</td>
<td>56.4</td>
<td>13.5</td>
<td>56.4</td>
</tr>
<tr>
<td>AS (D):</td>
<td>24.7</td>
<td>22.5</td>
<td>24.7</td>
<td>22.5</td>
<td>24.7</td>
<td>22.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
<tr>
<td>Tap:</td>
<td>Path 1</td>
<td>Path 2</td>
<td>Path 3</td>
<td>Path 4</td>
<td>Path 5</td>
<td>Path 6</td>
</tr>
<tr>
<td>--------------</td>
<td>---------</td>
<td>--------</td>
<td>---------</td>
<td>---------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Cluster</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>19.5</td>
<td>11.5</td>
<td>13.7</td>
<td>15.8</td>
<td>18</td>
<td>20.2</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>90</td>
<td>90</td>
<td>110</td>
<td>140</td>
<td>170</td>
<td>200</td>
</tr>
<tr>
<td>AoA:</td>
<td>290.3</td>
<td>332.3</td>
<td>332.3</td>
<td>332.3</td>
<td>332.3</td>
<td>332.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>24.6</td>
<td>22.4</td>
<td>22.4</td>
<td>22.4</td>
<td>22.4</td>
<td>22.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>13.5</td>
<td>56.4</td>
<td>56.4</td>
<td>56.4</td>
<td>56.4</td>
<td>56.4</td>
</tr>
<tr>
<td>AS (D):</td>
<td>24.7</td>
<td>22.5</td>
<td>22.5</td>
<td>22.5</td>
<td>22.5</td>
<td>22.5</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

**A.19.4 Model D**

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>0</td>
<td>0.9</td>
<td>1.7</td>
<td>2.6</td>
<td>3.5</td>
<td>4.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
<td>50</td>
</tr>
<tr>
<td>AoA:</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
</tr>
<tr>
<td>AS (A):</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
</tr>
<tr>
<td>AoD:</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 7 (Path 10)</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10 (Path 7)</th>
<th>Path 11</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>5.2</td>
<td>6.1</td>
<td>6.9</td>
<td>7.8</td>
<td>9.0</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>60</td>
<td>70</td>
<td>80</td>
<td>90</td>
<td>110</td>
</tr>
<tr>
<td>AoA:</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
</tr>
<tr>
<td>AS (A):</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
</tr>
<tr>
<td>AS (D):</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 12</th>
<th>Path 13</th>
<th>Path 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>11.1</td>
<td>9.5</td>
<td>13.7</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>140</td>
<td>140</td>
<td>170</td>
</tr>
<tr>
<td>AoA:</td>
<td>158.9</td>
<td>320.2</td>
<td>158.9</td>
</tr>
<tr>
<td>AS (A):</td>
<td>27.7</td>
<td>31.4</td>
<td>27.7</td>
</tr>
<tr>
<td>AS (D):</td>
<td>332.1</td>
<td>49.3</td>
<td>332.1</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 15</th>
<th>Path 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>19.3</td>
<td>17.4</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>240</td>
<td>240</td>
</tr>
</tbody>
</table>
### A.19.5 Model E

<table>
<thead>
<tr>
<th>Tap</th>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 5 (Path 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Moving Vehicle</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td></td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>2.6</td>
<td>3</td>
<td>3.5</td>
<td>3.9</td>
<td>4.5</td>
<td>1.8</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>163.7</td>
<td>163.7</td>
<td>163.7</td>
<td>163.7</td>
<td>251.8</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>35.8</td>
<td>35.8</td>
<td>35.8</td>
<td>35.8</td>
<td>41.6</td>
</tr>
<tr>
<td>AS (D):</td>
<td>105.6</td>
<td>105.6</td>
<td>105.6</td>
<td>105.6</td>
<td>105.6</td>
<td>293.1</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

#### R&S® SMW-B14/-B15/-K71/-K72/-K73/-K74/-K75/-K820/-K821

**802.11n-MIMO Standards**

---

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path 4 (Path 1)</td>
<td>Path 5 (Path 2)</td>
<td>Path 1 (Path 3)</td>
<td>Path 3 (Path 4)</td>
<td>Path 4 (Path 5)</td>
<td>Path 1 (Path 3)</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>36.1</td>
<td>36.1</td>
<td>36.1</td>
<td>42.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path 6 (Path 7)</td>
<td>Path 8 (Path 10)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cluster:</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Profil [Typ]:</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>5.6</td>
<td>3.2</td>
<td>6.9</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>80</td>
<td>80</td>
<td>110</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>251.8</td>
<td>163.7</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>41.6</td>
<td>35.8</td>
</tr>
<tr>
<td>AoD:</td>
<td>105.6</td>
<td>293.1</td>
<td>105.6</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>42.5</td>
<td>36.1</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 9</th>
<th>Path 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path 9 (Path 10)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cluster:</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]:</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>9.8</td>
<td>7.1</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>180</td>
<td>180</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>251.8</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>41.6</td>
</tr>
<tr>
<td>AoD:</td>
<td>105.6</td>
<td>293.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>42.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

#### R&S® SMW-B14/-B15/-K71/-K72/-K73/-K74/-K75/-K820/-K821

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 11 (Path 14)</th>
<th>Path 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>13.9</td>
<td>10.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>280</td>
<td>280</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>251.8</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>41.6</td>
</tr>
<tr>
<td>AoD:</td>
<td>105.6</td>
<td>293.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>42.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 13 (Path 15)</th>
<th>Path 14 (Path 11)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>18.3</td>
<td>14.7</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>380</td>
<td>380</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>251.8</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>41.6</td>
</tr>
<tr>
<td>AoD:</td>
<td>105.6</td>
<td>293.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>42.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 15 (Path 13)</th>
<th>Path 16</th>
<th>Path 17</th>
<th>Path 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
</tbody>
</table>

#### 802.11n-MIMO Standards
### A.19.6 Model F

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3 (Path 5)</th>
<th>Path 4 (Path 1)</th>
<th>Path 5 (Path 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td></td>
<td>1</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>3.3</td>
<td>3.6</td>
<td>3.9</td>
<td>4.2</td>
<td>4.6</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>50</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
<td>315.1</td>
<td>315.1</td>
<td>315.1</td>
<td>315.1</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>48</td>
<td>48</td>
<td>48</td>
<td>48</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>56.2</td>
<td>56.2</td>
<td>56.2</td>
<td>56.2</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
<td>41.6</td>
<td>41.6</td>
<td>41.6</td>
<td>41.6</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
<td>40</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8 (Path 10)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>5.3</td>
<td>2.8</td>
<td>6.2</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

#### 802.11n-MIMO Standards

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8 (Path 10)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay [ns]:</td>
<td>80</td>
<td>80</td>
<td>110</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
<td>180.4</td>
<td>315.1</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>55</td>
<td>48</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>183.7</td>
<td>56.2</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
<td>55.2</td>
<td>41.6</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 9</th>
<th>Path 10 (Path 8)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>8.2</td>
<td>5.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>180</td>
<td>180</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
<td>180.4</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>55</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>183.7</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
<td>55.2</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 11</th>
<th>Path 12 (Path 13)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>11</td>
<td>7</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>280</td>
<td>280</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
<td>180.4</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>55</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>183.7</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

#### 802.11n-MIMO Standards

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 11</th>
<th>Path 12 (Path 13)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS (D):</td>
<td>41.6</td>
<td>55.2</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>55</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>183.7</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 13 (Path 12)</th>
<th>Path 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster:</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]:</td>
<td>Bell Shape tgn Indoor</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>14.3</td>
<td>10.4</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>400</td>
<td>400</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
<td>180.4</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>55</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>183.7</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
<td>55.2</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster:</td>
<td>1</td>
</tr>
<tr>
<td>Profil [Typ]:</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>19.9</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>600</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>1.2</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
</tr>
</tbody>
</table>
### A.20 802.11ac-MIMO Standards

Option: R&S SMW-K71

The 802.11ac-MIMO channel models are conform for channel bandwidth ≤ 40 MHz.

According to IEEE 802.11-03/940r4

- Rx Antenna Distance = 1
- Tx Antenna Distance = 0.5
- Distribution = Laplace
- Profile = Bell Shape tgn Indoor, exception Model F, Path 3 where the Profile = Bell Shape tgn Moving Vehicle
- Speed = 0.089 km/h, exception Model F, Path 3 where Speed = 40 km/h

#### A.20.1 Model A (≤ 40 MHz)

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indoor</td>
</tr>
<tr>
<td>Loss [dB]</td>
<td>0</td>
</tr>
<tr>
<td>Delay [ns]</td>
<td>0</td>
</tr>
</tbody>
</table>
### A.20.2 Model B (≤ 40 MHz)

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>AoA</td>
<td>45</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS (A)</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AoD</td>
<td>45</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS (D)</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>0.089</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 5</th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>0</td>
<td>5.4</td>
<td>10.8</td>
<td>3.2</td>
<td>16.2</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>20</td>
<td>30</td>
</tr>
<tr>
<td>AoA:</td>
<td>4.3</td>
<td>4.3</td>
<td>118.4</td>
<td>4.3</td>
<td>118.4</td>
</tr>
<tr>
<td>AS (A):</td>
<td>14.4</td>
<td>14.4</td>
<td>25.2</td>
<td>14.4</td>
<td>25.2</td>
</tr>
<tr>
<td>AoD:</td>
<td>225.1</td>
<td>225.1</td>
<td>106.5</td>
<td>225.1</td>
<td>106.5</td>
</tr>
<tr>
<td>AS (D):</td>
<td>14.4</td>
<td>14.4</td>
<td>25.4</td>
<td>14.4</td>
<td>25.4</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>
### A.20.3 Model C (≤ 40 MHz)

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3 (Path 1)</th>
<th>Path 4</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>0</td>
<td>2.1</td>
<td>4.3</td>
<td>6.5</td>
<td>8.6</td>
<td>10.8</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
<td>50</td>
</tr>
<tr>
<td>AoA:</td>
<td>290.3</td>
<td>290.3</td>
<td>290.3</td>
<td>290.3</td>
<td>290.3</td>
<td>290.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>24.6</td>
<td>24.6</td>
<td>24.6</td>
<td>24.6</td>
<td>24.6</td>
<td>24.6</td>
</tr>
<tr>
<td>AoD:</td>
<td>13.5</td>
<td>13.5</td>
<td>13.5</td>
<td>13.5</td>
<td>13.5</td>
<td>13.5</td>
</tr>
<tr>
<td>AS (D):</td>
<td>24.7</td>
<td>24.7</td>
<td>24.7</td>
<td>24.7</td>
<td>24.7</td>
<td>24.7</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 7 (Path 10)</th>
<th>Path 7 (Path 10)</th>
<th>Path 8</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>13</td>
<td>5</td>
<td>15.2</td>
<td>7.2</td>
<td>17.3</td>
<td>9.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>60</td>
<td>60</td>
<td>70</td>
<td>70</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>AoA:</td>
<td>290.3</td>
<td>332.3</td>
<td>290.3</td>
<td>332.3</td>
<td>290.3</td>
<td>332.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>24.6</td>
<td>22.4</td>
<td>24.6</td>
<td>22.4</td>
<td>24.6</td>
<td>22.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>13.5</td>
<td>56.4</td>
<td>13.5</td>
<td>56.4</td>
<td>13.5</td>
<td>56.4</td>
</tr>
<tr>
<td>AS (D):</td>
<td>24.7</td>
<td>22.5</td>
<td>24.7</td>
<td>22.5</td>
<td>24.7</td>
<td>22.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 10 (Path 7)</th>
<th>Path 10 (Path 7)</th>
<th>Path 11</th>
<th>Path 12</th>
<th>Path 13</th>
<th>Path 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>19.5</td>
<td>11.5</td>
<td>13.7</td>
<td>15.8</td>
<td>18</td>
<td>20.2</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>90</td>
<td>90</td>
<td>110</td>
<td>140</td>
<td>170</td>
<td>200</td>
</tr>
<tr>
<td>AoA:</td>
<td>290.3</td>
<td>332.3</td>
<td>332.3</td>
<td>332.3</td>
<td>332.3</td>
<td>332.3</td>
</tr>
<tr>
<td>AS (A):</td>
<td>24.6</td>
<td>22.4</td>
<td>22.4</td>
<td>22.4</td>
<td>22.4</td>
<td>22.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>13.5</td>
<td>56.4</td>
<td>56.4</td>
<td>56.4</td>
<td>56.4</td>
<td>56.4</td>
</tr>
<tr>
<td>AS (D):</td>
<td>24.7</td>
<td>22.5</td>
<td>22.5</td>
<td>22.5</td>
<td>22.5</td>
<td>22.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

#### A.20.4 Model D (≤ 40 MHz)

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4 (Path 1)</th>
<th>Path 5</th>
<th>Path 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>0</td>
<td>0.9</td>
<td>1.7</td>
<td>2.6</td>
<td>3.5</td>
<td>4.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
<td>50</td>
</tr>
<tr>
<td>AoA:</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
</tr>
<tr>
<td>AS (A):</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
</tr>
<tr>
<td>AoD:</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 7 (Path 10)</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10 (Path 7)</th>
<th>Path 11</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>5.2</td>
<td>6.1</td>
<td>6.9</td>
<td>7.8</td>
<td>9</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>60</td>
<td>70</td>
<td>80</td>
<td>90</td>
<td>110</td>
</tr>
<tr>
<td>AoA:</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
<td>158.9</td>
</tr>
<tr>
<td>AS (A):</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
<td>27.7</td>
</tr>
<tr>
<td>AoD:</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
<td>332.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
<td>27.4</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 12</th>
<th>Path 13</th>
<th>Path 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>11.1</td>
<td>9.5</td>
<td>13.7</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>140</td>
<td>140</td>
<td>170</td>
</tr>
<tr>
<td>AoA:</td>
<td>158.9</td>
<td>320.2</td>
<td>158.9</td>
</tr>
<tr>
<td>AS (A):</td>
<td>27.7</td>
<td>31.4</td>
<td>27.7</td>
</tr>
<tr>
<td>AoD:</td>
<td>332.1</td>
<td>49.3</td>
<td>332.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>27.4</td>
<td>32.1</td>
<td>27.4</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 15</th>
<th>Path 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>19.3</td>
<td>17.4</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>240</td>
<td>240</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

#### 802.11ac-MIMO Standards

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 15</th>
<th>Path 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>AoA:</td>
<td>158.9</td>
<td>158.9</td>
</tr>
<tr>
<td>AS (A):</td>
<td>27.7</td>
<td>27.7</td>
</tr>
<tr>
<td>AoD:</td>
<td>332.1</td>
<td>332.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>27.4</td>
<td>27.4</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 17</th>
<th>Path 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster:</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>Profil [Typ]:</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>25.5</td>
<td>25.2</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>340</td>
<td>340</td>
</tr>
<tr>
<td>AoA:</td>
<td>320.2</td>
<td>276.1</td>
</tr>
<tr>
<td>AS (A):</td>
<td>31.4</td>
<td>37.4</td>
</tr>
<tr>
<td>AoD:</td>
<td>49.3</td>
<td>275.9</td>
</tr>
<tr>
<td>AS (D):</td>
<td>32.1</td>
<td>36.8</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### A.20.5 Model E ($\leq$ 40 MHz)

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1 (Path 4)</th>
<th>Path 2</th>
<th>Path 3 (Path 5)</th>
<th>Path 4 (Path 1)</th>
<th>Path 5 (Path 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster:</td>
<td>1</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profil [Typ]:</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td></td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>2.6</td>
<td>3</td>
<td>3.5</td>
<td>3.9</td>
<td>4.5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>50</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>163.7</td>
<td>163.7</td>
<td>163.7</td>
<td>251.8</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>35.8</td>
<td>35.8</td>
<td>35.8</td>
<td>41.6</td>
</tr>
<tr>
<td>AoD:</td>
<td>105.6</td>
<td>105.6</td>
<td>105.6</td>
<td>105.6</td>
<td>293.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>36.1</td>
<td>36.1</td>
<td>36.1</td>
<td>42.5</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

#### R&S® SMW-B14/-B15/-K71/-K72/-K73/-K74/-K75/-K820/-K821

#### 802.11ac-MIMO Standards

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 1 (Path 4)</th>
<th>Path 2 (Path 5)</th>
<th>Path 3 (Path 1)</th>
<th>Path 4 (Path 3)</th>
<th>Path 5 (Path 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed [km/h]</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8 (Path 10)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>5.6</td>
<td>3.2</td>
<td>6.9</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>80</td>
<td>80</td>
<td>110</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>251.8</td>
<td>163.7</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>41.6</td>
<td>35.8</td>
</tr>
<tr>
<td>AoD:</td>
<td>105.6</td>
<td>293.1</td>
<td>105.6</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>42.5</td>
<td>36.1</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 9</th>
<th>Path 10 (Path 8)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>9.8</td>
<td>7.1</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>180</td>
<td>180</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>251.8</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>41.6</td>
</tr>
<tr>
<td>AoD:</td>
<td>105.6</td>
<td>293.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>42.5</td>
</tr>
<tr>
<td>Speed [km/h]</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

#### R&S® SMW-B14/-B15/-K71/-K72/-K73/-K75/-K820/-K821

**802.11ac-MIMO Standards**

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 11 (Path 14)</th>
<th>Path 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>13.9</td>
<td>10.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>280</td>
<td>280</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>251.8</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>41.6</td>
</tr>
<tr>
<td>AoD:</td>
<td>105.6</td>
<td>293.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>42.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 13 (Path 15)</th>
<th>Path 14 (Path 11)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>18.3</td>
<td>14.7</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>380</td>
<td>380</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>251.8</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>41.6</td>
</tr>
<tr>
<td>AoD:</td>
<td>105.6</td>
<td>293.1</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>42.5</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 15 (Path 13)</th>
<th>Path 16</th>
<th>Path 17</th>
<th>Path 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Profil [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
</tbody>
</table>
### A.20.6 Model F (\(\leq 40 \text{ MHz}\))

<table>
<thead>
<tr>
<th>Tap</th>
<th>Path 1 (Path 4)</th>
<th>Path 2 (Path 3)</th>
<th>Path 3 (Path 1)</th>
<th>Path 4 (Path 5)</th>
<th>Path 5 (Path 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cls</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Prof [Typ]</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Moving Vehicle</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>3.3</td>
<td>3.6</td>
<td>3.9</td>
<td>4.2</td>
<td>4.6</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>50</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
<td>315.1</td>
<td>315.1</td>
<td>315.1</td>
<td>315.1</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>48</td>
<td>48</td>
<td>48</td>
<td>48</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>56.2</td>
<td>56.2</td>
<td>56.2</td>
<td>56.2</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
<td>41.6</td>
<td>41.6</td>
<td>41.6</td>
<td>41.6</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
<td>40</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

### Predefined Fading Settings

<table>
<thead>
<tr>
<th>Tap</th>
<th>Path 15 (Path 13)</th>
<th>Path 16</th>
<th>Path 17</th>
<th>Path 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>22.9</td>
<td>19.9</td>
<td>22.8</td>
<td>20.6</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>490</td>
<td>490</td>
<td>490</td>
<td>490</td>
</tr>
<tr>
<td>AoA:</td>
<td>163.7</td>
<td>251.8</td>
<td>80</td>
<td>182</td>
</tr>
<tr>
<td>AS (A):</td>
<td>35.8</td>
<td>41.6</td>
<td>37.4</td>
<td>40.3</td>
</tr>
<tr>
<td>AoD:</td>
<td>105.6</td>
<td>293.1</td>
<td>61.9</td>
<td>275.7</td>
</tr>
<tr>
<td>AS (D):</td>
<td>36.1</td>
<td>42.5</td>
<td>38</td>
<td>38.7</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
<tr>
<td>Tap:</td>
<td>Path 6</td>
<td>Path 7</td>
<td>Path 8 (Path 10)</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>--------</td>
<td>-----------------</td>
<td></td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>5.3</td>
<td>2.8</td>
<td>6.2</td>
<td>3.5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>80</td>
<td>80</td>
<td>110</td>
<td>110</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
<td>180.4</td>
<td>315.1</td>
<td>180.4</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>55</td>
<td>48</td>
<td>55</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>183.7</td>
<td>56.2</td>
<td>183.7</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
<td>55.2</td>
<td>41.6</td>
<td>55.2</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 9</th>
<th>Path 10 (Path 8)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster:</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]:</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>8.2</td>
<td>5.3</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>180</td>
<td>180</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
<td>180.4</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>55</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>183.7</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
<td>55.2</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 11</th>
<th>Path 12 (Path 13)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster:</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]:</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>11</td>
<td>7</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>280</td>
<td>280</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
<td>180.4</td>
</tr>
</tbody>
</table>
### Predefined Fading Settings

#### 802.11ac-MIMO Standards

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 11</th>
<th>Path 12 (Path 13)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>55</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>183.7</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
<td>55.2</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 13 (Path 12)</th>
<th>Path 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Profil [Typ]:</td>
<td>Bell Shape tgn Indorr</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>14.3</td>
<td>10.4</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>400</td>
<td>400</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
<td>180.4</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
<td>55</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
<td>183.7</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
<td>55.2</td>
</tr>
<tr>
<td>Speed [km/h]:</td>
<td>0.089</td>
<td>0.089</td>
</tr>
<tr>
<td>Distribution:</td>
<td>Laplace</td>
<td>Laplace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tap:</th>
<th>Path 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>1</td>
</tr>
<tr>
<td>Profil [Typ]:</td>
<td>Bell Shape tgn Indorr</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>19.9</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>600</td>
</tr>
<tr>
<td>AoA:</td>
<td>315.1</td>
</tr>
<tr>
<td>AS (A):</td>
<td>48</td>
</tr>
<tr>
<td>AoD:</td>
<td>56.2</td>
</tr>
<tr>
<td>AS (D):</td>
<td>41.6</td>
</tr>
</tbody>
</table>
A.21 802.11ac-SISO Standards

Option: R&S SMW-B14/B15

These fading profiles are implemented as the IEEE 802.11ac-MIMO models, except that:

- Correlation Path = Off
- Coefficient, % = 100
- Phase, deg = 0

See Chapter A.20, "802.11ac-MIMO Standards", on page 312.

A.22 802.11p Channel Models

Option: R&S SMW-B14/B15

According to C2C-CC TF Antennae & Wireless Performance – Whitepaper Vs 1.0

- Fading Profile = Custom
- Doppler Shape = Rayleigh
- Bandwidth = $2 \cdot \text{abs}(f_d)$
- Frequency Offset = 0 Hz
- for $fd > 0$: 
A.22.1 Rural LOS

This channel model is intended primarily as a reference result. It applies in very open environments where other vehicles, buildings and large fences are absent.

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static</td>
<td>0</td>
<td>14</td>
<td>17</td>
</tr>
<tr>
<td>Custom</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>(Relative) Loss [dB]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>8</td>
<td>10</td>
<td>15</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Delay [ns]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>117</td>
<td>183</td>
<td>333</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>f_o [Hz]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>236</td>
<td>-157</td>
<td>492</td>
<td></td>
</tr>
</tbody>
</table>

A.22.2 Urban Approaching LOS

Two vehicles approaching each other in an urban setting with buildings nearby.

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static</td>
<td>0</td>
<td>8</td>
<td>10</td>
<td>15</td>
</tr>
<tr>
<td>Custom</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>(Relative) Loss [dB]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>117</td>
<td>183</td>
<td>333</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Delay [ns]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>236</td>
<td>-157</td>
<td>492</td>
<td></td>
</tr>
</tbody>
</table>

A.22.3 Urban Crossing NLOS

Two vehicles approaching an Urban blind intersection with other traffic present. Buildings/fences present on all corners.

<table>
<thead>
<tr>
<th>Profile [Type]</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static</td>
<td>0</td>
<td>3</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td>Custom</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>(Relative) Loss [dB]:</th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>3</td>
<td>5</td>
<td>10</td>
<td></td>
</tr>
</tbody>
</table>
A.22.4 Highway LOS

Two cars following each other on Multi-lane inter-region roadways such as German autobahns and USA Interstates. Signs, overpasses, hill-sides and other traffic present.

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>267</td>
<td>400</td>
</tr>
<tr>
<td>$f_0$ [Hz]:</td>
<td>0</td>
<td>295</td>
<td>-98</td>
</tr>
</tbody>
</table>

A.22.5 Highway NLOS

As for Highway LOS but with occluding trucks present between the vehicles.

<table>
<thead>
<tr>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile [Type]</td>
<td>Static</td>
<td>Custom</td>
<td>Custom</td>
</tr>
<tr>
<td>(Relative) Loss [dB]:</td>
<td>0</td>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>0</td>
<td>200</td>
<td>433</td>
</tr>
<tr>
<td>$f_0$ [Hz]:</td>
<td>0</td>
<td>689</td>
<td>-492</td>
</tr>
</tbody>
</table>

A.23 5G NR Standards

Option: R&S SMW-B14/B15; MIMO profiles require R&S SMW-K74

According to 3GPP TS 38.101-4 and TS 38.141-1.

The following settings apply to all paths:
- Profile [Type] = Rayleigh
- LogNormal = Off
- Corr with = Off
- Power Ratio [dB] = 0
- Speed [km] = 0
Channel models naming convention

The names of the channel models follow the syntax:

\( \text{FR}<1|2> \quad \text{TDL}<A|B|C><\text{delay spread, ms}>-<\text{Doppler, Hz}> <\text{Low/Med/Med A/High/SISO}> \), where:

- FR designates the frequency band (FR1 below 6GHz, FR2 above 6GHz)
- Low/Med/Med A/High indicates the MIMO correlation matrix
- SISO designates the non-MIMO case; SISO and MIMO profiles are identical but in the SISO case correlation matrix is not relevant.

### A.23.1 FR1 TDLA30-5/10 Hz

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>5.1</td>
<td>9.6</td>
<td>15.5</td>
<td>5.1</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>10</td>
<td>15</td>
<td>25</td>
<td>0</td>
<td>20</td>
</tr>
<tr>
<td>Fine Delay required</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Doppler [Hz]: *</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>8.2</td>
<td>13.1</td>
<td>11.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>50</td>
<td>65</td>
<td>75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fine Delay required</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Doppler [Hz]: *</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Path 11</th>
<th>Path 12</th>
<th>Path 13</th>
<th>Path 14</th>
<th>Path 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>11</td>
<td>16.2</td>
<td>16.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>105</td>
<td>135</td>
<td>150</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fine Delay required</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Doppler [Hz]: *</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Path 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>26.2</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>290</td>
</tr>
<tr>
<td>Fine Delay required</td>
<td>1</td>
</tr>
<tr>
<td>Doppler [Hz]: *</td>
<td></td>
</tr>
</tbody>
</table>

*\) Doppler [Hz] = 5 Hz or 10 Hz
## A.23.2 FR1 TDLB100-400 Hz

Not supported in 4x4, 2x8 and 8x2 MIMO configurations.

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>2.2</td>
<td>0.6</td>
<td>0.3</td>
<td>0</td>
<td>0.6</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>10</td>
<td>30</td>
<td>35</td>
<td>0</td>
<td>20</td>
</tr>
<tr>
<td>Fine Delay required:</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Doppler [Hz]:</td>
<td>400</td>
<td>400</td>
<td>400</td>
<td>400</td>
<td>400</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>1.2</td>
<td>5.9</td>
<td>0.8</td>
<td>2.2</td>
<td>7.1</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>45</td>
<td>55</td>
<td>170</td>
<td>120</td>
<td>480</td>
</tr>
<tr>
<td>Fine Delay required:</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Doppler [Hz]:</td>
<td>400</td>
<td>400</td>
<td>400</td>
<td>400</td>
<td>400</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Path 11</th>
<th>Path 12</th>
<th>Path 13</th>
<th>Path 14</th>
<th>Path 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>6.3</td>
<td>7.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>245</td>
<td>330</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fine Delay required:</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Doppler [Hz]:</td>
<td>400</td>
<td>400</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## A.23.3 FR1 TDLC300-100 Hz

<table>
<thead>
<tr>
<th></th>
<th>Path 1</th>
<th>Path 2</th>
<th>Path 3</th>
<th>Path 4</th>
<th>Path 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>0</td>
<td>7.7</td>
<td>2.5</td>
<td>6.9</td>
<td>9.9</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>65</td>
<td>70</td>
<td>190</td>
<td>0</td>
<td>200</td>
</tr>
<tr>
<td>Fine Delay required:</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Doppler [Hz]:</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Path 6</th>
<th>Path 7</th>
<th>Path 8</th>
<th>Path 9</th>
<th>Path 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss [dB]:</td>
<td>2.4</td>
<td>6.6</td>
<td>13</td>
<td>8</td>
<td>7.1</td>
</tr>
<tr>
<td>Delay [ns]:</td>
<td>195</td>
<td>325</td>
<td>1045</td>
<td>240</td>
<td>520</td>
</tr>
<tr>
<td>Fine Delay required:</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Doppler [Hz]:</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Path 11</th>
<th>Path 12</th>
<th>Path 13</th>
<th>Path 14</th>
<th>Path 15</th>
</tr>
</thead>
</table>
A.23.4 FR2 TDLA30-75/300 Hz

The fading profile uses the same path settings as the settings defined for the FR1 TDLA30-5/10 Hz profiles; for the FR2 profiles merely the Doppler frequency changes to 75 Hz and 300 Hz.

See Chapter A.23.1, "FR1 TDLA30-5/10 Hz", on page 326.

A.23.5 MIMO Parameter

The MIMO correlation matrices for the high, medium and low antenna correlation are configured according to TS 38.101-4, section B.2.3.
B Antenna Pattern File Format

Antenna pattern files are XML files in the Rohde & Schwarz proprietary antenna pattern file format. These files use the predefined file extension *.ant_pat. They describe the antenna power response matrix as an array with resolutions of 1 degree to 5 degrees for both the elevation and the azimuth angles. In their minimum format, antenna pattern files contain only the loss values for a given azimuth angle. For an isotropic antenna for instance, that radiates the energy equally in all directions, the array elements are all 0 dB.

Antenna pattern files can also include the relative phase and antenna polarization information.

Parsing of antenna pattern files containing relative phase and polarization information requires option R&S SMW-K73.

Example: Antenna with three sectors (3Sectors.ant_pat) as specified in TR 25.996 (extract)

According to TR 25.996, the 3 sector antenna pattern is used for each sector. The following equation described the antenna pattern:

\[ A(\Theta) = -\min \left[ 12\left(\frac{\Theta}{\Theta_{3dB}}\right)^2, A_m \right] \]

Where:
- \(-180^\circ \leq \Theta < 180^\circ\) is the angle between the direction of interest and the boresight of the antenna
- \(\Theta_{3dB}\) is the 3 dB beamwidth in degrees
- \(A_m\) is the maximum attenuation

For the 3 sector scenario \(\Theta = 70^\circ\) and \(A_m = 40\) dB.

Note: The antenna pattern files define the antenna power and not the antenna gain.

<?xml version="1.0" encoding="ISO-8859-1"?>
<antenna_pattern>
  <antenna_descr count="1"/>
  <az_res>1.00000000e+000</az_res>
  <elev_res>1.00000000e+000</elev_res>
  <data>
    <!-- list of the azimuth values <az_values> -->
    -179.5,-178.5,-177.5,... -89.5, -88.5, -87.5, -86.5,...178.5,179.5
    <!-- <power_values> -->
    -89.5, 40, 40, 40, 40, 3.92e+01,3.84e+01,3.75e+01,3.66e+01,... 40,40
  </data>
</antenna_pattern>

The Table B-1 describes the used tags and parameters.
Example: Antenna pattern with polarization and relative phase information (extract)

This example contains comments for better understanding. Comments are indicated with <!-- and -->.

```xml
<?xml version="1.0" encoding="ISO-8859-1"?>
<antenna_pattern>
  <antenna descr>
    <antenna hasPhaseInfo="1" hasPolInfo="1"/>
  </antenna_descr>
  <az_res> 1.00000 </az_res>
  <elev_res> 1.00000 </elev_res>
  <data>
    <!-- list of the azimuth values <az_values> -->
    -180.0,-179.0... 0... 179.0,179.0
    <!-- vertical polarization <vertical_power_values> -->
    0,-9.722102564,-9.150142134... -12.79746154... -10.0064906,-9.722102564
    <!-- horizontal polarization <horizontal_power_values> -->
    0,-25.53114835,-25.53776203... -25.3327381... -25.48485262,-25.53114835
    <!-- vertical relative phase <vertical_phase_values> -->
    0,3.203435487,3.271611926... 3.767874967... 3.139292698,3.203435487
    <!-- horizontal relative phase <horizontal_phase_values> -->
    0,0.624420629,0.632933957... 0.56246144... 0.615821973,0.624420629
  </data>
</antenna_pattern>
```

### Table B-1: Format of *.ant_pat file

<table>
<thead>
<tr>
<th>Tag name</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;antenna_pattern&gt;</code></td>
<td></td>
<td>Defines antenna pattern file</td>
</tr>
<tr>
<td><code>&lt;antenna_descr&gt;</code></td>
<td></td>
<td>Contains the descriptions of the antennas</td>
</tr>
<tr>
<td><code>&lt;count&gt;</code></td>
<td></td>
<td>Number of antenna patterns; Value = 1 always</td>
</tr>
<tr>
<td><code>&lt;antenna&gt;</code></td>
<td></td>
<td>Descriptions of the individual antenna</td>
</tr>
<tr>
<td><code>&lt;hasPolInfo&gt;</code></td>
<td></td>
<td>Indicates if the file contains the vertical and horizontal gain information</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or not.</td>
</tr>
<tr>
<td></td>
<td>● &quot;0&quot;: gain information only (Antenna polarization is set with the parameter Antenna Polarization Slant Angle)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● &quot;1&quot;: vertical and horizontal gain information included</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The vertical and horizontal gain descriptions are mandatory</td>
<td></td>
</tr>
<tr>
<td><code>&lt;hasPhaseInfo&gt;</code></td>
<td></td>
<td>Indicates if the file contains relative phase description or not.</td>
</tr>
<tr>
<td></td>
<td>● &quot;0&quot;: no relative phase information</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● &quot;1&quot;: relative phase information included</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The relative phase description is mandatory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If also <code>&lt;hasPolInfo=&quot;1&quot;&gt;</code>, both the vertical and the horizontal relative phase descriptions are mandatory</td>
<td></td>
</tr>
<tr>
<td><code>&lt;az_res&gt;</code></td>
<td></td>
<td>Azimuth resolution of the antenna pattern description (<code>&lt;data&gt;</code> tag)</td>
</tr>
<tr>
<td></td>
<td>Value in degrees integer divider of 360</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Value range: -180° to 180°</td>
<td></td>
</tr>
</tbody>
</table>
## Tag name | Parameter | Description
--- | --- | ---
<elev_res> |  | Elevation resolution of the <data> tag
 |  | Value in degrees integer divider of 180
<data> |  | 2D antenna pattern description as an array with:
 |  | • [1 + 360<az_res>] columns
 |  | The first column indicates the elevation angle used to create the 2D pattern out of the 3D pattern. It is usually 0 degree.
 |  | • 2 to 5 rows, depending on the <hasPolInfo> and the <hasPhaseInfo> tags
 |  | The first row lists the azimuth angles <az_values>*).
 |  | The second row describes antenna power response in terms of loss values in dB, calculated as:
 |  | $20\log_{10}(\text{LinearGain})$
 |  | If <hasPolInfo>="1">, the descriptions of the vertical and horizontal power response of the antenna is mandatory.
 |  | Required are two rows, for the vertical and the horizontal information; always in this order.
 |  | If <hasPhaseInfo>="1">, the relative phase description is mandatory.
 |  | Required are one or, if <hasPolInfo>="1"> two rows - for the vertical and the horizontal information; always in this order.
 |  | Allowed are values in the range 0 rad to 2\pi rad.

*) If the azimuth angles (<az_values>) are given with lower resolution that the resolution specified with the <az_res> element, an interpolation is applied.

### How to create an antenna pattern file from the measured values

The radiated antenna pattern of the DUT is the measurement result of the stage 1 in the two stage MIMO OTA test method (see "About the MIMO OTA two stage method" on page 123). The following is an overview of the general steps required to convert the measured antenna pattern values into the Rohde & Schwarz 2D antenna pattern format.

#### General steps

1. Convert the azimuth value to the values range of -180° to 180°.
2. Convert the magnitude values expressed in dBm into loss values expressed in dB. The required power values are calculated as $20\log_{10}(\text{LinearGain})$
3. Interpolate the values to achieve an azimuth resolution of 1°
4. Create the 2D antenna pattern file

The example on Figure B-1 illustrates the required steps.
### Antenna Pattern File Format

#### R&S®SMW-B14/-B15/-K71/-K72/-K73/-K74/-K75/-K820/-K821

**Figure B-1: Converting custom data into the Rohde & Schwarz 2D antenna pattern file format**

1. Input file (extract, shows the first two and the last row)
2. Horizontal and vertical polarization values
3. Convert angle value for 0° to 360° to <az_values> = -180° to 180°
4. Convert magnitude values [dBm] to power [dB]
5. Interpolate the values to achieve azimuth resolution of 1°
6. Converted and interpolated values to achieve azimuth resolution of 1°

The example shows how to create the antenna pattern file of Antenna#2. An extract of antenna pattern file content is listed in Example “Antenna pattern with polarization and relative phase information (extract)” on page 330. The created file contains relative phase information and the description of the vertical and the horizontal polarizations `<antenna hasPhaseInfo="1" hasPolInfo="1"/>`.

Create the antenna pattern file of Antenna#1 in the same way but set the `<vertical_phase_values> = <horizontal_phase_values> = 0`.

<table>
<thead>
<tr>
<th>Phi</th>
<th>Antenna1</th>
<th></th>
<th>Antenna2</th>
<th></th>
<th>Delta Phase</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Magnitude [dBm]</td>
<td>Magnitude [dBm]</td>
<td>Antenna2 to Antenna1 [rad]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>-98.08118764</td>
<td>-90.41530118</td>
<td>-97.46156498</td>
<td>-99.62439586</td>
<td>0.56246144</td>
</tr>
<tr>
<td>15</td>
<td>-97.66130296</td>
<td>-65.13979326</td>
<td>-96.69758549</td>
<td>-92.7492214</td>
<td>0.37807383</td>
</tr>
<tr>
<td>345</td>
<td>-97.45984607</td>
<td>-93.42916732</td>
<td>-97.68697525</td>
<td>-93.97046242</td>
<td>0.80791088</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phi</th>
<th>Antenna1</th>
<th></th>
<th>Antenna2</th>
<th></th>
<th>Delta Phase</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Magnitude [dBm]</td>
<td>Magnitude [dBm]</td>
<td>Antenna2 to Antenna1 [rad]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-180</td>
<td>-97.86296976</td>
<td>-87.82683268</td>
<td>-97.66967525</td>
<td>-86.54900089</td>
<td>0.62442629</td>
</tr>
<tr>
<td>-165</td>
<td>-97.0861819</td>
<td>-91.13634303</td>
<td>-97.75918037</td>
<td>-77.39659443</td>
<td>0.75212055</td>
</tr>
<tr>
<td>180</td>
<td>-97.86296976</td>
<td>-87.82683268</td>
<td>-97.66967525</td>
<td>-86.54900089</td>
<td>0.62442629</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phi</th>
<th>Antenna1</th>
<th></th>
<th>Antenna2</th>
<th></th>
<th>Delta Phase</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Power [dB]</td>
<td>Power [dB]</td>
<td>Antenna2 to Antenna1 [rad]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-180</td>
<td>-23.92797258</td>
<td>-11.99890972</td>
<td>-25.53114835</td>
<td>-9.72102564</td>
<td>0.62442629</td>
</tr>
<tr>
<td>-165</td>
<td>-23.3363151</td>
<td>-14.36632057</td>
<td>-25.63053348</td>
<td>-1.1426861</td>
<td>0.75212055</td>
</tr>
<tr>
<td>180</td>
<td>-23.92797258</td>
<td>-11.99890972</td>
<td>-25.53114835</td>
<td>-9.72102564</td>
<td>0.62442629</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phi</th>
<th>Antenna1</th>
<th></th>
<th>Antenna2</th>
<th></th>
<th>Delta Phase</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Power [dB]</td>
<td>Power [dB]</td>
<td>Antenna2 to Antenna1 [rad]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-180</td>
<td>-23.92797258</td>
<td>-11.99890972</td>
<td>-25.53114835</td>
<td>-9.72102564</td>
<td>0.62442629</td>
</tr>
<tr>
<td>-170</td>
<td>-23.88840484</td>
<td>-11.7444377</td>
<td>-25.53776203</td>
<td>-9.15042134</td>
<td>0.63203967</td>
</tr>
<tr>
<td>180</td>
<td>-23.92797258</td>
<td>-11.99890972</td>
<td>-25.53114835</td>
<td>-9.72102564</td>
<td>0.62442629</td>
</tr>
</tbody>
</table>
Glossary: Specifications, References, Further Information

Symbols

[1]: http://www.ist-winner.org


[3]: 3GPP TSG RAN R4-136801 "Analysis of relative phase impact on two-stage results"

T

TGac: IEEE 802.11-09/0308r3
IEEE P802.11 Wireless LAN "TGac Channel Model Addendum"

TGn: IEEE 802.11-03/940r
IEEE P802.11 Wireless LAN "TGn Channel Models"

TR 25.996: Spatial channel model for Multiple Input Multiple Output (MIMO) simulations

TR 37.977: "Verification of radiated multi-antenna reception performance of User Equipment (UE)"

TS 34.114: "User Equipment (UE) / Mobile Station (MS) Over The Air (OTA) antenna performance; Conformance testing"

TS 38.101-4: "User Equipment (UE) radio transmission and reception; Part 4: Performance requirements"

TS 38.141-1: "Base Station (BS) conformance testing Part 1: Conducted conformance testing"
List of Commands

[:SOURCE]:FSIMulator:BYPass:STATe................................................................. 144
[:SOURCE]:FSIMulator:CATalog?................................................................. 153
[:SOURCE]:FSIMulator:DELETE................................................................. 142
[:SOURCE]:FSIMulator:MIMO:ANTenna:CATalog:USER?......................... 208
[:SOURCE]:FSIMulator:MIMO:ANTenna:CATalog........................................ 208
[:SOURCE]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical........ 206
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE............................. 207
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:COLUMN:SIZE............................ 207
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLe.................. 206
[:SOURCE]:FSIMulator:MIMO:ANTennad<di>:PFILe.................................... 223
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE............................. 222
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:COLumns:SIZE............................ 222
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontall.............. 208
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLE................... 206
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:ROWS:SIZE.................................. 207
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE............................. 222
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE............................. 207
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontall.............. 208
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLE................... 206
[:SOURCE]:FSIMulator:SCM:ANTenna:RX:CALC:MODE............................. 222
[:SOURCE]:FSIMulator:BYPass:STATe.................................................. 144
[:SOURCE]:FSIMulator:CATalog?................................................................. 153
[:SOURCE]:FSIMulator:DELETE................................................................. 142
[:SOURCE]:FSIMulator:MIMO:ANTenna:CATalog:USER?......................... 208
[:SOURCE]:FSIMulator:MIMO:ANTenna:CATalog........................................ 208
[:SOURCE]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical........ 206
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE............................. 207
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:COLUMN:SIZE............................ 207
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLe.................. 206
[:SOURCE]:FSIMulator:MIMO:ANTennad<di>:PFILe.................................... 223
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE............................. 222
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE............................. 207
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontall.............. 208
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLE................... 206
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:ROWS:SIZE.................................. 207
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE............................. 222
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:COLumns:SIZE............................ 222
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontall.............. 223
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLE................... 223
[:SOURCE]:FSIMulator:MIMO:ANTenna:RX:ROWS[S]:SIZE........................... 222
[:SOURCE]:FSIMulator:SYNchronize:STATE............................................ 153
[:SOURCE]<hw>:FSIMulator:BIRTHdeath:FRATio........................................ 178
[:SOURCE]<hw>:FSIMulator:BIRTHdeath:POSitions..................................... 177
[:SOURCE]<hw>:FSIMulator:BIRTHdeath:SOFSet........................................ 177
[:SOURCE]<hw>:FSIMulator:BIRTHdeath:STATe........................................... 179
[:SOURCE]<hw>:FSIMulator:CDYNamic:CATalog........................................ 227
[:SOURCE]<hw>:FSIMulator:CDYNamic:DELeate........................................... 227
[:SOURCE]<hw>:FSIMulator:CDYNamic:PATH<ch>:PROF.................................. 228
[:SOURCE]<hw>:FSIMulator:CDYNamic:PATH<ch>:STATe.............................. 228
[:SOURCE]<hw>:FSIMulator:CDYNamic:STATe............................................ 226
[:SOURCE]<hw>:FSIMulator:CLOCK:RATE?................................................. 146
[:SOURCE]<hw>:FSIMulator:CONFiguration............................................... 144
[:SOURCE]<hw>:FSIMulator:COPY:DESition.............................................. 145
[:SOURCE]<hw>:FSIMulator:COPY:EXECute............................................... 145
[:SOURCE]<hw>:FSIMulator:COPY:SOUnce.................................................... 145
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:COUPlle:LOGNornal:CSTD</td>
<td>163</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:COUPlle:LOGNornal:LCONstant</td>
<td>163</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:COUPlle:SPEeed</td>
<td>164</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:CPSeed</td>
<td>164</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:ADELay</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:BDELay</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:CORRelation:COEFficient</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:CORRelation:STATe</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:COPHase</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:CUSTom:DATA</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:CUSTom:DSHape</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:FDOPpler:ACTual?</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:FDOPpler[,RESulting]</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:FRATio</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:FSHift</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:FSPRead</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:LOGNornal:CSTD</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:LOGNornal:LCONstant</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:LOGNornal:STATe</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:LOSS</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:PRATio</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:PROFile</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:RDELay?</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:SPEeed</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:DELay</td>
<td>DEL:GROup&lt;st&gt;:PATH&lt;ch&gt;:STATe</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:FREQuency</td>
<td>146</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:FREQuency:DETect?</td>
<td>154</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:GLObal:SEED</td>
<td>147</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HOPPing:MODE</td>
<td>147</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:DISTance:Minimum</td>
<td>180</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:DISTance:STATe</td>
<td>181</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:DOWNlink:FREQuency</td>
<td>183</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe</td>
<td>183</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:FDOPpler?</td>
<td>181</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:FDOPpler:[:FREQuency]</td>
<td>182</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:FDOPpler:[:FRATio]</td>
<td>182</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:FDOPpler:[:FHAtch]</td>
<td>182</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:FDOPpler:[:FSPRead]</td>
<td>182</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:FDOPpler:[:FSTPeed]</td>
<td>182</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:FDOPpler:[:FXShift]</td>
<td>182</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:HSTRain:FDOPpler:[:FYShift]</td>
<td>182</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:LOAD</td>
<td>162</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:MDELay:ALL:MOVing:DELay:VARiation</td>
<td>184</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:MDELay:ALL:MOVing:VPERSiod</td>
<td>184</td>
</tr>
<tr>
<td>[:SOURce&lt;hw&gt;]:FSIMulator:MDELay:CHAnnel:MODE</td>
<td>185</td>
</tr>
</tbody>
</table>
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:ADELay......................................................... 165
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:BDELay......................................................... 166
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:CPHase....................................................... 185
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FDOPpler...................................................... 169
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FRATio......................................................... 170
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:LOSS............................................................. 172
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:PROFILE....................................................... 173
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:RDELay?....................................................... 166
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:SPEED......................................................... 174
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:STATE............................................................ 174
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DElay:MEAN............................................................................... 185
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DElay:VARIation......................................................................... 186
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:LOSS......................................................................................... 186
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:STATE......................................................................................... 187
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:VPERiod....................................................................................... 187
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:DElay..................................................................................... 187
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:LOSS....................................................................................... 187
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:STATE...................................................................................... 188
[:SOURce<hw>]:FSIMulator:MDELay:STATE.......................................................................................................... 188
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:STATE.................................................................... 209
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:MODeling:[STATE]........................................................................ 206
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:MODE......................................................................................... 206
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ANTenna<di>:PFILE.................................................................. 209
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:CALC:MODE........................................................................... 207
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:COLumn:SIZE....................................................................... 207
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:CROSSs.............................................................. 208
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:HORizontal.......................................................... 208
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:PATTERN.............................................................................. 209
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:POLarization:ANGLE........................................................... 206
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ROWS:SIZE.......................................................................... 207
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:CAPability?........................................................................ 189
[:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL...................................................................................................... 190
[:SOURce<hw>]:FSIMulator:MIMO:COPY:NEXT.................................................................................................. 190
[:SOURce<hw>]:FSIMulator:MIMO:COPY:PREVIOUS...................................................................................... 190
[:SOURce<hw>]:FSIMulator:MIMO:MDLoad....................................................................................................... 190
[:SOURce<hw>]:FSIMulator:MIMO:MDSTORE.................................................................................................. 190
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:ANGLE............................................................ 204
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:SPREAD.................................................................. 204
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEPArtature:ANGLE..................................................... 204
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEPArtature:SPREAD........................................................ 204
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DISTRIBUTION............................................................... 204
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:GAIN........................................................................... 203
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:STATE................................................................... 203
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:DOT...................................................................... 203
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:SPEED............................................................... 203
[:SOURce<hw>]:FSIMulator:MIMO:SUBSet......................................................................................................... 191
List of Commands

[:SOURce<hw>]:FSIMulator:MIMO:TAP .......................................................... 191
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:PRESet ......................................................... 196
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:<st>:GAIN ..................................................... 196
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:<st>:PHASe .................................................... 197
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:
  COLumn<st>:PHASe.................................................................................................................. 193
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:
  COLumn<st>:PHASe.................................................................................................................. 193
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:
  COLumn<st>:PHASe.................................................................................................................. 193
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:
  COLumn<st>:PHASe.................................................................................................................. 193
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:
  COLumn<st>:PHASe.................................................................................................................. 193
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:PHASe............................................................. 197
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:GAIN................................................................ 196
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:PRESet................................................................... 196
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ACCept ................................................................. 194
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:MODE...................................................................... 195
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:MAGNitude ......................................... 194
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:PHASe ............................................... 194
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:DISTRIBUTion ................................................................. 198
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:ANGLE .................................................. 199
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:SPRead .................................................. 199
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:ANGLE .............................................. 199
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:SPRead .................................................. 199
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:GAIN.................................................................... 199
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:STATE ................................................................. 200
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX .......................................................... 198
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX .......................................................... 198
[:SOURce<hw>]:FSIMulator:MIMO:TGN:PRESet ..................................................................................... 195
[:SOURce<hw>]:FSIMulator:RESTart:MODE ......................................................................................... 149
[:SOURce<hw>]:FSIMulator:RESTart:RMODE? ..................................................................................... 149
[:SOURce<hw>]:FSIMulator:ROUTe ........................................................................................................... 150
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ANTenna<di>:PFILe .................................................. 223
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:CALC:MODE ................................................................. 222
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:COLumnss:[SIZE] ............................................................. 222
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ESSpacing:HORizontal .................................................. 223
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:PATHern ........................................................................... 223
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ROWS:[SIZE]? .............................................................. 222
[:SOURce<hw>]:FSIMulator:SCM:DOT .................................................................................................... 219
[:SOURce<hw>]:FSIMulator:SCM:LOS:ARRival[<ANGLE>] ........................................................................... 224
[:SOURce<hw>]:FSIMulator:SCM:LOS:DEParture[<ANGLE>] ................................................................. 224
[:SOURce<hw>]:FSIMulator:SCM:LOS:KFACtor ...................................................................................... 224
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDOM:PHASe:HH ................................................................. 225
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDOM:PHASe:HV ................................................................. 225
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDOM:PHASE:STATE..............................224
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDOM:PHASE:VH................................225
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDOM:PHASE:VV................................225
[:SOURce<hw>]:FSIMulator:SCM:LOS:STATE..................................................224
[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:HORIZontal..................221
[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:VERTical.....................221
[:SOURce<hw>]:FSIMulator:SCM:SIGMa..............................................................219
[:SOURce<hw>]:FSIMulator:SCM:SPEed..............................................................218
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ANGLe.................................219
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:SPRead.............................220
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ANGLe............................219
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:SPRead..........................220
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:GAIN..................................................220
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:GAIN..........................220
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:STATE.......................220
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath:STATE.................................221
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:HH........................225
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:HV........................225
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:VH........................225
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:VV........................225
[:SOURce<hw>]:FSIMulator:SDESTination........................................................153
[:SOURce<hw>]:FSIMulator:SISO:COPY............................................................145
[:SOURce<hw>]:FSIMulator:SPEed:UNIT............................................................154
[:SOURce<hw>]:FSIMulator:STANdard...............................................................154
[:SOURce<hw>]:FSIMulator:STANdard:REFerence............................................161
[:SOURce<hw>]:FSIMulator:STORe.................................................................163
[:SOURce<hw>]:FSIMulator:TCINterferer:MOVing:DElay:MAXimum................211
[:SOURce<hw>]:FSIMulator:TCINterferer:MOVing:MMODE...............................212
[:SOURce<hw>]:FSIMulator:TCINterferer:PERiod...............................................212
[:SOURce<hw>]:FSIMulator:TCINterferer:REFERENCE:MOVing:DElay:MINimum......213
[:SOURce<hw>]:FSIMulator:TCINterferer:REFERENCE:MOVing:FDOPpler:ACTual?.....213
[:SOURce<hw>]:FSIMulator:TCINterferer:REFERENCE:MOVing:FDOPpler?...............213
[:SOURce<hw>]:FSIMulator:TCINterferer:REFERENCE:MOVing:FRATio?..............214
[:SOURce<hw>]:FSIMulator:TCINterferer:REFERENCE:MOVing:LOSS..................214
[:SOURce<hw>]:FSIMulator:TCINterferer:REFERENCE:MOVing:PROFILE................214
[:SOURce<hw>]:FSIMulator:TCINterferer:REFERENCE:MOVing:STATE..................214
[:SOURce<hw>]:FSIMulator:TCINterferer:SPEed...............................................212
[:SOURce<hw>]:FSIMulator:TCINterferer:[STATE]..............................................211
[:SOURce<hw>]:FSIMulator:[STATE].................................................................161
Index

Symbols
2 Channel Interferer ............................................................. 71
A
Accept Correlation Values .................................................. 102
Actual Doppler Shift ............................................................. 76
2 Channel Interferer ............................................................. 63
Additional delay ................................................................ 51
Antenna array
Antenna spacing .............................................................. 118, 135
Number of rows/columns ................................................... 118, 133
Relative phase ................................................................. 118, 134
Antenna Distance .............................................................. 107
Antenna polarization
Angle ............................................................................. 133
Number of rows/columns ................................................... 118, 133
Relative phase ................................................................. 118, 134
Spacing cross-polarization .................................................. 135
Spacing horizontal/vertical .................................................. 118, 135
Antennas array ................................................................. 130
Application cards ............................................................. 15
Application notes .............................................................. 15
Array Structure ............................................................... 130
Tx/Rx antennas ............................................................... 130
Auto detect output ........................................................... 33
B
Basic delay ........................................................................ 51
Birth Death Propagation ..................................................... 57, 176
Brochures ......................................................................... 15
Bypass if fading off ............................................................ 138
Description ...................................................................... 141
Enable during troubleshooting ........................................ 141
C
CDF
Customized dynamic fading .............................................. 77
Chamber effects
Compensate ..................................................................... 138
Channel model
IEEE 802.11p .................................................................. 85
Channel polarization
Cross polarization .............................................................. 116, 129
Pattern files with polarization information ......................... 129
Polarization mode ........................................................... 129
State ............................................................................... 116, 129
Channel polarization matrix ............................................. 130
CHST ............................................................................... 77
Clipped Samples ............................................................... 42, 148
Clock rate .......................................................................... 33
Cluster
Angle of arrival, AoA ....................................................... 111, 115
Angle of departure, AoD .................................................... 111, 115
AoA spread ....................................................................... 111, 115
AoD spread ...................................................................... 111, 115
Distribution ...................................................................... 111, 115
Gain ............................................................................... 110, 114
State ............................................................................... 110
Co-polarization .................................................................. 133
Coefficient for correlation ............................................... 55
Common speed for all paths ............................................. 47
Configuration fading ....................................................... 47
Configuration Fading ........................................................ 179
Conflict Correlation Values ............................................ 102
Constant Phase ................................................................. 52
Constant Phase – Fading .................................................. 165
Conventions
SCPI commands ............................................................... 142
Copy
Current settings to all taps ............................................... 99
Current settings to next tap ............................................... 99
Current settings to previous tap ....................................... 99
To next ........................................................................... 190
Copy fading settings ....................................................... 29
Copy Path Group ............................................................. 48
Copy settings
Destination ....................................................................... 48
Copy To Previous Tap ...................................................... 190
Copying a fading group .................................................... 47
Correlation Coefficient .................................................... 55
Correlation matrix
Fading MIMO settings .................................................... 94
Correlation Path ............................................................ 54
Correlation Phase .......................................................... 55
Coupled parameters ......................................................... 42
Coupled Parameters ......................................................... 39
Coupling
Local constant ................................................................. 43
Speed setting .................................................................... 43
Standard deviation ........................................................ 43
Start seed ........................................................................ 44
Cross polarization
Power ratio ..................................................................... 116, 129
Cross polarization power ratio ......................................... 126
Cross-polarization ............................................................ 133
Current path (tap) ............................................................ 99
Custom fading profile ..................................................... 85
Customized
Fading ............................................................................. 77
High-speed train .............................................................. 77
Customized dynamic
File ................................................................................. 78
Matrix .............................................................................. 79
Profile .............................................................................. 78
State .............................................................................. 78
D
Data sheets ........................................................................ 15
Dedicated
Connector ........................................................................ 36
Frequency ........................................................................ 36
Default settings ............................................................... 29
Delay
Birth Death ...................................................................... 60
Delay Max 2 Channel Interferer ......................................... 76
Delay Mean
Moving Path ................................................................. 69
Delay Min
2 Channel Interferer ........................................................ 75
Delay Positions
  Birth Death .................................................. 60
Delay Reference Path
  Moving Propagation .................................... 69, 187
Delay Variation
  Moving Propagation ...................................... 69, 71
Delay Variation Moving Path ........................................ 184
Delete
  Fading settings ........................................... 30
Direction of travel
  MS (mobile station) .................................. 110, 114
Distance ..................................................... 118, 135
Dmin ............................................................... 84
Documentation overview ........................................... 13
Doppler shift
  Actual ......................................................... 54
  Resulting .................................................... 53
DoT
  MS (mobile station) .................................. 110, 114
Downlink frequency
  Enabling ..................................................... 84
  Virtual value ................................................ 85
Ds ........................................................................ 84

E
Estimation
  Dedicated frequency ...................................... 33

F
Fader frequency
  Auto estimate .............................................. 33
  Automatic .................................................... 36
  Estimation fault ............................................ 33
  Manual ........................................................ 33
Fading
  Correlation matrix ........................................ 94
Fading settings
  Delete ......................................................... 30
  Load ............................................................ 30
  Recall .......................................................... 30
  Store ........................................................... 30
Fading simulator state .............................................. 29
Fine Delay ....................................................... 44
Flat Doppler ..................................................... 86
Frequency
  Higher cut-off ............................................ 87
  Lower cut-off .............................................. 87
  Offset ........................................................ 87
Frequency estimation
  Fault ........................................................... 33
Frequency I/Q modulator .............................................. 36
Frequency Ratio .................................................. 53
  2 Channel Interferer .................................... 75
  Birth Death .................................................. 62
Frequency Shift ..................................................... 52

G
Gain Vector
  gain ........................................................... 104
  phase ........................................................ 104
  preset ......................................................... 103, 196
Getting started .......................................................... 14
Grid
  Birth Death .................................................. 60

H
Help ...................................................................... 14
High-speed train
  Description ................................................... 79
  Scenarios ...................................................... 79
High-speed train state .............................................. 83
Hopping Dwell
  Birth Death .................................................. 61

I
Ignore RF changes < 5% ........................................ 36
Insertion Loss ..................................................... 42, 148
  Moving Propagation .................................... 69
  Insertion Loss Clipped Samples ...................... 42, 148
  Insertion Loss Configuration ......................... 39, 41, 148
  Insertion Loss Mode ..................................... 41, 148
Installation ..................................................... 16
Instrument help .................................................. 14
Instrument security procedures .................................. 15
Inverse channel matrix
  Apply .......................................................... 138
  Elements ...................................................... 138

K
Keep Constant ...................................................... 47

L
Load
  Fading settings .............................................. 30
  Local Constant .............................................. 55
  Lognormal Fading State .................................. 55
  LOS component
    Angle of arrival, AoA .................................. 121
    Angle of departure, AoD .............................. 121
    K factor .................................................... 121
    Random phases ......................................... 121
    Simulate .................................................. 120
    Start phase .............................................. 121
    LxMxN ....................................................... 92
Matrix mode ..................................................... 100
Matrix Mode ..................................................... 99
Max Delay
  Birth Death .................................................. 61
Max Delay Birth Death ........................................... 176
Mean Delay
  Moving Propagation ..................................... 69
MIMO
  Correlation matrix ....................................... 94
  LxMxN ......................................................... 92
  multi entity ................................................ 92
Min Delay
  Birth Death .................................................. 60
Mobile station
  Direction of travel, DoT .................................. 110, 114
  Speed ......................................................... 110, 114
  Velocity ..................................................... 110, 114
Moving Channels .................................................. 33, 185
Moving Mode
  2 Channel Interferer ..................................... 76
Moving Path State .................................................. 69, 187
Moving Propagation ................................................................. 63
Multi entity MIMO ................................................................. 92

N
Next tap ....................................................................................................... 99

O
Open source acknowledgment (OSA) ........................................... 15

P
PAS ................................................................................................. 111, 115
Path filter .......................................................................................... 47
Path graph .......................................................................................... 56
Path Loss .................................................................................................. 51
2 Channel Interferer ........................................................................ 60
Birth Death .......................................................................................... 69
Moving Path .......................................................................................... 69
Reference Path .......................................................................................... 69
Period Dwell
2 Channel Interferer ........................................................................ 76
Phase of correlation coefficient .......................................................... 55
Phase/Imaginary Correlation Value ...................................................... 102
Polarization .................................................................................................. 100
Positions
Birth Death .......................................................................................... 60
Power Ratio
Rice Fading .......................................................................................... 51
Previous tap .......................................................................................... 99
Profile
2 Channel Interferer ........................................................................ 75
Birth Death .......................................................................................... 60
HST ........................................................................................................ 83
Profile Birth Death .................................................................................. 177
Profile Path .............................................................................................. 49

R
Ray
Angle of arrival AoA ........................................................................ 108
Angle of departure AoD ................................................................. 108
AoA spread ......................................................................................... 108
AoD spread ......................................................................................... 108
Gain ........................................................................................................ 107
State ........................................................................................................ 107
Real/Ratio Correlation Value ............................................................... 102
Recall
Fading settings ...................................................................................... 30
Relative phase
Instead of antenna spacing ......................................................... 118, 134
Prerequisites ......................................................................................... 118, 134
Release notes ........................................................................................... 15
Restart
Event ................................................................................................. 38
Mode ......................................................................................................... 38
Resulting delay ....................................................................................... 51
Resulting Doppler shift ........................................................................... 53
Resulting Doppler Shift ................................................................. 169
2 Channel Interferer ........................................................................ 75
Birth Death .......................................................................................... 62
Rician factor .......................................................................................... 84
Route ......................................................................................................... 88

S
Safety instructions .................................................................................. 15
Save
Fading settings ...................................................................................... 30
SCM
Distribution ......................................................................................... 108
Service manual ................................................................................... 14
Set to default ......................................................................................... 29
Show
Path graph .............................................................................................. 56
Sigma .......................................................................................................... 114
Signal dedicated to ............................................................................ 33
Signal Routing ......................................................................................... 88
Slant angle
Antenna polarization ........................................................................... 133
Slant-polarized antennas ..................................................................... 133
Spacing cross-polarization .................................................................... 133
Antenna array ....................................................................................... 135
Antenna array .......................................................................................... 118, 135
Speed
2 Channel Interferer ........................................................................ 75
Birth Death .......................................................................................... 62
HST .......................................................................................................... 84
MS (mobile station) ............................................................................. 110, 114
Pure Doppler ......................................................................................... 52
Rayleigh .................................................................................................... 52
Rice Fading ........................................................................................... 52
Speed unit ............................................................................................... 47
Speed Unit .............................................................................................. 154
Standard ................................................................................................. 30
Standard Delay ..................................................................................... 44
Standard Deviation .................................................................................. 56
Start Offset
Birth Death .......................................................................................... 61
Start Seed .............................................................................................. 147
State
2 Channel Interferer ........................................................................ 74
Birth Death Propagation .................................................................... 30, 179
Fading simulator ................................................................................... 29
HST .......................................................................................................... 83
HST scenario 1 ...................................................................................... 83
HST scenario 3 ...................................................................................... 83
Moving Path .......................................................................................... 69
Moving Propagation ........................................................................... 188
Path delay .............................................................................................. 48
Reference Path ....................................................................................... 69, 188
Standard delay ..................................................................................... 30
State Moving Path ............................................................................... 187
Store
Fading settings ...................................................................................... 30

T
Test case ............................................................................................... 30
Test case reference ............................................................................... 30
Trigger ....................................................................................................... 37
Troubleshooting
Enable Bypass if Fading Off ............................................................. 141
Tutorials ................................................................................................. 14
Tx/Rx Antenna ....................................................................................... 100

U
UL Timing Adjustment ........................................................................... 66
User manual ............................................................................................... 14
V

Variation Period
   Moving Path ......................................................... 70, 71
Variation Period Moving Path ...................................... 184, 187
Velocity
   MS (mobile station) .............................................. 110, 114
Virtual bandwidth ..................................................... 86
Virtual profile ............................................................ 86
Virtual RF frequency ................................................... 36

W

White papers ........................................................... 15

X

XPR
   Vertical/horizontal ............................................... 116, 129